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Notice

Every effort was made to ensure that the information in this book was complete and
accurate at the time of printing. However, information is subject to change without notice.

Your Responsibility for Your System’s Security

Toll fraud is the unauthorized use of your telecommunications system by an unauthorized
party, for example, persons other than your company’s employees, agents,
subcontractors, or persons working on your company’s behalf. Note that there is a risk of
toll fraud associated with your telecommunications system and, if toll fraud occurs, it can
result in substantial additional charges for your telecommunications services.

You and your system manager are responsible for the security of your system, such as
programming and configuring your equipment to prevent unauthorized use. The system
manager is also responsible for reading all installation, instruction, and system
administration documents provided with this product in order to fully understand the
features that can introduce risk of toll fraud and the steps that can be taken to reduce that
risk.

The manufacturer does not unconditionally warrant that this product is immune from or
will prevent unauthorized use of common-carrier telecommunications services or facilities
accessed, or any charges that result from such unauthorized use.

Trademarks

Touch-Tone is a registered trademark of American Telephone and Telegraph Company.

Dialogic is a registered trademark of Dialogic Corporation.

Rhetorex is a registered trademark of Rhetorex, Inc.

TR112 is a trademark of Brooktrout Technology. Inc.

Sentinel is a registered trademark of Rainbow Technologies, Inc.

Microsoft, MS-DOS, Windows, and Windows NT are registered trademarks of Microsoft
Corporation.



FCC Part 15 Requirements

The components of the Octel 50 system described in this manual have been deemed to
comply with FCC Part 15.

Octel 50 equipment has been tested and found to comply with the limits for Class B
computing devices in accordance with the specifications in Subpart J of Part 15 of the
FCC rules. These specifications are designed to provide reasonable protection against
interference.

Some telephone companies require you to notify them if you connect electronic
communications equipment to the telephone lines. Provide the telephone company with
the FCC registration and Ringer Equivalence Numbers (REN). The sum of the RENs from
all equipment on one phone line must be less than 5. Note that the Octel 50 ringer
equivalence is approximately 0.5.

FCC Part 68 Requirements

The components of the Octel 50 system described in this manual have been deemed to
comply with the requirements of Part 68 of the FCC rules. Octel 50 equipment has a label
that contains the FCC registration and Ringer Equivalence Numbers (RENs) for the
board.

Some telephone companies require you to notify them if you connect electronic
communications equipment to the telephone lines. Provide the telephone company with
the FCC registration and Ringer Equivalence Numbers. The sum of the RENs from all
equipment on one phone line must be less than 5. Note that the Octel 50 ringer
equivalence is approximately 0.5.

The REN is used to determine the number of devices you can connect to the telephone
line and still be assured that all of those devices ring properly when the number is called.
In most areas, the sum of the RENs of all devices should not exceed 5. To be certain of
the number of devices you may connect to the line as determined by the RENs, call the
local telephone company and request information on the maximum REN for the calling
area.

The local telephone company must be notified prior to installation that you are connecting
a registered device to the phone system. You must also provide the following information
to the telephone company for it to select the correct type of service for its lines:

• Service type: Loop Start or Ground Start—see paragraph 4.1 of the Configuration
Note for the switch

• Jack required:  Multiple RJ-14

• Order in which you want incoming lines to be when they are connected to the
jacks

• Ringer Equivalence Number:  0.5A

The telephone company may make changes in its technical operation or procedures. If
these changes affect the use of this equipment, the telephone company is required to
provide you advance notice.



Ordering Information

Use the following information when ordering additional copies of this manual:

Call: Lucent Technologies BCS Publications Center
Voice 1-800-457-1235
Fax 1-800-457-1764
International Voice 1-317-322-6791
International Fax 1-317-322-6849

Write: Lucent Technologies BCS Publications Center
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Indianapolis, IN 46219
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How to Comment on This Manual

Use the feedback form located after this section to send your comments and
recommendations for changes.



Customer Feedback Form

We would like to hear from you about the quality of the documentation, products, and service.  Your
comments will help us provide increased satisfaction to our customers.  Would you please take a
few minutes and complete the following questionnaire and fax it to 303-538-1741.

Please rate the effectiveness of this Implementation and Service Manual in the following areas:

Area Excellent Good Fair Poor

1 Organization

2 Clarity

3 Completeness

4 Accuracy

5 Illustrations

6 Overall satisfaction

Please provide any other comments.
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C H A P T E R  1

Installation Overview

The Octel 50 Installation Guide is designed to provide technical information and guidance
for installing, configuring, and maintaining the Octel 50 system. This manual contains
comprehensive step-by-step procedures that help you:

• Install and configure the Octel 50 system

• Configure Octel 50

• Maintain the Octel 50 system

• Troubleshoot the Octel 50 system

This manual provides information on using all available Octel 50 features and options.
Note, however, that all features and options are not available with all Octel 50 systems.

Tabs for this Installation Guide are provided in separate wrapping. Insert the tabs before
their corresponding sections. Use the Additional Information tab for storing release notes,
manual updates, or other materials you may receive periodically for the Octel 50 system.
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Octel 50 System Overview

Octel 50 is an automated attendant and voice and fax messaging system that controls call
handling. As an automated attendant, Octel 50 greets incoming callers and instructs them
on how to proceed through the system using the messaging features. This type of
technology gives total control of a call to the user. If an extension is busy or there is no
answer, Octel 50 can take a message from the caller or transfer the call to another
extension.

The automated attendant features in Octel 50 can also provide callers with company
directories, automatically transfer callers from rotary phones to an operator, and answer
calls with after-hours or holiday greetings. The attendant can screen callers for the
subscriber, provide music or product messages while a caller is on hold in a queue, and
redirect a call either before it is transferred to an extension or only if the extension is busy
or not answered.

Octel 50’s messaging features eliminate “telephone tag” and incorrect or lost messages.
The system’s voice messaging features allow subscribers to send, receive, delete, skip,
redirect, review, and update messages. Subscribers can pause, fast-forward, and rewind
messages; send copies of messages to other subscribers; designate messages as listen-
only, private, or urgent; confirm message reception; and forward messages. The system’s
fax features allow subscribers to send and receive fax messages and to include fax
documents in voice response applications that they create. The AMIS Interface Module
(AIM) allows subscribers to send and receive messages to and from other voice mail
systems that support the AMIS-analog protocol.

Octel 50 is a voice-prompted, menu-driven system. Through voice prompts, the system
conveys information that includes the options subscribers can choose from to proceed. As
subscribers become familiar with the voice prompts for the options they use most often,
they can interrupt the prompts by pressing the telephone keypad button for an option
before the prompt is completely voiced.

Related Documentation

The following materials provide additional information that complements the information
presented in the Installation Guide:

• Octel 50 Quick Reference Guide—An easy-to-reference, foldout card, the Quick
Reference Guide shows system subscribers the telephone keypress navigation
paths to accessing voice mail features. Twenty-five Quick Reference Guides are
provided with each system shipped.

• Octel 50 Supervisor’s Guide —The supervisor is the individual at the customer
site who will be responsible for maintaining the installed Octel 50 system. The
Administration Guide can be left with the system supervisor at the site. The book
provides information on creating, modifying, and deleting mailboxes; setting and
modifying automated attendant features; generating system reports, and using
various other system features such as AMIS, V-Trees, and fax retrieval.

• Configuration Notes—Each switch supported by Octel 50 has an associated
Configuration Note that provides comprehensive, switch-specific integration
considerations. Configuration Notes are updated monthly. For information on
obtaining the latest version of configuration notes, contact a technical support
representative.
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C H A P T E R  2

Determining System Needs

This section discusses items you should consider before you set up the Octel 50 system
hardware and install the system software. The steps in this section help you:

• Determine system application and requirements

• Determine hardware requirements
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Step 1:  Determining the System Application and Requirements

Before installing the Octel 50 system, it is important to identify what tasks the system is
expected to perform. This determines what options may be required and which system
features you should enable. Use the following table as a guide.

Considerations Associated System Features

What type of phone system is the customer using; what
type of integration is necessary?

Integrator/SMDI

Number of phone extensions Number of ports

How many subscribers use the system? Number of mailboxes

Do certain subscribers require different features? Class of service

How many and what type voice boards are required? Number of ports

What options does the customer want callers to hear
when they first call into the system?

Attendant Menu

What morning, afternoon, evening, office closed, or
holiday prompts does the customer want?

System prompts

What kind of information or background music does the
customer want callers to hear while they are on hold?

Call Queuing phrases

How many languages are supported on the system?
Have the appropriate voice files been ordered?

Multiple languages

Does the customer want different lines answered with
different types of greetings?  Do several companies
share one system, each requiring a unique greeting?

Greeting by port

When and where do subscribers want to receive
notification of new messages in their system
mailboxes?

Message delivery

During which days and hours does the customer want
the system to voice daily greetings?

Business Hours

Does the customer want to be able to send faxes to
callers requesting information?
Does the customer want subscribers to be able to
receive faxes in their voice mailboxes?

Fax Solution module

Does the customer want to be able to send messages
via a network to other voice mail systems?

AMIS Interface module
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Step 2:  Determining the Hardware Requirements

The following hardware requirements are the minimum requirements for adequate system
performance.

Hard Drive Size

To determine the minimum amount of disk storage space needed to operate the system,
enter the information in the following list, then use the formula provided to calculate the
required hard drive size:

a. Number of subscribers _____

b. Average message length in seconds    45

c. Number of new and saved messages per subscriber (avg.)      5

d. Message seconds (a x b x c) _____

e. Audiotex (V-Trees) time in seconds (avg.)  1800

f. Total time in seconds (d + e) _____

g. Total recorded hours (f÷3600) _____

h. Megabytes needed for messages (g x 13.5) _____

i. Megabytes needed for Octel 50 software, prompts,     20
and up to 1000 subscribers

j. Megabytes needed for each additional 1000 subscribers _____
(5 for each additional 1000)

k. Estimated number of pages needed for fax applications _____

l. Megabytes needed for fax applications (k÷15) _____

Total Megabytes Needed (h + i + j + l) _____

If you are installing optional software, such as remote maintenance software, make sure
you allow sufficent hard drive space. See the documentation for the optional software you
are installing to identify hard drive space requirements.

CPU and Memory Requirements

The following table provides the minimum CPU and memory required for a PC to run
Octel 50. Do not attempt to run Octel 50 with memory capacity less than that listed here.

The PC’s BIOS should be millennium-compliant. See the PC’s documentation or contact
the PC manufacturer for information.

Ports CPU Clock Speed
MHz

RAM Extended
Memory

Ext. Memory
for Fax

4 386SX 16 640KB 1 MB 1 MB

6 386SX 16 640KB 1 MB 1 MB

8 386SX 20 640KB 2 MB 1 MB

12 386SX 20 640KB 2 MB 1 MB

16 386DX 25/33 640KB 3 MB 1 MB
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If you want the system to put the voice files in RAMDisk, 1 megabyte of memory is
required. For additional information on RAMDisk, see Chapter 4, “Installing the Software.”

At least 1 additional megabyte should be installed as a SMARTDrive. SMARTDrive is a
DOS 5.0 or higher disk-caching utility that allocates memory (cache) for storing
information usually read from the hard drive.

For example, suppose there is 4 MB of memory on the system. Octel 50 resides in 450K
of the base 640K RAM (the first megabyte). If a RAMDisk is selected during installation, it
uses the second megabyte. If SMARTDrive is chosen, it uses the third and fourth
megabytes.

Step 3:  Consider Additional Hardware Needs

The following hardware requirements represent the minimum to effectively run Octel 50.

Some additional hardware, such as a printer, modem (for remote maintenance), and tape
backup unit can optionally be used with the Octel 50 system. This optional hardware is not
supplied and the optional hardware is not supported by technical support.

Monitor

An VGA or better monitor should be used.

3½-inch Floppy Drive

One 1.44 megabyte, 3½-inch drive is necessary to install software and perform system
backups.

Parallel Port

A parallel port is required for the Sentinel® protection device and the optional printer. This
port must be bidirectional, as most are today.

Serial Port (Optional)

Depending on the system configuration, up to 4 serial (RS-232) ports may be required:

• Mouse (unless using a bus-type mouse)

• UPS integration

• Serial integration

• External modem for remote diagnostics

If you require additional serial ports, contact your authorized representative.

Mouse

A mouse can be used with the system, but is not required for full functionality of the
system.
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Printer (Optional)

A printer can be attached to the Octel 50 PC to produce hard copies (for example,
reports). The printer, which must connect to a parallel port, can be attached to the back of
the system’s sentinel unit.

If you attach a printer to the system’s sentinel, make sure you leave the printer on at all
times and never shut off power to the printer while it is connected to the sentinel. It is
recommended that you disconnect the printer from the sentinel when you are not using it.

Modem (Optional)

A modem may be used for remote diagnostics. Modems with a minimum speed of 9600
bps are recommended. An external modem that can utilize interrupts 10 through 15 is
recommended. It is suggested that you use COM2 for the modem. Contact your
authorized representative for additional information.

Tape Backup (Optional)

A tape backup unit can be used to archive the entire Octel 50 system or a portion of it (for
example, phrase files). Make sure a DOS-compatible tape backup unit is used.

Voice Boards

Dialogic® and Rhetorex® voice boards are supported for the Octel 50 system. Octel 50
only recognizes a voice board if the EPROM has been programmed to contain the proper
“signature.”  If a nonsignatured board is detected during initialization, its ports are
disabled.

Brooktrout TR112 Fax Boards (Optional)

A Brooktrout TR112 fax board may be installed to use the Fax Solution fax mail and fax
retrieval features. Octel 50 only recognizes a fax board if the EPROM has been
programmed to contain the proper “signature.”  If a nonsignatured board is detected
during initialization, its ports are disabled.

Call your authorized representative for additional information.

Uninterruptible Power Supply (Optional)

An Uninterruptible Power Supply (UPS) protects the Octel 50 PC from a sudden loss of
power. You must connect the UPS to a serial port if you plan to run UPS integration. It is
suggested that you connect the UPS to COM1.

Call your authorized representative for additional information.
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Installing the Hardware

This section provides information for configuring and installing the hardware required to
run Octel 50. The steps in this section help you:

• Assemble the required materials

• Preparing the phone system

• Configure and install the voice boards

• Configure and install the fax boards

• Connect phone and fax lines

• Install peripheral hardware
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 Step 1:  Assembling All Materials

 The following list of materials should be assembled before beginning the hardware
installation.

 Materials Checklist

  Assembled PC, including:  

   CPU (Memory and hard disk should already be installed.)

   CPU power cord

   Monitor-to-CPU cord

   Monitor

   Monitor power cord

   Keyboard

   Printer and cable (Optional)

  Voice and fax boards  

  Sentinel  

  UPS  

  UPS cable  

  Butt set  

  Digit grabber  

  Ground strap  

  Modular RJ-14 cables (4-connector)  

  Power strip  

  2500 set (at least one)  

  Phone system documentation  

  Octel 50 Configuration Note for the customer’s switch  

  Line simulator  

  DOS installation disks and manual  

  Octel 50 software  

  Octel 50 manuals  

  Hard disk utility software and manual  

  One or two boxes of high-density disks for system backup  

  Mouse, software, and manual (Optional)  

  Modem, software, and manual (Optional)  

  Tape backup, software, and manual (Optional)  

  Tool kit (Phillips and flathead screwdrivers, wire strippers, crimping tool,
punch down tool, etc.)

 

Optional items, such as a modem or tape backup unit are not provided with the Octel 50
system nor are they supported by technical support.
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 Step 2:  Verifying Phone System Readiness

 Before beginning hardware installation, you must prepare the phone system by:

• Confirming the presence of a dial tone on each board used

• Verifying that the phone system is configured properly

• Compiling phone system configuration information

Confirming Dial Tone

The first step in preparing the phone system at the customer site is to establish the
presence of dial tone.

To confirm the presence of a dial tone on the phone system:

1. Connect one end of a modular plug into the phone system.

2. Plug the other end of the modular plug into a 2500 set, a telephone test set, or the
proprietary telephone instrument if using a Dialogic D/42D-NS or D/42D-SX
integration.

3. Lift the handset and confirm that a dial tone is present.

Verifying the Phone System Configuration

Verify that the phone system is configured properly for the system:

• Ensure that the phone system technician followed the procedures detailed in the
latest Configuration Note when programming the phone system.

• If a Configuration Note is not available for the customer’s switch, contact a
technical support representative for information on the codes required.

 Compiling Phone System Configuration Information

 Obtain the following phone system configuration information:

• List of hunt groups configured for the phone system, if there are any.

• List of active phone system features, such as a distinctive ring or auto answer, so
you can ensure they do not conflict with the intended system application.

 Step 3:  Configuring the Voice Boards

 Voice boards provide the interface between Octel 50 and the phone system that allows
them to communicate. You must configure the voice boards for use with the Octel 50
system before you install them.

 Voice boards contain ports, which are the interface between a voice board and a phone
system channel. The Octel 50 system supports a maximum of 16 ports. System access to
ports is controlled by the sentinel attached to the Octel 50 PC.

 The boards you install in the Octel 50 PC must be purchased from an authorized
representative so they are programmed with the proper signature. If a nonsignatured
board is detected during Octel 50 system initialization, the board is disabled. In addition,
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the system writes an entry to the log file identifying the location of the nonsignatured
board.

 The Octel 50 system supports Dialogic voice boards for new systems. Rhetorex boards
are supported for existing systems in which they are already installed.

 Use caution when handling voice boards as they are electrostatic-sensitive. Ensure you
ground the PC, the work area, and the ground end of the antistatic wrist strap prior to
handling a board, and always use antistatic wrist straps and electrostatic-dissipative mats
while handling a board.

 Configuring Dialogic Boards

 Octel 50 supports the DIALOG/4 and D/42D-SX boards for new Octel 50 systems. In
addition, the Dialogic D/4xD board is supported for existing systems in which it is already
installed.

 The following figure illustrates the DIALOG/4 board.

 

The following diagram illustrates the D/4xD board. The location of the relevant jumpers
and switches on the D/42D-SX board is approximately the same as on the D/4xD board.

 Dialogic boards are all configured the same way for Octel 50. Complete the following
steps, as required, to configure each Dialogic board:

• Set the board’s base shared memory address

• Modify the board’s base memory segment

• Set the board’s hardware interrupt

• Set the default line state
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• Configure for multiple boards

 Setting the board’s base shared memory address –The base shared memory address
allows the voice board to communicate with the voice driver and, in turn, the Octel 50
system. SW1 determines the Dialogic board’s base shared memory address.

 If you are only installing one Dialogic board, leave SW1 at the default setting unless it
conflicts with another component. If you are installing multiple boards or there is a conflict,
you can change the base shared memory address by configuring the first three jumpers
on SW1.

 The following figure illustrates the recommended jumper settings for the boards. The first
column lists the board number, the second column lists the base shared memory address
that should be assigned to each board, and the third column represents the jumper
settings that correspond to the base shared memory address.

 

 Modifying the board’s base memory segment –The shared memory block on the PC is
called a segment. You can set most Dialogic boards to an address in the D segment,
which is the default. If you cannot use the D segment due to a conflict or for some other
reason, a technical support representative can advise you to use an address in segment
A or C.

 To use an alternate segment, you must install one of two jumpers on the Dialogic board:

• Install the JP5 jumper if you assign the voice board an address using the A
segment, such as A0000.

• Install the JP6 jumper if you assign the voice board an address using the C
segment, such as C0000.

Do not change the settings of either of these jumpers unless a technical support
representative directs you to set the voice board to an address using an alternate
segment.

Setting the board’s hardware interrupt –The JP1 jumper block sets the Dialogic boards’
hardware interrupt level, also called the IRQ. Interrupt settings for these boards range
from 2 through 7. Install the jumper that corresponds to the interrupt level you want to
use. You must set all Dialogic boards to the same interrupt level. The recommended
interrupt is IRQ5. Depending on the system configuration, you may have to try different
interrupts before you find one that does not conflict with other devices.

The interrupt levels typically assigned to standard computer components are as follows:

IRQ3 = COM2
IRQ4 = COM1
IRQ5 = LPT2
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IRQ6 = disk drive
IRQ7 = LPT1

Setting the board’s default line state –The fourth jumper on SW1 determines whether
the lines connected to the voice board return a ring-no-answer signal or a busy signal
when the Octel 50 system is not running. Make sure this jumper is always on to indicate
that the lines should return a busy when the Octel 50 system is not running.

Configuring for multiple boards–If you are installing multiple Dialogic boards, remove
the JP7 jumper clip on all but the first board. If you are using a single board, leave the JP7
jumper clip installed.

 Configuring Rhetorex Boards

 Rhetorex 432, 4132 and 4108 boards are supported for existing systems in which they
are already installed.

 All Rhetorex boards are configured the same way for Octel 50. All Rhetorex boards are
factory-set to a default address of 300 hex. If you are only installing one voice board,
leave the port address at the factory default unless it conflicts with the address of another
system component. If you are using multiple Rhetorex boards, you must assign a unique
port address to each board. Check with your PC manual to determine an available port
address.

 The following figure illustrates the default settings for the 432 board. On the 432 board,
the EJ1 jumper block sets the port address.

 

 The following figure illustrates the default settings for the 4132 and 4108 boards. On the
432 board, the W1 jumper block sets the port address.

 



Installing the Hardware Step 4:  Configuring the Fax Boards

Octel 50 Installation Guide 3-7

 The following figure displays recommended jumper settings for the 432 board. The first
column lists the board number, the second column lists the port address that should be
assigned to each board, and the third column represents the jumper settings that
correspond to the port address.

 

 The following figure displays recommended jumper settings for the 4132 and 4108
boards. The first column lists the board number, the second column lists the port address
that should be assigned to each board, and the third column represents the jumper
settings that correspond to the port address.

 

Step 4:  Configuring the Fax Boards

Fax boards allow the Octel 50 system to use the Fax Solution features. You must
configure the fax boards for use with the Octel 50 system before you install them.

Fax boards contain ports, which are the interface between the fax board and a phone
system channel. The Octel 50 system supports a maximum of 12 fax channels.

Octel 50 supports the Brooktrout TR112 fax board.

 The boards you install in the Octel 50 PC must be purchased from an authorized
representative so they are programmed with the proper signature.
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 Use caution when handling fax boards as they are electrostatic-sensitive. Make sure you
ground the PC, the work area, and the ground end of the antistatic wrist strap prior to
handling a board, and always use antistatic wrist straps and electrostatic-dissipative mats
while handling a board.

 Configuring Brooktrout TR112 Boards

 The TR112 is a 2-port fax card for use with the Fax Solution module.

 

 Before installing the TR112 board, you must:

• Set the board’s port address

• Set the interrupt level

• Set the DMA channel

 Setting the TR112 Port Address

 The PC and the Brooktrout boards communicate with each other through a shared
memory block that resides within the memory address space of the PC. You can modify
the physical address offset where this memory block is located by changing the dip
switches of SW1.

 The default setting, 220, is acceptable for the first TR112 board. However, if you are
installing more than one TR112 board, the address must be changed as shown in the
following figure. The SW1 switch is located in the lower-right corner of the board and
contains eight dip switches.
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 Setting the TR112 Board’s Hardware Interrupt Level

 The hardware interrupt allows the board to communicate with the driver, which in turn
communicates with the Octel 50 system. The J32 or J33 jumper controls the TR112
board’s hardware interrupt level, depending on the interrupt you select. J32 controls
interrupts 2 through 7. J33 controls interrupts 10, 11, 12, 14, and 15. Use the same
interrupt level for all Brooktrout boards you install in the Octel 50 PC.

 For the TR112 board, the default interrupt level of 10 should be acceptable in most cases.
Interrupt 10 is set on the J33 jumper.

 Setting the TR112 Board’s DMA Channel

 The DMA Channel transfers data from the TR112 board to the PC. The J31 jumper block
controls the DMA Channel for the TR112 board. Channel 1 is the recommended setting.
On the first TR112 board, you must set two jumpers—both jumpers must be set to the
same channel. On the remaining TR112 boards, you only need to set one jumper.

Step 5:  Installing the Voice and Fax Board(s) in the PC

Use caution when handling voice and fax boards as they are electrostatic-sensitive. Make
sure you ground the PC, the work area, and the ground end of the antistatic wrist strap
prior to handling a board, and always use antistatic wrist straps and
electrostatic-dissipative mats while handling a board.

To install the voice and fax boards:

1. Turn off the power to the PC and any peripherals.

2. Unfasten the screws retaining the PC’s cover and remove the cover.

3. Select an expansion slot in which to install the board. Use an 8- or 16-bit slot (PCI,
ISA) for the Dialogic and Rhetorex voice boards. Use a 16-bit slot for the Brooktrout
fax boards.

4. Unfasten the screw retaining the slot cover, located at the rear of the PC chassis, and
remove the slot cover.

5. Insert the board into the expansion slot by holding the board at the top of each corner.
Apply equal pressure to both sides of the board and push down firmly to seat the
board. The board should easily slide down most of the way. If you feel any resistance,
check the alignment of the board.

6. Make sure that the board’s RJ-11 or RJ-14 jacks are accessible from the rear of the
PC chassis.

7. Secure the board’s metal bracket with the retaining screw.

8. Replace the PC’s cover, and fasten it back into place with the retaining screws.



Installing the Hardware Step 6:  Connecting the Telephone and Fax Lines

Octel 50 Installation Guide 3-10

Step 6:  Connecting the Telephone and Fax Lines

Once you install the voice boards, you must connect them to the switch. The method of
connection depends on the type of voice boards you are using.

Connecting the Voice Boards

The Dialogic and Rhetorex boards all have two RJ-14 jacks on the brackets. Each jack
carries two telephone lines:

• The top RJ-14 jack supports channels 1 and 2. Channel 1 is the inside pair of
wires; Channel 2 is the outside pair.

• The lower RJ-14 jack supports channels 3 and 4. Channel 3 is the inside pair of
wires; Channel 4 is the outside pair.

If the switch uses RJ-14 jacks, you need a pair of standard 4-wire modular cables. If the
switch uses RJ-11 jacks, also called single-line terminations, you need RJ-14 to RJ-11
splitting cables, which are available from most electronic stores. Each splitting cable
consists of an RJ-14 plug and a Y cable that terminates in two RJ-11 plugs. If you have
another type of telephone line termination, use an adapter or connector that starts with an
RJ-14 connection and ends with the required termination.

To connect the Dialogic and Rhetorex voice boards to the phone system:

1. With the gold contacts on the RJ-14 end of the modular phone cable facing the gold
contacts of one of the connectors, insert the RJ-14 end of the modular telephone
cable into one of the phone connectors on the bracket of the voice board. The cable
should slide in easily and stay in place once the connection is made.

2. Connect the other end of the telephone cable to a telephone line termination on the
phone system.

3. Repeat step 2 for the other phone connector on the back of the first board.

4. Repeat steps 1-3 to connect each additional board.

Connecting the Fax Lines

Once you install the Brooktrout fax boards, you must connect them to the phone system.
There are two methods of connecting fax boards:

• Transfer

• Non-Transfer

 Because the type of wiring you use to connect the fax boards depends on a number of
factors, step-by-step connection procedures are not provided. Consult the Configuration
Note for the phone system to determine the hardware required to connect the fax board to
the switch. For additional information, see the considerations provided below.
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 Understanding Transfer Method vs. Non-Transfer Method

 Transfer Method–The Transfer method denotes a situation where the Octel 50 system
performs an internal transfer from a voice port to a fax port when:

• An incoming fax is detected

• A caller chooses to attach a fax message to a voice message

• The system delivers a fax retrieved from a V-Tree

 Keep the following considerations in mind when determining whether to use the Transfer
method:

• You must use the Transfer method if you have installed D/42D-SX boards since
fax boards use analog lines, and these Dialogic boards are digital.

• If the phone system does not support station-to-station transfers, you cannot use
the Transfer method.

• Note that with the Transfer method, the Octel 50 system performs a blind transfer
to a fax port. Therefore, callers sending a fax message must hang up after
pressing the Start/Send button on the fax machine.

• Use the Transfer method when the Octel 50 system does not have the same
number of voice ports as fax ports. For example, if the Octel 50 system has four
voice ports and two fax ports, you must use the Transfer method.

• With the Transfer method, you must use a separate telephone extension for each
voice and fax channel. For example, on an Octel 50 system with four voice ports
and two fax ports, you must have a total of six telephone extensions.

 Non-Transfer Method–The Non-Transfer method denotes a situation where voice and
fax channels share telephone extensions. Using this method, both voice and fax
transmission and reception occur on the same line.

 Keep the following considerations in mind when determining whether to use the
Non-Transfer method:

• With the Non-Transfer method, callers can continue on in the Octel 50 system
once they send or retrieve a fax.

• If the phone system does not support station-to-station transfers, you must use
the Non-Transfer method.

• You cannot use the Non-Transfer method if you have installed D/42D-SX boards
since fax boards use analog lines, and these Dialogic boards are digital.

• Use the Non-Transfer method when the Octel 50 system has the same number of
voice ports as fax ports.

• With the Non-Transfer method, each pair of channels, one voice and one fax,
share a single telephone line. For example, on an Octel 50 system with four voice
ports and four fax ports, you only need four telephone extensions.
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 Connecting the TR112 Board for the Transfer Method

 Consider the following when connecting TR112 boards for the Transfer method:

• The TR112 board has two RJ-11 jacks on the bracket. The top jack represents
channels 1; the lower jack represents channel 2.

• You must identify the extensions connected to each fax channel under Fax
Extensions in System Setup.

• Depending on the type of termination from the switch and the type of boards
used, splitters may be required.

 The following diagram represents a TR112 sample wiring configuration for the Transfer
method.

 

 Connecting TR112 Boards for the Non-Transfer Method

 Consider the following when connecting TR112 boards for the Non-Transfer method:

• Each voice channel must be assigned the same extension as the corresponding
fax channel. For example, if you assign extension 2100 to voice channel 1, fax
channel 1 must also be assigned extension 2100.

• You must have the same number of voice channels as fax channels.

• Depending on the type of termination from the switch and the type of boards
used, splitters may be required.

 The following diagram represents a sample TR112 wiring configuration for the
Non-Transfer method.

 

Step 7: Installing the Serial Integration Device

The Serial Integration utility takes proprietary information sent from the phone system
through the Octel 50 PC’s serial port, interprets it, and passes it to the Octel 50 system. If
you are using a serial integration device, install and test it using the information provided
with the device. Also, consult the Configuration Note for the switch for instructions on
configuring the device for use with the Octel 50 system
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 Step 8:  Installing the Uninterruptible Power Supply

 An uninterruptible power supply is vital to ensure proper system performance. When a
power failure occurs, it can corrupt data in any number of open files. By using a UPS, the
chances of data corruption are minimized.

 Octel 50 can integrate with a UPS that has communication ports to minimize file
corruption. In the event of a power failure, the UPS notifies Octel 50 when it reaches a low
battery condition and Octel 50 shuts down. For information on running UPS integration,
see Chapter 10, “Integrating with an Unterruptible Power Supply.”

 For detailed instructions on installing and using the UPS, see the manual shipped with the
UPS. It is suggested that you connect the UPS to COM1.

 Step 9:  Installing and Testing Other Peripherals

 If you plan to use a mouse or a modem with your system, the peripherals should be
installed and tested using the instructions in their respective manuals.

 Step 10:  Installing the Sentinel

 The sentinel shipped with the Octel 50 system controls:

• Maximum number of ports available on the system

• Octel 50 software version access

• Access to Octel 50 system optional utilities such as AMIS, Fax Solution, and SMDI
integration

• Octel 50 system copy protection

All sentinels are assigned a unique serial number, which identifies the Octel 50 system.
Please note that you must have the correct sentinel to run certain versions of the Octel 50
software.

To install the sentinel:

1. Make sure that the Octel 50 PC’s parallel ports are properly installed and configured.
For example, if two ports are configured as LPT1, the Octel 50 software may not be
able to locate the sentinel. In this case, the Octel 50 system does not run.

2. Attach the sentinel to the parallel port configured as LPT1. You must attach the
sentinel before you install the Octel 50 system software, and it must remain attached
while the Octel 50 system is running. If the proper sentinel is not attached, you cannot
run the software.
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Installing the Software

This section provides the step-by-step procedure for installing the Octel 50 software. It is
important that you complete the hardware installation and preparation processes before
installing the software.

The steps in this section help you:

• Verify the PC is ready for Octel 50 installation

• Back up the Octel 50 software

• Install the Octel 50 program files

• Confirm the contents of the AUTOEXEC.BAT, CONFIG.SYS, and RUNSMO3.BAT
files

• Define an alternate keypad format

This chapter also provides a list of important Octel 50 system files.

Procedures in this section assume that the hard drive on which the Octel 50 system is
installed is drive C: and the disk drive is A: (and B: if there is a second disk drive). Drive
designations on the specific PC on which you are working may vary. Confirm the
appropriate drive letters when necessary in procedures provided in this section.



Installing the Software Verifying the PC is Ready for Installation

Octel 50 Installation Guide 4-2

Verifying the PC is Ready for Installation

Before beginning the Octel 50 installation, verify the PC is equipped with the required
hardware and software.

To verify the PC is ready for Octel 50 installation:

1. Verify the PC is plugged in, the power is on, and the C: prompt displays on the screen
(where C is the root directory on which the Octel 50 system will be installed).

2. Install a millennium-compliant version of MS-DOS or PC-DOS, if it is not already
installed. For information on millennium-compliant versions of DOS, contact IBM (for
PC-DOS) or Microsoft (for MS-DOS).

3. From the C:\ prompt, type DIR/W then press <ENTER>. Scan the listed directories
to verify the \DOS directory exists.

4. From the C:\ prompt, type CHKDSK then press <ENTER> to display the hard disk
size. Verify that the hard disk has the minimum amount of required space available
based on the formula under CPU and Memory Requirements.

5. Run a hard disk optimization program. such as PC Tools Compress or DEFRAG.

6. From the C:\ prompt, type MEM/C then press <ENTER> to display the memory
status. Verify the amount of memory is sufficient. Octel 50 requires at least 450 KB of
RAM.

7. From the C:\ prompt, type DATE then press <ENTER>. If the current date displayed
is correct, press <ENTER>. If the current date displayed is not correct, enter the
current date as prompted, then press <ENTER>.

8. From the C:\ prompt, type TIME then press <ENTER>. If the current time displayed
is correct, press <ENTER>. If the current time displayed is not correct, enter the
current time as prompted, then press <ENTER>.

9. From the C:\ prompt, type CD\DOS then press <ENTER>.

10. From the \DOS directory prompt, type DIR/W then press <ENTER>. Verify that
there are files listed in the DOS directory.

Making Backup Copies of Software

To make backup copies of any software disks, use the DOS DISKCOPY command. For
more information on using the DISKCOPY command, see the DOS manual.

To copy software using two disk drives of the same size:

1. Type DISKCOPY A: B: then press <ENTER>.

2. When prompted, insert the first source disk (the one to copy from) in the A: drive and
the target disk (the one to copy to) into the B: drive, then press any key.

3. Once the information is copied, the system prompts you to copy another disk. Press
<Y> if you want to copy another disk, then repeat step 2. Press <N> if you do not
want to copy another disk.
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To copy software using a single disk drive:

1. Type DISKCOPY A: A: then press <ENTER>.

2. When prompted, insert the first source disk (the one to copy from) in the disk drive,
then press any key. Once the source disk is read, the system prompts you to insert
the target disk.

3. Remove the source disk, insert the target disk, then press any key. Once the
information is copied to the target disk, the system prompts you to create another
copy of the disk.

4. Press <N>. The system prompts you to copy another disk. Press <Y> if you want to
copy another disk, then repeat steps 2 through 4. Press <N> if you do not want to
copy another disk.

Installing Octel 50 Software

Before attempting to install Octel 50, be sure that you have completed all procedures in
the Hardware Installation section.

The Octel 50 software is contained on a set of high-density disks. The files must be
installed using the installation program provided for you; they cannot simply be copied
onto your hard disk.

If you are planning to UPS Integration, you must install to the C:\ drive. UPS Integration
enables the Octel 50 system to monitor the UPS’s status and recognize a potential
interruption in operation before it occurs. For additional information on integrating the
Octel 50 system with a UPS, see Chapter 10, “Integrating with an Uninterupptible Power
Supply.”

To install the Octel 50 software:

1. Turn on the Octel 50 PC if it is not already running.

2. Insert Octel 50 disk 1 into the disk drive.

3. At the command prompt, type A:INSTALL and press <ENTER>. An information
screen appears that briefly describes the installation procedure.

4. Press any key to continue. A dialog box describing proposed changes to the
AUTOEXEC.BAT and CONFIG.SYS files displays.

5. Press <Y> if you want the AUTOEXEC.BAT and CONFIG.SYS files to be
automatically modified during installation. Press <N> if you do not want the files to be
automatically modified.

If you have edited the AUTOEXEC.BAT or CONFIG.SYS files since DOS installation,
it is recommended you press <N>. If you press <N>, when the installation is
complete, you must compare the AUTOEXEC.BAT and CONFIG.SYS files against
the samples provided in the topic, “Confirming the Files,” later in this chapter. If there
are any lines in the sample files that must be added to the files on the Octel 50 PC,
you must manually edit the files to include the missing lines.
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6. A dialog box displays asking whether you will be using the Fax Solution (an optional
module that enables access to the fax mail and fax retrieval features:

• Press <Y> if the system will be using the Fax Solution module for fax mail
and fax retrieval.

• Press <N> to select No if the system does not have the Fax Solution module.
If you select <N>.

7. If more than one hard drive is detected, you are prompted to select the drive to which
the Octel 50 files should be installed. A list of all local fixed drives is displayed. (Drives
A and B are usually disk drives.)  Highlight the drive onto which you want to install the
system and press <ENTER>.

8. The system prompts you to enter the total amount of memory in the computer.
Highlight an option and press <ENTER>.

9. The system prompts you to enter the number of voice ports installed. Enter the
number of ports on the system and press <ENTER>.

10. The system displays a list of supported voice boards. Highlight the model of voice
board installed in the PC and press <ENTER>. If a DIALOG/4 board is installed,
select D/4xD.

11. If you selected <Y> in step 6, the system prompts you to enter the number of fax
ports installed on the system. Enter the number of ports and press <ENTER>.

12. The system prompts you to select the hardware interrupt level of the voice boards.
You set the hardware interrupt for the voice boards when you installed the boards.
Select the interrupt and press <ENTER>.

13. If you selected <Y> in step 6, the system prompts you to select the hardware interrupt
level of the fax boards. You set the hardware interrupt for the fax boards when you
installed the boards. Select the interrupt and press <ENTER>.

14. The system prompts, “Do you want to install the 4.0 program files?”  Press <Y>.

15. A dialog box displays describing the installation process and informing you that if
identical filenames are detected on the hard disk and the installation disk, you will be
prompted whether to overwrite the file. To continue, press any key.

 During the actual file installation, the screen displays two boxes. The top box
indicates the files that are being read from the disk and written to your hard drive. The
bottom box indicates the status of each file being read or written to and the overall
installation status.

16. As prompted by the system, replace installation disks, then press any key.

17. The system prompts, “Do you want to put the voice files in a RAMdisk?”  It is
recommended that you use a RAMDrive if you have more than 2 MB of RAM on your
system. Press <Y> for Yes or <N> for No.

When the system creates a RAMDrive, it uses 1 MB (1024K) of extended memory to
store the SO3-ALL.VAP voice file.

18. If you press <Y>, you are prompted to enter the drive of the RAMDrive. The system
notifies you if the RAMDrive you specify does not exist.

The system automatically creates 10 directories needed to store messages and
greetings:  \REC00 through \REC09. If you indicated in step 6 that you ar e using Fax
Solution, 10 fax directories, named \FAX00 through \FAX09, are also created.
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19. The system prompts, “Do you want to install the SMDI utility?”  Select <Y> for Yes or
<N> for No.

20. If you press <Y> to install the SMDI utility, the Integrate Switch dialog box displays.
For information on installing the SMDI utility, see Chapter 5, “Running the SMDI
Utility.”

21. The Configure Dial Plan dialog box displays. For information on running Dial Plan,
see Chapter 6, “Configuring Dial Plan.”

22. When you exit Dial Plan, a dialog box displays informing you that the system is now
installed. Remove the disk from the disk drive, and then press any key to continue.

23. If in step 5 you selected during the program file installation to have Octel 50 modify
the AUTOEXEC.BAT and CONFIG.SYS files, a dialog box displays informing you the
PC will reboot after you use the configuration utility. Press any key to continue.

24. The Configuration Utility dialog box displays.

29. Press <TAB> to select Integrator from the Configuration Utility menu then press
<ENTER>. For information on running Integrator, see Chapter 7, “Integrating with the
Phone System.”

30. When you exit Integrator, the Configuration Utility dialog box displays. Press <TAB>
to select Setup from the Configuration Utility menu and press <ENTER>. The System
Setup dialog box displays. For information on running System Setup, see Chapter 8,
“Setting Up the System.”

31. When you exit Setup, the Configuration Utility dialog box displays. To close the
Configuration Utility dialog box, press <TAB> to select Exit and press <ENTER>.

32. If you chose in step 5 to not have Octel 50 modify the AUTOEXEC.BAT and
CONFIG.SYS files, reboot the system by pressing <CTRL+ALT+DEL>. Otherwise,
the system automatically reboots. Once the system reboots, a menu with options to
run Octel 50, run Setup, or return to DOS displays.

If you installed new Rhetorex voice boards, and you do not have the boards
configured at the defaults (such as the first board set to a port address of 300), you
must run the Configur utility before you attempt to run Octel 50. Press <3> to return to
DOS from the menu that displays when Octel 50 installation is complete. For
information on running Configure, see the topic, “Defining an Alternate Rhetorex
Board Configuration,” later in this chapter.

33. Press <1> to run Octel 50.
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34. You are prompted to run call analysis. This option is always displayed the first time
you reboot the system after an installation. It is recommended that you press <Y> to
run call analysis. For information on running call analysis, see Chapter 9, “Defining
Phone System Signals.”

35. When you exit call analysis, Octel 50 launches, and the Octel 50 main screen
displays. If the Octel 50 system does not launch, contact a technical support
representative.

36. Shut down the Octel 50 system:

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.

b.  Press <ALT+F> to view the File menu options.

c.  From the File menu, use the down arrow key to select Exit and press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown and press <ENTER>. The system shutdown completes and the
\CVR prompt displays.

37. Press <CTRL+ALT+DEL> to reboot the PC. Once the system reboots, a menu with
options to run Octel 50, run Setup, or return to DOS displays.

38. Press <1> to run Octel 50. The Octel 50 launches, and the Octel 50 main screen
displays.

Confirming Files

During Octel 50 installation, if you selected not to have the system automatically update
the AUTOEXEC.BAT and CONFIG.SYS files, verify that the files on the Octel 50 PC
include the same lines as the sample files shown below. If there are lines in the sample
files that should be added to the files on the Octel 50 PC, you must manually edit the files
using the steps provided.

To view the files on the Octel 50 PC, from the directory in which the file is located, type
TYPE followed by the filename. For example, to view the AUTOEXEC.BAT file, type
TYPE AUTOEXEC.BAT.

Lines in the sample files that indicate drive designations depend on the drive on which
you installed the software.
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Sample Files

AUTOEXEC.BAT

@ECHO OFF
SMARTDRV C
PATH C:\DOS;C:\CVR;C:\MOUSE
PROMPT $P$G
SET COMSPEC=C:\DOS\COMMAND.COM
SET TEMP=C:\DOS
\DOS\SHARE /L:35
C:
CD\CVR
WINFACE
QUERY -A -CQUERY2.CTL
IF ERRORLEVEL==3 GOTO END
IF ERRORLEVEL==2 GOTO SETUP
IF NOT EXIST RECOVER.FLG CALL \CVR\RECOVER.BAT
QASSIST /B1 /D
LOGUTIL
LOGUTIL -A
RHETDRV  (for Rhetorex installations)
CALL D40  (for Dialogic installations)
CALL LOAD integration_name  (for SMDI installations)
IF EXIST \CVR\FIRST.CCA CALL \CVR\RUNCCA.BAT
BTKERNEL BTKERNEL.CFG  (for Brooktrout fax boards)
IF EXIST \CVR1\FXDRIVER.DAT DEL \CVR1\FXDRIVER.DAT  (for Brooktrout
fax boards)
FD -S \CVR1\FXDRIVER.DAT -U FD.CFG  (for Brooktrout fax boards)
RUNSMO3
GOTO END
:SETUP
SETUP
:END
CLS
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CONFIG.SYS

DEVICE=C:\DOS\SETVER.EXE
DEVICE=C:\WINDOWS\HIMEM.SYS /TESTMEM:OFF
DEVICE=C:\DOS\SMARTDRV.SYS 1024 256 (DOS 5.0)
DEVICE=C:\DOS\RAMDRIVE.SYS 1024 /E
REM DEVICE=C:\DOS\EMM386.EXE 576 FRAME E000 /X=D000-DFFF RAM
BUFFERS=30
FILES=60
STACKS=10,256
LASTDRIVE=D
DEVICE=C:\MOUSE\MOUSE.COM  (may differ depending on mouse)
SHELL=C:\DOS\COMMAND.COM C:\DOS /E:384 /P
FCBS 16,8
DOS=HIGH

Certain lines in the file, especially the RAMDrive and SMARTDrive lines, may have REM
at their beginning, effectively removing them, depending on memory availability, number
of ports, and whether or not use of RAMdrive was selected during installation.

RUNSMO3.BAT

@ECHO OFF
IF EXIST \CVR\RECOVER.FLG DEL \CVR\RECOVER.FLG
COPY C:\CVR\SO3-ALL.VOX D:\  (for Rhetorex with RAMDrive)
COPY C:\CVR\SO3-ALL.VAP D:\  (for Dialogic with RAMDrive)
SMOOTHX OPERATOR –H5 -R8  (for Dialogic with 8KHz phrases)
SMOOTHX OPERATOR –H5 -R8 -SX  (for D/42-SX board with 8KHz phrases)
IF ERRORLEVEL 50 DOW
IF ERRORLEVEL 20 GO TO QBOOT
IF ERRORLEVEL 15 UPS
GO TO END
:QBOOT
CLS
QUERY -A -CQUERY1.CTL
IF ERRORLEVEL==2 GOTO END
C_BOOT
:END
CLS

There are several command line options you can add to the SMOOTHX command line in
the RUNSMO3.BAT file located in the \CVR directory:

Option Description

-Hn Sets the interrupt level for the voice board, where n is a number 2
through 7. (The recommended hardware interrupt level is IRQ5.)

-SX Specifies that the system is using D/42-SX (or equivalent) voice
boards. -SX can only be used with Mitel SX Series systems that have
Dialogic boards.

-Rn Specifies the digitizing rate for playback and record operations for
systems with Dialogic boards, where n equals 8 kHz. Default =
6DTMF.DEF for Foreign Keypads.
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Editing the AUTOEXEC.BAT, CONFIG.SYS, RUNSMO3.BAT Files

Use the following procedure to edit the AUTOEXEC.BAT, CONFIG.SYS, or
RUNSMO3.BAT files using the DOS editor.

To edit a file:

1. From the \CVR directory prompt, type EDIT followed by the name of the file you
want to edit, then press <ENTER>. For example, to edit the AUTOEXEC.BAT file,
from the \CVR directory prompt, type EDIT AUTOEXEC.BAT and press <ENTER>.
The contents of the selected file appear in a DOS editor window.

2. Use the up and down arrows or the mouse to scroll to the line you want to modify.
Use the left and right arrows or the mouse to move the cursor to the point in the line
you want to modify. If you need to insert a new line, move the cursor to the end of the
end you want to insert the new line after and press <ENTER>.

3. Edit the existing line or type the new line.

4. Repeat steps 2 and 3 until you finish making modifications.

5. To save the modifications, select Save from the File menu.

6. To close the file, select Close.

7. To close the DOS Editor, select Exit.

Defining an Alternate Keypad Format

If you are installing the Octel 50 system in a country whose telephone keypad does not
follow the same format as that in the United States (where the <2> key is labeled ABC,
the <3> key is labeled DEF, etc.) you must define the foreign keypad in a file named
DTMF.DEF for use in proper directory searches.

There is a file named DTMF.ALT in the \CVR directory that includes alternate keypad
assignments where the letters A through D are assigned to the <1> key, the letters E
through H are assigned to the <2> key, continuing in groups of four letters to a key,
through Y and Z being assigned to the <7> key.

You can simply rename the existing DTMF.ALT file to DTMF.DEF to use the file’s current
assignments or you can modify the DTMF.ALT file as required then rename it to
DTMF.DEF.

To use this file with its current keypad assignments, from the \CVR prompt, type REN
DTMF.ALT DTMF.DEF and press <ENTER>.

To edit the DTMF.ALT file then rename it to DTMF.DEF, complete the following steps.

To edit the existing DTMF.ALT file and rename it to DTMF.DEF:

1. From the \CVR prompt, type EDIT DTMF.ALT and press <ENTER>. The contents
of the selected file appear in a DOS editor window.

2. Use the up and down arrows or the mouse to scroll to the line you want to modify.
Use the left and right arrows or the mouse to move the cursor to the point in the line
you want to modify. If you want to insert a new line, move the cursor to the end of the
end you want to insert the new line after, then press <ENTER>.

3. Edit the existing line or type the new line.
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4. Repeat steps 2 and 3 until you finish making modifications.

5. To save the modifications, select Save from the File menu.

6. To close the file, select Close.

7. To close the DOS Editor, select Exit.

8. From the \CVR prompt, type REN DTMF.ALT DTMF.DEF and press <ENTER>.
The modified file will now be used by the system.

Octel 50 System Files

This section contains the list of Octel 50 files that control voice drivers, system functions,
system data, and maintenance.

AUDIT.LOG

A log file that records AMIS-related activity

BTKERNEL.CFG

The configuration file for the BTKERNEL.EXE driver.

BTKERNEL.EXE

The Brooktrout driver Octel 50 uses to communicate with the RD driver.

COMPASS.TON

A tone table file shipped with the Rhetorex version only to handle tone for immediate fax
receive.

CONTROL.DAT, CONTROL.KEY

Files that control the system’s access to other system files.

DIALPLAN

An executable file that starts the Dial Plan utility for entering telephone area code/prefix
combinations.

DIRECTRY.KEY

A file containing alphabetical directory information.

DISTLIST.DAT

A file containing distribution list information.

EDPMI.OVL

The DOS protected mode interface manager for the extended version.

EVENT.KEY, EVENT.DAT

Schedule files for wake-up calls, message delivery, and message waiting lights.
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FD.CFG

The configuration file for the FD.EXE driver.

FD.EXE

The Brooktrout fax board driver.

FDEXIT.EXE

The command used to remove the FD driver from memory.

INTEGRAT.EXE

An executable file that starts the Integrator utility during installation.

MESSAGE.DAT

A file containing message control information.

MSGCONF.DAT

A file containing message confirmation information.

OPERATOR.CKP

A file containing statistical information used by the system.

OPERATOR.LOG

An output error log file.

OPERATOR.P

A system control file.

OPERATOR.SYS

A file containing System Setup parameters such as OUTBOUND and INBOUND.

PORTS.DAT

A greeting by port configuration file.

QASSIST.EXE

An executable file that starts the Octel 50 file maintenance utility.

RUNSMO3.BAT

A batch file that starts the execution of Octel 50.

SET_UP.CFG

A file containing Setup information such as the number of digits in a mailbox.

SMOOTHX.EXE

A DOS extended mode executable file.
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SO3-ALL.VAP, SO3-D1.VAP, SO3-D2.VAP

Octel 50 voice files used with Dialogic voice boards.

SO3-ALL.VOX, SO3-D1.VOX, SO3-D2.VOX

Octel 50 voice files used with Rhetorex voice boards.

SUBSCRIB.DAT

A file containing mailbox information.

SWDATA.TXT

A data file used in the Integrator utility.

VBOX.DAT

A file containing volatile mailbox information.

VFTREE.DAT

A file containing voice and fax tree information.
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Running the SMDI Utility

SMDI integration is an option available with Octel 50 that allows you to configure the
system for a serial integration. The steps in this section help you:

• Install the SMDI utility

• Run the SMDI utility in standalone mode
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Installing the SMDI Utility

You can install and configure SMDI during or after Octel 50 system installation or later,
after installation. However, it is recommended that you run it during system installation.

To install the SMDI utility during Octel 50 installation:

1. During Octel 50 installation, when you are prompted to run the SMDI utility, press
<Y>. An introductory dialog box displays.

Select Yes to install SMDI only if you have an SMDI disk. Note that the SMDI utility is
sentinel-controlled.

2. Press any key to continue. The Integration Configuration dialog box displays.

3. If you have an ITT or Hitachi switch, select the switch from the list and press
<ENTER>. If you have another type of switch, select SMDI.

4. When prompted, insert the Special Integration disk into the disk drive and press
<ENTER>. The Integration Configuration dialog box displays. The information you
enter on the Integration Configuration dialog box depends on the phone system
configuration and is strictly defined if the system connects directly to a central office
(CO) or switch. See the switch documentation or Configuration Note for more
information. Use the <TAB> key to move around the dialog box.

 

5. Under Baud, select the speed at which the data is transferred.

6. Under Databits, select the number of bits in each character (word).

7. Under Stopbits, select the number of bits used to signify the end of the word (byte).

8. Under Parity, select the algorithm used to calculate the parity bit in a word.

9. Under Comport, select the serial port where the data link with the switch is to be
established.

10. Under Event Rate, enter how often the SMDI information is read. Do not change this
value unless directed to by a technical support representative.

11. Under Desk ID, enter the number that identifies the SMDI source.

12. Under Timeout, enter the intercharacter timeout period, which determines the amount
of time the system is to wait between characters before it assumes a bad or failed
packet and aborts.
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13. When you finish entering the values, press <TAB> until the Port IDs button is
highlighted and press <ENTER>. The Port Identification dialog box displays.

14. In the ID # fields, enter the number that corresponds to each Port #.

15. When you finish, press <TAB> to highlight the Accept button and press <ENTER>.
The Integration Configuration dialog box displays.

16. To save the configuration and exit the SMDI utility,  press <TAB> until the Save
button is highlighted and press <ENTER>.

WARNING: You can edit the ICONFIG parameters at any time by typing ICONFIG
and pressing <ENTER> from the \CVR directory prompt to display the
Integration Configuration screen. However, each time you run ICONFIG,
the following parameters in the .CFG file are overwritten:  MWLPRFX,
MWLTIMEOUT, DATAWAIT, DTR, TRS, CTS, and DISPLAY.
Consequently, you must manually edit the .CFG file each time after you
run ICONFIG to restore these parameters’ previous settings. It is
therefore strongly recommended that you record the SI.CFG file settings
for future reference. The name of the .CFG file depends on the type of
SMDI integration. For example, the .CFG file for a generic SMDI
integration is SMDI.CFG.

Running SMDI as a Standalone Utility

You can set up the SMDI integration after you install the Octel 50 system by running SMDI
as a standalone utility.

To run SMDI:

1. Shut down the Octel 50 system if it is running.

2. Place the SMDI disk in the disk drive.

3. From a DOS prompt, type A:\SWITCH (where A: is the disk drive) and press
<ENTER>. The Integration Configuration dialog box displays.

4. Complete the steps under the procedure, “Installing the SMDI Utility,” earlier in this
chapter, starting with step 3.
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Notes:
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Configuring Dial Plan

The Dial Plan utility determines the correct outdial string for outbound dialing operations.
Use Dial Plan to identify the local area code and associated prefixes for the customer’s
Octel 50 system. This information is then compared to the outdial string supplied by the
application to determine the string the Octel 50 system dials.

An outbound dialing operation is any call scheduled by the Octel 50 system for which it
must access an outbound port. For an outbound dialing operation to an outside number to
be successful, the Octel 50 system must have the correct outdial string, which consists of
the applicable access codes and prefixes followed by the destination telephone number.
For the following outbound dialing operations, the entire outdial string may not be supplied
by the application and must be determined by the Octel 50 system:

• Replying to network messages

• Dispatching administered AMIS messages

• Sending a fax requested through fax retrieval to external destinations

The steps in this section help you:

• Identify the local area code and prefixes

• Run the Dial Plan utility after installation

• Delete prefixes

• Activate Dial Plan

• Understand how Dial Plan works
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Identifying Local Area Code and Prefixes

Use the following procedure to identify the local area code and associated prefixes for the
Octel 50 system.

To configure the Dial Plan utility during Octel 50 installation:

1. During installation, after the Octel 50 program files and SMDI utility are installed, the
Octel 50 Dial Plan Utility dialog box displays.

2. Press any key to continue. If previous Dial Plan information exists, you are prompted
whether to load the information. Select Yes if you want to display the existing
information or No to continue without displaying the existing information. The Local
Telephone Information dialog box displays.

 

3. Enter the local area code in the Area Code field at the top of the dialog box.

4. Press the down arrow key to move to the first prefix field, and enter a prefix
associated with the area code you entered. You can enter 3 digits to represent a 3-
digit prefix, 4 digits to represent a 1 plus a 3-digit prefix, or 6 digits to represent an
area code plus a 3-digit prefix.

 If the first 3 digits in a 6-digit string are the same as the specified local area code, Dial
Plan prompts you whether you want to convert the data to a 3-digit prefix.

5. Repeat step 4 until you identify all prefixes for the local area code. If you are entering
a list of sequential prefixes, once you enter the first, you can press the <1> key
(forward slash) to enter the previous prefix + 1.

6. To save the configuration and exit the Dial Plan utility, use the arrow or <TAB> keys
to highlight the Done button, then press <ENTER>.

To activate Dial Plan, enable the Use Dial Plan parameter in System Setup. If Use Dial
Plan is not selected, Dial Plan dials 1 before all 10-digit outdial sequences.

Running Dial Plan After Installation

You can set up or edit Dial Plan settings after you install the Octel 50 system by running
Dial Plan as a standalone utility. To run Dial Plan, from the \CVR prompt, type DIALPLAN
then press <ENTER>.

If you encounter a memory problem when running Dial Plan, unload the board drivers by
typing, from the \CVR prompt, RDSPEXIT for Rhetorex or RELEASE for Dialogic then
pressing <ENTER>.
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Deleting a Prefix

Use the following procedure to delete a prefix from Dial Plan after Octel 50 installation.

To delete a Dial Plan prefix:

1. Shut down the Octel 50 system if it is running. The \CVR prompt displays.

2. From the \CVR prompt, type DIALPLAN  and press <ENTER>. The Local
Telephone Information dialog box displays.

 

3. Press the down arrow key to move to the field that contains the prefix you want to
delete. The prefix field is highlighted.

4. To delete the highlighted prefix, use the arrow or <TAB> keys to highlight the Remove
button, then press <ENTER>.

5. To save the configuration and exit the Dial Plan utility, select Done.

Activating Dial Plan

Use the following procedure to activate the Dial Plan utility.

To activate Dial Plan:

1. If the Octel 50 system is currently running, make sure you are logged in as a level 3
supervisor, then select System Setup from the Options menu. If the Octel 50 system
is not currently running, from the \CVR prompt, type SETUP and press <ENTER>.
The System Setup dialog box displays.

 

2. Select Change System Setup. The first page of System Setup parameters displays.

3. Use the down arrow or Page Down key to move to the Use Dial Plan parameter.

4. To activate the Use Dial Plan parameter, press <SPACEBAR> to place a check in the
box.
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5. To return to the System Setup dialog box, select OK. The System Setup dialog box
displays.

6. To save System Setup settings, select Save System Setup.

7. To exit System Setup, select Exit.

Understanding How Dial Plan Works

Once you configure and activate Dial Plan, a request to dispatch an Administered network
message or a Fax Retrieval request triggers a search for a match of the destination
phone number’s area code to the data you entered in Dial Plan:

1. If the destination number’s area code (aaa) does not match the Local Area Code
defined in Dial Plan, a match of aaappp is attempted. If aaappp is found in the Prefix
List, the Octel 50 system dials aaapppnnnn. If a match is not found, the Octel 50
system assumes the number is long distance and dials 1aaapppnnnn, where 1
represents the Long Distance Access Code you defined on the Networking tab in
System Setup.

2. If the destination number’s area code matches the defined Local Area Code, Dial
Plan conducts the following additional searches:

a. Searches for an aaappp match. If a match is found, the Octel 50 system dials
aaapppnnnn.

b. Searches for ppp in a 4-digit entry (1ppp). If a match is found, the Octel 50
system dials 1pppnnnn.

c. Searches for a ppp match. If a match is found, the Octel 50 system dials
pppnnnn.

d. If no matches are found from the above searches, the Octel 50 system dials
1aaapppnnnn, where 1 represents the Long Distance Access Code.

Dial Plan is not used for international calls. When the Country Code you identify in System
Setup is different than the country code of the destination phone number, the Octel 50
system dials the number as entered.
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Integrating with the Phone System

The Integrator utility configures the Octel 50 system for use with the telephone switch by
setting many of the software’s parameters to values appropriate for the switch. This
allows you to move through the System Setup utility much faster and reduces the
possibility of making invalid entries in some of the more advanced setup fields.

The steps in this section help you:

• Run the Switch Integrator utility

• Run the Switch Integration utility after installation
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Running the Switch Integrator Utility

Integrator can be run from the Configuration Utility menu during installation or later from
the \CVR prompt. It is important that you run Integrator during Octel 50 system
installation, especially if you are installing the Octel 50 system for the first time.

To integrate Octel 50 with the switch:

1. During Octel 50 installation, the Configuration Utility main menu displays.

 

2. Select Integrator from the Configuration Utility main menu. An initial information dialog
box displays. To continue, select OK. The Select dialog box displays.

 

3. Use the mouse or up and down arrow keys to highlight the name of the switch, then
select Select SW. A dialog box displays the name of the selected switch. If you are
using a switch with the Simplified Message Desk Interface (SMDI), select the model
that indicates “with SMDI” or “with Voice Bridge.”  Be careful to select the proper
switch software version for any special board integrations.

If the switch is not listed in the Integrator, consult the switch documentation for the
correct codes.
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4. Select See/Modify codes. The Integrator Switch Data Editor dialog box displays the
codes for the selected switch. You can modify any of the codes; however, do not
modify the codes without first talking to a technical support representative.

5. When you finish viewing the codes, select DID Codes. The Integrator Switch Data
Editor dialog box displays the DID information for the switch. You can modify any of
the codes; however, do not modify the codes without first talking to a technical
support representative.

6. When you finish viewing the codes, select Leave DID. The Integrator Switch Data
Editor dialog box displays.

7. Select Install to install the selected switch.

When you select Install, if the selected switch is already installed the system displays
a dialog box asking if you want to terminate the integration. If you select No to
continue, the system reinstalls the switch and overwrites any customized switch
settings.

8. Once the switch information is installed, a dialog box displays a list of integration
requirements and switch programming notes.

9. Select OK when you are done reading the notes. The Configuration Utility dialog box
displays.

If you change any of the codes, the changes are written to the SET_UP.CFG or
OPERATOR.SYS files, as appropriate for the code.

Running the Switch Integrator After Installation

You can set up or modify switch settings after you install the Octel 50 system by running
the Switch Integrator utility as a standalone utility. To run Switch Integrator, type
INTEGRAT from the \CVR prompt and press <ENTER>.

If you are re-integrating or changing the phone switch for a particular system, the
Integrator warns you before overwriting the Integration setup.
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Setting Up the System

System Setup is comprised of parameters grouped by specific Octel 50 feature or
function.

System Setup controls feature settings on a system-wide basis. You can, however,
override some System Setup parameters on a class of service level. For example, you
can permit inbound and outbound AMIS messaging at a system level in System Setup,
then disable networking options for a particular group of mailboxes in the class of service
assigned to those mailboxes. Note, however, that you cannot activate options in an
individual class of service unless they are permitted on a system-wide basis in System
Setup.

Some of the System Setup parameters are preset for you by the Integrator utility. It is
strongly recommended that you run the Integrator utility before running the System Setup
utility.

This section contains information for configuring the Octel 50 system. The steps in this
section help you:

• Run the System Setup utility

• Run the System Setup utility after installation

• Configure System Setup parameters
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Running System Setup

You can run System Setup during system installation or after. However, it is
recommended that you run System Setup during installation.

To run System Setup:

1. During installation, the Configuration Utility main menu displays.

 

2. Select System Setup from the Configuration Utility main menu. An introductory dialog
box displays. Note that this introductory dialog box does not display when you run
System Setup from the Options menu or from the \CVR prompt.

3. Press any key to continue. The System Setup dialog box displays.

 

4. Select Change System Setup. The first page of System Setup parameters displays.
Individual parameter descriptions are provided on the pages that follow.

5. Use the up and down arrow keys to highlight individual parameters. To activate a
highlighted parameter with a checkbox, press <SPACEBAR> to place a check in the
box and activate the selection. To change the value of a highlighted parameter, enter
the appropriate value, then press <ENTER>.

Choices that cannot be modified are unavailable due to other parameter settings that
invalidate the parameter.

6. To move among pages of parameters, use the Previous Page button and Next Page
button.
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7. To return to the System Setup dialog box, select OK. The System Setup dialog box
displays.

8. To print the System Setup for later analysis or for a permanent record of the settings,
select Print System Setup. Select Print System Setup only if a printer is connected to
the Octel 50 PC.

9. To save System Setup settings, select Save System Setup. When you modify and
save System Setup parameters, the system saves the information to a file called
SET_UP.CFG located in the \CVR1 directory. If this file already exists on the system,
it is automatically renamed as SET_UP.BAK.

10. If you want to reset all the System Setup parameters to the default values, select Set
to Defaults. Use caution when returning system settings to the defaults. Some
settings may be set by the Integrator utility during system configuration. Resetting to
the system defaults may therefore prevent Octel 50 from interfacing with the switch.

11. To exit System Setup, select Exit. The Configuration Utility dialog box displays.

Running System Setup After Installation

You can modify System Setup settings after you install the Octel 50 system by running the
System Setup utility as a standalone utility. To run System Setup, type SETUP from the
\CVR prompt, then press <ENTER>. If you are logged into the Octel 50 PC as a level 3
supervisor, you can also access System Setup screens by selecting System Setup from
the Options pull-down menu.

Configuring System Setup Parameters

Unless otherwise noted, throughout the setup descriptions, “YES” means the parameter is
enabled, as indicated by a checked box next to the parameter name, and “NO” means it
is disabled, as indicated by an unchecked box. If you change a parameter that requires
restart, you must type RESTART then press <ENTER> from the Command Line interface
for the change to take effect.

General Parameters

The General parameters control general system-level functions.

General Parameters - #1

Enable
Automated
Attendant

The automated attendant routes calls to Octel 50 system
extensions.

When the automated attendant is disabled, the Octel 50
system routes callers directly to the subscribers’ mailboxes.
It does not attempt to transfer calls to subscriber extensions.

Note that this parameter does not affect the Attendant
menu, system prompts, or holidays, which determine what
the Octel 50 system voices to callers, or the ability to press
<0> to reach a default or personal operator.
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When/How to Use You should enable this parameter unless the Octel 50
system is being used in an application such as a service
bureau, where callers should not be allowed to transfer to
extensions.

On Octel 50 systems with live operators, you can configure
the automated attendant to handle call overflow.

Related Parameters/Features When the automated attendant is disabled, the following
Octel 50 system features are not available:

• Call screening

• Call queuing

• Call handling, although call blocking is still available

• Call waiting

• Intercom paging

 In addition, the following system setup parameters are not
available:

• Inform Subscriber Transfer is from Attendant

• Number Attempts Rotary Transfer to Busy
Receptionist

• General Transfer parameters

• The first six Call Transfer parameters

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 General Parameters - #2

 Number of Digits
in a Mailbox

  This parameter determines the length and available range of
Octel 50 system subscriber mailboxes. For example, if you
set this parameter to 5, the range of available mailboxes is
10000 to 99999.

  When/How to Use  Set this parameter using the System Setup before you begin
creating subscriber mailboxes. If you change the value of
this parameter after you have created mailboxes, the
existing mailboxes are unusable. In this case, all Octel 50
system mailboxes must be deleted and re-created, and all
prompts, messages, and events are lost.

 Because you cannot change this parameter once you create
mailboxes, you must be careful to allow for extra mailboxes
for new subscribers and any additional applications, such as
V-Trees, that may require a mailbox.

 This parameter is not available when you run System Setup
from the Options menu, and does not reset when you select
the Set to Defaults option from the System Setup File menu.
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  Related Parameters/Features  None.

  If Set Too High  While you want to make sure that you allow mailboxes for
expansion, setting this parameter too high may make it
more difficult for subscribers to remember their mailbox
numbers.

 If you set this parameter higher than the number of digits in
extension numbers on the phone system, inband signaling
may fail due to the mismatch between the length of the
extension and mailbox numbers.

  If Set Too Low  You may not have enough mailboxes for the number of
subscribers and applications requiring one.

  Min

 
1

 Max

 
9

 Default

 
4

 Requires
Restart

 –

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 General Parameters - #3

 Number of
Languages

  This parameter specifies the number of languages installed
on the Octel 50 system.

  When/How to Use  Enter the number of languages to use with the system. If
you are using multiple languages on the system, you must
load the appropriate voice files onto the system.

  Related Parameters/Features  You must define the multilingual prompts on the System
Prompts dialog box and/or select an alternative language in
each mailbox’s class of service.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
1

 Max

 
5

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 General Parameters - #4

 Tutor for New
Mailboxes

  This parameter determines whether Co-Educator, the Octel
50 system tutorial, is enabled for subscribers accessing
their mailboxes for the first time.

 Co-Educator provides an introduction to the Octel 50 system
and guides subscribers through the steps to change their
password and record their personalized prompts (Please
Hold, Directory, Name, and Personal Greeting prompts).

  When/How to Use  Enable this parameter to help ensure that subscribers
change their password from the assigned default and record
their personalized prompts right away.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.
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  Min

 
–

 Max

 
–

 Default

 No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 General Parameters - #5

 Minimum Length
of Password

  This parameter specifies the minimum number of digits the
Octel 50 system requires for a valid mailbox password. This
parameter is used as a security feature to require
subscribers to use passwords to log into their mailboxes.

  When/How to Use  For most Octel 50 systems, the default should be sufficient.

 If you change this parameter to a higher value, the Octel 50
system prompts subscribers using existing mailboxes to
change their passwords to comply with the new value before
gaining access to their mailboxes.

 If you change this parameter to a lower value, subscribers
are not required to change their passwords, since their
current passwords exceed the minimum.

  Related Parameters/Features  None.

  If Set Too High  Subscribers are required to enter very long strings of
keypresses to access their mailboxes.

  If Set Too Low  Setting this parameter low increases the chance that a
caller could guess a password and gain unauthorized
access to the Octel 50 system.

 If this parameter is set to 0, a password is not required to
access system mailboxes. However, subscribers can assign
passwords to their mailboxes.

  Min

 
0

 Max

 
9

 Default

 
4

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 General Parameters - #6

 Daily
Maintenance
Time

  This parameter determines when the Octel 50 system
performs its daily maintenance. During daily maintenance,
the Octel 50 system ages messages and purges expired
messages, updates statistics, and performs other functions.

 Daily maintenance only takes a moment. The Octel 50
system remains up and continues to answer calls.

  When/How to Use  Set this parameter to the desired hour in Military format, 0 to
23, where 0 represents midnight. This parameter can only
be set for the top of the hour and cannot be specified in
minutes.

  Related Parameters/Features  If you enable Shutdown After Daily Maintenance, you should
set Daily Maintenance Hour for a low-traffic time so that call
traffic is not interrupted.

  If Set Too High  Not applicable.
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  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
23

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 General Parameters - #7

 Shutdown
System After
Daily
Maintenance

  This parameter determines whether the Octel 50 system
goes through an automatic shutdown after daily
maintenance is complete to run user-supplied backup
programs or other disk utilities. A batch file must be
designed to perform such functions. A sample Day of Week
batch file (DOW.BAT) is described in the Maintaining the
System section.

  When/How to Use  Enable this parameter if you want to run third-party utilities
such as backups and disk maintenance after daily
maintenance.

  Related Parameters/Features  The Daily Maintenance Time parameter setting determines
when the Octel 50 system will perform the shutdown.

 If you enable Shutdown System After Daily Maintenance,
set the Daily Maintenance Time to a low-traffic time as the
Octel 50 system will be unable to accept calls until it
restarts.

 When this parameter is enabled, the OFFHDIS parameter
determines whether callers hear a busy or no answer while
the Octel 50 system is shut down. Note that if OFFHDIS is
enabled, some phone switches may see the off hook as a
line problem and disable the ports.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 Receptionist Parameters

 The Receptionist parameters specify extensions where callers requesting to speak to a
receptionist or exceeding a specified number of errors are transferred during or after
business hours. These parameters also determine how the Octel 50 system handles
callers dialing from rotary phones and whether subscribers are informed of calls
transferred from the attendant.

 Receptionist Parameters - #8

 Default
Receptionist
Mailbox Number

  This parameter defines the mailbox where the Octel 50
system routes callers during business hours when they
press <0> to speak to an operator, are dialing from a rotary
phone, or exceed the maximum number of errors allowed.
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  When/How to Use  You must manually create the default operator mailbox on
the Octel 50 system; it is not automatically created. If you do
not create the default receptionist mailbox, callers
transferred to that mailbox are told that the mailbox is not
recognized on the system and are disconnected.

 Make sure that the mailbox number specified for this
parameter is used for a receptionist mailbox or for a regular
subscriber. Otherwise, the subscriber assigned this mailbox
number may receive calls that are supposed to be directed
to the receptionist.

  Related Parameters/Features  Callers to mailboxes that have a personal operator defined
are transferred to the personal operator instead of the
default receptionist mailbox when they press <0>.

 The minimum and maximum values for this parameter
depend on the Number of Digits in a Mailbox. For example,
on a Octel 50 system with 3-digit mailboxes, the default for
this parameter is 100.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
1000

 Max

 
9999

 Default

 
1000

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Receptionist Parameters - #9

 After Hours
Receptionist
Mailbox Number

  This parameter defines the mailbox where the Octel 50
system routes callers after business hours.

  When/How to Use  You must manually create the after hours receptionist
mailbox on the Octel 50 system; it is not automatically
created. If you do not create the after hours receptionist
mailbox, callers transferred to that mailbox are told that the
mailbox is not recognized on the system and the callers are
disconnected.

  Related Parameters/Features  The minimum and maximum allowed values for this
parameter depend on the Number of Digits in a Mailbox
parameter setting. For example, on a Octel 50 system with
3-digit mailboxes, the default for this parameter is 100.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
1000

 Max

 
9999

 Default

 
1000

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Receptionist Parameters - #10

 Inform
Subscriber
Transfer is from
Attendant

  This parameter determines whether the Octel 50 system
voices a prompt informing subscribers when it transfers
calls.

 If this parameter is selected, subscribers hear the message,
“One moment, you have a call,” or, “There is a call for
<subscriber’s name>,”  before a call is transferred to their
extensions from the system. Otherwise, the caller is
immediately transferred.

  When/How to Use  Use this parameter if the phone system cannot display the
origin of calls and you want subscribers to be able to
distinguish between external and internal callers. Note that
this only applies when call progress is used.

  Related Parameters/Features  This parameter only applies when calls are supervised.

 This parameter is not available when Enable Automated
Attendant is disabled.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Receptionist Parameters - #11

 Disconnect All
Rotary Callers

  This parameter determines whether the Octel 50 system
disconnects all callers dialing from a rotary phone. The
Octel 50 system considers a rotary call to be any call from
which it does not detect touch-tone digits at the initial
greeting or at the main greeting for a V-Tree. When you
enable this parameter and the system detects a rotary call,
it voices, “Thank you, good-bye,” and disconnects the caller.

  When/How to Use  Enable this parameter when the switch does not use
positive disconnect to indicate hangups. This parameter
allows ports from which callers have hung up to become
available more quickly.

 If this parameter is enabled, the main greeting should
include an alternate phone number for rotary callers.

 If this feature is not enabled, the Octel 50 system transfers
rotary calls to the Default Receptionist Mailbox Number
during business hours or the After Hours Receptionist
Mailbox Number after business hours.

  Related Parameters/Features  You must create the default operator mailbox and the after
hours operator mailboxes if you want to transfer callers
using rotary phones.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.
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  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Receptionist Parameters - #12

 Number
Attempts Rotary
Transfer to Busy
Operator

  This parameter specifies the number of times the Octel 50
system attempts to transfer a rotary caller to the
receptionist’s extension when it is busy.

  When/How to Use  The default should be sufficient for most Octel 50 systems.
If a call cannot be transferred to the receptionist, it is
directed to the receptionist’s mailbox and the caller can
leave a message.

 This parameter only applies if calls to the receptionist are
supervised.

  Related Parameters/Features  This parameter is not used if Disconnect All Rotary Callers
is enabled.

 This parameter is not available if Enable Automated
Attendant is disabled.

  If Set Too High  The higher you set this parameter, the longer the port
holding the rotary caller is tied up.

  If Set Too Low  If this parameter is set to 0, the Octel 50 system attempts to
transfer rotary callers once before they are transferred to
voice mail to leave a message.

  Min

 
0

 Max

 
9

 Default

 
3

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Receptionist Parameters - #13

 Enable
Receptionist
Grunt Detection

  This parameter determines whether callers may use short
words such as Yes to transfer to a receptionist.

  When/How to Use  This parameter is useful for callers with rotary phones who
cannot successfully access the system but want to be
transferred to an operator. Also, this is useful for detecting
whether a caller has hung up before transferring the call to
the operator.

 It is recommended that you leave this parameter disabled.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.
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  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Receptionist Parameters - #14

 Maximum
Number of
Errors

  This parameter specifies the maximum number of
consecutive invalid mailbox entries and keypresses the
Octel 50 system allows each caller to make before the
system transfers the caller to the operator or disconnects.

  When/How to Use  The default setting should be sufficient.

 When you set this parameter to 0, the Octel 50 system
transfers or disconnects the caller after one error.

  Related Parameters/Features  This parameter determines the number of errors before the
Octel 50 system transfers callers to the operator if Transfer
Calls to Receptionist after Maximum Errors is enabled.

  If Set Too High  The higher this number, the more invalid entries each caller
is allowed to make.

  If Set Too Low  A low setting does not affect Octel 50 system performance,
but callers could perceive the system as intolerant if they
are disconnected or transferred after one error.

  Min

 
0

 Max

 
9

 Default

 
3

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Receptionist Parameters - #15

 Maximum
Number of No
Entries

  This parameter specifies the number of times the Octel 50
system prompts callers for an entry before assuming they
have hung up and releasing the line.

  When/How to Use  The default value for this parameter should be sufficient.

 When this parameter is set to 0, the caller is disconnected
after the first no entry.

 This parameter is not used when a caller fails to make an
entry at the initial greeting. In this case, the call is
considered a rotary call.

  Related Parameters/Features  None.

  If Set Too High  The higher the setting, the longer the off hook time between
callers hanging up and the Octel 50 system resetting the
port.

  If Set Too Low  Callers may perceive the Octel 50 system as intolerant if
they are transferred or disconnected after the first no entry.

  Min

 
0

 Max

 
9

 Default

 
3

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Receptionist Parameters - #16

 Transfer Calls to
Receptionist
after Max. Errors

  This parameter determines whether the Octel 50 system
transfers callers exceeding the Maximum Number of Errors
parameter setting to the default operator or politely
disconnects them.

  When/How to Use  Enable this parameter when you want callers exceeding the
Maximum Number of Errors setting to be transferred to an
operator for assistance or to leave a message.

  Related Parameters/Features  If you enable Transfer Calls to Receptionist after Maximum
Errors, you must create the default operator mailbox and the
after-hours mailbox. If you do not, callers transferred to
those mailboxes are told that the mailboxes are not
recognized on the system, and the callers are disconnected.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 General Transfer Parameters

 The General Transfer parameters control whether calls to invalid mailboxes are
transferred to the switch.

 General Transfer Parameters - #17

 Transfer Invalid
Mailboxes
During Business
Hours

  This parameter determines whether calls to an invalid
mailbox during business hours are transferred to the switch.
An invalid mailbox is an extension that is not assigned a
Octel 50 system mailbox number.

 If this parameter is enabled, calls during business hours to
numbers that do not exist as mailboxes are transferred
directly to the switch.

 If this parameter is off, callers dialing invalid mailbox
numbers during business hours hear, “<Mailbox number> is
an invalid extension number. Please enter the extension
number of the person you would like to speak with.”

  When/How to Use  Disable this parameter unless you have extensions that
callers should be allowed to directly dial.

 Be aware that enabling this parameter can pose a security
concern in that, depending on the configuration of the
switch, callers transferred to the switch may use this
capability to attempt to access an outside line. This is most
relevant for Octel 50 ports used for outcalls for networking
or message delivery to a beeper.

  Related Parameters/Features  If you turn off Enable Automated Attendant, this parameter
is not available.

 Business hours are defined under the Attendant menu.
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  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 General Transfer Parameters - #18

 Transfer Invalid
Mailboxes After
Business Hours

  This parameter determines whether calls to an invalid
mailbox after business hours are transferred to the switch.
An invalid mailbox is an extension that is not assigned as
Octel 50 system mailbox number.

 If this parameter is on, calls after business hours to
numbers that do not exist as mailboxes are transferred
directly to the switch.

 If this parameter is off, callers dialing invalid mailbox
numbers hear, “<Mailbox number> is an invalid extension
number. Please enter the extension number of the person
you would like to speak with.”

  When/How to Use  Disable this parameter unless you have extensions that
callers should be allowed to directly dial.

 Be aware that enabling this parameter can pose a security
concern in that, depending on the configuration of the
switch, callers transferred to the switch may use this
capability to attempt to access an outside line.

  Related Parameters/Features  If you turn off Enable Automated Attendant, this parameter
is not available.

 Business hours are defined under the Attendant menu.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 Time/Date Parameters

 The Time/Date parameters determine when the Octel 50 system voices the time of day
greetings (Morning, Afternoon, and Evening) defined on the System Prompts dialog box,
and how the Octel 50 system voices times and dates.

 The Octel 50 system only voices time of day greetings during open business hours. It
voices the Closed greeting after business hours.
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 Time/Date Parameters - #19

 Start of Morning
Hours

  This parameter defines when, during open hours, the
Octel 50 system begins voicing the Morning greeting
identified on the System Prompts dialog box.

 If you do not specify a Morning greeting on the System
Prompts dialog box, only the Attendant Menu prompt or, if
no attendant menu is defined, the default prompt is voiced
during morning hours.

  When/How to Use  Enter the hour and minutes, in military format, that you
want morning hours to begin. Morning hours cannot be set
on a day-by-day basis.

  Related Parameters/Features  The Start of Afternoon Hours parameter determines when
the morning hours end.

 The Morning greeting does not begin voicing each day
until the Open hours on the Business Hours dialog box is
reached. For example, if you set the Start of Morning
Hours parameter to 6:00 AM but set the Open time field on
the Business Hours dialog box to 8:00 AM, the Morning
greeting does not begin voicing until 8:00 AM.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0000

(12:00 AM)

 Max

 
2359

(11:59 PM)

 Default

 
600

(6:00 AM)

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Time/Date Parameters - #20

 Start of Afternoon
Hours

  This parameter defines when, during open hours, the
Octel 50 system begins voicing the Afternoon greeting
identified on the System Prompts dialog box.

 If you do not specify an Afternoon greeting on the System
Prompts dialog box, only the Attendant Menu prompt or, if
no attendant menu is defined, the default prompt is voiced
during afternoon hours.

  When/How to Use  Enter the hour and minutes, in military format, that you
want afternoon hours to begin. Afternoon hours cannot be
set on a day-by-day basis.

  Related Parameters/Features  The Start of Evening Hours parameter determines when
afternoon hours end.

 The Start of Afternoon Hours parameter must be later than
the Start of Morning Hours parameter.

 The Afternoon greeting is only voiced during the Open
hours set on the Business Hours dialog box. For example,
if you set the Start of Afternoon Hours to 1:00 PM but set
the Closed time on the Business Hours dialog box to
12:00 PM, the Afternoon greeting does not voice.

  If Set Too High  Not applicable.
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  If Set Too Low  Not applicable.

  Min

 
0000

(12:00 AM)

 Max

 
2359

(11:59 PM)

 Default

 
600

(6:00 AM)

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Time/Date Parameters - #21

 Start of Evening
Hours

  This parameter defines when, during open hours, the
Octel 50 system begins voicing the Evening greeting
identified on the System Prompts dialog box.

 If you do not specify an Evening greeting on the System
Prompts dialog box, only the Attendant Menu prompt or, if
no attendant menu is defined, the default prompt is voiced
during evening hours.

  When/How to Use  Enter the hour and minutes, in military format, that you
want evening hours to begin. Evening hours cannot be set
on a day-by-day basis.

  Related Parameters/Features  The Start of Morning Hours parameter determines when
the evening hours end.

 The Start of Evening Hours parameter must be set later
than the Start of Afternoon Hours parameter.

 The Evening greeting is only voiced during the Open
hours set on the Business Hours dialog box. For example,
if you set the Start of Evening Hours to 5:00 PM and set
the Closed time on the Business Hours dialog box to 9:00
PM, the Evening greeting voices from 5:00 PM to 9:00 PM.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0000

(12:00 AM)

 Max

 
2359

(11:59 PM)

 Default

 
1800

(6:00 AM)

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Time/Date Parameters - #22

 Enable Chinese
Date

  This parameter has been disabled.

 Message Timing Parameters

 The Message Timing parameters control the message playback features and the
maximum allowed lengths of message and prompt recordings.

 Message Timing Parameters - #23

 Number of
Seconds to
Rewind Message

 This parameter defines the number of seconds a message
rewinds when a subscriber uses the Rewind keypress
when reviewing messages.
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 When/How to Use  For most Octel 50 systems, the default value should be
sufficient.

 When you set this parameter to 0, the message continues
to play without rewinding when subscribers uses the
Rewind key.

 Related Parameters/Features  None.

  If Set Too High  When this parameter is set too high, subscribers have less
control over how much of the message they can review
when they use the Rewind key.

 If Set Too Low  When this parameter is set too low, subscribers may have
to use the Rewind key several times to review the desired
portion of the message. Set this parameter to 0 to disable
it.

 Min

 
0

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Message Timing Parameters - #24

 Number of
Seconds to Pause
Message

 This parameter defines the number of seconds a message
pauses when a subscriber uses the Pause keypress when
reviewing messages.

 When/How to Use  For most Octel 50 systems, the default value should be
sufficient.

 Subscribers may use the Pause keypress while the
message is paused to resume the playback of the
message.

 When you set this parameter to 0, the message continues
playback without pausing when subscribers use the Pause
keypress.

  Related Parameters/Features  None.

 If Set Too High  Not applicable.

 If Set Too Low  Short pauses may not allow sufficient time for subscribers
to complete what they wanted to do when they paused
the message. Set this parameter to 0 to disable it.

  Min

 
0

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Message Timing Parameters - #25

 Number of
Seconds to Fast
Forward Message

 This parameter defines the number of seconds to fast
forward a message when a subscriber uses the Fast
Forward keypress when reviewing messages.

 When/How to Use  For most Octel 50 systems, the default value should be
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sufficient.

 When you set this parameter to 0, the message continues to
play without fast forwarding when subscribers use the Fast
Forward keypress.

 Related Parameters/Features  None.

 If Set Too High  When this parameter is set too high, subscribers do not
have much control over how much of the message they can
fast forward through when they use the Fast Forward
keypress.

 If Set Too Low  When this parameter is set too low, subscribers must use
the Fast Forward keypress several times to fast forward the
desired portion of the message. Set this parameter to 0 to
disable it.

  Min

 
0

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Message Timing Parameters - #26

 Maximum Time to
Record Mailbox
Prompts

 This parameter specifies the maximum amount of time, in
seconds, for subscribers to record mailbox prompts and
folder labels.

 When/How to Use  For most Octel 50 systems, the default setting should be
sufficient.

 Some applications may require longer prompts. For
example, using V-Trees, you may want to raise this
parameter value. Set this value lower if you need to limit the
amount of disk space to store prompts on small Octel 50
systems to conserve disk space.

 Related Parameters/Features  None.

 If Set Too High  The higher this setting, the more disk space mailbox
prompts and folder labels are allowed to use on Octel 50
systems.

 If Set Too Low  The lower this setting, the less time subscribers have to
record their prompts and folder labels. If this parameter is
set to 0, subscribers cannot record prompts or folder labels.

  Min

 
0

 Max

 
999

 Default

 
90

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Message Timing Parameters - #27

 Minimum
Message Length
in Seconds

 This parameter specifies the minimum length, in seconds, of
messages allowed on the Octel 50 system.

 When/How to Use  For most Octel 50 systems using positive disconnect, the
default setting should be sufficient.
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 If the switch does not provide positive disconnect, set this
parameter higher than 0. This prevents the Octel 50 system
from recording blank messages when callers have hung up
during recording.

 Related Parameters/Features  None.

 If Set Too High  When set too high, the Octel 50 system may delete actual
messages.

 If Set Too Low  If you leave this parameter set to 0, and your switch does
not provide positive disconnect, mailboxes may receive
blank messages.

  Min

 
0

 Max

 
10

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 Subscriber Parameters

 The Subscriber parameters control password security features and message
maintenance features for subscriber mailboxes.

 Subscriber Parameters - #28

 Enable Extended
Password
Security

  This parameter determines whether the Octel 50 system
requires subscribers to press <#> after they enter their
passwords to gain immediate access to their mailboxes.

 If you enable this parameter and a subscriber enters the
correct password, but does not press <#>, the Octel 50
system pauses after the last digit before permitting access
to the mailbox.

 If you disable this parameter, the Octel 50 system allows the
subscriber access as soon as they finish entering the last
digit of the correct password.

  When/How to Use  For most Octel 50 systems, leave this parameter enabled to
provide added security for mailboxes.

  Related Parameters/Features  Enable Extended Password Security is only used if
mailboxes have passwords.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Subscriber Parameters - #29

 Permit
Subscribers to
Leave Messages
to Themselves

  This parameter allows subscribers to send messages to
their own mailboxes. When this parameter is on,
subscribers may use this feature as a message reminder. If
this parameter is off, subscribers attempting to send a
message to their own mailboxes are informed that the
mailbox is not recognized on the system and are prompted
to enter another mailbox number.

  When/How to Use  For most Octel 50 systems, leave this parameter enabled to
allow subscribers to send messages to themselves. Disable
this parameter to conserve hard disk space on small
systems if the Octel 50 system is being used in an
application such as a service bureau where you do not want
subscribers to leave messages for themselves.

  Related Parameters/Features  The subscriber mailboxes must be enabled for receive
messages in their class of service.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Subscriber Parameters - #30

 Permit
Listen-Only
Messages to be
Reviewed

  This parameter determines whether the Octel 50 system
allows subscribers to review listen-only messages before
deleting them. Messages marked as listen-only cannot be
saved or copied to another mailbox.

  When/How to Use  If this parameter is on, subscribers are given the choice of
replaying the message, accessing envelope information,
erasing the message, or exiting the message review.

 If this parameter is off, the message plays, then the Octel 50
system voices, “Message erased,” and continues to play the
rest of the new messages then returns to the Main menu.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Subscriber Parameters - #31

 Enable
Confirmation of
Deleted
Messages

  This parameter determines whether the Octel 50 system
prompts subscribers to confirm that they want to delete a
message by entering an additional keypress.
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  When/How to Use  For most Octel 50 systems, leave this parameter enabled to
help prevent subscribers from accidentally deleting
messages.

  Related Parameters/Features  Subscribers may retrieve accidentally deleted messages
during the same message review session by pressing 5
from the Main menu and following the prompts voiced by the
system.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Subscriber Parameters - #32

 Voice Warning
when Messages
Expire

  This parameter enables the Octel 50 system to notify
subscribers when messages are automatically deleted after
the number of days to save defined in the class of service
has expired.

  When/How to Use  Enable this parameter when you want the Octel 50 system to
inform subscribers that messages have been deleted from
their mailboxes because the messages exceeded the
Number of Days to Save New and Saved messages.

 It is recommended you enable this parameter if Days to Save
messages is set low. This should prevent subscribers from
thinking they have lost messages when they have, in fact,
expired.

  Related Parameters/Features  The Number of Days to Save New and Saved messages
determines when messages are purged from the subscriber’s
mailboxes. Setting Number of Days to Save New and Saved
messages to 99 saves the messages indefinitely so the Voice
Warning when Messages Expire is not used.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Subscriber Parameters - #33

 Voice Warning
When Message
Time is Less
than 2 Minutes

  This parameter enables the Octel 50 system to voice a
warning when a mailbox’s total time to record messages
drops below 2 minutes.
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  When/How to Use  Enable this parameter when you want the Octel 50 system to
inform subscribers when a mailbox’s total time to record
messages drops below 2 minutes. This warning alerts
subscribers to delete messages from their mailboxes.
Otherwise, total recording time could be reached and callers
trying to record messages are told that the mailbox is full.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Subscriber Parameters - #34

 Maximum
Number of
Forwarded
Extensions

  This parameter determines the maximum number of
extensions the Octel 50 system allows in a forwarding chain
when the desired extension is busy or not answered. When
this maximum is reached, the Octel 50 system voices the
extension is busy or not answered, then prompts the caller
to try another extension, leave a message for the original
mailbox, or disconnect.

  When/How to Use  The mailboxes included in the forwarding chain must be
using supervised transfers. A call is a supervised transfer if
the Maximum Rings setting in the mailbox’s class of service
is 1 or above. A call is a blind transfer if the Maximum Rings
setting is 0. If the mailboxes are not using supervised
transfers, the system cannot track the forwarding, which
prevents the system from voicing the greeting of the original
called party should the maximum be reached.

 For most Octel 50 systems the default setting should be
sufficient. If you change this setting, consider the maximum
amount of time you want callers to wait as they are
transferred from extension to extension before they are
prompted to try another extension, leave a message, or
disconnect.

 The Octel 50 system does not allow circular forwarding
situations. When the Octel 50 system encounters a circular
forwarding situation, the system does not forward the call,
regardless of the value of this parameter, and prompts the
caller to dial another extension, leave a message, transfer to
an operator, or disconnect.

 Setting this parameter to 0 disables call forwarding.

  Related Parameters/Features  Subscribers using call forwarding must have Forward
selected as the No Answer/Call Blocking or Busy option on
the Subscriber Settings dialog box.

  If Set Too High  The higher the setting, the longer callers wait while they are
transferred from extension to extension, and the longer the
voice port is occupied.
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  If Set Too Low  If you set this parameter to 0, automatic call forwarding is
not used, and callers will only be allowed to dial another
extension, leave a message, or disconnect.

  Min

 
0

 Max

 
99

 Default

 
10

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Subscriber Parameters - #35

 Set Initial
Password for
New Mailboxes
to 1111

  This parameter determines whether the Octel 50 system
assigns the password 1111 to all mailboxes created over
the phone by the supervisor.

  When/How to Use  If this parameter is disabled, the supervisor must enter an
initial password when creating mailboxes over the phone.
Note that when creating mailboxes onscreen, the initial
password is always set to 1111, regardless of this
parameter.

  Related Parameters/Features  If Minimum Length of Password is greater than 4,
subscribers are prompted to enter a new password that
complies with the minimum.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 Caller Parameters

 The Caller parameters control whether outside callers are allowed to leave multiple
messages during a single call and whether they can access subscriber directories.

 
 Caller Parameters - #36

 Permit Callers to
Leave Multiple
Messages

  This parameter determines whether outside callers are
allowed to leave multiple messages for Octel 50 system
subscribers during a single phone call.

 If you enable this parameter, the Octel 50 system voices an
option to disconnect along with the options to try another
extension or transfer to the operator.

 If you disable this parameter, callers are politely
disconnected after leaving a single message.
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  When/How to Use  This parameter should be enabled for most Octel 50
systems. If you disable it, callers could become frustrated
having to call back to leave additional messages.

 An application for which you may want to disable this
parameter is a service bureau, where you want callers
directly routed to subscriber mailboxes to leave a message
and then disconnected. Also, on smaller Octel 50 systems,
such as those with fewer ports, you may want to restrict
callers from tying up ports for considerable lengths of time.

  Related Parameters/Features  If you enable this parameter, you can use the PROGTIME
parameter under Channel Specific Parameters to control the
total length of calls to the system.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Caller Parameters - #37

 Permit Callers
Access to
Directory
Services

  This parameter determines whether outside callers can
access subscriber directories.

 If you enable this parameter, callers can press <*> to
access a directory they can use to dial the names of the
subscribers they want to reach.

 If you disable this parameter, callers must know the number
of the subscribers they wish to speak to, or they can transfer
to the default operator.

  When/How to Use  If the Octel 50 system is being used as a service bureau,
you may want to disable this parameter.

 If you do not have a live operator, it is recommended that
this parameter be enabled. Otherwise, callers will have no
timely way of reaching subscribers whose numbers they do
not know.

  Related Parameters/Features  To create directory entries, you must enter the First and
Last Names on the Mailbox Entry dialog box, and the
subscribers must record their name prompt.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 AMIS Parameters

 The AMIS parameters identify the local Octel 50 system and define system-wide defaults
for dispatching network messages. Some of these parameters can be overridden on a
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per-node basis on the AMIS Node Entry dialog box. AMIS parameters only apply to Octel
50 systems with sentinels that support the AMIS network protocol.

 For the first five parameters, the minimum and maximum refer to the length of the entry
allowed, not an actual number.

 AMIS Parameters - #38

 System
Telephone
Access Number

  This parameter defines the local Octel 50 system’s phone
number. The Octel 50 system includes the System
Telephone Access Number as part of network message
dispatches to remote systems. This allows remote sites to
reply directly to messages you send them.

  When/How to Use  When defining the System Telephone Access Number, you
must include the area code and 7-digit phone number, such
as 9415551234. Only digits can be entered for this
parameter.

 If you do not enter the System Telephone Access Number,
remote systems will be unable to reply directly to messages
dispatched from the Octel 50 system.

  Related Parameters/Features  The Country Code is placed in front of the System
Telephone Access Number to identify the Octel 50 system
for remote sites.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
16

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #39

 AMIS Prefix   This parameter defines the code that the Octel 50 system
must insert before the dialing string when dispatching
network messages. This code can be used to identify a local
phone network or the Code for Accessing an Outside Line.
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  When/How to Use  Use the AMIS Prefix to identify the code that must be dialed
if you are part of a local network. For example, some
companies have multiple sites that use a code other than
the Code for Accessing an Outside Line to indicate that they
are dialing another network site.

 If the customer’s system does not require a special prefix to
be dialed for network messages, leave this parameter blank.

 The AMIS Prefix is not used for replies to network
messages; the Code for Accessing an Outside Line is used
instead.

 If you need to use multiple prefixes, use the AMIS Prefix to
define the code used most often and then use the Prefix
Code field on the AMIS Node Entry dialog box to override
the AMIS Prefix for nodes that require a different prefix.

 If you do not define an AMIS Prefix, subscribers sending
Casual AMIS messages to destinations that require a prefix
must insert the prefix before the destination telephone
number when dialing.

  Related Parameters/Features  The Prefix Code field on the AMIS Node Entry dialog box
overrides the AMIS Prefix on a per-node basis.

 The Octel 50 system uses the Code for Accessing an
Outside Line when no AMIS Prefix or Prefix Code is defined.
If you do not want to use a prefix or the Code for Accessing
an Outside Line, insert a comma in this field.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
3

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #40

 International
Access Code

  This parameter defines the code used to access
international dialing in the country the Octel 50 system is
located. The Octel 50 system uses this code when sending
network replies to remote systems in other countries.

 The Octel 50 system determines whether the International
Access Code is required for a reply by comparing the
Country Code of the remote destination to the Octel 50
system’s Country Code. If the codes are different, the Octel
50 system inserts the International Access Code in the
dialing string.

  When/How to Use  Enter the International Access Code for the country in which
the local Octel 50 system is located. This code should only
contain numbers or commas.

 The International Access Code for the United States is 011.
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  Related Parameters/Features  You must correctly define the Country Code for the Octel 50
system to determine whether the International Access Code
is required for a network reply.

 This parameter is only used for network replies. If Reply is
disabled on the Class of Service dialog box for all
subscribers, the International Access Code is not used.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #41

 Long Distance
Access Code

  This parameter defines the code used to access long
distance dialing at the Octel 50 system location. The Octel
50 system uses this code when sending network replies to
remote systems in other area codes.

 Dial Plan determines whether the Long Distance Access
Code is required for network replies. If the prefix of the
remote system is not found in Dial Plan, the Octel 50 system
assumes it is a long distance number and inserts the Long
Distance Access Code in the dialing string.

  When/How to Use  Enter the Long Distance Access Code for the Octel 50
system location. The Long Distance Access Code for the
United States is 1.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  This code is only used for network replies. If Network Reply
is disabled on the Class of Service dialog box for all
subscribers, the Long Distance Access Code is not used.

 Use Dial Plan database must be enabled in the Dialing
parameters for the Octel 50 system to insert the Long
Distance Access Code when required for network replies.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 



Setting Up the System   Configuring System Setup Parameters

Octel 50 Installation Guide 8-27

 AMIS Parameters - #42

 Country Code   This parameter defines the dialing code for the country in
which the Octel 50 system is located.

 The Octel 50 system transmits the Country Code to remote
systems when it dispatches both casual and administered
network messages. This allows remote sites to reply directly
to messages you send them.

 The Country Code must be defined for network
transmissions to be successful.

  When/How to Use  Enter the Country Code for the country in which the Octel 50
system is located. The Country Code for the United States
is 1.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The Octel 50 system uses the Country Code to determine if
the International Access Code is required for network
replies.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #43

 Permit Inbound
AMIS Dispatch

  This parameter determines whether the Octel 50 system is
permitted to receive AMIS messages.

  When/How to Use  When you enable this parameter, all subscribers on the
Octel 50 system able to receive messages from local
subscribers can also receive AMIS messages.

  Related Parameters/Features  If Permit Inbound AMIS Dispatch is enabled but Permit
Outbound AMIS Dispatch is disabled, subscribers can
receive network messages but cannot send or reply to them.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #44

 Permit Outbound
AMIS Dispatch

  This parameter determines whether the Octel 50 system
can send network messages and replies.

  When/How to Use  Permit Outbound AMIS Dispatch controls the ability to send
network messages and replies from the Octel 50 system.
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  Related Parameters/Features  You must also activate the networking options on the Class
of Service dialog box.

 If Permit Outbound AMIS Dispatch is enabled but Permit
Inbound AMIS Dispatch is disabled, you can send network
messages but you cannot receive replies to those
messages.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #45

 Start of Economy
Weekday Hours

  This parameter defines the system-wide start of economy
dispatch hours during the week. During economy hours,
the Octel 50 system sends any casual or administered
network messages marked for economy dispatch since
the end of economy hours the previous day.

  When/How to Use  Enter the hour and minute that economy time begins in
military time. The same economy time is used for each
weekday; you cannot specify different economy times for
different weekdays.

 When defining economy hours, use the off-peak rate
period defined by the phone carrier.

 It is recommended that you start the economy hours a few
minutes after the start of the lower rate period to allow for
discrepancies between the Octel 50 system clock and the
carrier’s clocks.

  Related Parameters/Features  You can use the Economy Dispatch fields on the AMIS
Node Entry dialog box to override the economy hours for
individual nodes.

 The End of Economy Weekday Hours parameter
determines when economy hours end.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0000

(12:00 AM)

 Max

 
2359

(11:59 PM)

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #46

 End of Economy
Weekday Hours

  This parameter defines the system-wide end of economy
dispatch hours during the week. During economy hours,
the Octel 50 system sends any casual or administered
network messages marked for economy dispatch since
the end of economy hours the previous day.
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  When/How to Use  Enter the hour and minute that economy time ends in
military time. The same economy time is used for each
weekday; you cannot specify different economy times for
different weekdays.

 When setting economy hours, use the off-peak rate period
defined by the phone carrier.

 It is recommended that you end the economy hours a few
minutes before the end of the lower rate period to allow for
discrepancies between the Octel 50 system clock and the
carrier’s clocks.

 The economy time frame can overlap into the next day.
For example, Friday’s time may extend into Saturday
morning. In this case, the hours that extend into Saturday
are still considered part of the weekday economy time.

  Related Parameters/Features  You can use the Economy Dispatch fields on the AMIS
Node Entry dialog box to override economy hours for
individual nodes.

 The Start of Economy Weekday Hours parameter
determines when economy hours begin.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0000

(12:00 AM)

 Max

 
2359

(11:59 PM)

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #47

 Start of Weekend
Economy Hours

  This parameter defines the system-wide start of economy
dispatch hours for the weekend. During economy hours,
the Octel 50 system sends any casual or administered
network messages marked for economy dispatch since
the end of economy hours on the previous day.

  When/How to Use  Enter the hour and minutes that economy time begins for
Saturday and Sunday in military time. The same economy
time is used for both weekend days; you cannot specify
different economy times.

 When setting economy hours, use the off-peak rate period
defined by the phone carrier. Many carriers have different
off-peak hours on the weekend.

 It is recommended that you start the economy hours a few
minutes after the start of the lower rate period to allow for
discrepancies between the Octel 50 system clock and the
carrier’s clocks.

  Related Parameters/Features  You can use the Economy Dispatch fields on the AMIS
Node Entry dialog box to override economy hours for
individual nodes.

 The End of Economy Weekend Hours parameter
determines when economy hours end.
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  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0000

(12:00 AM)

 Max

 
2359

(11:59 PM)

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #48

 End of Economy
Weekend Hours

  This parameter defines the system-wide end of economy
dispatch hours for the weekend. During economy hours,
the Octel 50 system sends any casual or administered
network messages marked for economy dispatch since
the end of economy hours on the previous day.

  When/How to Use  Enter the hour and minutes that economy time ends in
military time. The same economy time is used for
Saturday and Sunday; you cannot specify different
economy times.

 When setting economy hours, use the off-peak rate period
defined by the phone carrier. Many carriers have different
off-peak hours on the weekend.

 It is recommended that you end the economy hours a few
minutes before the end of the lower rate period to allow for
discrepancies between the Octel 50 system clock and the
carrier’s clocks.

 The economy time frame can overlap into the next day.
For example, Sunday’s time may extend into Monday
morning. In this case, the hours that extend into Monday
are still considered part of the weekend economy time.

  Related Parameters/Features  You can use the Economy Dispatch fields on the AMIS
Node Entry dialog box to override economy hours for
individual nodes.

 The Start of Economy Weekend Hours parameter
determines when economy hours begin.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0000

(12:00 AM)

 Max

 
2359

(11:59 PM)

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #49

 Maximum
Number of
Attempts Before
Failure

  This parameter defines the number of unsuccessful
dispatch attempts to an Administered node allowed before
the Octel 50 system deactivates the node. When a node is
inactive, subscribers may not send any messages to it until
you reactivate the node on the AMIS Node Entry dialog box.

 This parameter only applies to Administered AMIS nodes.
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 An attempt is counted any time the Octel 50 system returns
a message to the sending subscriber’s mailbox:

• Maximum number of retries for busy is reached

• Minimum number of retires for no answer is reached

• Destination mailbox is full

• Dispatch fails

 For example, if you set this parameter to 5, the node will be
disabled if five messages to that node are returned to the
sending subscribers’ mailboxes.

  When/How to Use  The default for this parameter should be sufficient for most
Octel 50 systems.

 If subscribers notify you that they are unable to enter a node
number when sending a network message, it is likely the
node has been deactivated. Check the AMIS Node Entry
dialog box to determine if the Octel 50 system has
automatically disabled the Node Active checkbox. If so, you
should determine the reason for the messaging failures
before reactivating the node.

  Related Parameters/Features  Each time the Number of Retries for No Answer is reached
for a message, the Octel 50 system returns the message to
the subscriber’s mailbox and an attempt is counted towards
Maximum Number of Attempts Before Failure.

 Each time the Number of Retries for Busy is reached for a
message, the Octel 50 system returns the message to the
subscriber’s mailbox and an attempt is counted towards
Maximum Number of Attempts Before Failure.

  If Set Too High  It may be some time before you determine that there is a
problem with a node.

  If Set Too Low  You may deactivate nodes unnecessarily. Setting this
parameter to 0 acts the same as when you set it to 1.

  Min

 
0

 Max

 
9

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #50

 Maximum Delay
for Standard
Dispatch in
Minutes

  This parameter defines the number of minutes that any
message can be held in a standard dispatch queue. When
any message in the queue reaches the maximum delay, the
Octel 50 system dispatches all messages in the queue. This
parameter applies to all network messages assigned
standard dispatch (Administered or Casual AMIS).
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  When/How to Use  When setting this parameter, keep in mind that only one
message in the queue will be held for the maximum delay.
When the delay is reached, the Octel 50 system sends all
messages in the queue, regardless of how long they have
been there.

 Consider what type of messages subscribers usually send
with standard dispatch. If time-critical messages are
regularly sent with standard dispatch, you may want to set
this parameter lower to ensure that they are sent in a timely
manner.

 Also consider how active the queues are. The more
messages that are regularly sent with standard dispatch, the
higher you can set this parameter.

  Related Parameters/Features  This parameter defines the delay for standard dispatch on a
system-wide basis. You can override this parameter for
individual nodes using the Standard Dispatch Maximum
Delay field on the AMIS Node Entry dialog box.

 If Maximum Number of Standard Messages in System
Setup or Maximum Messages or Maximum Delay on the
AMIS Node Entry dialog box is reached first, the Octel 50
system dispatches all of the messages in the queue before
the maximum delay is reached.

 The Octel 50 system creates queues for standard dispatch
based on the System Telephone Access Number, not the
node number.

  If Set Too High  Some messages may be held in the queue for quite a while
before they are dispatched.

  If Set Too Low  The Octel 50 system will make more outcalls to the remote
sites to dispatch messages.

  Min

 
3

 Max

 
999

 Default

 
90

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #51

 Maximum
Number of
Standard
Messages

  This parameter defines the number of messages that may
accumulate in a standard dispatch queue. When the queue
reaches the maximum number, the Octel 50 system
dispatches all messages in the queue. This parameter
applies to all network messages (Administered or  Casual
AMIS) assigned Standard dispatch.

  When/How to Use  Consider what type of messages subscribers usually send
with standard dispatch. If time-critical messages are
regularly sent with standard dispatch, you may want to set
this parameter lower to ensure that they are sent in a timely
manner.

 Also consider how active the queues are. The more
messages that are regularly sent with standard dispatch, the
higher you can set this parameter.
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  Related Parameters/Features  This parameter defines the maximum messages for
standard dispatch on a system-wide basis. You can override
this parameter for individual nodes using the Standard
Dispatch Maximum Messages field on the AMIS Node Entry
dialog box.

 If Maximum Delay for Standard Dispatch in Minutes in
System Setup or Maximum Delay or Maximum Messages on
the AMIS Node Entry dialog box is reached first for a queue,
the Octel 50 system dispatches all of the messages in the
queue before the maximum number of messages
accumulate.

 The Octel 50 system creates queues for standard dispatch
based on the System Telephone Access Number, not the
node number.

  If Set Too High  Some messages may be held in the queue for quite a while
before they are dispatched.

  If Set Too Low  The Octel 50 system will make more outcalls to the remote
sites to dispatch messages.

  Min

 
2

 Max

 
9

 Default

 
8

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #52

 Delay for Busy In
Minutes

  This parameter defines the number of minutes the Octel 50
system waits between retries when dispatching to a remote
access phone number that is busy. This parameter applies
to all outbound network messaging (Administered AMIS,
Casual AMIS, network replies).

  When/How to Use  The default for this parameter should be sufficient on most
Octel 50 systems.

  Related Parameters/Features  This parameter determines the delay between Number of
Retries for Busy.

  If Set Too High  The higher you set this parameter, the longer it will take for
the message to reach its intended destination

  If Set Too Low  The lower you set this parameter, the faster the Octel 50
system exhausts the number of retries.

  Min

 
3

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #53

 Number of
Retries for Busy

  This parameter defines the number of busy responses the
Octel 50 system allows when attempting dispatch to a
remote access phone number. This parameter applies to all
outbound network messaging (Administered AMIS, Casual
AMIS, network replies).

  When/How to Use  The default for this parameter should be sufficient on most
Octel 50 systems.
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  Related Parameters/Features  The Delay for Busy In Minutes determines how long the
Octel 50 system waits between retries for attempts resulting
in a busy.

 If the Number of Retries for No Answer is reached first, the
Octel 50 system places the message in the sender’s new
message queue and makes no further attempts.

 Each time the Number of Retries for Busy is reached for a
message and the Octel 50 system returns the message to
the sender’s mailbox, an attempt is counted towards
Maximum Number of Attempts Before Failure.

  If Set Too High  The Octel 50 system may unnecessarily tie up a port trying
to reach a remote system that may be down.

  If Set Too Low  The Octel 50 system may unnecessarily return messages to
subscriber mailboxes. If set to 0, the Octel 50 system places
the message in the sender’s mailbox after the first attempt
resulting in a busy.

  Min

 
0

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #54

 Delay for No
Answer In
Minutes

  This parameter defines the number of minutes the Octel 50
system waits between retries when dispatching to a remote
access phone number that does not answer. This parameter
applies to all outbound network messaging (Administered
AMIS, Casual AMIS, network replies).

  When/How to Use  The default for this parameter should be sufficient for most
Octel 50 systems.

  Related Parameters/Features  This parameter determines the delay between Number of
Retries for No Answer.

  If Set Too High  The higher you set this parameter, the longer it will take for
the message to reach its intended destination

  If Set Too Low  The lower you set this parameter, the faster the Octel 50
system exhausts the number of retries.

  Min

 
3

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 AMIS Parameters - #55

 Number of
Retries for No
Answer

  This parameter defines the number of no answer responses
the Octel 50 system allows when attempting dispatch to a
remote access phone number. This parameter applies to all
outbound network messaging (Administered AMIS, Casual
AMIS, network replies).

  When/How to Use  The default for this parameter should be sufficient on most
Octel 50 systems.
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  Related Parameters/Features  The Delay for No Answer In Minutes determines how long
the Octel 50 system waits between retries for attempts
resulting in a no answer.

 If the Number of Retries for Busy is reached first, the Octel
50 system places the message in the sender’s new
message queue and makes no further attempts.

 Each time the Number of Retries for No Answer is reached
for a message and the Octel 50 system returns the
message to the sender’s mailbox, an attempt is counted
towards Maximum Number of Attempts Before Failure.

  If Set Too High  The Octel 50 system may unnecessarily tie up a port trying
to reach a remote system that may be down.

  If Set Too Low  The Octel 50 system may unnecessarily return messages to
subscriber mailboxes. If set to 0, the Octel 50 system places
the message in the sender’s mailbox after the first attempt
resulting in a no answer.

  Min

 
0

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 Fax Parameters

 The Fax parameters determine where and how callers retrieve faxes from the Octel 50
system.

 
 Fax Parameters - #56

 Local Fax
Machine
Telephone
Number

  This parameter defines the fax machine phone number
where Octel 50 system subscribers retrieve faxes sent to
their mailboxes. This phone number may be an extension
on the system or an external phone number.

  When/How to Use  The Local Fax Machine Telephone Number may be an
extension, external phone number, or a long distance
number.

 If the Local Fax Machine Telephone Number is an internal
extension, enter the extension number.

 If the fax machine is a local external phone number, enter
the number.

 If the Local Fax Machine Number is at a long distance
number, enter the long distance access code, followed by
the area code and the phone number.

 The minimum and maximum for this parameter refer to the
length of the entry allowed in this field, not an actual value.
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  Related Parameters/Features  If Fax Mail Allowed is disabled and the Octel 50 system
detects fax tones, it performs a blind transfer to the Local
Fax Machine Telephone Number.

 If the number of digits in the Local Fax Machine Telephone
Number is equal to or greater than the Number of Digits in
Local Telephone Number, the Fax Prefix Code is inserted at
the beginning of the dialing string. If the Fax Prefix Code is
not defined, the Custom Message Delivery Code is inserted
at the beginning of the dialing string.

 If the number of digits in the Local Fax Machine Telephone
Number is less than the Number of Digits in Local Phone
Number, the Custom Message Delivery Code is inserted at
the beginning of the dialing string.

 If both the Fax Prefix Code and a Custom Message Delivery
code are undefined, the Octel 50 system dials the fax
number as it displays in the field.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 

 The following fax parameters are only available on Octel 50 systems with sentinels that
support the Fax Solution module.

 Fax Parameters - #57

 Fax Board Type   This parameter indicates the type of fax board in the Octel
50 system. When you select None, all the Fax parameters,
except Local Fax Machine Telephone Number, are disabled.

  When/How to Use  Enter 0 if no fax board is installed and 2 if a Brooktrout fax
board is installed.

  Related Parameters/Features  When None is selected, the following parameters are not
available:

• V-Tree Fax Retrieval

• Use Immediate Fax Delivery Mode in V-Trees

• Fax Mail Allowed

• Use a Fax Cover Sheet

• Number of Attempts when Sending a Fax

• Fax Delivery Retry Delay

• Fax Prefix Code

If Set Too High Not applicable.

If Set Too Low Not applicable.
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Min

–

Max

–

Default

0

Requires
Restart

Yes

Switch-
Dependent

No

Set by
Integrator

No

Fax Parameters - #58

V-Tree Fax
Retrieval

This parameter determines whether the Octel 50 system
can distribute faxes requested by callers from a V-Tree.

When/How to Use You should enable this parameter when you want the Octel
50 system to be able to send faxes to callers. For example,
to provide product information to customers.

Related Parameters/Features Use Immediate Fax Delivery Mode in V-Trees is disabled if
V-Tree Fax Retrieval is off.

If Use Fax Cover Sheet is enabled, the Octel 50 system
sends a cover sheet with every outbound fax.

If Set Too High Not applicable.

If Set Too Low Not applicable.

Min

–

Max

–

Default

No

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No

Fax Parameters - #59

Use Immediate
Fax Delivery
Mode in V-Trees

This parameter determines whether the Octel 50 system
delivers a fax during the phone call the caller requested it or
schedules the fax for later delivery. If this parameter is
enabled, callers must be calling from a fax machine to
receive the fax.

When/How to Use Enable this parameter if you do not want the Octel 50
system to incur long distance charges for delivering faxes
requested by callers from a V-Tree.

Related Parameters/Features When V-Tree Fax Retrieval is disabled, Use Immediate Fax
Delivery Mode in V-Trees is not available.

Fax cover sheets are not sent with faxes retrieved from
V-Trees when Use Immediate Fax Delivery Mode in V-Trees
is enabled.

If Set Too High Not applicable.

If Set Too Low Not applicable.

Min

–

Max

–

Default

No

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No
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Fax Parameters - #60

Fax Mail Allowed This parameter determines whether Octel 50 system
subscribers are permitted fax mail.

When/How to Use This parameter permits fax mail for all mailboxes on the
Octel 50 system. Mailboxes must also be enabled for send
or receive faxes in the class of service.

Related Parameters/Features None.

If Set Too High Not applicable.

If Set Too Low Not applicable.

Min

–

Max

–

Default

No

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No

Fax Parameters - #61

Use a Fax Cover
Sheet

This parameter specifies whether the Octel 50 system
attaches a fax cover sheet when it delivers faxes retrieved
from a V-Tree.

When/How to Use If you enable this parameter, you must create a system-wide
fax cover sheet. You can only have one fax cover sheet in
the system.

Related Parameters/Features A Fax cover sheet is not sent from a V-Tree when Use
Immediate Fax Delivery Mode in V-Trees is enabled.

If Set Too High Not applicable.

If Set Too Low Not applicable.

Min

–

Max

–

Default

No

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No

Fax Parameters - #62

Number of
Attempts when
Sending a Fax

This parameter specifies the number of times the Octel 50
system attempts to send a fax for V-Tree fax retrieval and
fax mail when it encounters a busy or no answer condition
at the destination fax machine.

When/How to Use The default should be acceptable for most systems.

If you set this parameter to 0, and the Octel 50 system
encounters a busy or no answer condition at the destination
fax machine, the fax is not delivered.

Related Parameters/Features The Fax Delivery Retry Delay (Minutes) determines how
long the Octel 50 system waits between attempts to deliver
a fax.

If Set Too High The maximum is the default value for this parameter.

If Set Too Low The Octel 50 system may be unable to deliver the fax.
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Min

0

Max

9

Default

5

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No

Fax Parameters - #63

Fax Delivery
Retry Delay
(Minutes)

This parameter determines the number of minutes the Octel
50 system waits before attempting to send a fax after it
encounters a busy or no answer at the destination fax
machine.

When/How to Use For most Octel 50 systems, the default should be sufficient.
Increase this value if the Octel 50 system experiences
heavy fax traffic and the outbound ports are constantly
occupied by fax delivery.

Related Parameters/Features If the Number of Attempts when Sending a Fax is set to 0,
this parameter is not used.

If Set Too High The higher you set this parameter, the longer callers have to
wait for fax delivery.

If Set Too Low Ports may not have enough time to reset between delivery
attempts. Also, the number of attempts could be exhausted
before the fax can be delivered.

Min

1

Max

60

Default

2

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No

Fax Parameters - #64

Fax Prefix Code This parameter specifies the prefix the Octel 50 system dials
when accessing an external line to send a fax.

When/How to Use The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

Related Parameters/Features If the length of the destination fax number is equal to or
greater than Number of Digits in Local Telephone Number,
the Octel 50 system uses the fax prefix code to access an
external fax line when dialing the destination fax number.

If Set Too High Not applicable.

If Set Too Low Not applicable.

Min

0

Max

32

Default

9,

Requires
Restart

No

Switch-
Dependent

Yes

Set by
Integrator

No
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Fax Extensions

The Fax Extensions parameters are used for Octel 50 systems using the Transfer Method
to send and receive faxes. The Transfer Method is used when the Octel 50 system has
fewer fax ports than voice ports. When the Transfer Method is used, the Octel 50 system
must put the voice channel on hold, then dial a fax port extension.

Fax Extensions Parameters - #65

Transfer to
Extensions
(Requires
Shutdown)

This parameter determines whether the Octel 50 system
transfers calls from a voice port to a fax port when sending
and receiving faxes.

When/How to Use Enable this parameter if the Octel 50 system must use the
Transfer Method to send and receive faxes.

If you enable this parameter, you must shutdown the Octel
50 system and then restart it for the change to be
recognized.

Related Parameters/Features When Transfer to Extensions is enabled, you must
configure the Extension Connected to Fax Channel n
parameters.

The Fax Extensions parameters are not available when the
Fax Board Type parameter is set to 0.

If Set Too High Not applicable.

If Set Too Low Not applicable.

Min

–

Max

–

Default

No

Requires
Restart

Yes

Switch-
Dependent

No

Set by
Integrator

No

Fax Extensions Parameters - #66-77
Extension
Connected to
Fax Channel 0-11

These parameters define the phone system extension
number connected to each fax channel. Octel 50 systems
using the Transfer Method dial these extensions to transfer
faxes to a fax port.

When/How to Use Enter the extension number for each fax port on your
system. The extensions you enter for each channel must be
valid extensions that you assigned to the fax ports. Note that
the channel numbers begin at 0. For example, if you have
four fax ports on the Octel 50 system, enter an extension for
ports numbered 0-3.

The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

Related Parameters/Features Transfer to Extensions (Requires Shutdown) must be
enabled for these parameters to be available.

If Set Too High Not applicable.

If Set Too Low Not applicable.
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Min

0

Max

32

Default

Blank

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No

Call Queuing Parameters

The Call Queuing parameters control the number of callers allowed in holding queues for
the Octel 50 system and the prompts voiced to callers holding in queues. Call Queuing is
only available when Enable Automated Attendant is on, and when call progress is used.

Call Queuing Parameters - #78

Maximum
Number of
Callers Allowed
in Queue

This parameter specifies the total number of callers the
Octel 50 system permits to be holding in queues at any one
time.

When/How to Use When setting this parameter, consider the following:

• Set this parameter high enough to accommodate as
many callers as possible, but low enough so all the
inbound ports are not constantly tied up with callers
on hold.

• Do not set this parameter higher than the number of
ports installed on the Octel 50 system.

  Related Parameters/Features  The number of ports enabled for inbound calls determines
the maximum number of callers allowed in the Octel 50
system.

  If Set Too High  All inbound ports on the Octel 50 system are tied up by
callers on hold. If this occurs, the Octel 50 system will be
unable to receive inbound calls.

  If Set Too Low  Callers will not be able to wait in queues. Set this parameter
to 0 to disable it.

  Min

 
0

 Max

 
32

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Call Queuing Parameters - #79

 Voice “Extension
is (still) busy”
while in Queue

  This parameter determines whether the Octel 50 system
voices, “I’m sorry, but that extension is busy right now,”  to
callers after the system first attempts to transfer them to a
busy extension enabled for call queuing.

 If this parameter is enabled, and the caller is in the first
queue position, the Octel 50 system voices, “I’m sorry, but
that extension is still busy,” each time the system attempts
to transfer the caller to the busy extension.

 Callers in any queue position but the first do not hear this
phrase again until they move up to the first position in the
queue.
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  When/How to Use  For most Octel 50 systems, leave this parameter enabled.

  Related Parameters/Features  System managers may record call queuing prompts using
SOLVE or the phone interface.

 The Octel 50 system voices this prompt after the phrase,
“Please hold while your call is being transferred,”  if the
Voice “Please Hold while Call is Transferred” parameter is
enabled.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Call Queuing Parameters - #80

 Voice Caller’s
Position in
Queue

  This parameter determines whether the Octel 50 system
voices call queue positions to callers in the second queue
position or higher.

  When/How to Use  For most Octel 50 systems, leave this parameter enabled.
This parameter gives callers an indication of how long they
may need to wait to be connected to the subscriber at the
busy extension. Disable this parameter if you do not want
the Octel 50 system to inform callers of their positions in the
queue.

  Related Parameters/Features  When the caller is first transferred to the second position
queue position or higher the Octel 50 system voices,
“Please hold while your call is being transferred,” and “I’m
sorry, but that extension is busy,” followed by, “You are
number n in the queue,”  if these phrases are enabled.
Afterwards, the Octel 50 system only voices the keypress
options phrase, any additional call queuing phrases, and the
caller’s position phrase until the caller moves into the first
queue position.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Call Queuing Parameters - #81

 Voice “Please
Hold while Call
is Transferred”

  This parameter determines whether the Octel 50 system
voices, “Please hold while your call is being transferred,” to
the caller in the first queue position each time the system
attempts to transfer to an extension enabled for call
queuing.

  When/How to Use  For most Octel 50 systems, leave this parameter enabled.
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  Related Parameters/Features  If you recorded a Custom Transfer prompt using SOLVE or
the system manager’s phone interface, that prompt is
voiced each time the system attempts to transfer the caller.
In this case, disable this parameter so the Octel 50 system
does not voice two transfer prompts.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Call Queuing Parameters - #82

 Voice and
Accept Keypress
Options while in
Queue

  This parameter determines whether the Octel 50 system
voices keypress options to all callers waiting in queues.
Providing keypress options gives callers alternatives to
holding for the busy extension.

 When this parameter is enabled, the Octel 50 system
voices, “To continue holding, press <*>. To try another
extension, press <1>. To leave a voice or fax mail message,
press <2>. To be transferred to a live operator, press <0>.
Or to disconnect, press <#>.”

 This prompt is voiced after, “Please hold while your call is
being transferred,” and, “I’m sorry, but that extension is
busy,” if each of these phrases is enabled. If the caller is
holding in the second queue position or higher, this prompt
is voiced after the caller’s position.

  When/How to Use  For most Octel 50 systems, leave this parameter enabled. If
this parameter is disabled, callers only have the choice of
continuing to hold or hanging up.

  Related Parameters/Features  If this parameter is disabled, the Custom Call Queuing
Phrase for Receptionist and the Require Caller to Press Star
to Stay in Queue parameters are not available.

 If Require Caller to Press Star to Stay in Queue is enabled,
the Octel 50 system substitutes the phrase, “To continue
holding, press star,” in the keypress options prompt.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Call Queuing Parameters - #83

 Custom Call
Queuing Phrase
for Receptionist

  This parameter determines whether the Octel 50 system
uses a custom call queuing phrase for callers holding for the
default receptionist mailbox.

 This phrase should be recorded as phrase 93 in the
SO3-D1.VAP (Dialogic) or SO3-D1.VOX (Rhetorex) file
using the V-Edit voice editor.

  When/How to Use  If you enable this parameter, make sure the default
receptionist mailbox is enabled for call queuing in the class
of service, and call queuing is active on the Subscriber
Settings dialog box.

  Related Parameters/Features  This parameter is not available if Voice and Accept
Keypress Options while in Queue is disabled.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Call Queuing Parameters - #84

 Require Caller to
Press Star to
Stay in Queue

  This parameter determines whether the Octel 50 system
prompts all callers to press <*> to remain holding in a call
queue.

 When this parameter is enabled, the Octel 50 system
voices, “To continue holding, press <*>. To try another
extension, press <1>. To leave a voice or fax mail message,
press <2>. To be transferred to a live operator, press <0>.
Or to disconnect, press <#>.”  Callers in the queue who do
not press <*> when prompted to stay in the queue are
disconnected.

  When/How to Use  If the Octel 50 system experiences hangup detection
problems, enable this parameter to allow the Octel 50
system to reset ports when callers on hold hang up.

 If Require Caller to Press Star to Stay in Queue is enabled,
the Octel 50 system substitutes the phrase, “To continue
holding, press star,” in the keypress options prompt.

  Related Parameters/Features  This parameter is not available if Voice and Accept
Keypress Options while in Queue is disabled.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Call Queuing Parameters - #85

 Number of
Seconds for
First Caller in
Queue to Wait

  This parameter specifies the number of seconds the Octel
50 system waits after attempting to transfer the first caller in
a queue to the desired extension before attempting to
transfer them again.

  When/How to Use  For most Octel 50 systems, the default setting should be
sufficient. Increase this value if you want callers to remain
on hold longer between prompt voicing.

  Related Parameters/Features  None.

  If Set Too High  Callers may assume they have been disconnected and
hang up.

  If Set Too Low  Not applicable; the default is the minimum allowed setting.

  Min

 
1

 Max

 
99

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 Intercom Paging Parameters

 The Intercom Paging parameters define the codes the Octel 50 system dials to activate
the Intercom Paging feature. They also determine how many times and how often the
Octel 50 system pages a subscriber.

 
 Intercom Paging Parameters - #86

 Intercom Paging
Code

  This parameter specifies the dialing string the Octel 50
system must send to the switch to activate Intercom Paging.
When the Octel 50 system initiates a page, it puts the caller
on hold, dials the Intercom Paging Code, then returns to the
caller.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  Related Parameters/Features  If you want to configure zone paging, enter the zone paging
code for each mailbox in the Number field under Intercom
Paging on the Subscriber Settings dialog box. This code
overrides the Intercom Paging code.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
15

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes
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 Intercom Paging Parameters - #87

 Release Code for
Intercom Paging

  This parameter specifies the code the Octel 50 system dials
when required by the switch to return to a call after the
system attempts to page the subscriber.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Intercom Paging Parameters - #88

 Repeat Intercom
Paging Phrase

  This parameter determines whether the Octel 50 system
automatically repeats the paging phrase when performing a
page.

  When/How to Use  When this parameter is enabled, and a subscriber does not
respond to the paging announcement within the time
specified in Paging Wait Time (Intercom Redirect), the Octel
50 system repeats the announcement.

  Related Parameters/Features  If the subscriber’s mailbox is configured for Automatic
paging on the Subscriber Settings dialog box, the Octel 50
system automatically pages the subscriber when the
extension is not answered. If Repeat Intercom Phrase is
enabled, the Octel 50 system voices the announcement
twice, then prompts the caller to try another extension, leave
a message, retry the page, or disconnect. Note that the
Octel 50 system prompts callers to try the page again only if
Max. Number of Retries in Paging (Intercom Redirect) is set
greater than 0.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch
Dependent

 No

 Set by
Integrator

 No

 
 Intercom Paging Parameters - #89

 Number of
Retries when
Paging is Busy

  This parameter specifies the number of times the Octel 50
system attempts to page when the paging extensions are
busy.
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  When/How to Use  For most Octel 50 systems, the default value is sufficient. If
the Octel 50 system experiences heavy traffic, increase this
value.

  Related Parameters/Features  None.

  If Set Too High  The higher the setting, the more times the Octel 50 system
attempts to send the page.

  If Set Too Low  If the Octel 50 system cannot access the busy paging
system at the first attempt, the page is not voiced.

  Min

 
0

 Max

 
9

 Default

 
3

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Intercom Paging Parameters - #90

 Max. Number of
Retries in Paging
(Intercom
Redirect)

  This parameter specifies the number of times the Octel 50
system allows a caller to retry a page. When the caller
reaches the maximum number of retries, the Octel 50
system prompts the caller to try another extension, leave a
message, or disconnect.

  When/How to Use  When setting this parameter, consider the following:

• If Repeat Intercom Paging Phrase is enabled, the
Octel 50 system voices the paging announcement
twice for each paging attempt before prompting the
caller to try another extension, leave a message,
retry the page, or disconnect. Note that the Octel 50
system prompts callers to try the page again only if
Max. Number of Retries in Paging (Intercom
Redirect) is set greater than 0.

• If the subscriber’s mailbox is enabled for automatic
paging, the Octel 50 system immediately pages the
subscriber when the extension is not answered,
before prompting the caller to try another extension,
leave a message, retry the page (if this parameter is
greater than 0), or disconnect.

Related Parameters/Features The Paging Wait Time (Intercom Redirect) parameter
determines the amount of time the Octel 50 system waits
after paging a subscriber allowing the caller to retry the
page.

If Set Too High The higher the setting, the more times the intercom paging
announcement is voiced.

If Set Too Low Does not affect Octel 50 system performance.

Min

0

Max

9

Default

3

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No
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Intercom Paging Parameters - #91

Paging Wait
Time (Intercom
Redirect)

This parameter specifies the number of seconds the Octel
50 system waits for a subscriber to respond to a page
before prompting the caller try another extension, leave a
message, page the subscriber, or disconnect. Note that the
Octel 50 system prompts callers to try the page again only if
Max. Number of Retries in Paging (Intercom Redirect) is set
greater than 0.

When/How to Use For most Octel 50 systems the default should be sufficient.
However, if you find that many subscribers do not have
enough time to retrieve their pages, increase this
parameter.

Related Parameters/Features This parameter specifies the time between the paging
retries specified in Max. Number of Retries in Paging
(Intercom Redirect) and the time between the paging
phrases for Repeat Intercom Paging Phrase.

If Set Too High Callers may have to wait on hold for an excessive amount of
time before the subscriber answers the page or the Octel 50
system prompts them to try another extension, leave a
message, page the subscriber again (if Max. Number of
Retries in Paging (Intercom Redirect) is set greater than 0),
or disconnect.

If Set Too Low Subscribers do not have adequate time to respond to a
page.

Min

10

Max

99

Default

30

Requires
Restart

No

Switch-
Dependent

No

Set by
Integrator

No

Call Transfer Parameters

The Call Transfer parameters define the general transfer and release code sequences
and dialing standards that enable the voice boards installed in the Octel 50 system to
communicate with the switch.

The minimums and maximums for the codes on this screen refer to the length of the entry
allowed, not an actual number.

Call Transfer Parameters - #92

Transfer Prefix
Code

This parameter defines the code required by the switch to
perform a transfer. The Octel 50 system places this code in
the command string that the voice board uses to signal the
switch to perform a transfer. This code is not used on most
switches.

This code is always placed before the extension in the
command string.

When/How to Use This code is either hard-coded or programmable, depending
on the switch. It is recommended that you do not change
this parameter without speaking to a technical support
representative. If you do choose to modify this parameter,
write down the original code should you need to reenter it.

The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.
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Related Parameters/Features The Octel 50 system only looks for a Transfer Prefix Code if
no Custom Transfer Code is defined.

This parameter is not available when Enable Automated
Attendant is disabled.

If Set Too High Not applicable.

If Set Too Low Not applicable.

Min

0

Max

32

Default

Blank

Requires
Restart

No

Switch-
Dependent

Yes

Set by
Integrator

No

Call Transfer Parameters - #93

Custom Transfer
Code

This parameter defines the series of commands required by
the switch to perform a transfer. The Octel 50 system uses
this code to instruct the switch to attempt a transfer for
switches that require something other than a standard hook
flash.

When/How to Use This parameter is set when the Integrator utility is run, if
required by the switch.

This code is either hard-coded or programmable, depending
on the switch. It is recommended that you do not change
this parameter without speaking to a technical support
representative. If you do choose to modify this parameter,
write down the original code should you need to reenter it.

The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

Custom Transfer Codes can include the following
commands and codes, which signal the switch to perform
specific actions:

& Represents a flash hook

, Represents a pause

− Signals the switch to go on hook

+ Signals the switch to come off hook

D Tells the switch to dial with call progress

H Tells the switch to perform a hard hangup

N Tells the switch to dial without call progress

R Signals the switch to release the call to Octel 50

X Places the extension in the dialing string

C (Followed by a number) Indicates that the
system is to send a special feature code to the
switch. The C is always followed by a number
that defines how many characters are in the
special feature code. For example, if 550 is the
special feature code to activate intercom paging,
a C3 would be entered in the dialing code string
for intercom paging.
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T Tells the switch to use DTMF dialing

M Tells the switch to use MF dialing

P Tells the switch to use Pulse dialing

 Do not use M or P unless required by the switch. Once used,
all calls continue to be dialed using multifrequency or pulse
dialing until you shut down the Octel 50 system.

 Codes within the Custom Transfer Code must be followed
by a D for call progress or an N for no call progress.
Otherwise, the codes are ignored.

 If a release code is required on a busy, no answer, or
connect, an R must follow the D. The R instructs the
switch to get the code to connect or appropriate release
code. If a release code is required for a connect, the code
should immediately follow the in the Custom Transfer Code.
For example, if a switch requires a 1 to be dialed before the
extension to transfer the call as DID with call progress, the
Custom Transfer Code would be &C11XDR.

  Related Parameters/Features  If no Custom Transfer Code is defined, the Octel 50 system
looks for a Transfer Prefix Code. If neither is defined, the
Octel 50 system uses a default that performs a hook flash,
pauses, dials the extension number with call progress, and
then looks for the appropriate release code.

 If the Custom Transfer Code includes an R, the switch looks
for the appropriate release code. Release codes allow the
Octel 50 system to pull calls back from the switch for
routing. There are basic release codes for no answer and
busy and feature-specific release codes for call screening,
call waiting, intercom paging, and message waiting lights. If
no release codes are defined, the Octel 50 system uses an
ampersand.

 If the Custom Transfer Code does not include an R, a flash
hook is used.

 This parameter is not available when Enable Automated
Attendant is disabled.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Call Transfer Parameters - #94

 Number of
Seconds to
Delay before
Transferring

  This parameter defines the number of seconds the Octel 50
system is off hook after receiving a call before it sends the
transfer code to the switch.

  When/How to Use  The default should be adequate for most Octel 50 systems.
However, if you experience call transfer problems, try
increasing this parameter.
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  Related Parameters/Features  This parameter is not available when Enable Automated
Attendant is disabled.

  If Set Too High  Increasing this parameter should not adversely affect the
Octel 50 system. However, the higher you set this
parameter the longer the caller waits to be transferred.

  If Set Too Low  On some switches, a slight delay may be required.

  Min

 
0

 Max

 
9

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Call Transfer Parameters - #95

 Transfer Release
Code when Busy

  This parameter defines the series of commands required for
the Octel 50 system to pull a call back from the switch when
the switch receives a busy on an attempted transfer.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

 This code is either hard-coded or programmable, depending
on the switch. It is recommended that you do not change
this parameter without speaking to a technical support
representative. If you do modify this parameter, write down
the original code should you need to reenter it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

 If no release code is defined, the Octel 50 system uses a
flash hook.

  Related Parameters/Features  This parameter is not available when Enable Automated
Attendant is disabled.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Call Transfer Parameters - #96

 Transfer Release
Code when No
Answer

  This parameter defines the series of commands required for
the Octel 50 system to pull a call back from the switch when
the switch receives no answer on an attempted transfer.
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  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

 This code is either hard-coded or programmable, depending
on the switch. It is recommended that you do not change
this parameter without speaking to a technical support
representative. If you do modify this parameter, write down
the original code should you need to reenter it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

 If no release code is defined, the Octel 50 system uses a
flash hook.

  Related Parameters/Features  This parameter is not available when Enable Automated
Attendant is disabled.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Call Transfer Parameters - #97

 Permit Voice
Mail After a Busy
or No Answer

  This parameter determines if callers can leave a voice mail
message for a subscriber whose extension is busy or
unanswered.

 If you disable this parameter, callers are only able to try
another extension or transfer to the operator when an
extension is busy or unanswered. The Octel 50 will not
voice the option to leave a voice mail message.

  When/How to Use  If you have a live operator, but use the automated attendant
for overflow, disabling this parameter forces callers who
came in through the automated attendant to go to the
operator for routing to voice mail if the extensions they enter
are busy or unanswered.

 You may want to disable this parameter if you do not have a
live receptionist but you want callers to busy or unanswered
extensions to leave messages in a receptionist’s mailbox,
instead of in the subscribers’ mailboxes. The receptionist
can then distribute the messages to the appropriate voice
mailboxes. For this application, enable call blocking to
Default (voice mail) for the receptionist mailboxes.

  Related Parameters/Features  This parameter is only relevant when the Octel 50 system
attempts to transfer a caller and the extension is busy or
unanswered. It does not disable the voice mail feature as a
whole. Callers can still be blocked or manually transferred to
voice mail.

 This parameter is not available when Enable Automated
Attendant is disabled.

  If Set Too High  Not applicable.
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  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Call Transfer Parameters - #98

 Flash Time
Interval
(FLINTVL)

  This parameter defines the length of time, in 10 millisecond
units, that the hookswitch must be depressed for the switch
to recognize it as a flash hook.

  When/How to Use  If the switch requires a specific flash time interval, it is
automatically entered for you the Integrator utility is run.

 If this parameter is blank, the Octel 50 system default of 50
(half a second) is used. This default should be sufficient for
most switches.

  Related Parameters/Features  This parameter determines the length of the flash hook for
any codes that include an ampersand, such as release
codes.

  If Set Too High  The phone system may misinterpret the flash hook as a
hangup.

  If Set Too Low  The phone system may not recognize the flash hook.

  Min

 
0

 Max

 
30000

 Default

 
50

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Call Transfer Parameters - #99

 Pause Interval for
Comma in Dial
String (PAINTVL)

  This parameter defines the duration of the pause, in 10
milliseconds units, represented by a comma in a dialing
string. When a comma displays in a dialing string, the
voice board waits the value of PAINTVL before sending the
next character in the dialing string.

  When/How to Use  This parameter is set when the Integrator utility is run

 If this parameter is blank, the Octel 50 system default of
200 (two seconds) is used. This default should be sufficient
for most switches.

  Related Parameters/Features  This parameter determines the length of the pause for any
codes that include a comma, such as release codes.

  If Set Too High  Setting this parameter higher should not adversely affect
Octel 50 system operation.

  If Set Too Low  The switch may not recognize the pause.

  Min

 
0

 Max

 
30000

 Default

 
200

 Requires
Restart

 Yes

 Switch
Dependent

 No

 Set by
Integrator

 Yes

 



Setting Up the System   Configuring System Setup Parameters

Octel 50 Installation Guide 8-54

 Call Transfer Parameters - #100

 Inter-Digit Delay
Time (TONEDLY)

  This parameter defines the delay, in 10 millisecond units,
between characters such as digits and commas in a dialing
string necessary for the switch to recognize them. This
parameter only applies to transfers or outcalls.

  When/How to Use  If this parameter is blank, the Octel 50 system default of 5 is
used. This default should be sufficient for most switches.

  Related Parameters/Features  Not applicable.

  If Set Too High  The switch may fail to recognize DTMF.

  If Set Too Low  The switch may not recognize the pause.

  Min

 
0

 Max

 
30000

 Default

 
5

 Requires
Restart

 Yes

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Call Transfer Parameters - #101

 Duration Time of
Valid DTMF
(TONELEN)

  This parameter defines the minimum duration, in 10
millisecond units, of DTMF digits for them to be recognized
by the switch. This parameter only applies to transfer and
outcalls.

   The TONELEN required for the switch is automatically
entered when the Integrator utility is run.

  Related Parameters/Features  Not applicable.

  If Set Too High  Setting this parameter higher should not adversely affect
Octel 50 system operation.

  If Set Too Low  The switch may not recognize the digits.

  Min

 
0

 Max

 
30000

 Default

 
10

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Call Transfer Parameters - #102

 Enable Call
Progress
(CALLPROG)

  This parameter specifies whether the system should dial the
number without listening for a busy/no answer/connect
signal.

   If this parameter is enabled, the system places all outgoing
calls and transfers to a number or extension and listens for
a busy/no answer/connect signal. If this parameter is
disabled, the system does not listen for these signals, and
performs a blind transfer on all calls. A blind transfer may be
appropriate when calls are being transferred to another
application, such as Automatic Call Distribution (ACD),
instead of an extension.

  Related Parameters/Features  If Enable Call Progress (CALLPROG) is disabled, the Inform
Subscriber Transfer is from Attendant and Start Delay for
Call Progress (STARTDLY) parameters are not used and
call queuing is not available.



Setting Up the System   Configuring System Setup Parameters

Octel 50 Installation Guide 8-55

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Call Transfer Parameters - #103

 Start Delay for
Call Progress
(STARTDLY)

  This parameter specifies the amount of delay time, in 10
millisecond units, after the system dials a phone number
before starting Call Progress.

   Use this parameter to determine how long the system waits,
after dialing a phone number, before starting Call Progress.

  Related Parameters/Features  If Enable Call Progress (CALLPROG) is disabled, this
parameter is not used.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
30000

 Default

 
10

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 Call Screening Parameters

 The Call Screening parameters define the call screening release codes for the switch.
These release codes enable the Octel 50 system to either pull the call back from the
switch after a no answer, a busy, or a reject, or to release the call to the switch on an
accept for call screening.

 If the switch uses call screening release codes, they are automatically entered for you
when the Integrator utility is run for the switch. Do not modify the release codes unless
instructed to do so by a technical support representative. If the release codes are not
defined, the Octel 50 system uses an ampersand.

 Call screening is only available on Octel 50 systems using supervised transfers. Call
screening must be enabled on the Class of Service and Subscriber Settings dialog boxes
for subscribers to have access to the feature.

 If you disable the Enable Automated Attendant parameter under General Parameters in
System Setup, call screening is not available on the Octel 50 system.

 
 Call Screening Parameters - #104

 Release Code
When Busy

  This parameter defines the release code required to pull the
call back from the switch when a busy response is received
at the subscriber’s extension for a call screening attempt.

 Once the Octel 50 system retrieves the call, it informs the
caller that the line is busy and voices the available options.
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  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch. You should not need to modify this
parameter once it is set by Integrator.

 This release code is hard-coded for some switches and
programmable on others. If you choose to modify this
parameter, it is recommended that you write down the
original code should you need to reenter it.

 If no release code is defined, the Octel 50 system uses an
ampersand.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Call Screening Parameters - #105

 Release Code
When No Answer

  This parameter defines the release code required to pull the
call back from the switch when no answer is received at the
subscriber’s extension for a call screening attempt.

 Once the Octel 50 system retrieves the call, it informs the
caller that there was no answer and voices the available
options.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch. You should not need to modify this
parameter once it is set by Integrator.

 This release code is hard-coded for some switches and
programmable on others. If you choose to modify this
parameter, it is recommended that you write down the
original code should you need to reenter it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes
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 Call Screening Parameters - #106

 Release Code
When Reject

  This parameter defines the release code required to pull the
call back from the switch when the subscriber rejects the
call during a call screening attempt.

 Once the Octel 50 system retrieves the call, it informs the
caller that there was no answer and voices the available
options.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch. You should not need to modify this
parameter once it is set by Integrator.

 This release code is hard-coded for some switches and
programmable on others. If you choose to modify this
parameter, it is recommended that you write down the
original code should you need to reenter it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Call Screening Parameters - #107

 Release Code
When Transfer

  This parameter defines the code required to release the call
to the switch when a subscriber redirects a call screening
request.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch. You should not need to modify this
parameter once it is set by Integrator.

 This release code is hard-coded for some switches and
programmable on others. If you choose to modify this
parameter, it is recommended that you write down the
original code should you need to reenter it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes
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 Call Waiting Parameters

 The Call Waiting parameters determine how the Octel 50 system dispatches call waiting
attempts. Call waiting notifies the subscriber of another incoming call when the subscriber
is on the line by sounding a tone over the subscriber’s handset or intercom. Call waiting is
a system-wide feature and cannot be activated or deactivated for individual mailboxes.
When Enable Automated Attendant is disabled, Call Waiting is not available.

 
 Call Waiting Parameters - #108

 Call Waiting
Code

  This parameter determines the code the Octel 50 system
dials to instruct the switch to activate call waiting.

  When/How to Use  The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The Octel 50 system dials the Transfer Prefix or the Custom
Transfer Code, if defined, to transfer the call to the desired
extension. If the extension is busy, the Octel 50 system
places the call on hold, then dials the Call Waiting Code to
activate the call waiting feature.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Call Waiting Parameters - #109

 Number of
Attempts for Call
Waiting

  This parameter specifies the number of times the Octel 50
system attempts to notify a subscriber of an incoming call
before returning to the call with a busy or no answer
condition.

  When/How to Use  Set this parameter to a value greater than 0 if you want to
use Call Waiting.

  Related Parameters/Features  None.

  If Set Too High  The Octel 50 system ports activating call waiting are tied up
for Call Waiting instead of calls.

  If Set Too Low  Not applicable; the default value is the minimum allowed for
this parameter. Set this parameter to 0 to disable call
waiting.

  Min

 
0

 Max

 
9

 Default

 
3

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Call Waiting Parameters - #110

 Release Code for
Call Waiting

  This parameter determines the code the Octel 50 system
dials to retrieve the call from hold after the call waiting is
activated.
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  When/How to Use  The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The Octel 50 system dials the Release Code for Call
Waiting after the Call Waiting Code to take control of the
call.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 Dialing Parameters

 The Dialing parameters define the standards that allow the Octel 50 system to perform
outcalls through the switch. Octel 50 system features that require outbound dialing are
message delivery, AMIS, message waiting lights, and wake-up calls.

 Dialing Parameters - #111

 Use Dial Plan
Database

  This parameter determines whether the Dial Plan utility is
used to determine the correct dialing sequence for the
following outcall operations:

• Administered AMIS

• Network replies

• Delivery of Fax Retrieval requests

  When/How to Use  Dial Plan compares destination phone numbers to the Dial
Plan database to determine whether the numbers are local.
If a match is found, the last seven digits, but not the area
code, are dialed. If the numbers do not match identified
local prefixes, the entire number is dialed.

 For network replies to long distance numbers within the
country, Dial Plan also determines whether the Long
Distance Access Code is inserted in the dialing string.

 If you enable this parameter, you must configure the Dial
Plan utility.

  Related Parameters/Features  Dial Plan is only used when the length of the destination
number is equal to or greater than the Number of Digits in
Local Telephone Number.

 Make sure that you enter the Long Distance Access Code to
ensure that network replies are dialed properly.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Dialing Parameters - #112

 Code for
Accessing an
Outside Line

  This parameter defines the code required by the switch to
access an outside line. This code is used by the Octel 50
system to obtain an outside line for outbound dialing
operations (message delivery, message waiting lights, and
wake-up calls) when the length of the destination phone
number equals or exceeds the Number of Digits in Local
Telephone Number. The Octel 50 system also uses this
code for AMIS network messaging when no AMIS Prefix or
Prefix Code is defined, regardless of the length of the
destination phone number.

 ‘  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

 This code consists of the number you normally press to dial
an outside line on the phone system, usually followed by a
comma to instruct the switch to wait momentarily before
dialing the number.

 For most phone systems, the default 9, is used.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  If the Code for Accessing an Outside Line is not properly
defined, the Octel 50 system will not be able to execute
outcalls.

 The AMIS Prefix or Prefix Code parameters override the
Code for Accessing an Outside Line for AMIS outcalls.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
9,

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Dialing Parameters - #113

 Number of Digits
in Local
Telephone
Number

  This parameter defines the number of digits in telephone
numbers in the local dialing area.

 When/How to Use  In the United States and Canada, the default of 7 is normally
used. However, in other countries, the number of digits may
be different.
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  Related Parameters/Features  Dial Plan is only used when the destination number exceeds
the Number of Digits in Local Telephone Number.

 The Octel 50 system only uses the Code for Accessing an
Outside Line for numbers that are equal to or greater than
the length of Number of Digits in Local Telephone Number.

 The Custom Message Delivery Code is used for message
and fax delivery when the length of the destination number
is less than the Number of Digits in Local Telephone
Number.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
9

 Default

 
7

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Dialing Parameters - #114

 Number of Rings
Before No
Answer (RINGS)

  This parameter defines the number of rings the Octel 50
system will listen to before assuming a no answer. This
parameter is only used for outdial operations.

  When/How to Use  The default should be adequate for most Octel 50 systems.
However, if you find that the switch is routinely pulling calls
back, try lowering this parameter.

  Related Parameters/Features  This parameter is only used if the Octel 50 system is
supervising calls.

 The Maximum Rings field on the Class of Service dialog
box, which controls the number of rings that are considered
a no answer for both outcalls and internal transfers, can
override this parameter on a class of service basis.

 Do not confuse this parameter with the Number of Incoming
Rings (INRINGS). The Number of Incoming Rings
(INRINGS) determines the number of rings each port must
hear before it answers an inbound call.

  If Set Too High  If you set this parameter higher than the number of rings the
switch regards as a no answer, the call might go back to the
switch.

  If Set Too Low  Call progress may fail.

  Min

 
0

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Message Delivery Parameters

 The Message Delivery parameters determine how the Octel 50 system dispatches
message delivery attempts and delivers faxes to fax machines on internal extensions.

 
 Message Delivery Parameters - #115

 Custom Message
Delivery Code

  This parameter specifies the series of digits the Octel 50
system must dial for message and fax delivery to internal
phone and fax numbers, respectively.

  When/How to Use  This parameter is set by Integrator, if required by the switch.

 The Octel 50 system inserts the Custom Message Delivery
Code, when defined, in the dialing string before the phone
number for message delivery or the fax destination phone
number.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  If the phone number for message delivery is equal to or
greater than the Number of Digits in Local Phone Number,
the Code for Accessing an Outside Line is used instead of
the Custom Message Delivery Code.

 If the destination fax phone number is equal to or greater
than the Number of Digits in Local Phone Number, the Fax
Prefix Code is used instead of the Custom Message
Delivery Code.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Message Delivery Parameters - #116

 Number of
Seconds to Wait
before Message
Delivery

  This parameter defines the number of seconds the Octel 50
system waits to voice the Message Delivery prompt after a
subscriber answers the phone.

  When/How to Use  For most Octel 50 systems, the default value should be
sufficient. However, some switches require a few seconds to
establish a voice path after an extension goes off hook. Set
this parameter to a higher value if the Message Delivery
prompt is not always voiced completely.

  Related Parameters/Features  None.

  If Set Too High  Subscribers hear a long silence and may hang up before
the Message Delivery prompt is voiced.

  If Set Too Low  Subscribers do not hear the entire Message Delivery
prompt.
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  Min

 
0

 Max

 
9

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Message Delivery Parameters - #117

 Dial Tone
Timeout During
Message
Delivery
(DTONWAIT)

  This parameter specifies the amount of continuous energy,
in 10 millisecond units, that the Octel 50 must detect from
the switch before recognizing it as dial tone. This parameter
helps to ensure that the Octel 50 system allows the switch
enough time to stabilize dial tone after completion of a call
before initiating an event.

 This parameter only applies when the Octel 50 system goes
off hook to initiate an outbound message delivery or fax
event. The count for DTONWAIT starts as soon as a voice
port goes off hook.

 If the Octel 50 system does not detect dial tone for the
specified time, the Octel 50 system assumes the port is
receiving an incoming call and attempts to answer.

  When/How to Use  This parameter is set when the Integrator utility is run.

 For most Octel 50 systems, the default value should be
sufficient to allow the switch to reset the port after a call
before the next event.

 If you modify this parameter, make sure that it is less than
the value of DTONDET.

  Related Parameters/Features  DTONDET must be set at least 4 seconds higher than
DTONWAIT. For example, if you set DTONWAIT to 300, set
DTONDET to at least 700.

  If Set Too High  Switches send dial tone for a specified time before they time
out and stop sending it. If DTONWAIT is set too high, the
switch timeout is exceeded and DTONWAIT is never
completed. Consequently, the outbound event is never
initiated.

  If Set Too Low  If DTONWAIT is set too low, and the switch does not send
constant, stable dial tone immediately, the Octel 50 system
attempts to answer the port, and the outbound event is
never initiated.

  Min

 
0

 Max

 
30000

 Default

 
200

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes
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 Message Waiting Light Parameters

 The Message Waiting Light parameters specify how the Octel 50 system activates and
deactivates message waiting lights for the switch. All the Message Waiting Light
parameters are set when the Integrator utility is run.

 
 Message Waiting Light Parameters - #118

 Permit Message
Waiting Lights

  This parameter enables and disables the Message Waiting
Light feature for the Octel 50 system.

  When/How to Use  This parameter is set when the Integrator utility is run, if
your switch supports the Message Waiting Light feature.

  Related Parameters/Features  If this parameter is turned off, the other Message Waiting
Light parameters are not available.

 Message Waiting Lights must be enabled in the subscriber’s
class of service.

 If Use Communications Message Waiting Light Software
(COMMMWL) is enabled, the Permit Message Waiting
Lights parameter must be on.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Message Waiting Light Parameters - #119

 Message Waiting
Light Prefix ON
Code

  This parameter specifies the code the Octel 50 system must
insert at the beginning of the dialing string to turn a
message waiting light on.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

  Related Parameters/Features  Some switches require both a prefix code and a suffix code.
When Integrator is run, the Octel 50 system sets both of
these parameters, if required.

 If Use Communications Message Waiting Light Software
(COMMMWL) is enabled, the Message Waiting Light Prefix
ON Code must be left blank.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.
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  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Message Waiting Light Parameters - #120

 Message Waiting
Light Prefix OFF
Code

  This parameter specifies the code the Octel 50 system must
insert before dialing the extension to turn the Message
Waiting Light off.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

  Related Parameters/Features  Some switches require both a prefix code and a suffix code.
When Integrator is run, the Octel 50 system sets both these
parameters, if required.

 If Use Communications Message Waiting Light Software
(COMMMWL) is enabled, the Message Waiting Light Prefix
OFF Code must be left blank.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Message Waiting Light Parameters - #121

 Message Waiting
Light Suffix ON
Code

  This parameter specifies the code the Octel 50 system must
insert after the extension number is dialed to turn the
Message Waiting Light on.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

  Related Parameters/Features  Some switches require both a prefix code and a suffix code.
When Integrator is run, the Octel 50 system sets both
parameters, if required.

 If Use Communications Message Waiting Light Software
(COMMMWL) is enabled, the Message Waiting Light Suffix
ON Code must be left blank.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.
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  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Message Waiting Light Parameters - #122

 Message Waiting
Light Suffix OFF
Code

  This parameter specifies the code the Octel 50 system must
insert at the end of the dialing string to turn the Message
Waiting Light off.

  When/How to Use  This parameter is set when the Integrator utility is run, if
required by the switch.

  Related Parameters/Features  Some switches require both a prefix code and a suffix code.
When Integrator is run, the Octel 50 system sets both
parameters, if required.

 If Use Communications Message Waiting Light Software is
enabled, the Message Waiting Light Suffix OFF Code must
be left blank.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual value.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
15

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Message Waiting Light Parameters - #123

 Message Waiting
Light Supervised

  This parameter determines whether the Octel 50 system
performs call progress for message waiting light requests to
the switch.

  When/How to Use  This parameter is set when the Integrator utility is run. Some
switches require the Octel 50 system to wait for a
confirmation tone to indicate the switch accepted the
message waiting light event before returning to the call.

 This parameter should also be enabled for switches that do
not allow message waiting lights to be activated on busy
extensions.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes
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 Message Waiting Light Parameters - #124

 Light Message
Waiting Light for
Every Message

  This parameter determines whether the Octel 50 system
sends a message waiting light request every time a
message is received.

  When/How to Use  This parameter is set when the Integrator is run for switches
that do not reliably schedule message waiting lights. Do not
change the setting of this parameter unless instructed to by
a technical support representative.

 The Octel 50 system synchronizes message waiting light
events by sending one message waiting light activation
code to a port, then one message waiting light deactivation
code when the messages are retrieved by the subscriber. If
this parameter is enabled, message waiting light
synchronization is disrupted when a port has several
message waiting light activation codes for a mailbox, and
receives only one message waiting light deactivation code.
When this occurs, the remaining message waiting light stay
active, even though there are no more new messages, until
the port is manually reset.

 Some switches limit the number of message indications per
phone. In this case, do not enable this parameter.

  Related Parameters/Features  If this parameter is enabled, outbound ports that activate
and deactivate message waiting lights are tied up until the
port is manually reset.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Message Waiting Light Parameters - #125

 Message Waiting
Light Dials
Number On Hook

  This parameter determines whether the phone system
remains on hook when the Octel 50 system sends the string
for message waiting light events.

  When/How to Use  This parameter is set when the Integrator utility is run for
Octel 50 systems using some SL-1 integrations. Do not
adjust this parameter unless instructed to by a technical
support representative.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes
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 Uninterruptable Power Supply Parameters

 The Uninterruptable Power Supply parameters specify whether UPS integration is
enabled for the Octel 50 system and specifies the COM port to which the UPS is
connected.

 Uninterruptable Power Supply Parameters - #126

 Enable UPS
Integration

  This parameter determines whether the Octel 50 system
can integrate with the UPS connected to the Octel 50 PC.

  When/How to Use  If the Octel 50 system is integrated with the UPS, the Octel
50 system monitors the UPS status. If the power is
interrupted and the UPS battery is low, Octel 50 performs an
automatic shut down to prevent file corruption until the
power is restored.

  Related Parameters/Features  The UPS COM Port parameter specifies the COM port to
which the UPS is connected, if this parameter is enabled.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Uninterruptable Power Supply Parameters - #127

 UPS COM Port   This parameter specifies the COM port to which the UPS is
connected.

  When/How to Use  Use this parameter when the Enable UPS Integration
parameter is enabled. Leave this parameter at the default,
0, if UPS integration is not supported.

  Related Parameters/Features  The Enable UPS Integration parameter determines whether
UPS integration is supported on the Octel 50 system.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
4

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 Inband Signaling Parameters

 The Inband Signaling parameters configure the Octel 50 system to properly receive and
interpret the inband information sent from the switch.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.
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 Inband Signaling Parameters - #128

 Total Number of
DID Digits
(DIDCOUNT)

  This parameter defines the maximum number of digits the
Octel 50 system expects the switch to send in an inband
string. If the switch sends more digits than the maximum
defined in DIDCOUNT, the Octel 50 system does not see
the additional digits.

  When/How to Use  If you are using inband, this parameter must be defined.
This parameter is set when the Integrator utility is run. You
should not need to change it.

 When using DID strings of varying length, set this parameter
equal to or higher than the length of the longest string.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  If the incoming string is less than the Total Number of DID
Digits, the DID Terminating Character determines the end of
the string. If the DID Terminating Character parameter is
blank, the Number of Milliseconds to Wait for Digits
determines when the Octel 50 system considers the string
complete.

 This parameter enables Inband for the Octel 50 system. If
this field is set to 0, the remaining Inband parameters are
not available.

  If Set Too High  Setting this parameter higher should not adversely affect
Octel 50 system operation, although you should not modify
it without talking to a technical support representative.

  If Set Too Low  The Octel 50 system may not catch the whole string, and
integration may fail.

  Min

 
0

 Max

 
32

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Signaling Parameters - #129

 DID Terminating
Character
(DIDTERM)

  This parameter defines the character that the switch sends
to signify the end of an inband string. The most common
terminating character is a #.

  When/How to Use  The Octel 50 system automatically enters this character for
you when the Integrator utility is run. You should not need to
change it. Use this parameter when the Octel 50 system
uses variable-length DID strings.

 If the switch uses the # sign as separators in strings, you
cannot use # for DIDTERM. In this case, insert a tilde (~) for
the terminating character instead. The tilde represents a
space.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.
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  Related Parameters/Features  If the Total Number of DID Digits is set to 0, this parameter
is not used.

 If the DID Terminating Character is blank, the Number of
Milliseconds to Wait for Digits parameter determines when
the Octel 50 system considers the inband string complete.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
#

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Signaling Parameters - #130

 Seconds to Wait
for DID
(DIDTIME)

  This parameter defines the number of seconds the Octel 50
system waits for the first inband digit from the switch before
timing out. When a string times out, the Octel 50 system
ignores it.

 The most common cause of a string timing out is an invalid
mailbox number.

  When/How to Use  The Octel 50 system automatically sets this parameter when
the  Integrator utility is run. You should not need to change
it. However, if the Octel 50 system regularly misses inband
digits, try increasing this parameter.

 Some switches require the use of a sender to pass digits to
the Octel 50 system. Under light traffic, the sender is readily
available. However, when the switch is busy, the delay
before sending digits may exceed the value of this
parameter and cause it to time out before the digits are
sent.

  Related Parameters/Features  If the Total Number of DID Digits is set to 0, this parameter
is not used.

  If Set Too High  Setting this parameter higher may cause initial callers into
the system to hear silence before the main greeting is
voiced. Do not modify this parameter without talking to a
technical support representative.

  If Set Too Low  The Octel 50 system may regularly miss one or more inband
digits at the end of the inband string.

  Min

 
0

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Signaling Parameters - #131

 Location of
Inband Signaling
Code

  This parameter specifies which digit in an incoming inband
signaling string is the first digit of the inband signaling code.

  When/How to Use  Enter -1 to have the system search the entire string for the
specified code.
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  Related Parameters/Features  If the Total Number of DID Digits is set to 0, this parameter
is not used.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
-1

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Signaling Parameters - #132

 Number of
Milliseconds to
Wait for Digits

  This parameter defines the delay, in millisecond units,
between inband signaling tones sent from the switch. If the
Octel 50 system does not detect another tone within this
time, it processes the string. Each time the Octel 50 system
detects another tone, it resets the count for this parameter.

  When/How to Use  This parameter is set when the Integrator utility is run. You
should not need to change it.

  Related Parameters/Features  If the Total Number of DID Digits is set to 0, this parameter
is not used.

 If no DID Terminating Character is defined, this parameter
determines when the Octel 50 system considers the string
to be complete.

  If Set Too High  Setting this parameter higher may cause initial callers into
the system to hear silence before the main greeting is
voiced. Do not modify this parameter without talking to a
technical support representative.

  If Set Too Low  The Octel 50 system may not receive the entire string.

  Min

 
0

 Max

 
9999

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 Inband Code for Go to Voice Mail

 The Inband Code for Go to Voice Mail parameters configure the Octel 50 system to
transfer callers to subscriber mailboxes.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code for Go to Voice Mail Parameters - #133

 Inband Code
String

  This parameter specifies the code sent by the switch that
instructs the Octel 50 system to transfer the call directly to
the mailbox that follows the code.
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  When/How to Use  When this code is used, the caller hears the Personal
Greeting prompt.

 The Octel 50 system automatically sets this parameter when
the  Integrator utility is run. You should not need to change
it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The Location of Inband Signaling Code parameter specifies
where this code is located in an incoming inband string.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Code for Go to Voice Mail Parameters - #134

 Location of
Mailbox Number

  This parameter specifies which digit in the string for Go to
Voice Mail is the first digit in the mailbox number that follows
the code.

  When/How to Use  The setting of this parameter depends on whether the count
starts from the beginning or the end of the string.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
1

 Max

 
99

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Go to Voice Mail Parameters - #135

 Start at End of
String

  This parameter specifies whether the system starts at the
end of the inband signaling string for Go to Voice Mail when
counting digits to locate the start of the mailbox number.

  When/How to Use  Enable this parameter if variable-length strings are used.
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  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Go to Voice Mail Parameters - #136

 Total Length of
String

  This parameter specifies the number of characters and
digits in the Code for Go to Voice Mail string.

  When/How to Use  Calculate the Total Length of String by counting the number
of characters and digits that are sent in the Code for Go to
Voice Mail string. For example, if the code is $ and the
mailbox number is 1000, the string is $1000. In this case,
the Total Length of String is 5.

 If this parameter is set to 0, the system does not test the
string length.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The length of the Inband Code String and the Number of
Digits in a Mailbox parameters determine the setting of the
Total Length of String parameter.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No
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 Inband Code for Go to Immediate Record

 The Inband Code for Go to Immediate Record parameters configure the Octel 50 system
to place callers directly at the record beep for a subscriber mailbox.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code for Go to Immediate Record Parameters - #137

 Inband Code
String

  This parameter specifies the code sent by the switch that
instructs the Octel 50 system to transfer the call directly to
the mailbox that follows the code.

  When/How to Use  When this code is used, the caller can then begin recording
after the beep without hearing the mailbox greeting.

 The Octel 50 system automatically sets this parameter when
the  Integrator utility is run. You should not need to change
it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The Location of Inband Signaling Code parameter specifies
where this code is located in an incoming inband string.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Code for Go to Immediate Record Parameters - #138

 Location of
Mailbox Number

  This parameter specifies which digit in the string for Go to
Immediate Record is the first digit in the mailbox number
that follows the code.

  When/How to Use  The setting of this parameter depends on whether the count
starts from the beginning or the end of the string.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.
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  Min

 
1

 Max

 
99

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Go to Immediate Record Parameters - #139

 Start at End of
String

  This parameter specifies whether the system starts at the
end of the inband signaling string for Go to Immediate
Record when counting digits to locate the start of the
mailbox number.

  When/How to Use  Enable this parameter if variable-length strings are used.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Go to Immediate Record Parameters - #140

 Total Length of
String

  This parameter specifies the number of characters and
digits in the Code for Go to Immediate Record string.

  When/How to Use  Calculate the Total Length of String by counting the number
of characters and digits that are sent in the Code for Go to
Immediate Record string. For example, if the code is $ and
the mailbox number is 1000, the string is $1000. In this
case, the Total Length of String is 5.

 If this parameter is set to 0, the system does not test the
string length.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The length of the Inband Code String and the Number of
Digits in a Mailbox parameters determine the setting of the
Total Length of String parameter.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No
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 Inband Code for Go to Immediate Transfer to Extension

 The Inband Code for Go to Immediate Transfer to Extension parameters configure the
Octel 50 system to transfer callers to subscriber extensions.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code for Go to Immediate Transfer to Extension Parameters - #141

 Inband Code
String

  This parameter specifies the code sent by the switch that
instructs the Octel 50 system to transfer the call directly to
the mailbox that follows the code.

  When/How to Use  When this code is used, the caller hears, “Please hold for
<mailbox owner’s name prompt>.”

 The Octel 50 system automatically sets this parameter when
the  Integrator utility is run. You should not need to change
it.

  Related Parameters/Features  The Location of Inband Signaling Code parameter specifies
where this code is located in an incoming inband string.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Code for Go to Immediate Transfer to Extension Parameters - #142

 Location of
Mailbox Number

  This parameter specifies which digit in the string for Go to
Immediate Transfer to Extension is the first digit in the
mailbox number that follows the code.

  When/How to Use  The setting of this parameter depends on whether the count
starts from the beginning or the end of the string.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.
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  Min

 
1

 Max

 
99

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Go to Immediate Transfer to Extension Parameters - #143

 Start at End of
String

  This parameter specifies whether the system starts at the
end of the inband signaling string for Go to Immediate
Transfer to Extension when counting digits to locate the
start of the mailbox number.

  When/How to Use  Enable this parameter if variable-length strings are used.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Go to Immediate Transfer to Extension Parameters - #144

 Total Length of
String

  This parameter specifies the number of characters and
digits in the Code for Go to Immediate Transfer to Extension
string.

  When/How to Use  Calculate the Total Length of String by counting the number
of characters and digits that are sent in the Code for Go to
Immediate Transfer to Extension string. For example, if the
code is $ and the mailbox number is 1000, the string is
$1000. In this case, the Total Length of String is 5.

 If this parameter is set to 0, the system does not test the
string length.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The length of the Inband Code String and the Number of
Digits in a Mailbox parameters determine the setting of the
Total Length of String parameter.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No
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 Inband Code for Go to Immediate Subscriber Login to Mailbox

 The Inband Code for Go to Immediate Subscriber Login to Mailbox parameters configure
the Octel 50 system to place subscribers dialing the voice mail pilot number, from their
extension, in their mailbox.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code for Go to Immediate Subscriber Login to Mailbox Parameters -
#145

 Inband Code
String

  This parameter specifies the code sent by the switch that
instructs the Octel 50 system to transfer the call directly to
the mailbox that follows the code.

  When/How to Use  When this code is used and Require Password for Auto
Station Login is disabled, the subscriber hears, “Please
enter your password.”  If Require Password for Auto Station
Login is enabled, the subscriber hears, “You have
<number> new messages.”

 The Octel 50 system automatically sets this parameter when
the Integrator utility is run. You should not need to change it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The Location of Inband Signaling Code parameter specifies
where this code is located in an incoming inband string.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Code for Go to Immediate Subscriber Login to Mailbox Parameters -
#146

 Location of
Mailbox Number

  This parameter specifies which digit in the string for Go to
Immediate Subscriber Login to Mailbox is the first digit in the
mailbox number that follows the code.

  When/How to Use  The setting of this parameter depends on whether the count
starts from the beginning or the end of the string.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.
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  If Set Too Low  Not applicable.

  Min

 
1

 Max

 
99

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Go to Immediate Subscriber Login to Mailbox Parameters -
#147

 Start at End of
String

  This parameter specifies whether the system starts at the
end of the inband signaling string for Go to Immediate
Subscriber Login to Mailbox when counting digits to locate
the start of the mailbox number.

  When/How to Use  Enable this parameter if variable-length strings are used.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Go to Immediate Subscriber Login to Mailbox Parameters -
#148

 Total Length of
String

  This parameter specifies the number of characters and
digits in the Code for Go to Immediate Subscriber Login to
Mailbox string.

  When/How to Use  Calculate the Total Length of String by counting the number
of characters and digits that are sent in the Code for Go to
Immediate Subscriber Login to Mailbox string. For example,
if the code is $ and the mailbox number is 1000, the string is
$1000. In this case, the Total Length of String is 5.

 If this parameter is set to 0, the system does not test the
string length.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The length of the Inband Code String and the Number of
Digits in a Mailbox parameters determine the setting of the
Total Length of String parameter.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.
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  Min

 
0

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Inband Code for Go to Immediate Subscriber Login to Mailbox Parameters -
#149

 Require
Password for
Automatic
Station Login

  This parameter determines whether subscribers calling from
their own extensions must enter their passwords to gain
access to their mailboxes. This feature is only available on
integrated systems.

  When/How to Use  Enable this parameter if you want callers to be able to
immediately gain access to their mailboxes when they dial
the voice mail system pilot number from their extensions.

  Related Parameters/Features  The Inband Code String for Immediate Subscriber Login to
Mailbox determines the code that is required for subscribers
to gain immediate access to their mailboxes.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 Inband Code for Busy Extension

 The Inband Code for Busy Extension parameters configure the Octel 50 system to
properly receive and interpret the inband information sent from the switch for a busy
extension.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code for Busy Extension - #150

 Inband Code
String

  This parameter specifies the code sent by the switch that
instructs the Octel 50 system to instruct the system that the
requested extension is busy.

  When/How to Use  When this code is used, the system routes the call
according to the mailbox’s call handling settings.

 The Octel 50 system automatically sets this parameter when
the  Integrator utility is run. You should not need to change
it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The Location of Inband Signaling Code parameter specifies
where this code is located in an incoming inband string.
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  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Code for Busy Extension - #151

 Location of
Mailbox Number

  This parameter specifies which digit in the string for Busy
Extension is the first digit in the mailbox number that follows
the code.

  When/How to Use  The setting of this parameter depends on whether the count
starts from the beginning or the end of the string.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
1

 Max

 
99

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for Busy Extension - #152

 Start at End of
String

  This parameter specifies whether the system starts at the
end of the inband signaling string for Busy Extension when
counting digits to locate the start of the mailbox number.

  When/How to Use  Enable this parameter if variable-length strings are used.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Inband Code for Busy Extension - #153

 Total Length of
String

  This parameter specifies the number of characters and
digits in the Code for Busy Extension string.

  When/How to Use  Calculate the Total Length of String by counting the number
of characters and digits that are sent in the Code for Busy
Extension string. For example, if the code is $ and the
mailbox number is 1000, the string is $1000. In this case,
the Total Length of String is 5.

 If this parameter is set to 0, the system does not test the
string length.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The length of the Inband Code String and the Number of
Digits in a Mailbox parameters determine the setting of the
Total Length of String parameter.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 Inband Code for No Answer Extension

 The Inband Code for No Answer Extension parameters configure the Octel 50 system to
properly receive and interpret the inband information sent from the switch for extensions
that are not answered.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code for No Answer Extension - #154

 Inband Code
String

  This parameter specifies the code sent by the switch that
instructs the Octel 50 system to instruct the system that the
requested extension is not answered.

  When/How to Use  When this code is used, the system routes the call
according to the mailbox’s call handling settings.

 The Octel 50 system automatically sets this parameter when
the  Integrator utility is run. You should not need to change
it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The Location of Inband Signaling Code parameter specifies
where this code is located in an incoming inband string.

  If Set Too High  Not applicable.
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  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Code for No Answer Extension - #155

 Location of
Mailbox Number

  This parameter specifies which digit in the string for No
Answer Extension is the first digit in the mailbox number that
follows the code.

  When/How to Use  The setting of this parameter depends on whether the count
starts from the beginning or the end of the string.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
1

 Max

 
99

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code for No Answer Extension - #156

 Start at End of
String

  This parameter specifies whether the system starts at the
end of the inband signaling string for No Answer Extension
when counting digits to locate the start of the mailbox
number.

  When/How to Use  Enable this parameter if variable-length strings are used.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Inband Code for No Answer Extension - #157

 Total Length of
String

  This parameter specifies the number of characters and
digits in the Code for No Answer Extension string.

  When/How to Use  Calculate the Total Length of String by counting the number
of characters and digits that are sent in the Code for No
Answer Extension string. For example, if the code is $ and
the mailbox number is 1000, the string is $1000. In this
case, the Total Length of String is 5.

 If this parameter is set to 0, the system does not test the
string length.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The length of the Inband Code String and the Number of
Digits in a Mailbox parameters determine the setting of the
Total Length of String parameter.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 Inband Code for Go to Voice Mail and Get Mailbox

 The Inband Code for Go to Voice Mail and Get Mailbox parameters configure the Octel 50
system to transfer callers to voice mail to request the mailbox number.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code for Go to Voice Mail and Get Mailbox - #158

 Inband Code
String

  This parameter specifies the code sent by the switch that
instructs the Octel 50 system to transfer a caller to voice
mail to retrieve the mailbox number.

  When/How to Use  When this code is used, the caller hears, “Please enter the
destination mailbox number.”

 The Octel 50 system automatically sets this parameter when
the  Integrator utility is run. You should not need to change
it.

  Related Parameters/Features  The Location of Inband Signaling Code parameter specifies
where this code is located in an incoming inband string.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.
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  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Code for Go to Voice Mail and Get Mailbox - #159

 Total Length of
String

  This parameter specifies the number of characters and
digits in the Code for Go to Voice Mail and Get Mailbox
string.

  When/How to Use  Calculate the Total Length of String by counting the number
of characters and digits that are sent in the Code for Go to
Voice Mail and Get Mailbox string. For example, if the code
is $ and the mailbox number is 1000, the string is $1000. In
this case, the Total Length of String is 5.

 If this parameter is set to 0, the system does not test the
string length.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The length of the Inband Code String and the Number of
Digits in a Mailbox parameters determine the setting of the
Total Length of String parameter.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 Inband Code for Go to Automated Attendant and Get Mailbox

 The Inband Code for Go to Automated Attendant and Get Mailbox parameters configure
the Octel 50 system to transfer callers to the Automated Attendant entry point.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code for Go to Automated Attendant and Get Mailbox - #160

 Inband Code
String

  This parameter specifies the code sent by the switch that
instructs the Octel 50 system to transfer a caller to the
automated attendant mailbox entry point.

  When/How to Use  When this code is used, the caller hears, “Please enter the
mailbox number of the person you would like to speak with.”

 The Octel 50 system automatically sets this parameter when
the  Integrator utility is run. You should not need to change
it.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.
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  Related Parameters/Features  The Location of Inband Signaling Code parameter specifies
where this code is located in an incoming inband string.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
32

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Inband Code for Go to Automated Attendant and Get Mailbox - #161

 Total Length of
String

  This parameter specifies the number of characters and
digits in the Code for Go to Automated Attendant and Get
Mailbox string.

  When/How to Use  Calculate the Total Length of String by counting the number
of characters and digits that are sent in the Code for Go to
Automated Attendant and Get Mailbox string. For example,
if the code is $ and the mailbox number is 1000, the string is
$1000. In this case, the Total Length of String is 5.

 If this parameter is set to 0, the system does not test the
string length.

 The minimum and maximum for this parameter refer to the
length of the entry allowed, not an actual number.

  Related Parameters/Features  The length of the Inband Code String and the Number of
Digits in a Mailbox parameters determine the setting of the
Total Length of String parameter.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
99

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 Inband Code Default

 The Inband Code Default parameters configure the Octel 50 system to properly receive
and interpret the inband information sent from the switch.

 When the Integrator utility is run, the Octel 50 system enters default settings for the codes
required by the switch. These settings are determined based on default settings for the
switch. If you or the manufacturer modify the switch programming or features, integration
may be affected. If this occurs, call a technical support representative.

 Inband Code Default - #162

 Location of
Mailbox Number

  This parameter specifies which digit in the default inband
signaling string is the first digit in the mailbox number that
follows the code.

  When/How to Use  The setting of this parameter depends on whether the count
starts from the beginning or the end of the string.
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  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
1

 Max

 
99

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code Default - #163

 Start at End of
String

  This parameter specifies whether the system starts at the
end of the default inband signaling string when counting
digits to locate the start of the mailbox number.

  When/How to Use  Enable this parameter if variable-length strings are used.

  Related Parameters/Features  The Location of Mailbox Number and the Start at the End of
String parameters work together. For example, if the
incoming string is 9*1123 and the mailbox number is 123,
the Number of DID Digits to use is 6, the DID Code is 9*1,
the Location of Inband Signaling Code is 1, and, if Start at
End of String is set to Yes, the Location of Mailbox Number
is 3. If Start at End of String is set to No, the Location of
Mailbox Number is set to 4.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Inband Code Default - #164

 Off Hook Delay
Time (OFFHDLY)

  This parameter determines the delay, in 10 millisecond
units, after the Octel 50 system takes a port off hook, before
it starts DIDTIME.

  When/How to Use  This parameter is set when the Integrator utility is run. You
should not need to change it.

  Related Parameters/Features  If the Total Number of DID Digits is set to 0, this parameter
is not available.

 DIDTIME does not begin until OFFHDLY is reached.

  If Set Too High  The Octel 50 system may regularly miss one or more inband
digits at the beginning of the string.

  If Set Too Low  The Octel 50 system may prematurely drop incoming calls.
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  Min

 
0

 Max

 
30000

 Default

 
50

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 Hangup Detection Parameters

 The Hangup Detection parameters provide information on how a switch indicates that a
caller has hung up. This allows the Octel 50 system to release the port and wait for
another call. There are three ways switches indicate hangups: dial tone, hangup strings,
or a drop in loop current. When the Integrator is run, the Octel 50 system sets the
parameters required by the switch.

 
 Hangup Detection Parameters - #165

 Dial Tone
Detection Time
(DTONDET)

  This parameter specifies the amount of time, in 10
millisecond units, the Octel 50 system must detect constant
dial tone to determine a caller has hung up before dropping
the line.

  When/How to Use  This parameter is set when the Integrator utility is run for
switches that use dial tone to indicate a hangup.

 Adjust this parameter only when instructed to by a technical
support representative.

  Related Parameters/Features  You must set DTONDET at least 4 seconds higher than
DTONWAIT. For example, if you set DTONWAIT to 300,
DTONDET must be set to at least 700.

  If Set Too High  A high setting causes excessive off hook time between
calls.

  If Set Too Low  Setting this parameter to 0 disables it, and the Octel 50
system does not detect dial tones. The result is excessive
off hook time between calls.

  Min

 
0

 Max

 
1200

 Default

 
1200

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Hangup Detection Parameters - #166

 Hangup String
(HANGUPSTR)

  This parameter defines the sequence of digits the switch
sends to indicate a hangup.

  When/How to Use  This parameter is set when the Integrator utility is run for
switches that use hangup strings to signal disconnects.

 If your switch is programmable, and you modify the hangup
string, be sure the string does not represent a sequence of
keypresses that a caller might use to navigate through Octel
50 system menus.

 The minimum and maximum values for this parameter refer
to the length of the entry allowed, not an actual number.

  Related Parameters/Features  If using a hangup string, the Hangup String Timeout
(HANGUPDLY) should be a value greater than 0.
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  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
0

 Max

 
15

 Default

 
Blank

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Hangup Detection Parameters - #167

 Hangup String
Timeout
(HANGUPDLY)

  This parameter specifies the amount of time, in 100
millisecond units, that the Octel 50 system waits between
digits before identifying a string of DTMFs as a hangup
string. This eliminates false hangup string detections.

  When/How to Use  This parameter is set when the Integrator utility is run.

 Adjust this parameter only when instructed to by a technical
support representative.

  Related Parameters/Features  This parameter must be set to a value greater than 0 if using
the Hangup String (HANGUPSTR) parameter.

  If Set Too High  DTMFs from keypresses entered by callers or subscribers
using Octel 50 system features may be incorrectly
interpreted as hangup strings.

  If Set Too Low  Hangup strings may be ignored if the switch cannot send
the digits fast enough to meet this value. This may cause
excessive off hook times between calls.

  Min

 
0

 Max

 
30000

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Hangup Detection Parameters - #168

 Minimum
Duration for
Drop in Loop
Current
(LCDTIME)

  This parameter specifies the amount of time, in 10
millisecond units, necessary to recognize a drop in loop
current, when detecting a disconnect.

 When/How to Use  This parameter is set when the Integrator utility is run.

 Adjust this parameter only when instructed to by a technical
support representative.

 A setting of 0 disables this parameter.

  Related Parameters/Features  None.

  If Set Too High  If the switch sends a loop current drop for a shorter time
than the time set for LCDTIME, the Octel 50 system does
not identify the disconnect. This may cause excessive off
hook times between calls.
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  If Set Too Low  Noise spikes on the line could cause disconnect. Set this
parameter to 0 to disable it.

 A low setting may also cause call ghosting on the ports.

  Min

 
0

 Max

 
30000

 Default

 
30

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Hangup Detection Parameters - #169

 Maximum
Silence Before
Hanging Up
(MAXSIL)

  This parameter specifies the amount of time, in 10
millisecond units, during message recording that the Octel
50 system records silence before it determines the caller
has hung up and drops the line. MAXSIL prevents the Octel
50 system from recording silence when a caller has hung up
during a record session.

  When/How to Use  This parameter is used for switches that do not use positive
disconnects or dial tones to indicate disconnects.

 For most Octel 50 systems, the default value should be
sufficient.

  Related Parameters/Features  Set this parameter to a value less than 1000 if using AMIS
messaging.

 Set this parameter to a value greater than 0 if using
HANGUPSTR.

  If Set Too High  The Octel 50 system records silence. Also, switches could
detect a port as available and mistakenly pass incoming
calls to a port on which Octel 50 system is recording silence
(missed disconnect). In this case, a new caller would
append to the previous recording.

  If Set Too Low  Callers could be cut off during recording due to natural
pauses when they speak.

  Min

 
0

 Max

 
30000

 Default

 
600

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No
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 Channel Specific Parameters

 The Channel Specific Parameters specify how Octel 50 ports handle calls.

 Channel Specific Parameters - #170

 Inbound
Application
(INBOUND)

  This parameter assigns inbound applications to each port.

  When/How to Use  The valid entries for this parameter are 1 and 0. Enter a 0
for ports that are not to be answered by Octel 50. For
example, if each port on a 4-port system is to be answered
by Octel 50, set this parameter to 1111.

 The default shown is for an 8-port system.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
11111111

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Channel Specific Parameters - #171

 Outbound
Application
(OUTBOUND)

  This parameter specifies whether each port is allowed to
make outbound calls for outbound events (message
delivery, message waiting lights, AMIS messages, future
delivery messages, and wake-up calls).

  When/How to Use  The valid entries for this parameter are 0 and 2. Each digit
corresponds to a port on the voice board. Enter a 0 for ports
not allowed to support outbound events. If a position
contains a 2, the corresponding port may be used for
outbound events. For example, if this parameter is set to
0022 on a 4-port system, outbound calls may only be made
on ports 3 and 4.

 It is recommended that some calls not be enabled for
outbound events so incoming calls can access the port.

 The default shown is for an 8-port system.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
22222222

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Channel Specific Parameters - #172

 Init Mode   Init Mode reflects the method of answering for each port.
The Octel 50 system supports the following modes:

C Serial integration

D Inband signaling, off hook waiting for inband
signaling digits

N Normal, on hook waiting for rings

P Pulse inband signaling, off hook waiting for inband
signaling digits

T Tone inband signaling, off hook waiting for inband
signaling digits

W Wink start

  When/How to Use  Each position in the parameter setting equals the operating
mode of the corresponding port.

 This parameter supports SMDI-type switches that do not
use normal means for alerting the voice mail system of
incoming calls and hangups, the INITMODE should be set
to C for each port supporting the voice mail ports of the
switch.

 The default shown is for an 8-port system.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
NNNNNNNN

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Channel Specific Parameters - #173

 Number of
Incoming Rings
(INRINGS)

  This parameter specifies the number of rings each port must
hear before it answers an incoming call. Each character
represents the number of rings for each corresponding
channel. For example, if INRINGS is set to 2211, ports 0
and 1 are answered after two rings, while ports 2 and 3 are
answered after one ring.

  When/How to Use  On some phone systems, especially those without true hunt
groups, this parameter should be set to consecutive
numbers to prevent multiple lines from being answered at
the same time.

 The default shown is for an 8-port system.

  Related Parameters/Features  This parameter should not be confused with the Maximum
Rings Before No Answer (RINGS) parameter in System
Setup or the Maximum Rings parameter on the Class of
Service dialog box.

  If Set Too High  The higher you set this parameter, the longer the delay
before the port answers the call.
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  If Set Too Low  The minimum of 1 should be sufficient for most Octel 50
system ports.

  Min

 
–

 Max

 
–

 Default

 
11111111

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Channel Specific Parameters - #174

 Go OFF Hook
when Port
Disabled
(OFFHDIS)

  This parameter determines whether the Octel 50 system
takes a port off hook when the port is disabled so callers to
that port hear a busy signal. A number of occurrences can
temporarily disable a port, such as a power loss or when the
Octel 50 system shuts down after daily maintenance.

  When/How to Use  It is generally recommended that you enable this parameter
so callers hear a busy signal instead of ringing when they
call a disabled port.

 Some switches, such as those using digital integration, lock
the disabled ports when they have been off hook for a long
time. If your switch uses digital integration, you should
disable OFFHDIS. See the Configuration Note for your
switch for information on setting this parameter.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
Yes

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Channel Specific Parameters - #175

 Maximum Call
Duration
(PROGTIME)

  This parameter specifies the maximum amount of time, in
minutes, the Octel 50 system allows a call to occupy a port
before it disconnects the call without warning.

  When/How to Use  Use caution when setting this parameter. If callers are
disconnected while performing mailbox functions, such as
listening to messages or creating mailboxes, data corruption
could occur. Set this parameter to disable it.

 If you set PROGTIME to a value greater than 0, consider the
following:

• Set PROGTIME to a value high enough so calls
delivering faxes and callers on hold are not
disconnected.

• PROGTIME overrides Message Time on the Class
of Service dialog box. Set PROGTIME higher to
prevent callers from being disconnected while
recording messages. If this happens, data
corruption could occur.



Setting Up the System   Configuring System Setup Parameters

Octel 50 Installation Guide 8-94

  Related Parameters/Features  If PROGTIME is shorter than the Message Time setting on
the Class of Service dialog box, callers may be
disconnected before they finish recording long messages.

  If Set Too High  The higher you set this parameter, the longer callers are
allowed to remain in the Octel 50 system before being
disconnected.

  If Set Too Low  Callers recording messages, sending faxes, or waiting in
call queues are disconnected without warning and data
corruption could occur. Set this parameter to 0 to disable it.

  Min

 
0

 Max

 
999

 Default

 
30

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Channel Specific Parameters - #176

 DTMF Length to
Interrupt a
Prompt
(PLAYDTMF)

  This parameter specifies the length, in 10 millisecond units,
of a DTMF the voice board must receive to interrupt a
prompt voiced by the Octel 50 system.

  When/How to Use  For most Octel 50 systems, the default value is sufficient. If
the Octel 50 system misinterprets voice data as DTMF
tones during prompts, try increasing this setting.

  Related Parameters/Features  When RECDTMF is set to a higher value than PLAYDTMF,
the RECDTMF value is used for both.

  If Set Too High  The Octel 50 system may not recognize DTMF tones and
does not interrupt the prompt.

  If Set Too Low  The Octel 50 system may interpret voice data as DTMF.

  Min

 
0

 Max

 
30000

 Default

 
0

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Channel Specific Parameters - #177

 Printer LPT Port
(PRINTER)

  This parameter indicates whether the system is using a
printer.

  When/How to Use  The valid entries for this parameter are 1, 2, or N, where 1
or 2 corresponds to the LPT1 or LPT2 connection and N
corresponds to no printer.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
1

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No
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 Channel Specific Parameters - #178

 DTMF Duration
to Interrupt
Record
(RECDTMF)

  This parameter specifies the length, in 10 millisecond units,
of a DTMF a voice board must receive to interrupt recording
on the Octel 50 system.

  When/How to Use  For most Octel 50 systems, the default value is sufficient. If
the Octel 50 system misinterprets voice data as DTMF
tones during recording, try increasing this setting.

  Related Parameters/Features  When RECDTMF is set to a higher value than PLAYDTMF,
the RECDTMF value is used for both.

  If Set Too High  The Octel 50 system does not interrupt the recording
session when the callers enter DTMFs.

  If Set Too Low  The Octel 50 system may misinterpret voice data as DTMF
and interrupt the recording.

  Min

 
0

 Max

 
30000

 Default

 
0

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Channel Specific Parameters - #179

 Default Input
Timeout
(TIMEOUT)

  This parameter specifies the number of seconds the Octel
50 system waits for the caller to respond with a keypress
after voicing a prompt before voicing, “Please make your
selection now,” and repeating the prompt.

  When/How to Use  For most Octel 50 systems, the default allows sufficient time
for most callers to respond to prompts.

  Related Parameters/Features  Maximum Number of No Entries specifies the maximum
number of times the Octel 50 system voices prompts
without receiving input before it disconnects the caller.

  If Set Too High  There may be long pauses when the Octel 50 system voices
prompts and waits for input. Consequently, calls occupy
ports for a long time.

  If Set Too Low  Setting this parameter to 0 does not allow callers enough
time to respond to prompts. Callers could exceed the
Maximum Number of No Entries and be disconnected.

 

  Min

 
0

 Max

 
99999

 Default

 
20

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 Channel Specific Parameters - #180

 Duration of Ring
Off (RINGOFF)

  This parameter specifies the amount of time, in 100
millisecond units, that ring voltage must be off for the Octel
50 system to determine that a ring has stopped.
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  When/How to Use  For most Octel 50 systems, the default value is sufficient. If
your switch uses European-style rings, you may need to
adjust this setting. Call a technical support representative
for information on setting this parameter for European-style
rings.

  Related Parameters/Features  None.

  If Set Too High  The Octel 50 system cannot detect rings and does not
answer incoming calls.

  If Set Too Low  The Octel 50 system could misinterpret skips and jumps in
the ring voltage as incoming calls.

  Min

 
1

 Max

 
30000

 Default

 
5

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Channel Specific Parameters - #181

 Duration of Ring
On (RINGON)

  This parameter specifies the amount of time, in 100
millisecond units, that ring voltage must be on for the Octel
50 system to identify a ring cycle.

  When/How to Use  For most Octel 50 systems, the default is sufficient. If your
phone system uses European-style rings, you may need to
adjust this setting. Call a technical support representative
for information on setting this parameter for European-style
rings.

  Related Parameters/Features  None.

  If Set Too High  The Octel 50 system cannot detect rings and does not
answer incoming calls.

  If Set Too Low  The Octel 50 system could misinterpret short instances of
line noise as incoming calls.

  Min

 
1

 Max

 
30000

 Default

 
3

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 No

 
 Channel Specific Parameters - #182

 Maximum
Answer Time
(MAXANSR)

  This parameter specifies the maximum allowable time, in 10
millisecond units, for a greeting before returning a connect
signal. This parameter is used for outcall applications
(message delivery).

  When/How to Use  This parameter is useful for answering machines
applications, such as polling surveys.

 Do not modify this parameter unless directed to change it by
a technical support representative.

  Related Parameters/Features  None.

  If Set Too High  Should have no effect on system performance.

  If Set Too Low  The system may assume a connect too soon.
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  Min

 
0

 Max

 
30000

 Default

 
1000

 Requires
Restart

 Yes

 Switch-
Dependent

 No

 Set by
Integrator

 No

 PC Configuration Parameters

 PC Configuration Parameters - #183

 Virtual Disk for
Voice File
(VDISK)

  This parameter specifies the location of the memory file
(SO3-ALL.VAP or SO3-ALL.VOX) if using a RAMdisk.

  When/How to Use  Use this parameter to specify the hard drive to be used for
RAMdisk. This parameter is only used if you chose during
installation to use RAMdisk. If this parameter is set to the
default, C, no RAMdisk is used.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
C

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 PC Configuration Parameters - #184

 Sound Tone on
Answer
(ANSTONE)

  This parameter determines whether the Octel 50 system
sounds an audible tone when it answers an incoming call.

  When/How to Use  For most Octel 50 systems, leave this parameter disabled.

 Enable this parameter when recommended by a technical
support representative for troubleshooting.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 PC Configuration Parameters - #185

 Minutes Before
Blanking Screen
(DSPBLANK)

  This parameter specifies the number of minutes of inactivity
before the display screen blanks. The command helps
protect the phosphorous elements in the monitor screen.
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  When/How to Use  To return to the screen image, press any key. A setting of
99 disables this parameter.

  Related Parameters/Features  None.

  If Set Too High  Not applicable.

  If Set Too Low  Not applicable.

  Min

 
1

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 PC Configuration Parameters - #186

 Number of Calls
Between
Checkpoint File
Updates
(CKPRATE)

  This parameter specifies the number of completed calls to
or from the Octel 50 system before the Checkpoint file,
OPERATOR.CKP, is saved. The Checkpoint file records
critical Octel 50 system data such as business hours,
statistics, system manager passwords, prompt assignments,
multilingual information, and group lists.

  When/How to Use  This parameter should be set lower on lower call volume
systems than on high call volume systems. Do not set this
parameter to 0 as this disables it.

  Related Parameters/Features  None.

  If Set Too High  The higher you set this parameter, the longer between file
saves, and the greater the chance of data loss should there
be a power outage.

  If Set Too Low  A low setting for this parameter does not affect system
performance. However, setting it to 0, which disables the
parameter, is not recommended.

  Min

 
0

 Max

 
99

 Default

 
5

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 
 PC Configuration Parameters - #187

 Rate to Poll the
Voice Driver
(EVENTRATE)

  This parameter specifies the number of cycles between
checking for keystrokes. A cycle consists of scanning all
voice channels.

  When/How to Use  The default should be acceptable for most Octel 50
systems. You should not modify this parameter unless
instructed to by a technical support representative.

  Related Parameters/Features  None.

  If Set Too High  There may be a delay in recognizing keystrokes.

  If Set Too Low  On a small system, setting this too low may slow down the
system slightly.
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  Min

 
0

 Max

 
30000

 Default

 
40

 Requires
Restart

 No

 Switch-
Dependent

 No

 Set by
Integrator

 No

 Simplified Message Desk Interface Parameters

 The Simplified Message Desk Interface parameters specify whether the Octel 50 system
uses Serial integration and whether the system communicates message waiting light
commands through the serial interface.

 These parameters only apply to Octel 50 systems with sentinels that support Serial
integration.

 You can modify these parameters only when you run System Setup by clicking on the
System Setup icon in the system folder. You cannot modify these parameters when you
access System Setup from the Options menu in Octel 50.

 
 Simplified Message Desk Interface Parameters - #188

 Use SMDI (SMDI
Used)

 This parameter determines whether the Octel 50 system
uses Serial integration for incoming calls. If you enable this
parameter, the Octel 50 system looks for the supporting
Serial Integration program. If the system does not find the
required program, it displays an error message.

 When/How to Use  This parameter is enabled, if required, when the Integrator
utility is run for the switch.

 This parameter is not available when you run System Setup
from the Options menu, and does not reset when you select
the Set to Defaults option from the System Setup File menu.

 Do not enable this parameter unless the Octel 50 system
sentinel supports Serial integration, and you installed the
supporting program. If Octel 50 does not find the required
program when you attempt to launch the system, an error
displays and the system does not run.

 Related Parameters/Features  You must set the Init Mode parameter to C for all ports on
which you are using Serial integration.

 If Set Too High  Not applicable.

 If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 –

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Simplified Message Desk Interface Parameters - #189

 Use
Communications
Message Waiting
Software
(COMMMWL)

 This parameter determines whether the Octel 50 system
uses communications message waiting light software to
activate and deactivate message waiting lights through the
serial (COM) port instead of sending DTMFs.

 If this parameter is enabled, the Octel 50 system looks for
the supporting software. If Octel 50 does not find the
required program when you attempt to launch the system,
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an error displays and the system does not run.

 When/How to Use  This parameter is enabled, if required, when the Integrator
utility is run for the switch.

 Make sure the sentinel supports Serial integration, and you
installed the supporting program before attempting to launch
the Octel 50 system.

 Related Parameters/Features  You must set the Init Mode parameter to C for all ports on
which you are using communications message waiting light
software.

 If you enable this parameter, the Permit Message Waiting
Lights parameter must be enabled, and you can configure
the Light Message Waiting Lights for Every Message
parameter as you like. However, the remaining Message
Waiting Light parameters must be blank and disabled.

 If Set Too High  Not applicable.

 If Set Too Low  Not applicable.

  Min

 
–

 Max

 
–

 Default

 
No

 Requires
Restart

 Yes

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 
 Simplified Message Desk Interface Parameters - #190

 Strobe Interval in
Seconds
(STROBE)

 This parameter specifies the number of 10 millisecond
intervals that a signal is sent to the switch configured with
SMDI to notify the switch that voice mail is running.

 When/How to Use  The default should be sufficient for most Octel 50 systems.

 Related Parameters/Features  The Use SMDI parameter must be enabled for this
parameter to be used.

 If Set Too High  Not applicable.

 If Set Too Low  Not applicable.

  Min

 
0

 Max

 
999

 Default

 
0

 Requires
Restart

 No

 Switch-
Dependent

 Yes

 Set by
Integrator

 Yes

 Low-Level Voice Board Parameters

 The Low-Level Voice Board parameters are set when you run Call Analysis. Do not
modify these parameters unless you areinstructed to by a technical support
representative to change them.
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C H A P T E R  9

Defining Phone System Signals

 Call analysis enables the Octel 50 system to recognize dial tone, busy, no answer, and
connect signals from the switch. Octel 50 includes the CCA utility for both Dialogic and
Rhetorex voice boards, the AccuCall utility for Rhetorex boards, and the CPC utility for
Dialogic boards. The AccuCall and CPC utilities are provided as additional tools and
usually do not need to be run.

The steps in this section help you:

• Run the call analysis utility (CCA)

• Run the AccuCall call analysis utility for Rhetorex boards

• Run CPC call analysis utility for Dialogic boards
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Running Call Analysis

Before running call analysis, you must determine if you need to run call analysis and
whether the Octel 50 system meets the requirements for running call analysis.

Determining If You Should Run Call Analysis

 In most cases, you must run Call Analysis when you are installing an Octel 50 system.
There are instances, however, when you are not required to run it.

 You must run Call Analysis if:

• You are installing a new Octel 50 system.

• You are upgrading an existing system.

 You may not need to run Call Analysis if:

• You are running a special integration, such as a D/42-SX. Consult the
Configuration Note included with the Octel 50 system to determine if you need to
run Call Analysis for the type of board you are installing.

• You are adding the Fax Solution utility to the Octel 50 system. The fax tone table
that ships with the Octel 50 system is the industry-standard tone for a fax
machine. If you find that the fax machine uses tones that do not fall within an
acceptable variance for the fax tone standard, contact a technical support
representative to help you increase the fax tone variance.

 You do not need to run Call Analysis if:

• You are installing a new voice board in an existing Octel 50 system.

• You are upgrading to add additional ports to the Octel 50 system.

• You set up the Octel 50 system to only perform blind transfers.

Meeting the Requirements to Run Call Analysis

 Before you run Call Analysis on the Octel 50 system, determine if the Octel 50 system
meets the following requirements:

• The Octel 50 system has access to at least one extension from the phone
system. Access to two extensions is preferred.

• The extensions you use to run Call Analysis are not in a hunt or rollover group.

• No one can access the extensions used to run Call Analysis while it is running.

• Auto Answer, Call Forwarding, and Camp-On features are deactivated while you
run Call Analysis.
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Using CCA for Rhetorex and Dialogic Boards

 CCA enables he Octel 50 to evaluate the progress of an outbound call and make
decisions based on the responses.

 CCA monitors activity on the line after a phone number is dialed. It can detect six different
conditions:

• No Ringback–Detects no recognizable cadence pattern.

• No Answer–Detects a ringing line that was not answered.

• Busy–Detects a busy signal.

• Connect–Detects a line that has been answered.

• Fast Busy–Detects a fast busy or reorder tone.

• SIT–Detects a Special Information Tone, which indicates that an invalid number
has been dialed or there is a problem completing the call.

 CCA is composed of three different processes used to determine the progress of the call.
The processes function simultaneously during CCA. Each process uses its own
parameters, which can be adjusted to maximize the efficiency of call analysis and Octel
50:

• Cadence detection–Looks for a repeating pattern in the signal. Cadences usually
detected include the ring, busy, and fast busy signals. Once a cadence has been
established, it can be classified by comparing the periods of silence and
nonsilence to established parameters.

• Frequency detection–Used to identify single-frequency tones, such as Special
Information Tone (SIT) sequences. It can detect single-frequency tones below
2100 Hz.

• Loop current detection–Used to return a connect signal when a drop in loop
current is detected.

CCA is designed to operate in either Auto or Advanced mode. Use Auto mode to run CCA
for all signals (ring, busy, fast busy, and connect) using the default parameters. In most
cases, running CCA in Auto mode is sufficient to enable Octel 50 to function properly. If
you run CCA and Octel 50 still does not properly detect switch signals, contact a technical
support representative for information on using the Advanced CCA options.

You may not need to run CCA if the Octel 50 system is using a special board integration.
Consult the Configuration Note to determine if you need to run CCA for the type of board
you are using.

To run CCA:

1. Verify you have access to two extensions from the phone system.

2. After you install Octel 50 and the system reboots, a dialog box displays asking if you
want to run CCA. To start CCA, press <Y>. Press <N> to launch the Octel 50 system
without running CCA. If you do nothing, CCA is automatically launched. When you
press <Y>, an introductory Call Analysis screen displays.
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3. Select OK to continue. The Dial Tone Detection dialog box displays. CCA checks all
channels for dial tone and their state.

4. After CCA initializes the channels, the Call Analysis Auto Mode dialog box displays. In
the Channel Out # field, enter the number of the channel you want the system to call
out from for CCA. Port numbering begins at 1. This field defaults to the first channel
on which CCA detects dial tone.

 

5. In the Channel In # field, enter the number of the channel you want to call for CCA.
Port numbering begins at 1. This field defaults to the second channel on which CCA
detects dial tone.

6. Verify that an extension is plugged into the port you specified in the Channel Out #
field.

7. Verify that an extension is plugged into the port you specified in the Channel In # field.

8. In the Phone Number field, enter the number of the extension connected to the
Channel In #. For example, if you entered channel 3 in the Channel #3 field and
extension 5500 is plugged into channel 3, enter 5500 in this field.

9. To begin CCA, use the <TAB> or arrow keys to highlight the Start option, then press
<ENTER>. Once you select Start, you cannot stop CCA. The Call Analysis dialog box
displays and the system automatically tests for busy, ring, connect, and fast busy. In
almost all cases, Auto Analysis passes all tests and no further parameter adjustments
are necessary. The Auto Analysis Using Channels x and y dialog box displays, where
x and y are the channels you specified in steps 4 and 5 respectively.

If you are using fax mail, the tone for fax machine detection is automatically created
and added to the tone table by CCA. However, if you need to run AccuCall, you must
manually add this tone to the tone table.
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10. When Auto Analysis is complete, the Call Analysis Summary dialog box displays
which of the analysis detections passed and which failed for the first channel. You can
select Next or Prev to display results for additional channels.

11. To display a graph of the results, select Graph. A graph for the first busy test displays.
Use the Up and Down buttons to view graphs for the other tests.

12. Select Exit to close the graph. The Call Analysis Summary dialog box displays.

13. To close the Call Analysis Summary dialog box, select OK. The Call Analysis Auto
Mode dialog box displays.

To adjust CCA parameters, you can use the <TAB> or arrow keys to highlight Advanced
and press <ENTER>. For more information on using the Advanced CCA parameters,
contact a technical support representative.

14. To exit CCA from the Call Analysis Auto Mode dialog box, select Exit. The system
reboots and the Octel 50 system launches, if it is configured to start automatically
upon bootup.
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Running CCA After Installation

If you need to run CCA at a later time, either start the Octel 50 system then shut it down
or load the voice board drivers from the command line by typing RHETDRV for Rhetorex
boards or D40 for Dialogic boards. To start CCA from the command line, type CCA
then press <ENTER> at the \CVR prompt. The CCA initialization dialog box displays.

Clear the previous settings before running CCA again. To clear CCA settings, type
CLEARCCA then press <ENTER> from the \CVR prompt.

When you exit CCA from standalone mode, you return to the \CVR prompt. You must
then reboot the PC.

Running AccuCall–Call Analysis for Rhetorex

Rhetorex’s AccuCall program is provided to handle situations that CCA may not be able
to handle. Normally, AccuCall does not need to be run. For additional information, contact
a technical support representative.

Do not modify parameters in the program unless you are instructed to do so. The
parameters you do need to modify are explained in detail and recommended values are
provided.

To run AccuCall:

1. From the \CVR prompt, type ACCUCALL then press <ENTER>. The AccuCall Plus
Main Menu dialog box displays.
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2. Press <F5>. The Setup dialog box displays.

It should not be necessary for you to change anything in the Environment
Parameters, Global Parameters, or the Channel Parameters on the Setup dialog box.
The only parameters you may need to edit in the Setup dialog box are those listed in
step 3. Use the up and down arrow keys to access these fields.

3. In the Hardware Interrupt field, enter the interrupt set on the voice boards. Valid
values are 2 through 7.

4. In the Out Dial Channel Number field, change the value to equal the active channel
(or port), if you want to use a specific channel. This is the channel to which the phone
line is connected, not an extension number.

5. In the Auto Run/Run Verification Count field, verify the field is set to 1. This value
determines the number of times the Auto Run operation should be executed when
determining a call-monitoring tone frequency and cadence.

6. In the Auto Run Minimum Cycles field, verify the field is set to 10. This value
determines the minimum number of call progression-cadence cycles that Auto Run
should analyze during each call.

7. In the Auto Run Align Frequencies field, verify the field is set to YES. Press the
<SPACEBAR> if necessary to change the selection.

8. In the Auto Run Quick Frequency Scan field, press the <SPACEBAR> to change the
selection to YES if the signal of the destination phone has no cadence or a cadence
that changes after a short period, such as 1-tone burst. For example, on some
switches, a busy signal eventually yields to a fast busy. You can set the quick scan to
capture the cadence before it changes.

9. In the Log Results to Disk field, make sure the field is set to YES if you want AccuCall
to generate a printable log file containing AccuCall test information, such as the
frequencies produced by the switch. Press the <SPACEBAR> to change the selection
if necessary.

10. In the Use Internal Speaker field, verify the field is set to YES if you want the PC to
generate an audible tone while testing the call frequencies. Press the <SPACEBAR>
to change the selection if necessary.

11. In the Phone No. field, enter the number of the extension you want AccuCall to dial.
Use a comma (,) to insert necessary delays into the dial string. Each comma
represents approximately 2 seconds.

12. To save changes to the Setup Screen, press <F7>.



Defining Phone System Signals   Running AccuCall–Call Analysis for Rhetorex

Octel 50 Installation Guide 9-8

13. Press <F6>. The Auto Run dialog box displays.

14. To test busy, verify that the extension you entered in the step 11 is busy by creating a
talk path to another phone. Dialing another number ensures that there is not a tone
change or time-out on the line.

15. To start AccuCall analysis, press <F9>. A graphic representation of the busy signal
displays in the Cadence Detected box.

16. When prompted to add tones, press <F8>. The Edit Tones dialog box displays.

17. In the Name field, enter a name for the tone. The name should be descriptive such as
the name of the switch followed by Busy. Once you name the tone, it appears on the
Main Menu dialog box. If you need to edit the tone later, select it from the Main Menu
dialog box by highlighting it and pressing <ENTER>.
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18. In the Type field, use the <SPACEBAR> to select a classification. Assign a BUSY
type since you are currently testing the busy signal.

19. In the Terminating field, use the <SPACEBAR> to select Yes if the tone is used to
indicate a disconnect.

In most cases, you do not need to specify the busy or ring signals you are analyzing
as Terminating. A terminating tone is a tone from the switch that indicates a
disconnect. Some tones need to be identified as Terminating during playback or
record operations if the call is to terminate when the tone is detected. For example,
you may need to designate a fast busy as Terminating on some switches. Note that if
you do identify a tone as Terminating, at least one frequency must be detected in the
Auto Run <F6> test. This frequency must be in one of the first three positions in the
<F3> Filter Table.

20. In the Cadence field, use the <SPACEBAR> to select Yes if the word None appears
in both frequency fields. If the frequencies of a tone are unknown, call progress
monitoring analyzes the cadence without frequency analysis.

21. In the FREQUENCY1 and FREQUENCY2 fields, verify that there is a minimum 40 Hz
spread between the detected frequencies. (If one of the frequencies is None, this is
not necessary.)  If there is not at least a 40 Hz spread, adjust the FREQUENCY1 and
FREQUENCY2 settings on the screen as little as possible to achieve the spread. If
the two tones in question are within 10 Hz of each other, change the lower frequency
value of the two to equal the higher frequency value.

22. In the PCPMCODE field, enter a numeric identifier to the tone. Specify identifier 7 for
all busy tones. If the tone is undefined, the device driver returns PCPMCODE 9; if an
answer is detected, the driver returns PCPMCODE 10.

If an incorrect PCPMCODE is returned, AccuCall is not differentiating between the
tones. See the topic, “Common AccuCall Problems/Solutions,” later in this chapter for
information on how to help AccuCall differentiate between tones.

23. To add the tone to the tone table and save it, press <F8> twice. If a tone with the
name you entered in step 17 already exists, you are prompted to press <F7> to
replace the existing tone. Press <F7> if you want to replace the existing tone with the
new tone. If you do not want to replace the existing tone, press <Esc>, enter a new
name for the tone, then press <F8> twice again.

24. To advance to the Auto Run dialog box to analyze the ring tone, press <F6>.

25. To test ring, make sure the receiver of the extension you are using is on hook.

26. To start AccuCall analysis, press <F9>.

27. When prompted to add tones, press <F8>. The Edit Tones dialog box displays.

28. In the Name field, enter a name for the tone. The name should be descriptive such as
the name of the switch followed by the Ring. Once you name the tone, it appears on
the Main Menu dialog box. If you need to edit the tone later, select it from the Main
Menu dialog box by highlighting it and pressing <ENTER>.

29. In the Type field, use the <SPACEBAR> to select a classification. Assign a RING type
since you are currently testing the ring signal.

30. In the Terminating field, use the <SPACEBAR> to select Yes if the tone is used to
indicate a disconnect.
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In most cases, you do not need to specify the busy or ring signals you are analyzing
as Terminating. A terminating tone is a tone from the switch that indicates a
disconnect. Some tones need to be identified as Terminating during playback or
record operations if the call is to terminate when the tone is detected. For example,
you may need to designate a fast busy as Terminating on some switches. Note that if
you do identify a tone as Terminating, at least one frequency must be detected in the
Auto Run <F6> test. This frequency must be in one of the first three positions in the
<F3> Filter Table.

31. In the Cadence field, use the <SPACEBAR> to select Yes if the word None appears
in both frequency fields. If the frequencies of a tone are unknown, call progress
monitoring analyzes the cadence without frequency analysis.

32. In the FREQUENCY1 and FREQUENCY2 fields, verify that there is a minimum 40 Hz
spread between the detected frequencies. (If one of the frequencies is None, this is
not necessary.)  If there is not, adjust the FREQUENCY1 and FREQUENCY2 settings
on the screen as little as possible to achieve the spread. If the two tones in question
are within 10 Hz of each other, change the lower frequency value of the two to equal
the higher frequency value. Write down the values of the FREQUENCY 1 and
FREQUENCY 2 fields. You will be required to enter these values later.

33. In the PCPMCODE field, enter a numeric identifier to the tone. Specify identifier 8 for
all ring tones. If the tone is undefined, the device driver returns PCPMCODE 9; if an
answer is detected, the driver returns PCPMCODE 10.

If an incorrect PCPMCODE is returned, AccuCall is not differentiating between the
tones. See the topic, “Common AccuCall Problems/Solutions,” later in this chapter for
information on how to help AccuCall differentiate between tones.

34. To add the tone to the table and save it, press <F8> twice. If a tone with the name
you entered in step 28 already exists, you are prompted to press <F7> to replace the
existing tone. Press <F7> if you want to replace the existing tone with the new tone. If
you do not want to replace the existing tone, press <Esc>, enter a new name for the
tone, then press <F8> twice again.

35. To return to the Main Menu, press <F10> twice.

36. Press <F3>. The Filters dialog box displays.

37. In the Filters box, enter all the frequency values listed in the Undefined Tone
Frequencies box. Before you begin, verify that no two values are within 40 Hz of each
other.
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You can edit tones by pressing <F10> to return to the Main Menu dialog box, then
highlighting the tone you want to edit and pressing <F8>. When you finish making any
necessary adjustments to the frequencies, press <F8> to accept the new values and
<F7> to replace the existing saved values. Then, press <F10> to return to the Main
Menu dialog box and <F3> to go back to the Filters dialog box where you can enter in
the new values.

38. Once the detected frequencies are entered, it is recommended that you specify the
remaining filters, incrementing the values by approximately 200 Hz. For example, if
existing frequencies are 350, 443, and 493, enter additional frequencies of 700, 900,
1100, 1300, etc.

39. When you finish adding the frequencies to the Filters box, press <F2> to verify the
analysis. The Run dialog box displays.

40. Press <F9> to start the AccuCall verification. AccuCall tests the ring and busy signals
it analyzed to make sure the analysis was correct. Keep the receiver on hook to test
the ring signal.

41. Verify that the test returns a PCPMCODE value of  8.

42. After the ring test, verify that the extension you entered in the step 11 is busy by
creating a talk path to another phone. Dialing another number ensures that there is
not a tone change or time-out on the line. Once the extension is busy, press <F9> to
test the busy signal.

43. Verify the test returns a PCPMCODE value of 7.

44. Set up a termination tone using the guidelines listed below:

• If the busy tone is also the tone which Octel 50 hears if a caller hangs up, edit the
busy tone and set the Terminating field to Yes.

• If the tone emitted is different than a normal busy (for example, a fast busy), learn
the new tone in the Auto Run dialog box. Assign the tone a PCPMCODE of 31,
set Type to Other, and set Terminating to Yes. Any frequencies detected for the
termination tone should be the first frequency in the Filter Table. Move other
defined frequencies down, overwriting the remaining frequencies you specified in
step 38 if necessary.

• If the termination tone is a fast busy or a re-order tone, set the Auto Run Quick
Frequency Scan parameter on the Setup dialog box to Yes.

• If the termination tone is a solid or D tone, enter D in the HANGUPSTR field in
Octel 50 System Setup (after you complete the AccuCall session).
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45. Set up a calling fax tone using the following steps:

a. Press <F10> to return to the Main Menu.

b. Press <F8>. The Edit Tones dialog box displays.

c. On the Edit Tones dialog box, enter a name in the Name field. The name should
be descriptive such as the name of the switch followed by Fax. Note that you
should enter a unique name so an existing tone is not overwritten.

d. In the Type field, press the <SPACEBAR> until Other displays in the field.

e. Set Terminating to Yes.

f. Set Cadence to No.

g. Type 1075 as Frequency 1; no Frequency 2 is required.

h. Set the PCPMCODE value to 13.

i. Press <F8> twice to add the tone.

j. Press <F10> to return to the Main Menu.

k. Press <F3>. The Filters dialog box displays.

l. In the Filters box, enter a frequency of 1075 for the tone. Overwrite a filter you
entered in step 38 if necessary.

m. Press <TAB> to move to the Filter Characteristics box and change the Inband
Ratio field in the Filter Characteristics box to -6.

46. Press <F10> to return to the Main Menu.

47. From the Main Menu, press <F7> to advance to the File dialog box.

48. In the Enter file name field, assign an 8-character name to the tone table you just
created. Enter a descriptive name (perhaps the switch name).

49. Press <F8> to save the tone table file.

50. To exit the AccuCall program, press <F10>, then press <Y> at the prompt. The \CVR
prompt displays.

51. To verify the tone table is saved in the Configure utility, from the \CVR prompt, type
CONFIGUR then press <ENTER>. The Configure dialog box displays.
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52. If you chose to name the tone table other than TONETAB1 in step 48:

a. Press <F4>. The PCPM File Name Entry/Editing dialog box displays.

b. Read the contents of the dialog box, then press any key to continue. The PCPM
File Name dialog box displays.

c. Type in the name you gave the AccuCall tone table in step 48, then press
<ENTER>.

53. Press <F10>. The Main Menu dialog box displays.

54. Under I/O Ports, verify that the hex address for each board installed is correct. If not,
press <F2> to display the I/O Ports screen, make any necessary modifications to the
listed hex addresses, then press <F10> to save the changes and return to the Main
Menu.

55. Under VP Driver, verify that the Entry Point field is set to 61H if you have a VGA
board. If not, press <F5> to display the VP Driver Parameters screen, modify the
defined entry point, then press <F10> to save the changes and return to the Main
Menu.

56. Under Memory, verify the Real Memory parameter has 32K for each board installed.
If not, press <F3> to display the Memory Allocation Parameters screen, change the
setting of the line that specifies the amount of DOS memory allocated for the disk
buffers pool, then press <F10> to save the changes and return to the Main Menu.

57. Under VP Driver, verify that Hook is set to OFF. This indicates that callers hear a
busy signal if the system is down. If it is not set to OFF, press <F5> to display the VP
Driver Parameters screen, change the default phone line HOOK state to OFFHOOK,
then press <F10> to save the changes and return to the Main Menu.

58. When you finish making necessary modifications, press <F10> to exit the program.

59. When prompted, press <Y> to save the changes. The \CVR prompt displays.

60. Press <CTRL+ALT+DEL> to reboot the PC. When the menu displays, select <1> to
run Octel 50.

Common AccuCall Problems/Solutions

If either of the PCPMCODEs returned are incorrect, AccuCall is not differentiating
between the tones.

To help AccuCall differentiate between tones:

1. Edit the tones and set Cadence to Yes for tones with close frequencies.

2. Adjust the <F5> setup Channel Parameters, Glitch, and Spike down to 80. Relearn
the tones within the Auto Run test. If this returns the correct PCPMCODEs, then set
the HIGLITCH and LOGLITCH to 8.

3. Edit the tones and increase the percentages by 5% for minimum/maximum variances,
ensuring that the variances are set to at least 20%. Retry the run tests. If necessary,
increase the percentages again.

4. Pull some frequencies out of the Filter Table and out of the Tones. Ensure that no
frequencies are within 40 Hz of each other and that the frequencies within the tones
are matching the frequencies within the Filter Table.
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5. Calculate the averages of the highest and lowest values for both the ON TIME and
OFF TIME cadences on the Auto Run dialog box. Enter each average value on the
<F8> Edit Tones dialog box. Set the variances to approximately 30%.

6. Verify that the AccuCall tone table has been saved and loaded into the CONFIGUR
dialog box. Ensure that the file name is spelled correctly and is a valid DOS file name
located in the \CVR directory.

7. Ensure the RHETDRV has been unloaded and reloaded. Also make sure the
computer has rebooted after loading the tone table into the CONFIGUR file and Octel
50 has been brought online.

8. Rerun the AccuCall Run tests and set Adjust Filter Characteristics to Yes, and rerun
the tone tests to ensure the correct PCPMCODEs are returned.

9. Save the AccuCall tone table.

10. Unload or reload the RHETDRV or reboot.

11. Drop Glitch and Spike to no lower than 80 in the AccuCall <F5> setup, and re-run the
RUN tests to ensure the correct PCPMCODEs are returned. Set HIGLITCH and
LOGLITCH to 8, then save the AccuCall tone table. Unload and reload the RHETDRV
or reboot.

To eliminate delayed call transfers:

1. If the highest frequency scanned is 650 or lower, add values 700, 750, 800, 850, and
so on, through 1050 to the <F3> Filter Table in AccuCall.

2. Set OUTDIAL to Voice, VOXLIMIT to 2, SPIKES to 3, and DROPOUTS to 3 on the
Configure Main Menu dialog box. To make these changes, use the up and down
arrow keys to highlight the parameter you want to change, edit the field, then press
<ENTER> to save the changes.

3. If AccuCall detects a do not disturb tone, but the system does not, change HIGLTCH
and LOGLTCH to 8. You can also use these settings if the system disconnects on a
reorder tone except when recording, that is, the reorder tone is recorded with the
message.

Running Call Progress Characterization (CPC) Call Analysis for
Dialogic

Dialogic’s CPC program is provided to handle unforeseen situations that CCA may not be
able to handle. Normally, CPC does not need to be run. For additional information,
contact a technical support representative.

To run Dialogic’s CPC Call Analysis:

1. Load the GENLOAD program by typing GENLOAD from the \CVR directory prompt,
then pressing <ENTER>.

2. Load the voice board driver by either typing D40DRV -H7 -I6C -G20 at the \CVR
prompt (where -H7 is the hardware interrupt level, -I6C is the software interrupt level,
and -G20 allocates storage for tone templates), then pressing <ENTER>, or by typing
D40 at the \CVR directory prompt, then pressing <ENTER>.
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To run CPC, you must have access to one extension from the telephone switch. This
extension cannot be in a hunt or rollover group or in use by any other person during
the call analysis process. Additionally, the Auto Answer, Call Forwarding, and Camp-
On features must be deactivated during the test.

3. To test the on-hook signal, type CPC -R10 -I(IRQ#) at the \CVR prompt, then
press <ENTER>. IRQ# represents the hardware interrupt level set on the voice board.

4. When prompted, enter the available extension number. CPC dials the extension 10
times as it identifies the ring signal. The phone must be on hook at the extension.
When the process is complete, the \CVR prompt displays. If the phone continues to
ring, lift the receiver and hang it up again.

5. To test busy, verify that the extension is busy by creating a talk path to another
phone. Dialing another number ensures that there is not a tone change or time-out on
the line. From the \CVR prompt, type CPC -B10 -I(IRQ#) then press <ENTER>.

6. When prompted, enter the extension number. CPC dials the extension 10 times to
listen for a busy signal. During this process, you do not hear any sounds.

7. When the process is complete, hang up the receiver. The \CVR prompt displays.
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Integrating with an Unterruptible Power Supply

During a power failure, the Octel 50 system files and the Octel 50 PC can be severely
damaged. Attaching an Uninterruptible Power Supply (UPS) provides protection against
failures of a relatively short duration. Note, however, if there is a major power failure that
exceeds the life of the UPS’s battery, the Octel 50 PC can lose power and the Octel 50
system and PC can be damaged.

UPS Integration enables the Octel 50 system to monitor the UPS’s status and recognize a
potential interruption in operation before it occurs. The UPS Integrator can shut down the
Octel 50 system to maintain system integrity, and then restart the Octel 50 system when
power returns.

The steps in this section help you:

• Understand UPS integration

• Run the UPS Integrator utility

A UPS is optional on the Octel 50 system. The UPS is not supplied nor is the UPS itself
supported by technical support.
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Understanding UPS Integration

Most UPS’s have three states of operation:

• Normal Operation–Power is on to the Octel 50 PC.

• Power Out–The UPS is supplying power to the Octel 50 PC.

• Low Battery–The UPS is still supplying power to the Octel 50 PC but the battery
is low.

 When you run the UPS Integration utility, the Octel 50 system learns how to recognize
these three states of operation.

 Once the UPS is integrated, if a power failure occurs, the UPS monitor recognizes that
the UPS is supplying power to the Octel 50, and normal operation continues. If the power
failure is lengthy, and the UPS reaches a Low Battery state, the Octel 50 UPS.EXE file
sends an error code to the RUNSMO3.BAT file that signals the system to automatically
perform a Force shutdown. All idle ports as well as occupied ports are disabled
immediately. This procedure prevents a shutdown with open files, which can cause data
corruption.

 Because the UPS monitor still runs after Octel 50 is shut down, UPS.EXE also monitors
for the restoration of power. Once power returns to the Octel 50 PC and the UPS
recognizes a normal operating state, UPS.EXE signals the RUNSMO3.BAT file to restart
the Octel 50 system. This minimizes Octel 50 system downtime.

 The following requirements must be met to run UPS integration:

• The UPS you use must have a serial port connection.

• A serial port on the Octel 50 PC must be dedicated to the UPS. The Octel 50
system configuration (modem, serial integration, mouse, etc.)  may require you to
purchase an additional serial port card.

• For the UPS utility to monitor the UPS, it must run in the background,
independent of the Octel 50 system. During Octel 50 system installation, you are
prompted, “Do you want the UPS monitor to load automatically upon boot up?”  If
you are going to run UPS integration during installation, answer Yes to load the
UPS.EXE file upon bootup. When auto-loaded, UPS.EXE is executed and stays
resident until the Octel 50 PC is rebooted.
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Running UPS Integration

To integrate the UPS with the Octel 50 system, you must rename one of a number of
sample UPS configuration files as UPS.CFG.

To use UPS Integration, the Octel 50 system must on the C:\ drive, as discussed in the
section Installing the Octel 50 Software. The system is installed on the C:\ drive on
systems purchased with the Octel 50 system preinstalled.

To integrate a UPS with Octel 50:

1. From the \CVR1 prompt, type UPSCFG then press <ENTER>. The following *.CFG
files are extracted:

TAESUNG.CFG TAESUNG Industries UPS 5500
PCMIGHT.CFG PC Might 35
VICTRON.CFG VICTRON MICRO UPS Series
MINMAN.CFG Minute Man
ALPHA.CFG Alpha
TRIPLITE.CFG TRIPLITE
APCTRIP.CFG American Power Conversion (with Triplite cable)
APC.CFG American Power Conversion (with APC cable)

2. From the \CVR1 prompt, select the file corresponding to the UPS you installed and
copy it to UPS.CFG. For example, to use the APC.CFG file, type COPY APC.CFG
UPS.CFG then press <ENTER>.

3. Open System Setup by selecting System Setup from the Options menu on the Octel
50 main window. The System Setup dialog box displays.

4. Under General Parameters, select Shutdown System After Daily Maintenance
(Parameter #7).

5. Under Uninterruptible Power Supply Parameters, select Enable UPS Integration
(Parameter #126).

6. If in step 5, the Enable UPS Integration parameter was previously disabled, you must
complete the following before continuing to step 7:

a. Select Save System Setup to save the new settings.

b. Select Exit to exit System Setup.

c. Open System Setup by selecting System Setup from the Options menu on the
Octel 50 main window. The System Setup dialog box displays.

7. Under Uninterruptible Power Supply Parameters, in the UPS COM Port field
(Parameter #127), enter the number of the COM port on the Octel 50 PC to which the
UPS is connected. It is suggested that you use COM1 for the UPS.

8. To return to the System Setup dialog box, select OK. The System Setup dialog box
displays.

9. To save System Setup, select Save System Setup.

10. To exit System Setup, select Exit.
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Setting Up the Fax Retrieval Utility

This section describes how to set up Octel 50’s fax retrieval feature, which allows the
Octel 50 system to automatically fax information to callers. Steps in this section help you:

• Understand fax retrieval

• Load documents onto the system

• Set up fax cover pages

• Activate fax retrieval
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Understanding Fax Retrieval

The fax retrieval feature is available as part of the Fax Solution optional add-on module.
Fax retrieval allows you to set up the system to automatically fax documents to callers
that request them from a V-Tree. With fax retrieval, people can call to request information
quickly and easily by selecting from documents provided on commonly requested topics.

For example, you can instruct a caller to press <1> for a fax on the company’s history,
<2> for a fax on product information, or <3> for a fax of the product order form. Or you
can set up fax retrieval to provide callers with fact sheets on any product in the company’s
catalog by simply prompting the caller to enter a certain number, such as the catalog part
number for the product.

Using procedures provided in this section, you can:

• Add fax retrieval documents to the system.

• Change the number of a fax retrieval document.

• Update a fax retrieval document.

• Set up a cover page for the fax documents.

Before you can use the fax retrieval feature, you must:

• Install and configure a fax board on the Octel 50 PC. For additional information
on configuring and installing fax boards, see Chapter 3, “Installing the Hardware.”

• Set up the system to use the fax retrieval options. For additional information on
enabling fax retrieval for the system, see Chapter 8, “Setting Up the System.”

• Install and set up the fax mail feature to use fax retrieval to fax into the system.

Fax Retrieval capabilities are provided to callers through Octel 50’s V-Tree feature. For
more information on creating a V-Tree that includes fax retrieval, see Chapter 11,
“V-Trees,” in the Supervisor’s Guide.

Adding Fax Retrieval Documents into the Brooktrout System

To add a fax document to the system:

1. From a fax machine, load the first document in the fax machine’s tray as though you
were faxing it, then dial the extension that connects to the system.

2. When the system answers, press <#> and log into the mailbox from which you want
to send fax documents. This mailbox must have fax send enabled in its assigned
class of service, so you can send faxes from the mailbox.

3. Press <3> from the Octel 50 Main menu to send a message. Enter the number of the
mailbox that will be storing the fax documents as the destination mailbox.  This
mailbox must have Fax Receive enabled in the class of service, and the Number of
Days to Save Saved Messages should be set to 99 in the class of service so the fax
documents are saved indefinitely.

4. When prompted, record a short message describing the contents of the fax you are
sending, then press <#> to end the recording. Note that this message is only used to
help you identify fax documents. The message is not voiced to callers.

5. From the Delivery Options menu, press <5> to attach a fax to the message.
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6. When prompted, press the <Start> button on your fax machine and hang up. The fax
is sent to the mailbox.

7. From any extension, log into the mailbox to which you sent the fax document.

8. Listen to the first message, then press <6><2> for Message Information. The system
voices an 8-digit fax number.

9. Record this number along with a description of the fax. This 8-digit number
represents the fax document number and filename of the fax, which is what the
system uses to retrieve the fax for a V-Tree.

10. Repeat  steps 1 through 9 until you have sent all of the faxes to the destination
mailbox, then log out of the mailbox.

Do not specify the extra zeroes to the left of the fax document number when indicating
fax document numbers in V-Trees. These extra zeroes are added by the system to
create files with 8-digit filenames. A caller or the V-Tree creator does not need to enter
these zeroes when specifying a fax.

11. Log out of the mailbox. You can now assign fax retrieval actions to options on a
V-Tree using the fax document numbers.

Changing a Fax Retrieval Document Number

Use this procedure to change the fax document number to a number you specify. For
example, you can use this procedure to change the fax document numbers to match the
catalog numbers of products, enabling customers to receive a fax on a product by
entering the product’s catalog number while using a V-Tree.

To change a fax document number:

1. Identify the directory where the fax document file is stored on the system by recording
the last digit of the fax document number. This number indicates the last number of
the fax directories on the system.

 For example, if the fax document number is 00001005, the last digit of the fax
document number is 5, and the file is stored in the \FAX05 directory as 00001005.TIF.

2. Select Command Line Interface from the Display menu.

3. To change the number of the fax retrieval document, at the \CVR directory prompt,
type COPY \FAX0A\XXXXXXXA.TIF \FAX0B\YYYYYYYB.TIF and press
<ENTER>, where A is the last digit of the original fax document number, X is the
original fax number, B is the fax directory where you want to store the changed fax,
and Y is the new fax document number.

 For example, if you want to change the fax document numbered 00001005 to
00023456, from the \CVR directory prompt, type COPY \FAX05\00001005.TIF
\FAX06\00023456.TIF and press <ENTER>. Filenames must be 8 characters in
length. If the filename is not 8 characters, it must be left-filled with zeros to fill 8
characters.

Do not specify the extra zeroes to the left of the fax document number when
indicating fax document numbers in V-Trees. These extra zeroes are added by the
system to create files with 8-digit filenames. A caller or the V-Tree creator does not
need to enter these zeroes when specifying a fax.
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4. Press <ENTER>. The system changes the fax document number to the entered
number.

Setting Up a Header or Footer Page for the Brooktrout Board

Use this procedure to set up the system to automatically fax a cover page with every
document. The cover page displays the number the caller entered as the destination for
the fax and the caller’s extension, if one was entered.

To set up a header or footer page:

1. Verify that the Use a Fax Cover Sheet option is enabled in System Setup. A cover
page is now automatically sent with each fax.

2. If you want to add a logo or header to the top of the cover page, fax the logo or
header into the system, change the name of the fax document to HEADER.TIF, and
save it in the \CVR1 directory.

Regardless of the size and contents of the header and footer files, the system always
prints the information bar immediately after the header.

3. If you want to add a footer or logo to the bottom of the cover page, fax the logo or
footer into the system, change the name of the fax document to FOOTER.TIF, and
save it in the \CVR1 directory.

Activating Fax Retrieval

To activate fax retrieval:

1. Start Octel 50 if it is not already running.

2. Select System Setup from the Options menu. System Setup dialog box displays.

3. Select Change System Setup.

4. Under Fax Parameters, verify that Fax Board Type is not set to None.

5. Under Fax Parameters, verify that V-Tree Fax Retrieval is enabled.

6. Under Fax Parameters, verify that Use a Fax Cover Sheet is enabled.

7. Under Fax Parameters, verify that the Number of Attempts when Sending a Fax is not
set to 0.

8. Press <ESC>. The System Setup dialog box displays.

9. Select Exit. The Octel 50 main window displays.
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S E C T I O N  1 2

Maintaining the System

This section discusses procedures you can use to properly maintain the Octel 50 system.
It includes information on several utilities included with Octel 50 that help you maintain
Octel 50 files and rebuild files in the event they suffer damage due to problems with the
computer system.

For more information on exactly under what conditions you should use each utility, contact
a technical support representative.

The steps in this section help you:

• Shut down and start the Octel 50 system

• Add additional boards to the system

• Use the Quick Assist utility

• Use the Log File utility

• Understand the Automatic Data Recovery utility

Procedures in this section assume that the hard drive on which the Octel 50 system is
installed is drive C: and the disk drive is A:. Drive designations on the specific PC on
which you are working may vary. Confirm the appropriate drive letters when necessary in
procedures provided in this section.
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Starting and Shutting Down Octel 50

Use the following procedures to start and shut down Octel 50.

Starting Octel 50

Use the following procedure to start Octel 50 from the \CVR prompt. Remember that you
can also start the system by pressing <1> to select Run Octel 50 from the menu that
displays when you turn on or reboot the PC.

To start Octel 50

1. From the C:\ prompt, type CD CVR and press <ENTER>. The \CVR directory
prompt displays.

2. Load the voice drivers, if they are not already loaded:

a. For Dialogic systems, from the \CVR prompt, type D40 and press <ENTER>.

b. For Rhetorex systems, from the \CVR prompt, type RHETDRV and press
<ENTER>.

3. Once the voice drivers are loaded, from the \CVR directory prompt, type RUNSMO3
and press <ENTER>. The Octel 50 main window displays.

Shutting Down Octel 50

To shut down Octel 50:

1. From the Octel 50 main screen, select Exit from the File menu. A dialog box prompts
you to confirm you want to shut down the Octel 50 system.

2. To proceed with the shutdown, press <Y>. The Octel 50 system shuts down and the
DOS prompt displays.

Adding Additional Boards to the System

Use the following procedures to add additional voice boards to the Octel 50 system after
installation.

Adding Rhetorex Boards

To add a new Rhetorex board:

1. Configure the board’s I/O address according to the address information in the
Installing the Hardware section.

2. From the \CVR prompt, type CONFIGUR and press <ENTER> to start the
Configure utility.

3. For each board you are installing, add 64 to the value in the RealMemory field.

4. Enter the new board’s address in the Ports box.

5. To save the configuration and exit the Configure utility, press <F10>.
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Adding Dialogic Boards

To add a new Dialogic board:

1. Configure the SW1 settings on the board according to the information provided in the
Installing the Hardware section.

2. From the \CVR directory prompt, type EDIT DIALOGIC.CFG and press
<ENTER>. A DOS editor window displays the contents of the DIALOGIC.CFG file.

3. Add an additional line for each new board you are installing, changing the address
value (ADDR) on each line to match the board’s shared memory address, set on
SW1. For more information, see Chapter 3, “Installing the Hardware.”

4. Save the changes and exit the DOS editor.

5. From the \CVR directory prompt, type EDIT D40.BAT and press <ENTER>. A
DOS editor window displays the contents of the D40.BAT file. Change the value next
to the -b parameter to add 64 for each new board.

6. Save the changes and exit the DOS editor.

Using Quick Assist

The Octel 50 system includes a file maintenance program called Quick Assist that
enables you to verify system file integrity and recover files in the \CVR1 directory, the
REC00 through REC09 directories, and the FAX00 through FAX09 directories.

Using Quick Assist, you can:

• Verify and recover Octel 50 system files

• Run Quick Assist as part of routine Octel 50 system maintenance

 Quick Assist allows you to verify Octel 50 system file integrity and, as necessary, rebuild
certain Octel 50 files if they become damaged. Recoverable files are those that contain
important Octel 50 site-specific information concerning Octel 50 system mailboxes,
subscriber greetings and messages, and supervisor prompts.

 Use Quick Assist any time you want to check site-specific Octel 50 system file integrity or
when you suspect file damage. There are four recovery mode options based on problem
severity:

• Verify

• Update partial

• Update all boxes

• Rebuild all boxes

 It is recommended that you always run the verify feature first to ensure that an update or
rebuild is warranted.
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 Verifying Octel 50 File Integrity

 The verify feature allows you to ensure the integrity of the site-specific Octel 50 system
files. When you run Quick Assist Verify, the system searches the Octel 50 system’s
\CVR1 directory to verify that:

• All messages and greetings indexed to Octel 50 system mailboxes actually exist
in the appropriate \REC0n and FAX0n directories

• System prompts, distribution lists, and scheduled events are accessible

• Mailboxes specified in the Attendant Menu dialog box exist on the Octel 50
system

When you select Verify, the \CVR1 directory is first copied into a directory named
\~REPAIR~. Although the files in this directory are not necessary for Octel 50 execution,
they should not be deleted until you are confident that any corruption errors have been
corrected.

Once the Verify procedure is completed, review the report named QASSIST.RPT in the
\CVR1 directory. If errors or warnings were detected during the Verify procedure, the
appropriate corrective action is suggested in the report file.

To verify Octel 50 system file integrity:

1. Shut down the Octel 50 system if it is currently running.

2. From the \CVR prompt, type QASSIST and press <ENTER>. The Quick Assist
dialog box displays.

 
3. Select Recover Files. The Recover Options dialog box displays.

 

4. Under Options Select, select the Verify option.
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5. Under Options Information, in the Drive field, enter the drive on the Octel 50 PC
where the \CVR1 directory is located.

6. Under Report Information, select the Disk option if you want to create a report file.
When you select this option, the system creates a report with the specified filename in
the \CVR1 directory. Select Printer if you want to send the report to the printer
attached to the Octel 50 PC. Do not select the Printer option if there is not a printer
attached to the PC.

7. Under Report Information, enter the name of the report you want the system to
generate, if you do not want to accept the default QASSIST.RPT.

8. To begin the verification, select Start. The Recover Status dialog box displays.

 The system copies the files in the \CVR1 directory into a directory named \~REPAIR~.
Do not delete the files from the \~REPAIR~ directory until you are confident the
system has corrected any file damage.

 The Searching Directory and Processing Mailbox fields display the directory and
mailbox currently being verified. The Errors and Warnings fields reflect the respective
number of errors and warnings the system encounters during verification.

9. When verify is complete, select View Report to display the report. If the system
detected errors or warnings during verification, the appropriate corrective action is
suggested in the report.

10. To close the report window, select continue. The Recover Status dialog box displays.

11. To close the Recover Status dialog box, select OK. The Recover Options dialog box
displays.

12. To close the Recover Options dialog box, select Cancel. The Quick Assist dialog box
displays.

13. To close Quick Assist, select Quit from the Quick Assist dialog box.

Running a Partial Mailbox Update

The Update (partial) recover feature allows you to update only those mailboxes that may
be corrupt and to locate unattached messages. When you run Quick Assist in update
partial mode, the system:

• Deletes and rebuilds the index file used for reports by name, search lists, and
directories for Octel 50 mailboxes

• Verifies distribution lists and V-Trees

• Verifies that mailboxes specified in the Attendant Menu dialog box exist on the
Octel 50 system

• Creates mailboxes that do not currently exist but that have messages or
greetings indexed to them

• Re-establishes links that have been broken between subscriber greetings and
mailboxes

• Resets subscriber settings for mailboxes, such as extension number and
personal operator, to default values if the mailbox setting information is damaged

• Resets message delivery entries to the defaults if the mailbox setting information
is damaged
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• Scans the \REC0n directories and indexes messages and greetings that are not
already indexed to a mailbox; these messages, as well as comments formerly
attached to the messages, become new individual messages in the mailbox;
unattached messages are assigned to a default mailbox you specify, unless you
choose to have the system delete them

To perform a partial Octel 50 system mailbox update:

1. Shut down the Octel 50 system if it is currently running.

2. From the \CVR prompt, type QASSIST and press <ENTER>. The Quick Assist
dialog box displays.

 

3. Select Recover Files. The Recover Options dialog box displays.

 

4. Under Options Select, select the Update (partial) option.

5. Under Options Information, in the Drive field, enter the drive on the Octel 50 PC
where the \CVR1 directory is located.

6. Under Options Information, in the Default Box field, enter the mailbox in which you
want the system to place messages with invalid header information. Unattached
messages with valid header information are placed in the new message queue of the
receiving mailbox.

7. Under Options Information, select the Verify Before Create option if you want the
system to prompt you for confirmation before it creates mailboxes. The system
creates mailboxes when it finds messages or greetings that are linked to a mailbox
number that does not exist. If you deselect this option, the system automatically
creates the mailboxes indicated by the message or greeting links.

8. Under Options Information, select the Delete Unattached Msg option if you want the
system to automatically delete unattached messages. If you deselect this option,
unattached messages are placed in the mailbox specified in step 6.
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9. Under Report Information, select the Disk option if you want to create a report file.
When you select this option, the system creates a report with the specified filename in
the \CVR1 directory. Select Printer if you want to send the report to the printer
attached to the Octel 50 PC. Do not select the Printer option if there is not a printer
attached to the PC.

10. Under Report Information, enter the name of the report you want the system to
generate, if you do not want to accept the default QASSIST.RPT.

11. To begin the update, select Start. The Recover Status dialog box displays.

 The system copies the files in the \CVR1 directory into a directory named \~REPAIR~.
Do not delete the files from the \~REPAIR~ directory until you are confident the
system has corrected any file damage.

 The Searching Directory and Processing Mailbox fields display the directory and
mailbox currently being verified. The Errors and Warnings fields reflect the respective
number of errors and warnings the system encounters during verification.

12. When the update is complete, you can update specific information for each mailbox.
To do this, select Mailboxes from the Recover Status dialog box. The Mailbox Edit
dialog box displays.

13. On the Mailbox Edit dialog box, you can enter the extension number, mailbox owner’s
name, company, department, and Personal Operator. Use the Next and Previous
buttons to view a dialog box and enter information for each recovered mailbox. Use
the <Tab> and up and down arrow keys to move about each dialog box.

14. Select OK to close the Mailbox Edit dialog box. The Recover Status dialog box
displays.

15. Select View Report to display the report. If the system detected errors or warnings
during verification, the appropriate corrective action is suggested in the report.

16. To close the report window, select Continue. The Recover Status dialog box displays.

17. To close the Recover Status dialog box, select OK. The Recover Options dialog box
displays.

18. To close the Recover Options dialog box, select Cancel.

19. To close Quick Assist, select Quit from the Quick Assist dialog box.

Running an Update on All Mailboxes

The Update (all boxes) recover feature allows you to update all Octel 50 system
mailboxes.

Use this feature only when recommended during Verify and only under the guidance of a
technical support representative.

When you run Quick Assist in update all boxes mode, the system:

• Deletes and rebuilds the index file used for reports by name, search lists, and
directories for Octel 50 mailboxes

• Verifies distribution lists and V-Trees

• Creates mailboxes that do not currently exist but that have messages or
greetings indexed to them
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• Re-establishes links that have been broken between subscriber greetings and
mailboxes

• Resets subscriber settings for mailboxes, such as extension number and
personal operator, to default values if the mailbox setting information is damaged

• Attempts to re-index all scheduled outbound network messages

• Deletes non-network outbound events (message delivery, message waiting lights)
and message confirmation data

To perform an update on all Octel 50 system mailboxes:

1. Shut down the Octel 50 system if it is currently running.

2. From the \CVR prompt, type QASSIST and press <ENTER>. The Quick Assist
dialog box displays.

 

3. Select Recover Files. The Recover Options dialog box displays.

 

4. Under Options Select, select the Update (all boxes) option.

5. Under Options Information, in the Drive field, enter the drive on the Octel 50 PC
where the \CVR1 directory is located.

6. Under Options Information, in the Default Box field, enter the mailbox in which you
want the system to place messages with invalid header information.

7. Under Options Information, select the Verify Before Create option if you want the
system to prompt you for confirmation before it creates mailboxes. The system
creates mailboxes when it finds messages or greetings that are linked to a mailbox
number that does not exist. If you deselect this option, the system automatically
creates the mailboxes indicated by the message or greeting links.
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8. Under Options Information, select the Delete Unattached Msg option if you want the
system to automatically delete unattached messages. If you deselect this option,
unattached messages are placed in the mailbox specified in step 6.

9. Under Report Information, select the Disk option if you want to create a report file.
When you select this option, the system creates a report with the specified filename in
the \CVR1 directory. Select Printer if you want to send the report to the printer
attached to the Octel 50 PC. Do not select the Printer option if there is not a printer
attached to the PC.

10. Under Report Information, enter the name of the report you want the system to
generate, if you do not want to accept the default QASSIST.RPT.

11. To begin the update, select Start. The system prompts you to confirm that you want to
continue.

12. Select Yes to continue. The Recover Status dialog box displays.

The system copies the files in the \CVR1 directory into a directory named \~REPAIR~.
Do not delete the files from the \~REPAIR~ directory until you are confident the
system has corrected any file damage.

The Searching Directory and Processing Mailbox fields display the directory and
mailbox currently being verified. The Errors and Warnings fields reflect the respective
number of errors and warnings the system encounters during verification.

13. When the update is complete, you can update specific information for each mailbox.
To do this, select Mailboxes from the Recover Status dialog box. The Mailbox Entry
dialog box displays.

14. On the Mailbox Edit dialog box, you can enter the extension number, mailbox owner’s
name, company, department, and Personal Operator. Use the Next and Previous
buttons to view a dialog box and enter information for each recovered mailbox. Use
the <TAB> and up and down arrow keys to move about each dialog box.

15. Select OK to close the Mailbox Entry dialog box. The Recover Status dialog box
displays.

16. Select View Report to display the report. If the system detected errors or warnings
during verification, the appropriate corrective action is suggested in the report.

17. To close the report window, select Continue. The Recover Status dialog box displays.

18. To close the Recover Status dialog box, select OK. The Recover Options dialog box
displays.

19. To close the Recover Options dialog box, select Cancel.

20. To close Quick Assist, select Quit from the Quick Assist dialog box.



Installation Overview Using Quick Assist

Octel 50 Installation Guide 12-10

Rebuilding All Mailboxes

The Rebuild (all boxes) recover feature allows you to rebuild all Octel 50 system
mailboxes.

Use this feature only if the system encounters a problem during an update and only under
the guidance of a technical support representative.

When you run Quick Assist in rebuild all boxes mode, the system:

• Deletes all Octel 50 system mailboxes; you cannot select individual mailboxes for
rebuilding

• Searches the \REC0n directories for messages and greetings

• Rebuilds those mailboxes for which at least one message or greeting is found in
the REC0n directories; the system does not rebuild mailboxes that have no
messages or greetings indexed to them

 If possible, the system restores the following information to the rebuilt mailboxes:

• Greetings–Name prompt, directory prompt, optional prompts, personal greeting

• Mailbox information–First and last name, extension, company, division, class of
service number or custom class of service, personal operator

• Mailbox settings–Active call handling options, message delivery entries, V-Tree,
folders

 If the system cannot restore this information, it returns the mailboxes to the defaults, and
you must manually edit the mailboxes to reenter the settings.

 Messages are affected as follows:

• All message pointers are re-indexed and placed in their respective mailboxes’
new message queue

• Messages sent to a distribution list are only retained in the first recipient’s mailbox

• Messages that were copies of messages sent from another subscriber are not
replaced

• Comments attached to messages are treated as separate messages

• All scheduled outbound network messages are re-indexed

 The following information is not restored during a rebuild all operation:

• Outbound events other than network messages, such as message delivery
events and message waiting light events

• Distribution lists

• Message confirmation data
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To rebuild all Octel 50 system mailboxes:

1. Shut down the Octel 50 system if it is currently running.

2. From the \CVR prompt, type QASSIST and press <ENTER>. The Quick Assist
dialog box displays.

 

3. Select Recover Files. The Recover Options dialog box displays.

 

4. Under Options Select, select the Rebuild (all boxes) option.

5. Under Options Information, in the Drive field, enter the drive on the Octel 50 PC
where the \CVR1 directory is located.

6. Under Options Information, in the Default Box field, enter the mailbox in which you
want the system to place messages with invalid header information.

7. Under Options Information, select the Verify Before Create option if you want the
system to prompt you for confirmation before it creates mailboxes. The system
creates mailboxes when it finds messages or greetings that are linked to a mailbox
number that does not exist. If you deselect this option, the system automatically
creates the mailboxes indicated by the message or greeting links.

8. Under Options Information, select the Delete Unattached Msg option if you want the
system to automatically delete unattached messages. If you deselect this option,
unattached messages are placed in the mailbox specified in step 6.

9. Under Report Information, select the Disk option if you want to create a report file.
When you select this option, the system creates a report with the specified filename in
the \CVR1 directory. Select Printer if you want to send the report to the printer
attached to the Octel 50 PC. Do not select the Printer option if there is not a printer
attached to the PC.

10. Under Report Information, enter the name of the report you want the system to
generate, if you do not want to accept the default QASSIST.RPT.
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11. To begin the rebuild, select Start. The system prompts you to confirm that you want to
continue.

12. Select Yes to continue. The Recover Status dialog box displays.

 The system copies the files in the \CVR1 directory into a directory named \~REPAIR~.
Do not delete the files from the \~REPAIR~ directory until you are confident the
system has corrected any file damage.

 The Searching Directory and Processing Mailbox fields display the directory and
mailbox currently being verified. The Errors and Warnings fields reflect the respective
number of errors and warnings the system encounters during verification.

13. When the update is complete, you can update specific information for each mailbox.
To do this, select Mailboxes from the Recover Status dialog box. The Mailbox Entry
dialog box displays.

14. On the Mailbox Edit dialog box, you can enter the extension number, mailbox owner’s
name, company, department, and Personal Operator. Use the Next and Previous
buttons to view a dialog box and enter information for each recovered mailbox. Use
the <TAB> and up and down arrow keys to move about each dialog box.

15. Select OK to close the Mailbox Entry dialog box. The Recover Status dialog box
displays.

16. Select View Report to display the report. If the system detected errors or warnings
during verification, the appropriate corrective action is suggested in the report.

17. To close the report window, select Continue. The Recover Status dialog box displays.

18. To close the Recover Status dialog box, select OK. The Recover Options dialog box
displays.

19. To close the Recover Options dialog box, select Cancel.

20. To close Quick Assist, select Quit from the Quick Assist dialog box.

Running Quick Assist as Part of Routine Octel 50 Maintenance

Quick Assist has been placed in the AUTOEXEC.BAT to correct any corruption problems
that may have been caused by a power failure or any other abnormal program
termination. You can edit the Quick Assist command line in this file to indicate one of the
following file repair methods:

/b0 Indicates Verify
/b1 Indicates Update (Partial)
/b2 Indicates Update (All Boxes)
/b3 Indicates Rebuild (All Boxes)

When used in a batch file, Quick Assist checks the OPERATOR.CKP file to determine if a
power failure has occurred. If no power failure was detected, the Quick Assist utility
terminates. However, if a power failure was detected, the DOS CHKDSK program is run,
followed by the specified file repair method of the Quick Assist utility. You may use the /I
option to ignore the OPERATOR.CKP file; that is, run Quick Assist even if there was no
power outage.

The best option for using Quick Assist in the AUTOEXEC.BAT file is to use the Update
(Partial) procedure since this option only affects the mailboxes and associated messages
that appear to be corrupt. You can add /D to the command line to delete the unattached
messages. To do this, edit the AUTOEXEC.BAT file and insert the command immediately
before the line that executes the voice board driver. The Installation program places the
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recommended QASSIST/B1/D in the AUTOEXEC.BAT file. When executed from the
command line, Quick Assist directs all logging details to the OPERATOR.LOG file in the
\CVR1 directory.

Using the Log File Utility

To ensure proper Octel 50 maintenance, a log file utility is called in the AUTOEXEC.BAT
file to automatically compress and archive the Octel 50 system’s OPERATOR.LOG file.
When the OPERATOR.LOG file has grown beyond a specified size (default is 1
megabyte), the log utility compresses the log and renames it to \CVR1\OPERATOR.1.
LOGUTIL.EXE automatically runs each time the Octel 50 system is rebooted.

The system renames the existing \CVR1\OPERATOR.1 to \CVR1\OPERATOR.2,
renames the \CVR1\OPERATOR.2 to \CVR1\OPERATOR.3, and so on up to
\CVR1\OPERATOR.5. The existing OPERATOR.5 file is deleted.

You can add the following parameters to the log file utility command line in the
AUTOEXEC.BAT file:

Parameter Description

Sn Where n is the number of megabytes to which the log file may
grow before being compressed and archived. Default = 1

D Instructs Octel 50 to delete OPERATOR.LOG instead of
compressing and archiving the log.

Un Where n is the extension of the archived compressed log file
to uncompress. Valid range = 1 to 5

Fn Where n is the filename given to the uncompressed archive
log file. Default = ARCHIVE.TXT

A Instructs the log file utility to automatically compress and
archive the AUDIT.LOG file, which logs AMIS related activity.

Understanding the Automatic Data Recovery Utility

The Automatic Data Recovery utility helps prevent the loss of messages and other Octel
50 system data that could result from an unprotected loss of power that causes an
abnormal system shutdown.

You must enable the Shutdown System after Daily Maintenance parameter on the
General Parameters tab in System Setup to use this utility.

The Automatic Data Recovery utility performs the following functions:

• During the system shutdown after daily maintenance, a backup of the contents of
the \CVR1 directory is created in the \CVR1\BACKUP directory.

• If a power failure (or other abnormal system shutdown is detected), the utility
backs up the existing \CVR1 directory, which may have become corrupt, and
stores it in the \CVR1\OLD_DB directory.

• Once the existing \CVR1 is backed up, the contents of the \CVR1\BACKUP
directory replaces the files in the \CVR1 directory.
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• Once the \CVR1 directory has been replaced with the backed up files, the Quick
Assist utility is run in Update All mode. This reattaches all messages to their
destination mailbox. For more information on running Quick Assist in Update All
mode, see the topic, “Running an Update on All Mailboxes,” earlier in this
chapter.

Any changes made to the system since the last shutdown after daily maintenance,
excluding prompts and voice/fax message sending and receipt, are lost.

Protecting Your System

Voice messaging toll fraud has risen dramatically in recent years. Now more than ever, it
is imperative that you take steps to secure your system. Callers into the voice
messaging/automated attendant system may transfer to an outgoing trunk if adequate
security measures are not implemented. Callers who have unauthorized access to a voice
mailbox can use it as a message drop for communications at your expense on your 800
numbers. Securing your system means protecting the switch, protecting the voice
messaging system, and protecting any automated attendant applications.

Please review and implement, as appropriate, the following security measures to:

• Prevent callers from transferring to extensions not assigned system mailboxes

• Impede callers from gaining access to the Quick Assist maintenance mailbox

• Require passwords at least one digit longer than mailbox numbers

• Require subscribers to regularly change their passwords

• Use extended password security

• Have subscribers record their Name prompts

• Delete unused mailboxes immediately

• Secure the system PC

• Utilize phone system security features

• Use supervisor passwords to restrict system management access

• Logoff from the system when not using it to restrict system management access

It is recommended that these security features be reviewed and implemented as
appropriate. A Security Checklist is provided at the end of the this section to help you
implement these features.

Preventing Callers from Transferring to Extensions Not
Assigned System Mailboxes

On some phone systems, callers can transfer to a system extension and then use that
extension to access an outside line. This is most relevant for system ports used for
outcalls for networking or message notification to a beeper. By preventing callers from
accessing system extensions not assigned system mailboxes, you can substantially
reduce the risk of outside callers accessing an outside line.

The General Transfer parameters in System Setup can prevent callers from accessing
non-assigned extensions for this purpose:

• Transfer Invalid Mailboxes During Business Hours

• Transfer Invalid Mailboxes After Business Hours
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When these parameters are disabled, callers dialing an extension that has not been
assigned a mailbox hear, “<Mailbox number> is an invalid extension number. Please
enter the extension number of the person you would like to speak with.”

It is recommended that these parameters are disabled. For additional information on
these parameters, see Chapter 8, “Setting Up the System.”

Impeding Callers from Accessing the Quick Assist Maintenance
Mailbox

When you run Quick Assist in a recover mode, the system can automatically assign
messages with invalid header information to a default mailbox. This allows the system
manager to then copy the messages to the correct subscriber mailbox. The default for
this maintenance mailbox is the last mailbox number available on the system. For
example, on a system with four-digit mailboxes, mailbox 9999 is used.

Since it is easier for an outside caller attempting to gain unauthorized mailbox access to
guess a mailbox number such as 9999, it is recommended that you specify a system
mailbox in which you want unattached messages to be placed. In addition, it is strongly
recommended that this mailbox be assigned a long password that cannot easily be
guessed by an outside caller attempting to access the system.

When you run Quick Assist in recover mode from the Quick Assist icon in the program
folder, use the Mailbox to Receive Unattached Messages field on the Recover Files dialog
box to specify a mailbox in which to place messages with invalid header information.

For additional information on using Quick Assist, see the topic, "Using Quick Assist,"
earlier in this chapter.

Requiring Passwords at Least One Digit Longer than Mailbox
Numbers

The longer the passwords assigned to system mailboxes, the harder it is for a caller to
guess them. The Minimum Length of Password parameter under the General parameters
in System Setup allows you to set the least number of digits required in a mailbox
password. It is recommended that you set this parameter at least one digit higher than the
length of the system’s mailbox numbers. For example, if the system uses four-digit
mailboxes, it is recommended that the Minimum Length of Password parameter be set to
at least 5. Remember when setting this parameter to balance system security against
ease of use for the subscribers. Setting this parameter too high may make it difficult for
system subscribers to remember their passwords.

For additional information on using this parameter, see Chapter 8, “Setting Up the
System.”

Encouraging Subscribers to Regularly Change Their Passwords

Encouraging subscribers to regularly change their passwords helps prevent outside
callers from determining subscriber passwords and gaining unauthorized access to
system mailboxes.

Using Extended Password Security

Extended password security requires subscribers to press <#> after entering their
passwords to access their mailboxes. If subscribers do not press <#>, the system pauses
before allowing mailbox access. The Enable Extended Password Security parameter
under Subscriber parameters in System Setup determines whether the system waits for
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the subscriber to press <#> or allows immediate mailbox access after successful
password entry.

This parameter helps prevent unauthorized users from determining the number of digits in
system mailbox passwords.

It is recommended that this feature be enabled. For additional information on using this
parameter, see Chapter 8, “Setting Up the System.”

Having Subscribers Record Their Name Prompts

When subscribers record their Name prompts, those prompts are voiced as confirmation
to callers sending messages to system mailboxes. This ensures that messages will be
sent to the correct mailboxes. If a Name prompt is not recorded for a subscriber mailbox,
only the mailbox number is voiced to callers sending messages to that mailbox.

Deleting Unused Mailboxes Immediately

If a mailbox is no longer being used, it is recommended that you immediately delete that
mailbox from the system. This prevents anyone from gaining unauthorized system access
through the mailbox. If a mailbox is being reassigned to a new mailbox owner, it is
strongly recommended that you delete, then re-create the mailbox.

For additional information on deleting system mailboxes, see the topic, "Delete a
Mailbox," in Chapter 3, “The Mailbox Menu,” in the Supervisor’s Guide.

Securing the System PC

It is very important the system PC be protected from unauthorized system management
access. Unauthorized access to the system PC could result in system setup changes,
loss of mailboxes and messages, and database corruption. The best way to prevent
unauthorized system management access to the system PC is to store the PC in a secure
area, such as a locked room.

If you cannot store the system PC in a secure area, consider using security features of
the PC, such as passwords, to provide a degree of protection. See the PC documentation
for information on available security features.

Before implementing security features on the PC, contact a technical support
representative to review the security features you intend to use to ensure they will not
disrupt system performance in any way.

Utilizing Phone System Security Features

Most phone systems have security features that help prevent unauthorized access to
system ports. Contact your phone system representative to determine what security
features are available and how to implement them.

Before implementing security features on the phone system, contact a technical support
representative to review the security features you intend to use to ensure they will not
disrupt system performance in any way.
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Using Supervisor Passwords to Restrict System Management
Access

Access to system management features is password-protected. There are two levels of
system manager passwords. Level 2 access allows a system manager to create, edit, and
delete mailboxes; to access reports and system statistics; to create and specify prompts;
maintain network nodes; and to create V-Trees. Level 3 access allows a system manager
to perform all Level 2 tasks, to set system parameters using the System Setup utility, to
configure greeting by port, to modify classes of service, and to configure multilingual
systems.

It is recommended that you use at least a six-digit password for both the Level 2 and
Level 3 passwords. The longer the Level 2 and Level 3 passwords, the more difficult it is
for someone to guess them. It is also recommended that the supervisor passwords be
changed on a regular basis to further protect against unauthorized system manager
access.

When giving the Level 2 or Level 3 password to system managers, keep in mind that the
more people who have a password, the greater the possibility for problems to occur.
There should be more than one individual who knows the passwords for the system,
however, so when one system manager is away from the office, another is available to
maintain the system.

For additional information on supervisor passwords, see Chapter 2, “The File Menu,” in
the Supervisor’s Guide.

Logging Off from the System When Not Using It to Restrict
System Management Access

It is recommended that you always logoff from the Octel 50 system when not using it. This
helps prevent unauthorized access to system manager functions.

For additional information on logging into the system, see Chapter 2, “The File Menu,” in
the Supervisor’s Guide.

Remote Access

Use the following guidelines to secure remote access to the system:

• The remote access software that you install and use should be configured to require a
password to gain access to the system.

• The passwords should be periodically changed. Make sure you notify the appropriate
individuals or organizations each time you change the passwords.

• The modem connected to the system should be disabled when it is not required for
use by authorized personnel. The connection should be enabled only by the system
administrator on an “as needed” basis.



Installation Overview Protecting Your System

Octel 50 Installation Guide 12-18

Security Checklist

It is recommended that the following checklist to be used to ensure that the security measures listed
below are implemented, as appropriate, on the messaging system.

_____1. (Required) Store the messaging system PC in a secure area.

_____2. (Required - Toll Fraud) Disable the Transfer Invalid Mailboxes During Hours and Transfer
Invalid Mailboxes After Hours parameters on the Invalid Mailbox tab in System Setup.

_____3. (Recommended) When Quick Assist is run in recover mode from the Quick Assist icon in the
program folder, specify a Mailbox to Receive Unattached Messages on the  Recover Files
dialog box.

_____4. (Required) Set the Minimum Length of Password parameter on the Subscriber tab in System
Setup at least 1 digit higher than the number of digits system mailboxes.

_____5. (Recommended) Activate the Enable Password Security parameter on the Subscriber tab in
System Setup to require subscribers to press <#> after they finish entering their passwords.

_____6. (Recommended) Require that  subscribers  record their Name prompts so that the system
voices the mailbox owner’s name to callers sending messages to messaging system
mailboxes.

_____7.  (Required) Use at least 6-digit level 2 and level 3 supervisor passwords to prevent
unauthorized system manager access.

_____8. (Recommended) Write down level 2 and level 3 passwords and keep them in a secure place.

_____9. (Recommended) Notify the local service provider of any changes to level 2 or level 3
supervisor passwords in case remote maintenance is required.

_____10. (Required) Contact the system representative to determine what security features are
available for the phone system and how to implement them. Before implementing any security
features on the phone system, contact a technical support representative to ensure that the
features you want to implement will not disrupt messaging system performance in any way.

_____11. (Recommended) Logoff from the Octel 50 system when not using it to help prevent
unauthorized access to management features.

_____12. (Required) All remote access logins to the system must be administered to require the use of
a secondary password.

_____13. (Required) The end-user must periodically/frequently change all secondary passwords. After
changing the secondary  passwords, the end-user should notify the appropriate support
organization(s) that the passwords have been changed.

_____14. (Required) The modem connection to the system should be “disabled” when it is not required
for use by authorized personnel. This connection should be enabled only by the system
administrator on an “as needed” basis.
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S E C T I O N  1 3

Testing and Troubleshooting the Octel 50 System

After you install and set up the Octel 50 system, test the integration with the phone
system and the Octel 50 software features to ensure the entire system works as it should.
The topics included in this section help you:

• Test the Octel 50 system to ensure it is correctly installed and configured

• Troubleshoot possible program problems you may encounter

• Understand call flow conditions

• Determine a switch’s disconnect signal

• Display the features enabled on the system’s sentinel

• Use the command line interface

Some information provided in this section is highly technical. Your level of knowledge on
general telephony and the switch being used and your access to tools such as digit
grabbers will dictate how effectively you can interpret some of the information. If you have
questions, be sure to contact a technical support representative.
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Testing and Troubleshooting Octel 50

Once you install and set up Octel 50 and optional Octel 50 add-on modules at the
customer site, it is essential that you test the software to ensure it is correctly configured
and functioning as intended. To thoroughly test the software, you must exercise all
automated attendant and voice/fax mail features to confirm that all calls handled by the
system are properly answered, routed, and messaged.

This section provides a test plan you can use to help you exercise system features and
options and confirm they are functioning appropriately. Depending on the features used
for individual applications of the Octel 50 system, you may not need to complete every
part of the test plan. For your convenience, the test plan is separated into two parts. The
first part covers basic integration, system greeting, and messaging functionality. The
second part covers the special features available on Octel 50, such as call queuing, call
screening, and V-Trees.

If, while performing the steps outlined in this test plan, you encounter unexpected results,
see the troubleshooting table later in this chapter for information that may help you
resolve the issue. The troubleshooting table is organized alphabetically by problem area in
a format that describes possible problems and potential resolutions.

This section also includes troubleshooting procedures to help you to confirm Octel 50 is
configured to recognize the appropriate switch disconnect signal, ensure the system
sentinel permits features in question, and use the command line interface.

If, after referring to this information, you are unable to resolve specific issues, contact a
technical support representative.

Octel 50 Installation Test Plan

To prepare to use the test plan:

1. Record the personal greetings to be used for at least three test mailboxes on the
system. You will place calls to and from these mailboxes during these tests.

2. Attach a digit grabber to the system.

3. Press <ESC> to close the active display and active the menu bar.

4. Select Command Line from the Display menu.

5. From the Command Line, type DIGRAB ON then press <ENTER>.

6. From the Command Line, type DEBUG ON then press <ENTER>.

To troubleshoot certain integration problems you may uncover, you will need to consult
the Configuration Note for the switch and possibly the switch documentation.
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Part 1—Integration, Greeting, and Messaging Testing

Test Voice Mail Ports This section tests the ports to verify they are initialized
properly.

Test Port Initialization

Test:

Verify the correct status message for each port
displays on the Channel Status display.

Expected Outcome:

The Channel Status display should display one of the
following messages for each channel:

For SMDI integration–Waiting for Data

For Inband integration–Waiting for Ring

For DID integration–Waiting for DID

If this test fails, see the appropriate integration section
of the Octel 50 Troubleshooting Table for possible
resolutions.

Test Voice Mail Extensions

Test:

From any station set, dial each extension
number connected to a Octel 50 port.

Expected Outcome:

Verify each port goes off hook as it is dialed. The
Channel Status window should display the following
status for each port as it goes off hook:

For SMDI integration–Querying Integration Server

For Inband integration–Answering

For DID integration–Answering

If this test fails, see the appropriate integration section
of the Octel 50 Troubleshooting Table for possible
resolutions.

Pilot Number (Hunt Group) This section tests the pilot number to verify the ports answer
as expected when the pilot number is dialed.

Serial Integrations

Test:

Call into Octel 50 using the internal pilot number.

Note which hunt group method, linear or circular
(rotary), is used. Test all the ports on the Octel
50 system to verify each port answers calls in
order.

For a linear hunt group, test channel 1 then
disable it,  test channel 2 then disable it, and so
on until all ports are verified. When you are
finished, enable all the ports.

Repeat the steps using the external pilot
number.

Expected Outcome:

Verify the ports answer as expected and the Channel
Status display shows the status Querying Integration
Server for the port.

If this test fails, see the “SMDI integration does not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.
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Inband/DID Integrations

Test:

Call into Octel 50 using the internal pilot number.

Note which hunt group method, linear or circular
(rotary), is used. Test all the ports on the Octel
50 system to verify each port answers calls in
order.

For a linear hunt group, test channel 1 then
disable it, test channel 2 then disable it, and so
on until all ports are verified. When you are
finished, enable all ports.

Repeat the steps using the external pilot
number.

Expected Outcome:

Verify the ports answer as expected and the Channel
Status display shows the status Answering for the port.

If this test fails, see the “Inband/DID integration does
not work” section of the Octel 50 Troubleshooting Table
for possible resolutions.

Call Analysis (Supervised) This section tests call analysis/supervised transfers to verify
Octel 50 correctly recognizes ring-no-answer and busy
conditions.

Ring-No-Answer

Test:

Turn off the station forwarding features on a
phone set used for testing.

In a test mailbox, set the No Answer/Call
Blocking feature to Default on the Subscriber
Settings dialog box.

In the same test mailbox, set the Maximum
Rings on the Class of Service dialog box to 3 or
greater.

Call into the Octel 50 system and dial the
mailbox number. Do not answer the phone.

Expected Outcome:

Verify the system voices, “I’m sorry, there is no answer
at that extension.”

Verify the Channel Status display shows the status
Ring/No Answer for the port.

If this test fails, see the “Call analysis does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

Busy

Test:

Turn off the station forwarding features on a
phone set used for testing.

In a test mailbox, set the Busy feature to Default
on the Subscriber Settings dialog box.

In the same test mailbox, set the Maximum
Rings on the Class of Service dialog box to 3 or
greater.

Make the extension associated with the test
mailbox busy.

Call into the Octel 50 system and dial the
mailbox number.

Expected Outcome:

Verify the system voices, “I’m sorry, that extension is
busy right now.”

Verify the Channel Status display shows the status
Extension Busy for the port.

If this test fails, see the “Call analysis does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.
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Connect

Test:

Call into the Octel 50 system and dial a mailbox
number. Answer the extension when it rings.

Expected Outcome:

Verify the Channel Status display shows the status
Connected for the port.

If this test fails, see the “Call analysis does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

Integrated/Serial SMDI (Unsupervised) This section tests serial integration to verify Octel 50
correctly recognizes ring-no-answer and busy conditions.

Blind Transfer

Test:

For a test mailbox, set the Maximum Rings field
on the Class of Service dialog box to 0.

Call the Octel 50 pilot number.

If the Octel 50 system is set up for automatic
station login, press <0> to go to the Attendant
menu.

At the Attendant menu prompt, dial the mailbox
number.

Expected Outcome:

The Channel Status display should show the following
messages:

Transfer <mailbox number>

Dialing <extension number>

Waiting for Ring (or Data, or DID, depending on
integration)

Note that if station set forwarding is on, the call will be
returned to the Octel 50 system in a busy or no answer
situation.

If this test fails, see the “SMDI integration does not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.

Ring-No-Answer

Test:

Set the phone to forward to the Octel 50 system
in ring and no answer conditions.

In a test mailbox, set the No Answer/Call
Blocking feature to Default on the Subscriber
Settings dialog box.

For the same mailbox, set the Maximum Rings
on the Class of Service dialog box to  0.

Call into the Octel 50 system and dial the
mailbox number.

Do not answer the extension.

Expected Outcome:

Verify the system voices, “I’m sorry, there is no answer
at that extension.”

Verify the Channel Status display shows the status
Ring/No Answer for the port.

If this test fails, see the “SMDI integration does not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.
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Busy

Test:

Set the phone to forward to the Octel 50 system
in ring-no-answer conditions.

In a test mailbox, set the Busy feature to Default
on the Subscriber Settings dialog box.

For the same mailbox, set the Maximum Number
of Rings on the Class of Service dialog box to 0.

Make the extension associated with the test
mailbox busy.

Call into the Octel 50 system and dial the
mailbox number.

Expected Outcome:

Verify the system voices, “I’m sorry, that extension is
busy right now.”

Verify the Channel status display shows the status
Extension Busy for the port.

If this test fails, see the “SMDI integration does not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.

Automatic Station Login (Direct Dial)

Test:

From an integrated set, dial the Octel 50 pilot
number.

Expected Outcome:

Verify the system voices the mailbox owner’s name
prompt or default mailbox number prompt followed by,
“Please enter your password.”

Note that this feature is switch-dependent.

If this test fails, see the “SMDI integration does not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.

Message Waiting Lights This section tests the message waiting light feature to verify
message waiting lights turn on to signal new messages
then off as expected. Be sure to note the method the phone
set uses to indicate messages.

Turn Message Waiting Light On

Test:

Clear all messages from a test mailbox by
logging in over the phone and deleting the
messages. Exit the mailbox by pressing <#> until
you hear, “Thank you. Good-bye.”

Close the Mailbox Status window so the Debug
information displays.

From a phone other than the one for which you
want to test the message waiting light, call into
the Octel 50 system and leave a message for the
test mailbox.

Expected Outcome:

Verify the message waiting light for the phone set
associated with the mailbox turns on.

If this test fails, see the “Message Waiting Lights do not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.
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Turn Message Waiting Light Off

Test:

Call into the Octel 50 system and log into a test
mailbox with the message waiting light on and
select to listen to new messages. Save or delete
the message.

Exit the mailbox by pressing <#> until you hear,
“Thank you. Good-bye.”

Expected Outcome:

Verify the message waiting light for the phone set
associated with the mailbox turns off when you exit the
mailbox.

If this test fails, see the “Message Waiting Lights do not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.

Hangup Detection This section tests Octel 50’s ability to recognize the hangup
signal from the switch.

Test:

From an internal line, call into the Octel 50
system.

Hang up at the greeting.

Repeat the test using an external line.

Expected Outcome:

On the Channel Status window, verify the port
disconnects in less than three seconds and displays
one of the following status messages:

• For SMDI integration–Waiting for Data

• For Inband integration–Waiting for Ring

• For DID integration–Waiting for DID

If this test fails, see the “Disconnects are not
recognized properly” section of the Octel 50
Troubleshooting Table for possible resolutions.

Greetings This section tests the greetings to verify Octel 50 voices the
appropriate greetings at various times.

Note that the Time/Greeting parameters in System Setup
and Business Hours settings under the Attendant menu
determine when greetings are voiced.

To efficiently test the system greetings, change the time on
the computer running the Octel 50 system to morning,
afternoon, evening, and after hours times as needed.

If these tests fail, see the “Greetings do not voice properly”
section of the Octel 50 Troubleshooting Table for possible
resolutions.

Morning Greeting

Test:

From an external line, dial into the Octel 50
system during morning hours.

Expected Outcome:

Verify the Octel 50 system voices the morning greeting.

Afternoon Greeting

Test:

From an external line, dial into the Octel 50
system during afternoon hours.

Expected Outcome:

Verify the Octel 50 system voices the afternoon
greeting.
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Evening Greeting

Test:

From an external line, dial into the Octel 50
system during evening hours.

Expected Outcome:

Verify the Octel 50 system voices the evening greeting.

Closed Greeting

Test:

From an external line, dial into the Octel 50
system during hours the office is closed.

Expected Outcome:

Verify the Octel 50 system voices the after-hours
greeting.

Attendant Menu Prompt

Test:

From a non-integrated station set, dial into the
Octel 50 system. The Attendant Menu prompt
voices after the system greeting prompt.

Test each option voiced in the Attendant Menu
prompt.

Expected Outcome:

Verify each option voiced by the Attendant Menu
prompt routes the call as expected.

Note that this prompt does not play during days
specified as holidays or after office hours.

Holiday Greetings

Test:

From a non-integrated station set, dial into the
Octel 50 system during a holiday date.

Expected Outcome:

Verify the holiday greeting is voiced.

Messaging This section tests the messaging feature to verify messages
can be sent and reviewed as expected.

See the Special Features section in this table to test the
destinations for messages sent using the auto forwarding,
AMIS, and V-Tree features.

Send Messages

Test:

Verify test mailboxes have Send Messages
enabled on the Class of Service dialog box.

Log into a test mailbox and send messages to
other mailboxes.

From an outside line, call into the Octel 50
system and leave a message for a test mailbox.

Expected Outcome:

View the Mailbox Status window and verify the
messages are sent to the expected mailboxes.

Receive Messages

Test:

Verify a test mailbox has Receive Messages
enabled on the Class of Service dialog box.

Log into a test mailbox that contains messages
and review them.

Expected Outcome:

Verify the messages from both internal and external
callers can be reviewed as expected.
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Distribution Lists This section tests the distribution list features to verify
messages are received in all mailboxes included in
distribution lists.

Distribution Lists

Test:

Using the distribution list feature in a test
mailbox, create a distribution list.

Send messages to the distribution list.

Expected Outcome:

Verify all the mailboxes included in the list receive the
messages.

If this test fails, see the “Distribution lists do not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

Company-Wide and Division-Wide (Global)
Distribution Lists

Test:

For several test mailboxes, enter matching
company and division names on the Mailbox
Entry dialog box.

Log into one of these mailboxes and send
messages to division-wide and company-wide
distribution lists (*98 and *99 respectively).

Expected Outcome:

Verify all the mailboxes with the same company and/or
division as the sending mailbox receive the messages.

If this test fails, see the “Distribution lists do not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

Group Distribution Lists

Test:

Using the supervisor menu functions over the
phone interface, create a global distribution list.

Log into a mailbox and send messages to the
global distribution list.

Expected Outcome:

Verify all the mailboxes included in the lists receive the
messages.

If this test fails, see the “Distribution lists do not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

Part 2—Octel 50 Special Feature Testing

Greeting by Port This section tests the greeting by port feature to verify the
Octel 50 system answers calls to different ports with the
appropriate greetings.

Test:

From an external line, dial the phone number
for each port set up for greeting by port.

Expected Outcome:

Verify each call is answered with the expected greeting.

If this test fails, see the “Greeting by port does not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.
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Call Queuing This section tests the call queuing feature to verify the
appropriate prompts are voiced to callers waiting on hold in
a call queue.

Test:

Make an extension busy.

From an external line, call into the Octel 50
system and dial the busy extension.

Listen to the prompts voiced for the first call
position.

Do not hang up.

Using a second line, call into the system and
dial the busy mailbox.

Listen to the prompts voiced for the second call
position.

Expected Outcome:

Verify the prompts specified under Call Queuing in
System Setup are voiced for the first and second call
queue positions, as appropriate.

Verify custom call queuing prompts are voiced, if they
are recorded.

If this test fails, see the “Call queuing does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

Call Screening This section tests the call screening feature to verify
subscribers can accept, reject, and reroute callers.

Call Screening Accept

Test:

In a test mailbox, activate the call screening
feature. Call the Octel 50 system and dial the
mailbox number.

Answer the mailbox’s extension when it rings
and press <#> at the call screening prompt to
accept the call.

Expected Outcome:

Verify the system voices to the caller, “Please speak
your name at the tone so I may say who is calling.”

Verify the caller is transferred and connected to the
extension.

If this test fails, see the “Call screening does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.
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Call Screening Reject

Test:

In a test mailbox, activate the call screening
feature. Call the Octel 50 system and dial the
mailbox number.

Answer the mailbox’s extension when it rings
and press <1> at the call screening prompt to
reject the call.

Expected Outcome:

Verify the system voices to the caller, “Please speak
your name at the tone so I may say who is calling.”

Verify the system voices to the caller, “I’m sorry, there
is no answer at that extension. To try another
extension, press <1>. To leave a voice message, press
<2>. To be transferred to our receptionist, press <3>.

If this test fails, see the “Call screening does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

Call Screening Reroute

Test:

In a test mailbox, activate the call screening
feature. Call the Octel 50 system and dial the
mailbox number.

Answer the mailbox’s extension when it rings
and press <*> at the call screening prompt to
transfer the call, then enter the new destination
mailbox number.

Expected Outcome:

Verify the system voices to the caller, “Please speak
your name at the tone so I may say who is calling.”

Verify the caller is connected to the new destination
mailbox.

If this test fails, see the “Call screening does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

Call Handling This section tests to verify call handling options are voiced
and work properly for subscriber mailboxes.

Call Blocking

Test:

In a test mailbox, set the No Answer/Call
Blocking feature to Default on the Subscriber
Settings dialog box.

From a non-integrated station set, call into the
Octel 50 system and dial the mailbox number.

Expected Outcome:

Verify the call is transferred to voice mail and you hear
the personal greeting recorded for the mailbox.

If this test fails, see the “Call handling does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.
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No Answer

Test:

In a test mailbox, set the No Answer/Call
Blocking feature to Default on the Subscriber
Settings dialog box.

From a non-integrated station set, call into the
Octel 50 system and dial the extension
associated with the mailbox.

Do not answer the extension.

Expected Outcome:

Verify the system voices to the caller, “I’m sorry, there
is no answer at that extension.”

If this test fails, see the “Call handling does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

If the system uses blind transfers, you may not hear the
prompt unless the phone system provides distinct busy
and no answer codes. The inband code for no answer
must be entered in the System Setup.

Busy

Test:

In a test mailbox, set the Busy call handling
feature to Default.

Make the extension associated with the test
mailbox busy.

From a non-integrated station set, call into the
Octel 50 system and dial the extension
associated with the mailbox.

Expected Outcome:

Verify the system voices to the caller, “I’m sorry, but
that extension is busy right now.”

If this test fails, see the “Call handling does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.

If the system is configured to use blind transfers, you
may not hear the prompt unless the phone system is
able to provide distinct busy and no answer codes.
These inband code for busy must be entered in the
Inband template information.

V-Trees This section tests system V-Trees to verify V-Trees are
accessible and the options work as expected.

Automated Attendant V-Tree

Test:

From a non-integrated station set, call into the
system and select the keypress to access the
V-Tree.

Expected Outcome:

Verify each option voiced by the V-Tree performs as
expected.

If this test fails, see the “V-Trees do not work” section
of the Octel 50 Troubleshooting Table for possible
resolutions.
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Integrated Station Set V-Tree

Test:

Set up a mailbox’s call handling for busy and no
answer for a V-Tree:

1. From an integrated station set, dial the pilot
number of the Octel 50 system and dial the
extension for the mailbox. Do not answer the
phone.

2. Make the extension associated with the test
mailbox busy.

From an integrated station set, dial the pilot
number of the Octel 50 system and dial the
extension for the mailbox.

Expected Outcome:

Verify under both busy and no answer conditions, the
call is transferred to the V-Tree and that the options
perform as expected.

If this test fails, see the “V-Trees do not work” section
of the Octel 50 Troubleshooting Table for possible
resolutions.

Supervised Transfers V-Tree

Test:

Set up a mailbox’s call handling for busy and no
answer for a V-Tree:

1. From an integrated station set, dial the pilot
number of the Octel 50 system and dial the
extension for the mailbox. Do not answer the
phone.

2. Make the extension associated with the test
mailbox busy.

From an integrated station set, dial the pilot
number of the Octel 50 system and dial the
extension for the mailbox.

Expected Outcome:

Verify under both busy and no answer conditions, the
call is transferred to the V-Tree and that the options
perform as expected.

If this test fails, see the “V-Trees do not work” section
of the Octel 50 Troubleshooting Table for possible
resolutions.

V-Tree Fax Retrieval This section tests the V-Tree fax retrieval feature to verify
faxes stored in the V-Tree can be retrieved. Note that the
availability of the V-Tree fax retrieval feature is controlled by
the sentinel.

Automated Attendant V-Tree

Test:

From a non-integrated station set, call into the
Octel 50 system and select the keypress to
access the V-Tree.

Expected Outcome:

Follow the V-Tree prompts you created to access fax
retrieval.

Verify you receive the fax you requested.

If this test fails, see the “Fax features do not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.
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Message Delivery (Outcall Notification) This section tests the message delivery feature to verify the
notifications are delivered as expected to phone numbers or
beepers.

Message Delivery to a Phone

Test:

In a test mailbox, set up the message delivery
feature to call a phone number.

Delete any messages from the test mailbox.

From another extension, call the Octel 50
system during the day of week and time of day
window specified for message delivery and
leave a message for the test mailbox.

Expected Outcome:

Verify the Octel 50 system calls the specified phone
number and voices that there are messages and
requests the password. Verify the message can be
reviewed.

Debug should display the message TONEOUT followed
by the phone number. Note that you must press <#>
after you enter the password.

If this test fails, see the “Message delivery to a phone
does not work” section of the Octel 50 Troubleshooting
Table for possible resolutions.

Message Delivery to a Beeper

Test:

In a test mailbox, set up the message delivery
feature to call a beeper number.

Delete any messages from the test mailbox.

From another extension, call the Octel 50
system during the day of week and time of day
window specified for message delivery and
leave a message for the test mailbox.

Expected Outcome:

Verify the system calls the specified beeper number
and the beeper displays the specified phone number.

Debug should display the message TONEOUT followed
by the pager phone number.

If this test fails, see the “Message delivery to a beeper
does not work” section of the Octel 50 Troubleshooting
Table for possible resolutions.

Auto Forwarding This section tests the auto forwarding feature to verify
messages left in mailboxes configured for auto forwarding
are forwarded to the specified mailbox.

Test:

In a test mailbox, set up the auto forwarding
feature.

Call into the Octel 50 system and leave a
message for the test mailbox.

Expected Outcome:

Verify the message is forwarded to the appropriate
mailbox according to the specified delay.

If this test fails, see the “Auto forwarding does not work”
section of the Octel 50 Troubleshooting Table for
possible resolutions.



Testing and Troubleshooting the Octel 50 System Octel 50 Installation Test Plan

OCTEL 50 INSTALLATION GUIDE 13-15

Network Messaging
This section tests network messaging to verify messages
sent to and received from remote voice mail systems are
delivered as expected. Note that the availability of the AMIS
network protocol is controlled by the sentinel.

Send

Test:

Log into a subscriber mailbox. At the main
menu, choose to send a message. Choose one
of the following destinations:

Casual AMIS node–Press <0>, dial the other
voice mail system’s access number, followed by
<#>,  and the mailbox number, followed by <#>.

Administered AMIS node–Dial the AMIS node
number, followed by the mailbox number.

Expected Outcome:

Verify the messages are received at the remote voice
mail systems.

If this test fails, see the “Network messages are
returned to mailboxes” section of the Octel 50
Troubleshooting Table for possible resolutions.

Receive

Test:

Send messages from other voice mail systems
to mailboxes on the Octel 50 system.

Expected Outcome:

Verify the messages are received in the expected
mailboxes.

Language Selection This section tests the language selection feature to verify
callers can select a preferred language.

Note that the availability of the language selection feature is
controlled by the sentinel.

Test:

From a non-integrated station set, call the Octel
50 system.

Expected Outcome:

Verify the expected language selection prompt is
voiced.

Verify the prompts are voiced in the expected language
for each language option.

If this test fails, see the “Greetings are not voiced
properly” section of the Octel 50 Troubleshooting Table
for possible resolutions.

Intercom Paging
This section tests the intercom paging feature to verify
callers can page the desired parties. Note that you can only
use this feature if the Octel 50 system uses supervised
transfers or the switch provides a unique code for busy and
ring-no-answer.

Test:

In a test mailbox, set up the intercom paging
feature.

Call into the Octel 50 system and dial the
mailbox number.

Do not answer the extension. After the no
answer prompt voices, choose to page the
subscriber.

Expected Outcome:

Verify the system voices the page over the station set
or over the external paging system as expected.

Verify the paged subscriber can connect with the caller
who placed the page.

If this test fails, see the “Intercom paging does not
work” section of the Octel 50 Troubleshooting Table for
possible resolutions.
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Using the Octel 50 System Troubleshooting Table

If you encounter a problem with the Octel 50 system, use this table for possible
resolutions before contacting an authorized representative. By following these Octel 50
Troubleshooting Table guidelines, you may be able to independently solve the problem or,
if not, at least gather information an authorized representative can use to more effectively
assist you.

For easy reference, this troubleshooting table lists problem areas and their possible
resolutions alphabetically. Note that some problem areas are very broad and have
subtopics listed below the main heading. For example, if you encounter a problem where
subscribers cannot log into their mailboxes, look under Mailboxes are not functioning
properly to locate the subtopic Cannot log into a mailbox.

When you encounter a problem with Octel 50, be sure the DIGRAB  and DEBUG features
are enabled from the Command Line interface. These parameters instruct the Octel 50
system to log errors and digit strings in the system log files. This information helps
authorized representatives solve the problems you encounter.

Octel 50 System Troubleshooting Table

Auto forwarding does not work

Resolution Possibilities:

Mailbox Entry dialog box:

• Verify the Auto forwarding active option is enabled on the Auto
Forwarding dialog box for the mailbox.

• Verify the Delay field on the Auto Forwarding dialog box is set to
3 minutes or greater value. Allow enough time for the caller to
review and/or rerecord the message.

System Setup parameters:

• Verify at least one port is enabled for outbound calls under
Channel Specific in System Setup.

Call analysis does not work

Resolution Possibilities:

• Re-run the Call Analysis utility. Be sure to delete the existing
tone table before you run Call Analysis. For more information on
running the Call Analysis utility, see the topic, “Running Call
Analysis,” in Chapter 9, “Defining Phone System Signals.”

• If you re-run Call Analysis and problems persist, contact a
technical support representative for information on using
Advanced Call Analysis.
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Callers are disconnected

Resolution Possibilities:

• Verify the method the switch uses for a disconnect. Verify the
appropriate Octel 50 hangup detection parameters are
configured. For information on verifying a switch’s disconnect
signal, see the topic, Determining a Switch’s Disconnect Signal,”
later in this chapter.

• Note under what conditions callers are being disconnected.

• Verify call analysis was run and Octel 50 correctly interprets
signals from the switch. If call analysis was run and Octel 50 still
cannot correctly interpret signals from the switch, contact a
technical support representative for information on using
Advanced Call Analysis.

System Setup parameters:

• Turn off all System Setup parameters that cause disconnects to
help determine if the problem is caused by the phone system or
Octel 50:

− Set Minimum Message Length in Seconds under
Message Timing to 0.

− Increase Maximum Silence under Hangup Detection to
1200.

− Set DTONDET under Hangup Detection to 0, if your
switch uses the BellCore tone table.

− Set HANGUPDLY under Hangup Detection to 0.
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Callers cannot transfer

Resolution Possibilities:

• See the Configuration Note for the switch for the proper transfer
and release codes. If you do not have the Configuration Note for
the switch, you can determine the switch code by replacing the
voice mail port with a 2500 set, or the proprietary telephone
instrument if using a D/42D-NS, D/42D-SX, or D/42D-SL
integration, and transfer a caller to an extension in a busy state,
then pull the call back. Do the same for the ring-no-answer
state.

• Verify call analysis was run and Octel 50 correctly interprets
signals from the switch. If call analysis was run and Octel 50 still
cannot correctly interpret signals from the switch, contact a
technical support representative for information on using
Advanced Call Analysis.

System Setup parameters:

• Verify the Custom Transfer Code under Call Transfer is entered
correctly.

• Verify the Transfer Release Code for Busy under Call Transfer is
entered correctly.

• Verify the Transfer Release Code for No Answer under Call
Transfer is entered correctly.

• Verify the FLINTVL parameter under Call Transfer matches the
hook flash time of the switch.

• Verify the TONEDLY parameter under Call Transfer is set high
enough for the system to distinguish the time between DTMFs. If
this parameter is set to 8 and callers still cannot transfer, contact
a technical support representative.

• Verify the TONELEN under Call Transfer parameter is high
enough so the system can distinguish DTMFs. If this parameter
is set to 8 and callers still cannot transfer, contact a technical
support representative.

Callers hear, “There is a line
problem. Please try again
later,”  when they access a
mailbox

Resolution Possibilities:

• This prompt indicates file corruption. Use the following
procedure to recover from file corruption:

1. Exit Octel 50 by selecting Exit from the File menu.

2. View the OPERATOR.LOG file for any errors indicating
power failures.

3. Run Quick Assist using the Verify Recovery Mode and the
Delete Unattached Messages Recovery Option.

4. If Quick Assist does not report any errors, restart Octel 50.



Testing and Troubleshooting the Octel 50 System Using the Octel 50 System Troubleshooting Table

OCTEL 50 INSTALLATION GUIDE 13-19

If Quick Assist does report errors, it instructs you on which
recovery options to run. Note that if Quick Assist
recommends using the Update All option, contact a
technical support representative for assistance.

5. Reboot the PC and restart Octel 50. If the problem
persists, contact a technical support representative for
information.

Call forwarding does not work

Resolution Possibilities:

• Verify the correct call condition is being satisfied for the call
forwarding option to work properly:  busy, no answer, busy or no
answer, or all calls.

System Setup parameters:

• Verify the Maximum Number of Forwarded Extensions
parameter under Subscriber is not being exceeded.

Class of Service dialog box:

• Verify the Call Handling option is enabled.

Mailbox Entry dialog box:

• Verify call forwarding is activated for the mailbox by either the
subscriber over the phone or the system manager through the
Subscriber Settings dialog box.

• Verify a valid mailbox number is entered in the Forward To field
on the Subscriber Settings dialog box.

Call handling does not work

Resolution Possibilities:

• Verify the correct call condition is being satisfied for the call
handling option selected: busy, no-answer, busy or no-answer,
or all calls.

• Verify the mailbox has Call Handling enabled on the Class of
Service dialog box.

• Verify the subscriber enabled the call handling option over the
phone or the system manager enabled it on the Subscriber
Settings dialog box.

• Note that if call paging is active for the mailbox, the subscriber is
paged before the call handling options are available.
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Call queuing does not work

Resolution Possibilities:

• Verify the phone system switch is configured for supervised
transfers.

• Verify the PBX does not forward calls back to Octel 50 on a busy
condition.

System Setup parameters:

• Verify the correct code is entered for the Transfer Release Code
on Busy parameter under Call Transfer.

• Confirm that the Number of Seconds for the First Caller in the
Queue to Wait is set correctly.

• Be sure that the Maximum Number of Callers Allowed in Queue
parameter is not set to 0.

Class of Service dialog box:

• Verify that Call Queuing is enabled.

• Verify the Maximum Rings parameter is set to 3 or greater.

System Prompts dialog box:

• Verify that If using supervisor prompts, confirm that the 10 call
queuing phrases are specified on the System Prompts dialog
box, and that the prompts have been recorded.

Call screening does not work

Resolution Possibilities:

• Disconnect a line from the Octel 50 system and attach a single
line phone. Attempt to use call screening manually to verify the
switch supports call screening.

• Verify call analysis recognizes no answer and busy conditions
properly.

• Verify the Octel 50 system is using supervised transfers. Call
screening is not available on systems using blind transfers.

• Verify the appropriate Call Screening Busy, No Answer,
Transfer, and Reject codes are entered under Call Screening in
System Setup.

Class of Service dialog box:

• Verify Maximum Rings is set to 3 or greater.

• Verify the Call Screening option is enabled.

Mailbox Entry dialog box:

• Verify Call Screening under Special Features is enabled on the
Subscriber Settings dialog box.
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Calls to certain ports do not
answer

Resolution Possibilities:

• If the port was disabled using the DIS command, enable it by
typing ENA n then pressing <ENTER> at the command line
interface, where n is the number of the port.

System Setup parameters:

• Verify that at least one port is enabled for inbound under
Channel Specific in System Setup.

Cannot access system fields,
checkboxes, or menus
on-screen

Resolution Possibilities:

• Verify you are logged in at the appropriate security level to
access the feature associated with the fields.

• Verify the sentinel on the Octel 50 system permits the features
associated with the fields you want to access. For information on
verifying the features enabled on a sentinel, see the topic,
“Displaying Features Enabled on the Sentinel,” later in this
chapter.

• Verify the field you want to access is available. If the field is
grayed out, it cannot be accessed.

• Log out of supervisor access then log back in.

• If a mouse is connected to the Octel 50 system, use the mouse
to place the cursor in a field, button, or checkbox, then click the
left mouse button to select the option.

• Use <TAB> and <Shift-Tab> to move the cursor through the
options.

• Press <Alt> plus the first highlighted character of the button or
field name, then press <ENTER>. Or use the <TAB> or <Shift-
Tab> key to move the cursor to the field or button, then press
<ENTER>.

• If you cannot select items within parenthesis ( ) or brackets [ ],
move to the field with the <TAB> or <Shift-Tab> key with one of
the other options described for selecting a field or button. Press
<Spacebar> to activate the toggle (On/Off) for that field.

• Note that you can only select one item of a set with parenthesis
( ). However, in a set with brackets [ ], you can select any
number of the options.

• To select menus, use the mouse or <TAB>, <Shift-Tab>, or the
right or left arrow keys to move the highlighted bar. Click or
press <ENTER> to select a highlighted menu.

• To select menu options, hold down <Alt> and type the first
highlighted character of the menu name.
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• The menus cannot be selected if the Mailbox Status display is
active.

Disconnects are not
recognized properly

Resolution Possibilities:

• See the Configuration Note for the switch to determine the type
of disconnect supervision the PBX provides. For information on
verifying a switch’s disconnect signal, see the topic,
“Determining a Switch’s Disconnect Signal,” later in this chapter.

For Dial Tone detection Resolution Possibilities:

System Setup parameters:

• Verify the value entered for DTONDET under Hangup Detection
in System Setup is not set too low. If it is, the system
disconnects prematurely. This parameter is set by the Integrator
utility.

• If the switch does not return dial tone, set this value to 0 to
disable it. If the switch does not use dial tone for disconnect
detection, and you want to keep DTONDET enabled but inactive,
set it to 1200 (12 seconds).

For Hangup String detection Resolution Possibilities:

System Setup parameters:

• Verify the correct string is entered in the HANGUPSTR
parameter under Hangup Detection in System Setup. It should
be blank if the switch does not use a hangup string.

• Verify the HANGUPDLY parameter under Hangup Detection in
System Setup is correct for the switch. To calculate this value:

1. Multiply the number of digits in the switch’s hangup string
by 40 milliseconds.

2. Multiply the number of pauses between digits in the string
by 20 milliseconds.

3. Add the results from steps 1 and 2 to determine the
minimum amount of delay that should be entered in this
field.

4. If Octel 50 still does not recognize the hangup string, keep
increasing this value by 20 milliseconds until it does.

For Drop in Loop Current
detection

Resolution Possibilities:

• If the ports do not disconnect, set LCDTIME under Hangup
Detection in System Setup to 6 and restart the system.

• If ports drop the call, then immediately go back off-hook,
increase the value of LCDTIME under Hangup Detection in
System Setup. If you have an AT&T Legend with the new 012
card, set this parameter to 75.

For systems using supervised Resolution Possibilities:
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transfers • Clear the previous CCA results and run Call Analysis again. For
more information on running Call Analysis, see the topic,
“Running Call Analysis,” in Chapter 9, Defining Phone System
Signals.”

Distribution lists do not work

Group distribution lists do not
work

Resolution Possibilities:

• Verify the Distribution List option on the Class of Service dialog
box is enabled. The distribution lists feature provides access to
lists *0 through *9, which can be created by the mailbox owner
for that individual mailbox.

• Verify a distribution list is created.

Global distribution lists do not
work

Resolution Possibilities:

• Verify the Global Distribution option on the Class of Service
dialog box is enabled. This feature provides access to system
distribution lists *10 through *19, which can be created by a
system manager, and division-wide and company-wide lists (*98
and *99 respectively), which are automatically created by the
system.

• Note that system distribution lists (*10-*19) can only be created
using the supervisor’s main menu available through the phone
interface.

• Note that there must be more than one mailbox with entries in
the Company and Division fields on the Mailbox Entry dialog box
to create company-wide and division-wide distribution lists (*98
and *99).

• Verify a system distribution list is created.

DTMFs are not recognized
properly

Resolution Possibilities:

System Setup parameters:

• Verify the PLAYDTMF parameter under Voice System is set to
5.

• If the system experiences talkoff (when a recording session is
interrupted by the system voicing prompts), increase the
RECDTMF parameter setting under Voice System. Verify
RECDTMF is set not higher than 7 or 8.

• Verify the TONEDLY parameter under Call Transfer is set high
enough for the system to distinguish the time between DTMFs. If
this parameter is set to 8 and DTMFs still are not recognized,
contact a technical support representative.

• Verify the TONELEN parameter under Call Transfer is high
enough so the system can distinguish DTMFs. If this parameter
is set to 8 and DTMFs still are not recognized, contact a
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technical support representative.

Fax Features do not work

Fax retrieval does not work Resolution Possibilities:

• Verify the wiring to the fax card is set up correctly for the wiring
method used (transfer or non-transfer).

• Verify faxes have been loaded onto the Octel 50 system and are
ready to be sent.

• Verify a V-Tree has been created, includes the fax option, and is
activated.

• Verify the Configure utility has been set up properly for
Brooktrout fax boards.

• Verify the sentinel on the Octel 50 system allows Fax Solution.
For information on verifying the features enabled on a sentinel,
see the topic, “Displaying Features Enabled on the Sentinel,”
later in this chapter.

Class of Service dialog box:

• Verify the Fax V-Trees option is enabled.

System Setup parameters:

• Verify the entries under Fax Extensions are configured properly
if using the transfer method.

• Verify that at least one port is enabled for outbound under
Channel Specific.

Folders do not work

Resolution Possibilities:

• Verify the Voice Folders option is enabled on the Class of
Service dialog box.

• Verify folders are created in the subscriber’s mailbox and that
label names are recorded.

• Verify messages are being saved to the proper folder.

Greetings do not voice
properly

Attendant Menu prompt does
not voice

Resolution Possibilities:

• Make sure that Greeting by Port is not active for that port.

• Confirm that an Attendant menu is configured. A keypad button
on the dialog box should have a valid corresponding mailbox
number next to it.
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• Confirm that message prompt numbers are specified on the
System Prompts dialog box in the Attendant Menu Language 1
field and that the prompt is recorded.

• Verify that phones are sending valid DTMF signals.

System Setup parameters:

• Adjust the RECDTMF and PLAYDTMF values under Voice
System.

Holiday Greetings do not voice Resolution Possibilities:

• Verify the date in question is specified as a holiday on the
Holiday dialog box and that a prompt for the holiday has been
recorded and specified on the Holidays dialog box.

• Note that Holiday greetings do not voice if Greeting by Port is
configured and active.

• Verify the PC clock is set to the correct date and time.

• If a holiday greeting voices on a non-holiday date, access the
Holiday dialog box and check to see if the Retain field is
selected for the date in question. If so, this date was specified as
a holiday in a previous year and retained for use in the current
year.

Multilingual greetings do not
voice

Resolution Possibilities:

• Verify the sentinel supports multiple languages. For information
on verifying the features enabled on a sentinel, see the topic,
“Displaying Features Enabled on the Sentinel,” later in this
chapter.

• Verify a Language Select prompt is recorded and specified on
the System Prompts dialog box accessible from the Attendant
menu.

• Listen to the Attendant Menu prompts and the Message Delivery
prompts using SOLVE or over the supervisor’s menu phone
interface to verify they are correct.

• Note that Holiday greetings can only be voiced in one language.

• Verify the Attendant Menu and Message Delivery prompts are
recorded in each language being used. Specify the appropriate
prompt numbers on the System Prompts dialog box for each
language listed in the Language Select prompt.

• Verify the correct language is specified under Language on the
Class of Service dialog box.

Greeting by port does not work

Resolution Possibilities:

• Verify the appropriate trunks are routed to the correct ports. This
allows the system to voice the correct greetings when the phone
number is called.

• Verify the port is active for greeting by port on the Greeting by
Port dialog box.
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• Verify the correct mailboxes are assigned on the Greeting by
Port dialog box and the Personal Greetings for the mailboxes
are recorded with an appropriate greeting.

Mailbox Entry dialog box:

• Verify the correct company and division information is entered
on the Mailbox Entry dialog box. Note that these fields are case-
sensitive.

• Verify the correct call handling option is selected for the
mailboxes handling calls for ports active for greeting by port.

Inband/DID integration does
not work

Resolution Possibilities:

• Attach a digit grabber to a line and verify the switch is sending
the appropriate inband signaling digits.

System Setup parameters:

• Verify the following Inband Parameters:

− The Total Number of DID Digits (DIDCOUNT) is set equal
to or higher than the total number of digits in the inband
signaling string.

− The Number of Milliseconds to Wait for Inband Signaling
(DID) is set to 1000.

− If the switch requires a * or # to signify the end of an
inband code, verify it is entered in the DID Terminating
Character (DIDTERM) parameter.

− No spacer characters are entered in the DID Terminating
Character (DIDTERM) parameter.

− Seconds to Wait for DID (DIDTIME) is set to 5.

• If the beginning of the inband signaling string is missing, change
the Offhook Delay parameter to 25. Reboot the system.

• If the end of the inband signaling string is missing, increase the
value for the Total number of DID digits parameter under Inband
Signaling.

• If changing the Total number of DID digits parameter under
Inband Signaling in System Setup did not work, increase the
Number of Milliseconds to Wait parameter under Inband
Signaling by 500.

Intercom paging does not
work

Resolution Possibilities:

• Note that a paging system (external or extension) must be
available on the switch for the intercom paging feature to be
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used.

• Note that there must be at least two ports available on the Octel
50 system to complete a page cycle.

• Note that paging works on Octel 50 systems using supervised
transfers or a switch that uses a unique code for busy and no-
answer.

• Verify call analysis recognizes ring-no-answer and busy
conditions accurately.

System Setup parameters:

• Verify an Intercom Paging Code is specified under Intercom
Paging.

• Verify the Release Code for Intercom Paging is specified under
Intercom Paging.

Class of Service dialog box:

• Verify the Intercom Paging option is enabled.

Mailbox Entry dialog box:

• If intercom paging was activated by the subscriber over the
phone, verify the system manager did not override the setting on
the Subscriber Settings dialog box.

Mailboxes are not functioning
properly

Cannot edit a mailbox Resolution Possibilities:

• You must be logged in as a level 2 or 3 supervisor to access
most features on-screen.

• Make sure that the correct level of security access is entered. To
access the functions under all menus but the Options menu
(with the exception of the AMIS Maintenance option), enter the
level 2 security password (Default = 12345). To access all
system functions, including those on the Options menu, enter
the level 3 security password (Default = 67890).

• Note that a guest mailbox cannot be edited, nor can you edit a
mailbox that is in use.

• Note that when using greeting by port, the supervisor mailbox
must have either the same company entry as the subscriber’s
mailbox or no company entry to edit the mailbox using the
supervisor main menu functions over the phone.

Cannot change class of service Resolution Possibilities:

• Verify you have logged in at a level 3 security level.

• You can only modify a predefined class of service from the
Class of Service option on the Options menu.

• Note that a security level 3 supervisor can change a class of
service for an individual mailbox by designing and applying a
custom class of service.
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Cannot access mailbox features Resolution Possibilities:

• Verify the sentinel on the Octel 50 system permits the feature.
For information on verifying the features enabled on a sentinel,
see the topic,”Displaying Features Enabled on the Sentinel,”
later in this chapter.

• Verify the feature in question is permitted in the class of service
assigned to the mailbox.

• Verify the feature is active on the Subscriber Settings dialog box.

• Note that a guest mailbox can only send and receive messages.

Cannot log into a mailbox Resolution Possibilities:

• Dial the system’s extension or phone number and press <#>
after the system greeting. Enter the mailbox number and, when
prompted, the mailbox’s password.

• Do not log in using a speakerphone.

• If Octel 50 is on an integrated system using automatic station
login, verify the Inband Signaling code is correct.

• Note that you must enter <#> after the password if the extended
security feature is active. Otherwise, the system pauses after
you finish entering the password before accessing the mailbox.

• Verify the password contains the minimum number of digits
specified in Minimum Length of Password under General in
System Setup.

• Note that a guest mailbox is deleted with its sponsor mailbox.

• Note that the system manager can assign a new password
either through the Edit Mailbox dialog box or over the phone if
the subscriber cannot remember the password.

• The mailbox may be corrupt. Contact a technical support
representative for information on using the Quick Assist utility.

Cannot record mailbox prompts Resolution Possibilities:

• Verify the class of service assigned to the mailbox permits
recording prompts.

• Verify the Maximum Time to Record Mailbox Prompts parameter
is not set to zero under Message Timing in System Setup.

Mailbox is full Resolution Possibilities:

• The value specified in the Max Messages field or Total Time
field in the class of service assigned to the mailbox may have
been reached. Delete messages to allow for more recording
time in the mailbox or increase the limits.

• The class of service may be corrupt. Assign a new class of
service to the mailbox.

• The mailbox may be corrupt. Run Quick Assist using the Update
Partial option. For information on running the Quick Assist utility,
see Chapter 12, “Maintaining the System.”
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Messages

Cannot edit a sent message Resolution Possibilities:

• Verify the Sent Message Editing option is enabled on the Class
of Service dialog box.

• Note that a sent message cannot be edited if it does not reside
in the recipient’s new message queue.

• Note that a message that is in the new message queue cannot
be edited if it has been reviewed or skipped.

• Note that messages scheduled for dispatch through AMIS
cannot be edited.

Cannot save messages Resolution Possibilities:

• Verify the Save Messages option is enabled on the Class of
Service dialog box.

• Note that listen-only messages cannot be saved.

Messages vanishing from
mailboxes

Resolution Possibilities:

• Verify the correct date and time are set on the PC clock.

Mailbox Entry dialog box:

• If Auto Forwarding is active on the Auto Forwarding dialog box,
confirm that the option to delete the message after forwarding is
disabled.

• Note that the number of days to save messages can be set to
99, allowing saved messages to remain on the Octel 50 system
indefinitely.

Class of Service dialog box:

• Note that a message will be removed from the saved message
queue when its age is equal to the Days to Save Saved
Messages value in the class of service. The age is calculated
from the time a message was first received in a mailbox.

System Setup parameters:

• When the number of days to save messages has expired,
messages are automatically deleted. To warn subscribers of
deleted messages, activate the Voice Warning when Messages
Expire parameter under Subscriber.

Message confirmation does
not work

Resolution Possibilities:

• Verify the Message Confirmation option is enabled on the Class
of Service dialog box.

• Note that confirmations are only generated for messages tagged
for confirmation when they are sent.
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• Note that subscribers must check message confirmations
through the check message confirmations feature selected from
the Main menu. Confirmations are not sent as separate
messages.

• Note that messages dispatched to remote sites using AMIS
cannot be sent with message confirmation activated.

Message delivery does not
work for a phone

Resolution Possibilities:

• Attach a digit grabber to monitor a line. Verify the Octel 50
system can access the line and connect to the phone number.

• If Debug displays the error “WARNING 18 No Dial tone
Detected,” all outbound ports were busy when notification was
attempted. You may want to enable more outbound ports on the
system.

System Setup parameters:

• Verify at least one port is enabled for outbound events under
Channel Specific.

• Verify that the Code for Accessing an Outside Line (for example
9,) is specified. If message delivery is to an internal extension
(less than the Number of Digits in Local Telephone Number), the
switch may require a Custom Message Delivery code.

• Verify the value entered for DTONDET under Hangup Detection
is at least 400 units higher than the value entered for
DTONWAIT under Message Delivery.

• The value for DTONDET may be set too low. If it is, the system
may hang up prematurely. Adjust this parameter only if
instructed to by a technical support representative.

Mailbox Entry dialog box:

• Verify the Message Delivery feature is enabled on the
Subscriber Settings dialog box.

• Verify the time blocks are configured on the Message Delivery
dialog box.

• Verify the Message Delivery dialog box indicates PHONE in the
Call Back field.

Class of Service dialog box:

• Verify the Message Delivery option is enabled.

• Verify the Long Distance option under Message Delivery is
selected if subscribers are allowed to enter long distance
numbers for message delivery.
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Message delivery does not
work for a beeper

Resolution Possibilities:

• Attach a digit grabber to monitor a line. Verify the Octel 50
system can access the line and connect to the phone number.

• If Debug displays the error “WARNING 18 No Dial tone
Detected,” the system experienced all outbound ports were busy
when notification was attempted. You may want to enable more
outbound ports on the system.

• Some pager companies use three beep tones to indicate a
connect. If the system does not recognize this connect signal,
configure notification with no call progress using the following
steps:

1. Call the paging company phone number and determine
the number of seconds after the digits are dialed and the
call is connected. Write this number down for use in step
3.

2. Remove all data from the call back field on the Message
Delivery dialog box.

3. In the Phone # field, enter an N followed by a 1, if
required, followed by the area code and pager company’s
phone number. Insert a comma for every two seconds of
time it took to connect that you found in step 1, and then
enter the call back number. For a company that took 10
seconds to connect, a phone number would look like:

N+1+[Area Code]+[Pager Company’s #]+,,,,,+[Callback #]

4. Verify the entire callback number is displayed on the
pager. If not, adjust the number of commas in the Phone
# field.

System Setup Parameters:

• Verify at least one port is enabled for outbound events under
Channel Specific.

• Verify the value entered for DTONDET under Hangup Detection
is at least 400 units higher than the value entered for
DTONWAIT under Message Delivery.

• The value for DTONDET on the may be set too low. If it is, the
system may hang up prematurely. Adjust this parameter only if
instructed to by a technical support representative.

Mailbox Entry dialog box:

• Verify the message delivery feature is enabled on the
Subscriber Settings dialog box.

• Verify the time blocks are configured on the Message Delivery
dialog box.

• Verify on the Message Delivery dialog box that the proper phone
number is entered for the subscriber to return the call in the Call
Back field.

• Verify the Phone # field on the Mailbox Delivery dialog box
contains the pager company’s phone number. If it is a long
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distance call, verify a 1 precedes the area code.

Class of Service dialog box:

• Verify the Message Delivery option is enabled.

• Verify the Long Distance option under Delivery Options is
selected if subscribers are allowed to enter long distance
numbers for message delivery.

Message Waiting Lights do not
work

Message Waiting Lights do not
work for Inband

Resolution Possibilities:

• Disconnect a voice mail port and attach a 2500 set or the
proprietary telephone instrument if using a D/42D-NS,
D/42D-SX, or D/42D-SL integration. Go off hook and manually
test the message waiting light by entering the codes specified
under Message Waiting Light in System Setup.

System Setup parameters:

• Verify that at least one port is enabled for outbound events
under Channel Specific in System Setup.

• Verify the Permit Message Waiting Lights parameter under
Message Waiting Light in System Setup is enabled.

• Verify the Message Waiting Light Prefix ON Code, Message
Waiting Light Prefix OFF Code, Message Waiting Light Suffix
ON Code, and the Message Waiting Light Suffix OFF Code are
entered in the fields under Message Waiting Light. If using the
Dialogic SX or SL integration, see the appropriate Configuration
Note for the correct codes to enter in these fields.

• Some PBXs require Octel 50 to wait for a confirmation tone to
complete the message waiting light event. For these systems,
enter a comma (,) at the end of the Message Waiting Light Suffix
OFF or ON code.

• Verify the value entered for DTONDET under Hangup Detection
is at least 400 units higher than the value entered for
DTONWAIT under Message Delivery.

Class of Service dialog box:

• Verify the Message Waiting Light option is enabled.

Message Waiting Lights do not
work for SMDI

Resolution Possibilities:

• Place a breakout box on the line and verify message waiting
light information is being sent over the SMDI link.

System Setup parameters:

• Verify COMMWL is enabled under SMDI.

• Verify that at least one port is enabled for outbound events
under Channel Specific.

• Verify the Permit Message Waiting Lights parameter under
Message Waiting Light is enabled.
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• Verify the value entered for DTONDET under Hangup Detection
is at least 400 units higher than the value entered for
DTONWAIT under Message Delivery.

Class of Service dialog box:

• Verify the Message Waiting Light option is enabled.

Message Waiting Lights do not
work for DID

Resolution Possibilities:

• Unplug the port from the Octel 50 system and attach a digital
phone to the port. Verify the message waiting light can be lit.

System Setup parameters:

• Verify that at least one port is enabled for outbound events
under Channel Specific.

• Verify the Permit Message Waiting Lights is enabled under
Message Waiting Light and that the correct prefix and suffix
codes are entered.

Class of Service dialog box:

• Verify the Message Waiting Light option is enabled.

Network messages are
returned to mailboxes

Resolution Possibilities:

• Verify AMIS is enabled on the sentinel.  For information on
verifying the features enabled on a sentinel, see the topic,
“Displaying Features Enabled on the Sentinel,” later in this
chapter.

• Verify the Access Phone Number on the AMIS Maintenance
dialog box is correct.

• If using Dial Plan, verify the Dial Plan database is set up
correctly.

• Dedicate a line for testing the networking feature and attach a
digit grabber. Verify the Octel 50 system can access the line and
connect to the remote site.

Class of Service dialog box:

• Verify the node is configured correctly on the AMIS Maintenance
dialog box.

• Verify Highest Outgoing Dispatch is not set to Not Allowed.

System Setup parameters:

• Verify Permit Outbound is enabled under AMIS.
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Operator or subscriber gets
blank messages

Resolution Possibilities:

• Verify the method the switch uses for a disconnect and verify the
appropriate Octel 50 parameters are configured properly. For
more information, see the topic, “Determining a Switch’s
Disconnect Signal,” later in this chapter.

• If the blank messages are recorded noise, check the phone
system for the following problems:

− Noisy phone lines
− RF interference
− Ground problems
− Cross talk/wiring problems
− Tip and ring reversed

System Setup parameters:

• Verify the Minimum Message Length in Seconds parameter
under Message Timing is set to the recommended setting, 2
seconds.

• If setting the Minimum Message Length in Seconds parameter
under Message Timing to 2 seconds does not correct the
problem, set the parameter to 4 seconds and set the Maximum
Silence parameter under Hangup Detection to 350.

PC continually reboots after
Octel 50 installation

Resolution Possibilities:

• Make sure that the sentinel is installed.

• If it is a Rhetorex system, from the \CVR directory prompt, type
CONFIGUR then press <ENTER>. Change the entry point from
6D (Hex) to 61H.

PC is locked up

Resolution Possibilities:

• Try holding down <Ctrl-Alt-Del> for a few seconds. The PC will
reboot and you can restart Octel 50  If this does not work the
first time, try holding them down a little longer.

• If the previous procedure does not work, the last resort is to turn
off power to the PC. This may result in file corruption. Complete
the following procedure to recover from possible file corruption:

1. Turn off the power to the PC. Wait 30 seconds, then turn
power back on.

2. After DOS and Octel 50 have rebooted, view the
OPERATOR.LOG file for an error that might have caused
the lockup. Report this error to a technical support
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representative.

3. Shut down Octel 50 by selecting Exit from the File menu.

4. Run the Quick Assist utility using the Verify option.

5. If Quick Assist does not report any errors, restart Octel 50.
If Quick Assist finds errors, it instructs you on which
recovery options to run. Contact a technical support
representative if Quick Assist recommends you use the
Update All or Rebuild All options.

Personal Network Addresses
(PNA) do not work

Resolution Possibilities:

• Be sure that Distribution Lists (which control PNAs) are
permitted for the mailbox in the class of service.

• Confirm that the PNA is defined with the remote phone number
and mailbox.

• When sending a message to a Personal Network Address, be
sure to enter <*> followed by the PNA number. Personal
Network Addresses are numbered *20 - *39.

Propeller stops spinning

Resolution Possibilities:

• Attempt to exit the system by selecting Exit from the File menu.

• If you cannot exit, select Command Line from the Display menu.
From the command line, type SHUTDOWN then press
<ENTER>.

• If Shutdown has no effect, from the command line, type FORCE
then press <ENTER>.

• If neither Shutdown nor Force works, contact a technical support
representative.
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Ports come off hook when
there are no calls

Resolution Possibilities:

System Setup parameters:

• Verify all ports enabled for outbound events under Channel
Specific have a dial tone. If no dial tone is detected, the system
assumes there is an incoming call.

• Verify the value entered for DTONDET under Hangup Detection
is at least 400 units higher than the value entered for
DTONWAIT under Message Delivery.

Receiving error message
“Voice board not found”

Resolution Possibilities:

• If you have a Rhetorex board and you encounter this problem,
you must run the Configure utility. From the \CVR prompt, type
CONFIGUR then press <ENTER>. On the Configure dialog
box, use the up and down arrow keys to add the hex address for
each installed board. For example, 300 for board 1, 301 for
board 2, 302 for board 3, etc. To update the computer’s
memory, select <F3> and add 32 K for each board after the first.
Here is one example of a two-board configuration:

Real Memory Ports
64KB 300H

301H
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Receiving error message
“Software driver cannot find
the voice board”

Resolution Possibilities:

• On some VGA boards, a 16-bit board cannot be used in a 16-bit
slot with a 16-bit jumper setting. Try using an 8-bit slot or an 8-bit
jumper setting.

• Set auto detect on the VGA card to Off.

• If the voice board is Rhetorex, use the RDSPTEST utility to
diagnose the problem. The RDSPTEST utility provides
diagnostics for the Rhetorex boards. The utility performs three
types of tests on the boards:

Initialization–Verifies that the board is accessible using the
specified configuration. If the board is not accessible,
RDSPTEST posts a warning message and tries to reconfigure
the allocation parameters so that the board is accessible.

Board Diagnostics–Verifies the board’s digital circuitry by
testing the board’s memory, shared memory allocated for the
board, base I/O port, the interrupt level, and the signal levels.

Phone Diagnostics–Verifies the board’s analog hardware by
placing a call between two channels and transmitting data
across both channels.

To copy the contents of the RDSPTEST diskette into the \CVR
directory:

1. Insert the RDSPTEST diskette in the PC’s diskette drive

2. Access the command line interface under the Display menu.

3. Type COPY A:*.* C:\CVR (where A: is the diskette
drive) then press <ENTER>.

Use this utility before requesting an RMA on any Rhetorex
board. For more information, contact a technical support
representative.

Reports are not functioning
properly

Cannot save reports to disk Resolution Possibilities:

• Verify you are selecting to save the report to a disk on the
Reports dialog box.

• Verify the drive name and directory is specified and a filename is
entered in the Report Filename dialog box.

• Verify a formatted diskette is in a valid PC diskette drive and that
the drive door is closed properly.

• Attempt to save a file from another application on the Octel 50
PC to determine if there is a problem with the diskette drive.

Cannot print reports Resolution Possibilities:

• Verify the user is selecting to print the report to a printer (not to a
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disk) on the Reports dialog box.

• Verify the printer was plugged in and turned on when the Octel
50 system was started.

• Attempt to print a document from another application on the PC
to isolate the problem to Octel 50.

• Verify the printer is ready to print (power is on, printer is online,
printer contains paper).

• Verify the printer is attached to the Octel 50 PC or accessible
through the network.

• The printer may be hung. Use the CLRPRT command from the
command line interface to clear the printer.

System Setup parameters:

• Verify the Printer LPT Port (PRINTER) parameter under Channel
Specific is set to the correct LPT port.

Cannot delete statistical
information from reports

Resolution Possibilities:

• Select Statistics on the Clear Mailbox dialog box to clear a
specific mailbox or a range of mailboxes.

• Reset the mailbox using the supervisor main menu functions
over the phone. After logging in, press <1> from the supervisor
menu for mailbox functions and select <4> to reset a mailbox.

• Note that when you select the Statistics option on the Clear
Mailbox dialog box, the statistics are deleted permanently.

Some mailboxes are not
included in reports

Resolution Possibilities:

• The entry in the mailbox’s Company or Division field is incorrect
or missing. Check the field for spelling errors or extra spaces.
Note that these fields are case-sensitive.

• Use the Mailbox Quick List report to display the information
entered in the Company and Division fields for the mailboxes.

• Verify the mailbox owner’s name was specified on the Mailbox
Entry dialog box during mailbox creation. Select the Edit option
from the Mailbox menu, enter the mailbox number when
prompted, and type an entry in the First and Last Name fields of
the dialog box.

Serial Integration (SMDI) does
not work

Resolution Possibilities:

• Verify incoming data packets use the appropriate protocol and
the data being sent contains the proper codes for the integration
device.

• Verify the sentinel allows Serial Integration. For information on
verifying the features enabled on a sentinel, see the topic,
“Displaying Features Enabled on the Sentinel,” later in this
chapter.

• Verify the baud rate entered on the ICONFIG dialog box for the
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Serial Integration utility is the correct value for the serial
integration device.

• Verify the PARITY value selected on the ICONFIG dialog box in
the Serial Integration utility is the correct value for the serial
integration device.

• Verify the STOPBITS value selected on the ICONFIG dialog box
for the Serial Integration utility is the correct value for the serial
integration device.

• Verify the DESKID number entered on the ICONFIG Port ID
dialog box for the Serial Integration utility is the correct number.
Verify this number with the central office.

• Verify the port numbers are entered on the ICONFIG Port ID
dialog box.

Supervised transfers do not
work

Resolution Possibilities:

• Clear the previous CCA results and run Call Analysis again. For
more information on running Call Analysis, see Chapter 9,
“Defining Phone System Signals.”

Voice system has an echo

Resolution Possibilities:

• Check the interrupts on the voice and fax boards, and confirm
they are set to different values.

V-Trees do not work

Resolution Possibilities:

• Verify V-Trees are permitted in the mailbox’s class of service.

• Verify the V-Tree is created and has been activated through call
handling.

• Verify the correct call handling condition is being satisfied:  busy,
no-answer, busy or no-answer, or all calls.

• Listen to the V-Tree over the phone interface to verify the V-Tree
is complete.
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Understanding Call Flow for Specific Call Handling Conditions

The table shown below details the prompts that are voiced under specific call handling
conditions. Call handling is specified for each mailbox on the Subscriber Settings dialog
box. It can be modified by each mailbox owner through the subscriber phone interface.

Call
Blocking

Option set
to:

No
Answer/Call

Blocking
Option set to:

Busy Options set
to:

Result

Active Default (see
note below)

Optional 1 During a Busy condition, callers hear
the Busy menu. If they select the option
to go to voice mail, Optional Prompt 1 is
voiced.

Active Optional 1 Optional 1 Callers hear Optional Prompt 1.

Inactive Optional 1
or Optional 2

Optional 1 Callers hear Optional Prompt 1 or 2, as
defined in the Subscriber Settings.

Active Optional 1 or
Optional 2 or

V-Tree

Default Callers pressing <#><#> and then the
extension number to reach the
extension hear Optional Prompt 1 or 2
or the V-Tree, as defined in the
Subscriber Settings.

On systems using inband signaling, when Call Blocking is active, the No Answer/Call
Blocking call handling option is set to Default, and call paging is set to Automatic, call
paging takes priority over call handling.

Determining a Switch’s Disconnect Signal

When you are troubleshooting certain integration issues, you are instructed to confirm
that Octel 50 is configured to detect the appropriate disconnect signal from the switch.
When possible, consult the Configuration Note and the switch documentation for this
information. If you do not have access to this information, you can use the procedure
below to determine the switch’s disconnect signal.

To determine a switch’s disconnect signal:

1. Disconnect a voice mail port and attach a 2500 set (or the proprietary telephone
instrument if using a D/42D-NS, D/42D-SX, or D/42D-SL integration) and a digit
grabber.

2. From another phone, call the port.

3. Answer the phone connected to the port and listen over the handset.

4. Hang up the calling phone.

5. Use the following table to determine the disconnect signal.

Volt Meter Reading Audible Signals Disconnect Signal

drops to 0 V silence loop current drop

no change DTMF tones hangup string

no change dial tone dial tone

no change silence silence
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Displaying Features Enabled on the Sentinel

An improperly programmed sentinel can inhibit the functionality of certain system
features. To confirm the sentinel is programmed appropriately, you can use the View
Sentinel program to display a list of enabled features.

To display features enabled on the sentinel:

1. If the Octel 50 system is not running, proceed to step 2. If the Octel 50 system is
running, shut down it down:

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.

b.  Press <Alt-F> to view the File menu options.

c.  From the File menu, use the down arrow key to select Exit then press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown then press <ENTER>. The system shutdown completes and the
\CVR prompt displays.

2. From the \CVR prompt, type VIEWSENT then press <ENTER>.

3. The sentinel information displays.

Interpreting the View Sentinel Information

The following information displays when you run the View Sentinel program:

• Serial Number–Identifies the sentinel unit’s serial number. You may be asked to
provide this number when you contact a technical support representative.

• Product Code–Indicates the product the sentinel is programmed to run.

• Max Ports–Indicates the maximum number of channels the Octel 50 system is
allowed to use.

• Max Mailboxes–Indicates the maximum number of mailboxes allowed on the
Octel 50 system.

• Revision–Identifies the software version number the sentinel is programmed to
use.

• Max Languages–Identifies the maximum number of languages allowed on the
Octel 50 system.

• Fax Retrieval–Indicates whether the fax retrieval feature is enabled.

• Fax Mail–Indicates whether the fax mail feature is enabled.

• SMDI–Indicates whether SMDI Integration is allowed on the Octel 50 system.

• AMIS–Indicates whether the AMIS analog protocol for networking is enabled.

• Intercom Redirect–Indicates whether the intercom redirect feature is enabled.

• Octel Board Required–Indicates whether Octel 50 must use voice and fax
boards with the proper signature. On indicates that a signatured board is required.
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Using the Command Line Interface

The Command Line feature provides an interface for you to enter system operation
commands while the Octel 50 system is running. The available commands enable you to
perform a number of functions, including copying files, disabling and enabling ports, and
enabling the debug feature.

Opening and Closing the Command Line Interface

Use the following procedures to open and close the Command Line interface.

To open the Command Line interface:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

To close the Command Line interface:

1. Press <ESC> to close the active display and active the menu bar.

2. Reselect Command Line from the Display menu.

Closing Business Hours

Use the following procedure to immediately terminate any active business hours.

To close business hours:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type CLOSED then press <ENTER>.

The system resets at midnight to normal hours.

Opening Business Hours

Use the following procedure to immediately activate business hours.

To open business hours:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type OPEN then press <ENTER>.

The system resets at midnight to normal hours.
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Clearing the Printer

Use the following procedure to reset the printer functions when a hung condition is
determined. The printer may hang due to an internal problem or an undetected system
problem.

You may also want to use this command whenever the system encounters difficulty
during a shut down and after all voice ports are disabled.

To clear the printer:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type CLRPRT then press <ENTER>.

Clearing the Screen

Use the following procedure to erases all information, such as error messages, in the
Command Line interface display area.

To clear the Command Line display area:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type CLS then press <ENTER>.

Copying Files

Use the following procedure to copy a file from the Command Line interface.

To copy a file:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type COPY source_filename target_filename
then press <ENTER> where source_filename is the filename (including the full
path) to copy from and target_filename (including the full path) is the filename
to copy to.

 For example, to copy the OPERATOR.LOG file from the \CVR1 directory on the C:\
drive to a floppy diskette, type COPY C:\CVR1\OPERATOR.LOG
A:\OPERATOR.LOG then press <ENTER>.

Use this command with caution as the system does not check to see if the filename
already exists. This could result in an existing file being overwritten.
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Changing the System Date

Use the following procedure to set the date on the PC. The default is the date set by the
operating system on the PC.

To set the system date:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type DATE mmddyyyy then press <ENTER> where mm
specifies the month, dd specifies the day, and yyyy specifies the year.

 For example, to set the date to August 30, 1996, from the Command Line, type
DATE 08301996 then press <ENTER>.

Changing the System Time

Use the following procedure to set the time on the PC. The default is the time set by the
operating system on the PC.

To set the system date:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type TIME hhmm then press <ENTER>where hhmm
denotes the hour and minute in military format.

 For example, to set the time to 1:05 PM, from the Command Line, type TIME 1305
then press <ENTER>.

Activating Debug Mode

Use the following procedure to activate debug mode. When debug is enabled, system
information is sent to the Command Line interface.

To activate debug mode:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type DEBUG ON then press <ENTER>.

Deactivating Debug Mode

Use the following procedure to deactivate debug mode.

To deactivate debug mode:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type DEBUG OFF then press <ENTER>.
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Activating and Deactivating Digit Grabber

Use the following procedures to activate and deactivate the digit grabber utility. When
debug is enabled, digits sent by the switch display on the Command Line interface.

To activate digit grabber:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type DIGRAB ON then press <ENTER>.

To deactivate digit grabber:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type DIGRAB OFF then press <ENTER>.

Disabling and Enabling Ports

Use the following procedures to disable and enable system ports. When you use the
disable command, the port is disabled at the completion of the current call and no further
calls are accepted.

To disable a port:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type DIS n then press <ENTER> where n is the
number of the port you want to disable. For example, to disable the first port, from the
Command Line, type DIS 0 then press <ENTER>.

4. To disable all ports, type DIS ALL then press <ENTER>.

 To free all ports, first use the DIS command to prevent unoccupied ports from
answering further calls, then use DROP to terminate calls on any occupied lines.

To enable a port:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type ENA n then press <ENTER> where n is the number
of the port you want to enable. For example, to enable the first port, from the
Command Line, type ENA 0 then press <ENTER>.
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Dropping Ports

Use the following procedures to drop system ports. When you use the drop command,
current calls are immediately terminated and the port is reset to answer another call.

To drop a port:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type DROP n then press <ENTER> where n is the
number of the port you want to drop. For example, to immediately terminate
communication on the first port, from the Command Line, type DROP 0 then press
<ENTER>.

 To drop all ports, type DROP ALL then press <ENTER>.

Restarting the System

Use the following procedures to restart the Octel 50 system. The restart command
instructs the system to reinitialize the voice board. All channels are disabled first. The
voice board must be reinitialized to recognize any changes made that affect the board.

To restart the system:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type RESTART then press <ENTER>.

Shutting Down the System

Use the following procedures to shut down the Octel 50 system. This command shuts
down system operations and returns to the operating system. Unoccupied ports are
disabled to prevent further incoming calls. Each occupied port is automatically disabled
after current calls are terminated. Once all ports are disabled, the system shuts down and
returns to DOS.

To shut down the system:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type SHUTDOWN then press <ENTER>.

You can also shut down the system by selecting Exit from the File menu.

Performing a Force System Shutdown

Use the following procedures to perform a force system shutdown. Unlike the
SHUTDOWN command, this command shuts down the system without regard to current
calls. Activity on all ports is immediately terminated. This command should only be used
as a last resort to shut down the system.
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To perform a force system shutdown:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type FORCE then press <ENTER>.

Use this command with caution. Current calls are immediately terminated.

Displaying Memory Statistics

Displays the amount of dynamically allocated memory and the amount of available
extended memory.

To display memory statistics:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type MEMSTAT then press <ENTER>. A message
displays such as:

 System heap intact. Dynamic Memory Allocated 153K Memory
Free 1692K

Displaying the Status of System Setup Parameters

Use the following procedure to display the current status of certain system parameters (in
rings, active, event rate, serial count, blanking rate, checkpoint rate, last message, and
message count).

To display the parameters’ status:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type STATUS then press <ENTER>. The parameter
settings display in the following format (the numbers displayed are for example
purposes only):

In Rings: 1 Serial Count: 10
Active: 0 Blanking Rate: 30
Event Rate: 40 Checkpoint Rate: 5
Last Message: 1 Message Count: 0

Resetting System Statistics

Use the following procedure to reset system performance and application statistics to
zero. Statistics affected are hourly counts, monthly statistics, calls on each channel, failed
calls on each channel, and application statistics.

To reset system statistics:

1. Press <ESC> to close the active display and active the menu bar.
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2. Select Command Line from the Display menu.

3. From the Command Line, type STRESET then press <ENTER>.

Diagnostic statistics, serial call counts, and application-defined statistics are not reset with
the STRESET command.

Displaying File Command Settings

Use the following procedure to display the setting of a specified system file command.

To display a file command setting:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type SYSLOOK sys_parameter then press <ENTER>
where sys_parameter is the parameter whose setting you want to view. For
example, to view the value of the INBOUND setting, from the Command Line, type
SYSLOOK INBOUND then press <ENTER>.

Displaying the System Version Number

Use the following procedure to display the version number of the system software.

To display the software version number:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type VERSION or VER then press <ENTER>.

Repeating the Most Recent Command

Use the following procedure to repeat the most recently entered command. This
command allows you to avoid repetitive typing when entering multiple commands.

To repeat the most recently entered command:

1. Press <ESC> to close the active display and active the menu bar.

2. Select Command Line from the Display menu.

3. From the Command Line, type = then press <ENTER>. For example, if you have
just entered the STATUS command and want to display the status again, from the
command line, type = then press <ENTER>.
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Understanding Phrase Files and Using V-Edit

This section lists Octel 50’s phrase files along with each phrase’s corresponding phrase
number, helps you use the system’s multilingual capabilities, and helps you use Dialogic
V-Edit and Rhetorex V-Edit to record and modify phrases for use with Octel 50.
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Understanding Octel 50 Phrase Files

Octel 50 uses three phrase files:  SO3-ALL.*, SO3-D1.*, and SO3-D2.*, where the *
represents a VAP extension for systems using a Dialogic voice board or a VOX extension
for systems using a Rhetorex voice board. The first two phrase files contain system
prompts, while the SO3-D2.* file is an empty file for storage of custom phrases recorded
on-site. Following the phrase file listings is information on how you can prepare
professionally-recorded phrases for use on Octel 50. If you are using the system’s
multilingual capabilities, see the topic, “Using the Multilingual Capabilities,” later in this
chapter for information on recording and storing phrases in more than one language.

SO3-ALL.VAP and SO3-ALL.VOX Phrase Files

1 “one”

2 “two”

3 “three”

4 “four”

5 “five”

6 “six”

7 “seven”

8 “eight”

9 “nine”

10 “ten”

11 “eleven”

12 “twelve”

13 “thirteen”

14 “fourteen”

15 “fifteen”

16 “sixteen”

17 “seventeen”

18 “eighteen”

19 “nineteen”

20 “twenty”

21 “thirty”

22 “forty”

23 “fifty”

24 “sixty”

25 “seventy”
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26 “eighty”

27 “ninety”

28 “hundred”

29 “thousand”

30 “million”

31 “dollars”

32 “cents”

33 “and”

34 “oh”

35 “AM”

36 “PM”

37 “January”

38 “February”

39 “March”

40 “April”

41 “May”

42 “June”

43 “July”

44 “August”

45 “September”

46 “October”

47 “November”

48 “December”

49 “on”

50 “at”

51 “zero”

52 .25 second silence

53 .50 second silence

54 .75 second silence

55 1.0 second silence

56 “month”

57 “day”

58 “hour”

59 “minute”
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60 “new”

61 “code”

62 “item”

63 “total”

64 “count”

65 “reset”

66 “saved”

67 “default”

68 “error”

69 “star”

70 “you”

71 “Hello, thank you for calling. Your call is being handled by our automated
attendant/voice mail system.”

72 “Please make your selection now.”

73 “<mailbox number> ...was not found on this system.”

74 “Please leave a message for ...<mailbox owner’s name prompt>.”

75 “The pound key...”

76 “At the tone, please record your message.”

78 “If you are satisfied with your message, press 1 to send.”

79 “To review your message, press 4.”

80 “...is not an available selection.”

81 “To mark this as a regular message, press 7. To mark this as an urgent message,
press 8.”

82 “To rerecord your message, press 2.”

83 “Message sent...”

86 “The password you have entered is not valid.”

87 “When you are finished recording, you can press the pound key for special sending
options, or simply hang up.”

90 “Or to disconnect, press pound.”

92 “I’m sorry, but mailbox number ...<number>....”

103 “To page the person you are calling, press 4.”

106 “...press 7.”

125 “To continue holding, do nothing. To try another extension, press 1. To leave a voice
mail message, press 2.”

126 “You are currently number ...<number>...”
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127 “...in the queue.”

128 “When you are finished, press pound.”

129 “Enter the next mailbox number.”

130 “Or to return to the message menu, press pound.”

136 “Or to return to the Main menu, press pound.”

138 “...off.”

175 “Enter the destination mailbox number.”

176 “You have exceeded the maximum number of errors permitted on this system.”

177 “Message to be sent to...<mailbox owner’s name prompt>.”

195 “I’m sorry, there has been a recording error. Please try again later.”

202 “Thank you, good-bye.”

204 “Please enter the extension number of the person you would like to speak with.”

205 “If you do not know the extension number, press the star button for directory
services.”

206 “<mailbox>...is an invalid extension number.”

207 “Please hold while your call is being transferred.”

208 “I’m sorry, but that extension is busy right now.”

209 “To try another extension, press 1.”

210 “I’m sorry, but there is no answer at that extension.”

211 “To be transferred to our receptionist, press 3.”

212 “Please speak your name at the tone, so that I may say who is calling.”

213 “You have a call from...<name>.”

223 “There is a call for ...<name>.”

227 “For an alphabetical directory, press pound.”

228 “Enter the first few letters of the last name of the person you are calling.”

230 “I’m sorry, there is no one with that last name in the directory.”

231 “I’m sorry, but there is no directory recording for that mailbox.”

232 “Use the 1 button for q and z.”

233 “Or press the star button for a complete directory.”

238 “...private.”

239 “This message is marked...”

243 “For a directory, press star star.”

252 “To leave a voice mail message, press 2.”

253 “Or to try the extension again, press 3.”
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259 “I’m sorry, but that extension is still busy.”

260 “One moment, you have a call.”

271 “Please hang up now to transfer the caller.”

277 “Or to return to the previous menu, press pound.”

281 “To send the message with future delivery, press 9.”

282 “If you do not want to send a message, press pound.”

284 “...followed by the pound sign.”

285 “Press”

286 “Your call is being re-routed. Please hold.”

289 “Thank you.”

292 “Or you may hold the line and you will be automatically transferred to our
receptionist.”

299 “If you want to be transferred to our receptionist, say yes.”

302 “To append to your comments, press 3.”

303 “To append to your message, press 3.”

304 “At the tone please leave a voice message.”

305 “Please leave a voice message for...”

306 “Six”

307 “Thank you, good-bye”

SO3-D1.VAP and SO3-D1.VOX Phrase Files

Some phrases reference a Subsriber’s Guide. In these cases, users should see the Quick
Reference Guide.

1 “You have entered an invalid class of service number.”

2 “This message has been deleted by the sender.”

3 “In class of service number...”

4 “The message length is out of range. The message length must be between 30 and
32,000 seconds.”

5 “Enter the number of days to save new messages, followed by the pound sign. If
you do not want new messages to be automatically deleted, enter 99 followed by the
pound sign.”

6 “To allow local message delivery, press 1. To allow long distance message delivery,
press 2. Or for no message delivery, press 3.”

7 “To allow regular beeper paging, press 1. To allow digital beeper paging, press 2. Or
for no beeper paging, press 3.”
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8 “Mailbox added.”

9 “Enter the number of the mailbox to update. Or press the star button to return to the
Main menu.”

10 “The mailbox you have selected belongs to...”

11 “To change the mailbox password, press 1. To  change the mailbox prompts, press
2.”

12 “Enter the number of the mailbox you want to delete.”

13 “To delete, press 1. Or to return to the Main menu, press star.”

14 “Mailbox deleted.”

15 “To change the please hold prompt, press 1. To change the directory prompt, press
2. To change the mailbox owner’s name prompt press 3. To change the personal
greeting prompt, press 4.”

16 “To change the class of service, press 3.”

17 “Enter the class of service number followed by the pound sign. Or to hear a brief
description of a specific class of service, enter star followed by the class of service
number and the pound sign.”

18 “Please enter the extension you are calling from followed by the pound sign or press
the pound sign followed by the mailbox number.”

19 “To return to the Main menu, press star.”

20 “To delete a mailbox from the distribution list, press 2.”

21 “To verify your new password, please re-enter it now.”

22 “The passwords entered do not match.”

23 “Password accepted. Your new password will be in effect the next time you call.”

24  “At the tone, record system prompt number...”

25 “...has not been created.”

26 “To add a new mailbox, press 1. To update an existing mailbox, press 2. To delete
an existing mailbox, press 3. To reset an existing mailbox, press 4.”

27 “You will have to enter both passwords again.”

28 “Please enter your Supervisor password.”

29 “Supervisor Main menu. For mailbox functions, press 1. To change system prompts,
press 2. To change system distribution lists, press 3.”

30 “Or if you are finished, press star.”

31 “Enter the number of the folder you wish to name, 1 through 9.”

32 “Or, press star for a listing of current folders.”

33 “Enter the number of the folder in which you want to save this message. Or, if you
do not want to save it in a folder, press 0. For a listing of current folders, press star.”

34 “Folder deleted.”

35 “To create or update your V-Tree, press 1.”
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36 “There are currently no folders defined.”

37 “Your V-Tree is now...”

38 “A V-Tree must be created before it can be turned on.”

39 “Enter the file number of the prompt to use, or press star to record the prompt now.”

40 “At the tone, record the prompt.”

41 “To accept, press 1. Or, to rerecord, press 2.”

42 “Enter the phrase number.”

43 “To accept, press 1. Or to select a different prompt, press 2.”

44 “You have already created a V-Tree.”

46 “Enter the action code for option...”

47 “For proceed to the next menu, press 1. For transfer to a mailbox, press 2. For
record to a mailbox, press 3. For disconnect caller, press 4. For return to the
previous menu, press 5.”

48 “Enter the mailbox number.”
 
49 “Returning to level...”

50 “Advancing to level...”

53 “For record and go to next level, press 7. For transfer to mailbox entry, press 8. For
transfer caller to voice mail, press 9.”

54 “For transfer caller to directory services, press 6.”

55 “To select Intercom paging options...”

56 “...automatic”

57 “For automatic call paging...”

58 “For review the last recorded message, press 3.”

59 “Call paging is now...”

60 “...or press star to return to the previous menu.”

61 “For send a user selected fax document and advance to next level, press 1.”

62 “...is...”

63 “...is empty...”

64 “To activate optional prompt number 1, press 1.”

65 “To activate optional prompt number 2, press 2.”

66 “To forward calls to another mailbox, press 3.”

67 “To review active call handling options, press 8.”

68 “...for...”

69 “The optional prompt must be recorded before it can be used for call handling.”

70 “To be transferred to a live operator, press 0.”
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71 “...has expired.”

72 “You have activated Intercom Redirect.”

73 “Enter the number of the language to use, 1 through...”

74 “To activate your V-Tree, press 4.”

75 “To return to normal call handling, press 9.”

76 “To use...”

77 “...optional prompt number 1...”

78 “...optional prompt number 2...”

79 “...call forwarding...”

80 “...V-Tree...”

81 “...to block calls to your extension, press 1.”

82 “...after your extension is not answered, press 2.”

83 “Message confirmation deleted.”

84 “Please enter the month you want  your message delivered. Enter the number of the
month, such as one for January or one zero for October, followed by the pound
sign.”

85 “Enter the date you want your message delivered. Enter the date, between one and
thirty-one, followed by the pound sign.”

86 “Enter the hour you want your message delivered. Enter the hour, between zero and
twenty-three, followed by the pound sign.”

87 “Enter the minute you want  your message delivered. Enter the minute, between
zero and fifty-nine, followed by the pound sign.”

88 “This message will be delivered on ...<date>...”

89 “If this is correct, press 1. If this is not correct, press 2.”

90 “This message was auto forwarded from...”

91 “Enter the new supervisor password, or press star to return to the Supervisor Main
menu.”

92 “...digit password or press star to return to the Supervisor Main menu.”

93 “To continue holding, do nothing. To try another extension, press 1.”

94 “...to block calls to your extension...”

95 “...after your extension is not answered.”

96 “To accept, press 1. To rerecord, press 2. Or, to delete, press 3.”

97 “I’m sorry. There are currently no directory entries recorded.”

98 “At the tone, record optional prompt number 1.”

99 “At the tone, record optional prompt number 2.”

100 “To review options, press 9.”
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101 “Enter the number of days to save your saved messages, followed by the pound
sign. If you do not want saved messages to be automatically deleted, enter 99
followed by the pound sign.”

102 “The maximum number of days to save messages is ...<number>.”

103 “Enter the number of the mailbox to reset.”

104 “Press 1 to reset, or press the star button to return to the previous menu.”

105 “The mailbox has been reset.”

106 “...is in use.”

107 “System prompt deleted.”

108 “You are not authorized to access this mailbox.”

109 “Please enter the number of the recipient’s mailbox to check for message
confirmations or press pound to check all message confirmations.”

110 “I’m sorry but there are no message confirmations for ...”

111 “To repeat, press 2.”

112 “To continue press 2.”

113 “The message confirmation for mailbox number...”

114 “...no longer exists on the system.”

115 “To delete this message confirmation, press 1.”

116 “Message waiting available.”

117 “Saving of messages...”

118 “Distribution lists...”

119 “Supervisor functions...”

120 “Undelete messages...”

121 “V-Trees...”

122 “Message confirmation...”

123 “Access to directory services...”

124 “Voice only mailbox...”

125 “Guest mailbox...”

126 “Receive only mailbox ...”

127 “Long distance outcalling...”

128 “Local outcalling is permitted.”

129 “No outcalling is permitted.”

130 “The maximum recording time for a message is...”

131 “The maximum number of messages allowed is...”

132 “The maximum recording time for all messages is...”
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133 “To confirm the deletion of this message, press 9. If you do not want to delete this
message, press pound.”

134 “The number of days new messages will be saved is...”

135 “The number of days saved messages will be saved is...”

136 “...permitted”

137 “Intercom paging...”

138 “You cannot change your personal distribution list from the Supervisor menu.”

139 “System distribution lists can only be changed from the Supervisor menu.”

140 “To mark this as a listen only message, press 6.”

141 “To have message notification notify you for your first message only, press 1. To
have it notify you each time you receive a message, press 2.”

142 “Wake-up call...”

143 “Enter the folder number, 1 through 9, or press zero to listen to all saved messages.
For a listing of current folders, press star.”

144 “Your wake-up call has been activated for...”

145 “To turn...”

146 “...cannot receive messages.”

147 “Company list.”

148 “Division list.”

149 “To create a guest mailbox, press 8.”

150 “Enter the mailbox number to use for the guest mailbox.”

151 “<mailbox number>...has been created as a guest mailbox.”

152 “Enter the system prompt number, 1 through 999.”

153 “Distribution list added.”

154 “To change the default operator for this mailbox, press 4.”

155 “Enter the number of the mailbox to use as the default operator.”

156 “...is the default operator, now.”

157 “Please hold ...”

158 “Enter the number of the mailbox to search for messages from.”

159 “To scan for messages from a specific mailbox, press 6.”

160 “This message is marked ‘listen only’.”

161 “Recording of prompts...”

162 “Message scanning...”

163 “Call handling ...”

164 “Editing sent messages...”
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165 “Ring count is...<number>.”

166 “Current folders are...<number>.”

167 “At the tone, speak the folder label.”

168 “Folder number...<number>...”

169 “Enter the number of the fax machine followed by the pound sign.”

170 “Enter the telephone number of the destination fax machine, or, if you are calling
from a fax machine, press pound.”

171 “Enter your extension or phone number. It will be used to help identify this fax.”

172 “I’m sorry the fax board is not responding. Please try again later.”

173 “Fax...”

175  “To update system faxes, press 4.”

176 “At the tone, press the send key on your fax machine.”

177 “To activate Intercom Redirect, press star.”

178 “For fax a predefined document and advance to next level, press 2.”

179 “Enter the number of the document to send followed by the pound sign.”

180 “Enter the area code and phone number of your fax machine followed by the pound
sign.”

181 “To help identify the fax, enter your extension number followed by the pound sign.”

182 “...attempts will be made to send the requested fax.”

183 “...does not exist.”

184 “Your fax is number...”

186 “You have requested a fax be sent to...”

188 “I’m sorry but there are currently no V-Trees defined.”

189 “To insert a level, press 7.”

190 “To return to the top of your V-Tree, press 9.”

191 “For advanced options, press 0.”

192 “To continue holding, do nothing. To try another extension, press 1. To leave a voice
or fax mail message, press 2.”

193 “To try another extension, press 1. To leave a voice or fax mail message, press 2.”

194 “To leave a voice or fax mail message, press 2.”

195 “...has not picked up messages.”

196 “To include a fax, press star.”

197 “Press the start button on your fax machine now.”

198 “Press the start/receive button on your fax machine now.”
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199 “When you are finished recording, you can press the pound key for special sending
and fax options, or simply hang up.”

200 “To review options, press 1.”

202 “To delete an option, press 3.”

204 “To execute an option, press 5.”

205 “For proceed to the next menu, press 1. For transfer to a mailbox, press 2. For
record to a mailbox, press 3. For disconnect caller, press 4.”

207 “Option number...”

208 “...is proceed to next level.”

209 “...is transfer to mailbox number.”

210 “...is record and return from mailbox number.”

211 “...is disconnect.”

212 “...is return to previous level.”

213 “...is go to directory.”

214 “...is record and go to next level using mailbox number.”

215 “...is transfer to automated attendant.”

216 “...is transfer to voice mail.”

217 “...is advance to next level after sending a user-specified fax.”

218 “...is advance to next level after faxing document number...<number>.”

219 “...is to review the last recorded message and go to next level.”

220 “Please hold while I page...”

221 “Delete option.”

222 “Enter the number of the option to delete.”

223 “Option deleted.”

228 “To edit the prompts for this level, press 6.”

229 “Level number...<number>.”

231 “Execute option.”

232 “Enter the number of the option to execute.”

233 “Creating level...”

234 “To accept, press 1. To rerecord, press 2. To append, press 3.”

235 “To confirm the deletion of this V-Tree, press 9. If you do not want to delete this V-
Tree, press pound.”

236 “The option you have selected is incomplete. Please select another option.”

237 “You have requested document number...”

238 “...to be delivered to...”
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239 “If this information is correct, press 1; if not, press 2.”

240 “If no password is desired, press zero followed by the pound sign.”

241 “To listen to your V-Tree, press 2. To delete your V-Tree, press 3.”

242 “To change this message, press 1. To continue,  press 2.”

250 “Please enter the number of the mailbox you are adding.”

251 “...already exists on the system.”

252 “Enter the initial password followed by the pound sign.”

253 “To record the individual prompts for this mailbox, press 1. If you do not wish to
record the prompts, press 2.”

254 “At the tone, record your please hold prompt.”

255 “At the tone, record your mailbox owner’s name prompt.”

256 “At the tone, record your directory prompt.”

257 “At the tone, record your personal greeting prompt.”

258 “Please enter your mailbox number.”

259 “...no...”

260 “Please enter your password...”

261 “You have...”

262 “...new message...”

263 “...saved message...”

264 “...new messages...”

265 “...saved messages...”

266 “Warning!  Your remaining message recording time is now under 2 minutes.”

267 “Main menu”

268 “To listen to new messages, press 1.”

269 “To listen to saved messages, press 2.”

270 “To send a message, press 3.”

271 “To check message confirmations, press 4.”

272 “To recover a deleted message, press 5.”

273 “Please continue holding while I wait for a response.”

274 “To change a message that has been sent, press 7.”

275 “I’m sorry, there is no page for...”

276 “For more options, press 9.”

277 “To return to the automated attendant, press 0.”

278 “To return to voice mail, press 0.”
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279 “Options menu”

280 “To rerecord prompts, press 1.”

281 “To change special features, press 2.”

282 “To change call handling, press 3.”

283 “To define or edit a folder, press 4.”

284 “To rerecord your please hold prompt, press 1.”

285 “To rerecord your directory prompt, press 2.”

286 “To rerecord the mailbox owner’s name prompt, press 3.”

287 “To rerecord optional prompt 1, press 4.”

288 “To rerecord optional prompt 2, press 5.”

289 “To rerecord the personal greeting prompt, press 6.”

290 “To change the message delivery selection, press 1.”

291 “To change your message delivery number, press 2.”

293 “Call queuing...”

294 “To turn call screening...”

295 “To update call distribution lists, press 6.”

296 “To turn call paging...”

297 “To update your V-Tree, press 8.”

298 “Or to retrieve the fax now, press pound.”

299 “Or press pound to return to the Options menu.”

301 “...is now off.”

302 “Call paging...”

303 “Message delivery...”

304 “To be notified of urgent messages only, press 1. To be notified of all messages,
press 2.”

305 “To turn message delivery off, press 3.”

306 “Message delivery is now...”

307 “If the message delivery number calls a beeper, press 1. If it calls a phone, press 2.”

308 “Enter the message delivery setting you want to update, 1 through 8.”

309 “...to mailbox number...”

310 “Enter the number to display on the digital beeper followed by the pound sign.”

311 “Call screening...”

312 “To reschedule your wake-up call, press 1. To turn your wake-up call off, press 2.”

313 “Enter the phone number for your wake-up call followed by the pound sign.”
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314 “Hello, this is your wake-up call. The time is...<time>.”

315 “...to create...”

316 “...to delete...”

317 “Distribution list deleted.”

318 “To add a mailbox to the distribution list, press 1.”

319 “...to be updated.”

320 “Press star followed by the number of the list...”

321 “To create a list, press 1.”

322 “To review or update a list, press 2. To delete a list, press 3.”

323 “...contains the following mailboxes...”

324 “Please enter the number of the mailbox to add, or to return to the previous menu
press pound.”

325 “Distribution list...”

326 “...is full...”

327 “All list numbers must begin with a star.”

328 “Current list numbers are...”

329 “To review all current list numbers, press 4.”

330 “I’m sorry, but you have no lists on the system.”

331 “...already exists in the distribution list.”

332 “Message recovered.”

334 “Enter the number of the mailbox to which calls will be forwarded.”

335 “Optional prompt number...”

336 “...has been activated.”

337 “Calls will be forwarded to mailbox...<number>.”

338 “...after your extension is busy.”

339 “...after your extension is either not answered or busy.”

341 “Please enter your new password followed by the pound sign.”

342 “You have entered an invalid password. The maximum password length is...”

343 “...digits and cannot begin with zero.”

344 “First new message...”

345 “First saved message...”

346 “Next message.”

347 “...from...”

348 “This message is marked urgent.”
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349 “End of new messages.”

350 “End of saved messages.”

351 “Message menu.”

352 “To reply, press 3.”

353 “To review, press 4.”

354 “Message deleted.”

355 “Message will be saved for...”

356 “...day.”

357 “...days.”

358 “Message received...”

359 “This message was from...”

360 “Length of message is...”

361 “...minutes.”

362 “...seconds.”

363 “To be transferred to...”

364 “To skip this message, press 6, 4.”

365 “To send a copy of this message to another mailbox, press 5.”

366 “For message delivery information, press 6, 2.”

367 “Message saved.”

368 “To delete, press 1.”

369 “To accept this message, press 1. To continue, press 2. Or to return to the previous
menu, press pound.”

370 “To delete, press 1. To rerecord, press 2.”

371 “Enter the number of the mailbox containing the message to be changed.”

372 “First deleted message.”

373 “End of deleted messages.”

374 “...today...”

375 “Or...”

376 “To review, press 4.”

377 “If message confirmation is desired, press 1. If not, press 2.”

378 “In addition to your personal greeting prompt, two optional prompts are available for
special call handling functions. To activate your optional prompts, refer to the Call
Handling section of your Subscriber’s Guide.”

379 “...sent...”

380 “...has not been received.”
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381 “...was received.”

382 “Message to...”

383 “To review your comments, press 4.”

384 “Your V-Tree has been deleted.”

385 “There is no prompt recorded for this level.”

386 “To continue holding, press star. To try another extension, press 1. To  leave a
voice mail message, press 2.”

387 “Enter the option number of the level you wish to insert this level before.”

388 “Action code must be of the advance to next level type.”

389 “Forwarded from...”

390 “Enter your message delivery number followed by the pound sign.”

391 “To rerecord your comments, press 2.”

392 “...is not an active distribution list number.”

393 “To mark this as a private message, press 9.”

394 “Private messages may not be forwarded.”

395 “Message confirmation is on.”

396  “To send the message without comments, press 1. To add comments to the
message, press 2.”

397 “Record your comments at the tone. When you are finished recording, press
pound.”

398 “To send your comments and the message, press 1. To review your comments,
press 2. To rerecord your comments, press 3.”

399 “To send the message with the same comments, press 1. To record new comments
or to send the message without comments, press 2.”

400 “At the tone, record your reply to...”

401 “Hello, this is your voice mail system, I have a message for...”

402 “You have a call waiting. To take this call, press pound.”

403 “To take this call, press pound.”  

404 “Mailbox number...<mailbox number>.”

405 “To change the message delivery number, press 1. To change the call back
number, press 2. If no changes are desired, press pound.”

406 “Urgent message sent.”

407 “To reject the call, press 1, or to redirect the call, press star.”

408 “In the morning.”

409 “In the evening.”

410 “Or to return to the message menu without sending the message, press pound.”
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411 “Or to return to the main menu without sending the message, press pound.”

412 “For go to login point, press 4.”

413 “To send a new message, press 3.”

414 “To send the message with the same comments, press 1. To record the comments
again or to send the message without comments, press 2.”

415 “Your new message delivery number is...”

416 “This message has been retracted by its sender.”

417 “To keep the same phone number, press 1. To use a different phone number, press
2.”

418 “To reschedule your wake up call for the same time tomorrow, press 1. To use a
different time, press 2.”

419 “...is go to mailbox login point.”

420 “To update an existing mailbox, press 2. To delete an existing mailbox,  press 3. To
reset an existing mailbox, press 4.”

421 “To create or update an option, press 2.”

422 “To activate your optional prompt, press 1.”

423 “To rerecord your optional prompt, press 4.”

424 “At the tone, record your optional prompt.”

425 “Optional prompt”

426 “Press 1 to continue or press two to repeat these instructions.”

427 “For proceed to the next menu, press 1. For transfer to a mailbox, press 2. For
disconnect caller, press 4. For return to the previous menu,  press 5.”

428 “Create or update an option.”

429 “Enter the number of the option to create or update.”

430 “Hello. This is your new voice processing system. Since this is your first time calling
we need to take a few minutes to familiarize you with the system and customize
your mailbox. While we recommend that you continue, you may exit the tutorial and
set up your mailbox manually by pressing the star button at any time. First, let’s
personalize your password. A password protects against the accidental or
intentional access to your mailbox by someone else. Your mailbox password can be
any combination of numbers from one to nine digits in length and cannot begin with
zero. You may want to write down your password for reference, but for security
purposes, do not share your password with others.”

431 “Now, let’s record your personalized prompts. When recording these prompts, make
sure you speak clearly into the telephone handset. Do not use a speakerphone, and
try to eliminate any background noise. Start speaking after the tone, and press the
pound key when you finish.”

432 “The pound key is located on the bottom right corner of your telephone keypad.”

433 “First, let’s record your please hold prompt. This prompt is the one callers hear as
they are transferred to your extension. An example is, ‘Please hold for Mary Jones’.”

434 “Next we are going to record your directory prompt, which consists of your name
and mailbox number. This prompt will be added to your company’s directory listing,
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which can be accessed by callers who do not know your mailbox number. An
example of a directory listing is, ‘For Mary Jones, press 123’.”

435 “The next personalized prompt is your name prompt, and it consists only of your first
and last name. The system inserts your name prompt into a variety of different
phrases so that people leaving you messages are assured that they are leaving
them in the correct mailbox. An example of a name prompt is, ‘Mary Jones’.”

436 “Finally, let’s record your personal greeting prompt. This prompt is played to outside
callers who request to leave a message when your extension is either busy or there
is no answer. An example of a personal greeting prompt may sound like this, ‘Hi,
this is Mary. I’m either on the phone or away from my desk. Leave a message after
the tone, and I will return your call as soon as possible’.”

437 “This completes your mailbox setup. Your password and personalized prompts may
be changed at any time by following the instructions in your Subscribers Guide.
Please contact your system supervisor if you have any questions about using your
new mailbox. Thank you.”

438 “Since you have decided not to personalize your mailbox at this time, you will need
to refer to the Options menu section of the Subscriber’s Guide for assistance in
changing any or all of your personal prompts.”

439 “In addition to your personal greeting prompt, an optional prompt is available for
special call handling functions. To activate your optional prompt, refer  to the Call
Handling section of your Subscriber’s Guide.”

440 “Option accepted.”

441 “This message includes a fax which could not be delivered.”

442 “This message includes a fax.”

443 “This message is a fax.”

444 “The fax for this message could not be received.”

445 “To retrieve the fax, press star.”

446 “The fax will be available for retrieval after you finish listening to your messages.”

447 “Enter the telephone number of the fax machine that you are sending the fax to,
followed by the pound sign.”

448 “Press star to send the fax to your local fax machine.”

449 “To retrieve the fax immediately, simply press the start/receive button on your fax
machine after the tone.”

450 “Enter the telephone number of the receiving fax machine, followed by the pound
sign.”

451 “If you are calling from a fax machine, please hold and you will be connected to the
fax system..”

452 “Press star to send the faxes to your local fax machine.”

453 “Your fax will be sent to...”

454 “Your faxes will be sent to...”

455 “...attempts will be made to deliver the selected faxes.”

456 “This message includes a fax which has never been retrieved.”
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457 “Length of fax is <number>...”

458 “The fax document number is...”

459 “page”

460 “pages”

461 “To send the message immediately, press 1. To send the message with future
delivery, press 2.”

462 “Cannot receive faxes.”

463 “If you do not want to retrieve the fax, press pound.”

464 “If you do not want to retrieve the faxes, press pound.”

465 “There are ten seconds remaining; please conclude your message.”

466 “I’m sorry, there is a line problem. Please hang up and try again.”

467 “I’m sorry, the mailbox for ...<mailbox owner’s name prompt>...”

468 “...is full. Please call back later.”

469 “I’m sorry, but that mailbox is currently in use. Please try again later.”

470 “Please hold while you are connected to the fax system.”

471 “If you wish to cancel the fax operation, press the pound key now.”

472 “The fax system is currently busy. Please hold for the next available fax line.”

473 “To save, press 2.”

474 “To continue holding, press star. To try another extension, press 1. To leave a voice
or fax mail message, press 2.”

475 “To access the Supervisor On-Line Voice Editor.”

476 “You may then hang up at anytime.”

477 “Enter the access phone number.”

478 “Lists 20 through 39 are available for use as Personal Network Addresses.”

479 “Network Address accepted.”

480 “Enter the destination network mailbox number.”

481 “...to send a casual AMIS network message, press zero.”

482 “...for a directory of network nodes, press zero, star.”

483 “Network message scheduled for dispatch.”

484 “Voice information processing system. Press 1 to disconnect.”

485 “Your message to..”

486 “Access phone number..”

487 “...could not be delivered because...”

488 “To update a Distribution list or Network Address, press 6.”

489 “Your sending options will be ignored.”
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490 “...that system was busy.”

491 “...that system did not answer.”

492 “...the call was answered incorrectly.”

493 “...of a probable receiving system transmission error.”

494 “...of a probable sending system transmission error.”

496 “...that system’s disk was full.”

497 “...the message is too long.”

498 “...was not found on the remote system.”

499 “...would not accept messages.”

500 “...was full.”

501 “...of an unspecified recording error on the receiving system.”

502 “...press...”

503 “...that system would not accept AMIS analog network messages.”

504 “AMIS Networking does not support...”

505 “...special sending options.”

506 “...special sending and fax options.”

507 “I’m sorry, your number has been dialed in error.”

508 “Please select the method by which you wish to dispatch your message.”

509 “For standard dispatch, press 2.”

510 “For priority dispatch, press 3.”

511 “For economy dispatch, press 1.”

512 “.. exists as both a mailbox number and network address.”

513 “To send to the local mailbox, press 1. To dispatch to the network node, press 2.”

514 “...contains the following Network address...”

515 “To change, press 1. To delete, press 2.”

516 “Network address deleted.”

517 “The system now requires that the minimum length password be...”

518 “The minimum length password is...”

519 “...is not an active personal network address.”

520 “...to re-enter, press pound.”

521 “If no password is desired, press zero followed by the pound sign.”

522 “Message canceled.”

523 “Message dispatched.”

524 “Network address...”
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525 “...is not an active network address.”

526 “Network address deleted.”

527 “Network address added.”

Preparing Professionally-Recorded Phrases for System Use

You can record voice phrases in another language (see the topic, “Using the Multilingual
Capabilities,” later in this chapter) or customize some or all of the phrases provided with
Octel 50.

Once the customized phrases are recorded, you must digitize the recordings so the
phrases can be stored on the system. To digitize the recordings, you need a voice editing
package. V-Edit (for Dialogic) and the V-Edit (for Rhetorex) are included in your Dealer
Kit. Please see their accompanying documentation for instructions on placing custom-
recorded phrases in the SO3-D2.* files.

To use custom phrases for system prompts such as the time of day greeting, precede the
prompt number you enter in the dialog box field with the letter D.

Using the Multilingual Capabilities

Octel 50 has the ability to support up to five languages, English plus four others. To
activate the multilingual capability, specify the number of languages supported on the
system in the Number of Languages parameter in the System Setup. If the system is
English-only, set the Number of Languages parameter to 1.

The order of the languages on the system is based on the filenames assigned to the
system’s phrase files. The system phrases are stored in either the SO3-ALL.* file or the
SO3-D1.* file. Any custom phrases recorded for the system, such as V-Trees or
greetings, are stored in SO3-D2.*. The primary system language (English is the default)
should be stored in the following phrase files:

• SO3-ALL.VAP (or *.VOX)

• SO3-D1.VAP (or *.VOX)

• SO3-D2.VAP (or *.VOX)

To use more than one language, store the phrases recorded in additional languages
under the filenames listed below:

First additional language:

SO3-ALL1.*
SO3-D11.*
SO3-D12.*

Second additional language:

SO3-ALL2.*
SO3-D21.*
SO3-D22.*

Third additional language:

SO3-ALL3.*
SO3-D31.*
SO3-D32.*
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Fourth additional language:

SO3-ALL4.*
SO3-D41.*
SO3-D42.*

The Language Selection prompt is voiced on multilingual Octel 50 systems to allow
callers to select the language in which they want to hear system prompts. For example, if
the system contains English, Spanish, and French voice files, the Language Selection
prompt should instruct callers which key to press to change the language of the prompts
voiced by the system. The order of the additional languages is based on the filename of
the language’s phrase files. If the system only uses one language, you do not need to set
up this prompt.

For additional information on recording and setting up prompts, see the Octel 50
Supervisor’s Guide.

The Morning, Afternoon, Evening, Closed, Holiday, Custom Transfer, and Call Queuing
prompts may be recorded in multiple languages or in the primary language. The Attendant
menu, if used, should be recorded as a different prompt for each language. You can also
specify different Message Delivery prompts for each language. The language the prompt
is voiced in is based on the mailbox’s class of service setting for language selection.
Remember to specify the prompt numbers for these phrases on the System Prompt
dialog box. If you are using custom phrases, be sure to precede the prompt number in the
field with the letter D.

During business hours, the caller will hear the appropriate time of day greeting, followed
by the Language Select prompt and the Attendant menu (if used). During non-business
hours, a caller will hear either the Closed or Holiday greeting, followed by a beep to record
a message to the After Hours Receptionist mailbox.

Using Dialogic V-Edit

V-Edit is an advanced phrase editing tool that allows you to combine and edit:

• Existing phrases previously recorded with V-Edit

• Phrases professionally recorded outside of Octel 50

Phrases you create or modify using V-Edit that you want to use with Octel 50 must be
stored by phrase number in the SO3-ALL.VAP, SO3-D1.VAP, and SO3-D2.VAP files in
the \CVR directory.

Installing Dialogic V-Edit

Use the following procedure to install Dialogic V-Edit.

Before attempting to install V-Edit, make sure that you have completed the steps to install
the Dialogic voice boards and the Octel 50 software.

To install Dialogic V-Edit:

1. Shut down the Octel 50 system if it is currently running:

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.
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b.  Press <ALT+F> to view the File menu options.

c.  From the File menu, use the down arrow key to select Exit, then press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown, then press <ENTER>. The system shutdown completes and
the \CVR prompt displays.

2. Insert the V-Edit Installation diskette in the diskette drive.

3. From the \CVR directory prompt, type MD VEDIT then press <ENTER>.

4. From the \CVR directory prompt, type CD VEDIT then press <ENTER>.

5. From the \VEDIT directory prompt, type COPY A:*.* (where A is the diskette
drive) then press <ENTER>. The files from the diskette are copied to the \VEDIT
directory.

Preparing Existing Phrase Files for Use with V-Edit

If you want to edit one of the existing phrase files, [Language]1.VOX, [Language]2.VOX,
or [Language]3.VOX, complete the following procedure to back up the existing file and
copy it to the \VEDIT directory for use with V-Edit.

To prepare an existing phrase file for use with V-Edit:

1. Shut down the Octel 50 system if it is currently running:

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.

b.  Press <ALT+F> to view the File menu options.

c.  From the File menu, use the down arrow key to select Exit, then press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown, then press <ENTER>. The system shutdown completes and
the \CVR prompt displays.

2. Back up the existing language file you want to modify. For example, to back up the
SO3-D2.VAP file to another filename on the same hard drive, from the \CVR directory
prompt, type COPY SO3-D2.VAP SO3-D2.BAK then press <ENTER>.

3. Copy the phrase file to the \VEDIT directory. For example, to copy the backup created
in the example in step 2, from the \CVR directory prompt, type COPY SO3-D2.VAP
\VEDIT then press <ENTER>. The file is copied to the \VEDIT directory.

Starting Dialogic V-Edit

Use the following procedure to start Dialogic V-Edit.

To launch Dialogic V-Edit:

1. Shut down the Octel 50 system if it is currently running.

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.

b.  Press <ALT+F> to view the File menu options.
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c.  From the File menu, use the down arrow key to select Exit, then press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown, then press <ENTER>. The system shutdown completes and
the \CVR prompt displays.

2. From the \CVR prompt, type CD VEDIT then press <ENTER>.

3. From the \VEDIT prompt, type VEDIT -hn where n is the hardware interrupt of the
Dialogic board installed in the system, then press <ENTER>. The V-Edit title screen
displays.

If you do not know the Dialogic board hardware interrupt, from the C:\ prompt, type
EDIT C:\CVR\DIALOGIC.CFG then press <ENTER>. A DOS editor window
displays the contents of the DIALOGIC.CFG file. In the first line, locate the words
IRQ= followed by a number. The number following the IRQ= is the hardware
interrupt of the system’s Dialogic boards.

4. At the Enter File Name prompt, enter the name of the new phrase file you want to
create or the existing phrase file you want to open, then press <ENTER>. If you
create a new file, it is automatically assigned a .VAP extension.

5. At the prompt to enter the maximum number of prompts, enter the number of phrases
for that file, from 1 to 3000, then press <ENTER>. Allow for any phrases you may
want to add to the file. Wait while the system initializes the voice system.

At the prompt to enter a port number or dial in to start, pick up the telephone handset
and dial the extension of the line you want to use to record. The V-Edit main screen
displays. The top of the screen provides information on the currently open phrase file,
the phrase currently in use, the size of the file, the channel being used, the sample
rate, and the unused file space. The bottom of the screen displays the V-Edit main
menu.

As you use V-Edit, you can press <ESC> to exit the current function or return to the
previous menu. For example, to return to the Main menu from the Edit menu, press
<ESC>.
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Opening or Creating a Phrase File

Use the following procedure to open an existing phrase file or create a new phrase file
from within V-Edit.

To open or create a phrase file:

1. If the Main menu is not displayed, press <ESC> until you return to the Main menu.

2. From the Main menu, press <O>. The V-Edit title screen displays. The Enter File
Name field displays the name of the file currently open.

3. Enter the name of the new phrase file you want to create or the existing phrase file
you want to open, then press <ENTER>. If you create a new file, it is automatically
assigned a .VAP extension.

4. At the prompt to enter the maximum number of prompts, enter the number of phrases
for that file, from 1 to 3000, then press <ENTER>. Allow for any phrases you may
want to add to the file. Wait while the system initializes the voice system. If you are
currently connected to the voice mail system, you will be disconnected.

5. At the prompt to enter a port number or dial in to start, pick up the telephone handset
and dial the extension of the line you want to use to record. The V-Edit main screen
displays.

Recording New Phrases

Before you begin recording in V-Edit, make sure you set any necessary equipment as
specified by the equipment manufacturer. Attempt to eliminate any background noise, and
do not record over a speakerphone.

If you reach the maximum number of phrases you specified when you opened the file, but
want to record more phrases, you can use the Compress option to add additional blank
phrases. See the topic, “Adding Blank Phrases to the Current Phrase File,” later in this
chapter.

To record new phrases:

1. Open the phrase file in which you want to record phrases, if it is not already open.

2. From the Main menu, press <R>.

3. When prompted to enter the starting phrase number, either press <ENTER> to
accept the default (1) or enter a new number, then press <ENTER>.

4. When prompted to enter the ending phrase number, either press <ENTER> to accept
the default (equal to the maximum number of phrases currently set) or enter a new
number, then press <ENTER>.

5. To begin recording, press <SPACEBAR> and begin speaking. As you record, the
elapsed time, in seconds, is displayed at the bottom of the recording window.

6. To end recording, press <SPACEBAR>.

7. To begin recording the next phrase, press <SPACEBAR> or press <R> to rerecord
the phrase you just recorded.

8. Repeat steps 5 through 7 until you record the last phrase (specified in step 4). Once
you record the last phrase, the record window then automatically closes. If you want
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to stop recording before you reach the phrase number you specified in step 4, press
<ESC> at the prompt to record the next phrase, rerecord the existing phrase, or exit.

Adding Blank Phrases to a Phrase File

V-Edit’s Compress option allows you to add additional blank phrases to the current
phrase file. This option is helpful if you want to record additional phrases in a file, but have
reached the maximum number of phrases you specified when you opened the file. The
maximum number of phrases allowed in a file is 3000.

To add blank phrases to the current phrase file:

1. Open the phrase file in which you add phrases, if it is not already open.

2. From the Main menu, press <C>.

3. When prompted to enter the maximum number of phrases, enter the total number of
phrases for the open phrase file, then press <ENTER>. Make sure you allow for any
phrases you may want to add to the file.

V-Edit then compresses the file to allow for the number of phrases you specified.

Listening to Phrases

You can listen to a phrase in its entirety or only listen to a selected portion of the phrase.

To listen to an existing phrase in its entirety:

1. Open the phrase file in which you want to review phrases, if it is not already open.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to review, then press
<ENTER>. The selected phrase is graphically displayed.

5. To review the phrase, press <P>. The phrase voices.

6. To review the previous phrase in the file, press <->, then repeat step 5. To review the
next phrase in the file, press <+>, then repeat step 5. To select and review other
phrases in the same file, repeat steps 3 through 5.

To listen to a selected portion of a phrase:

1. Open the phrase file in which you want to review phrases, if it is not already open.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to review, then press
<ENTER>. The selected phrase is graphically displayed.

5. Select the portion of the phrase you want to hear. For information on selecting part of
a phrase, see the topic, “Selecting a Portion of a Phrase,” later in this chapter.

6. To review the phrase, press <P>. The phrase voices.
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7. To review the previous phrase in the file, press <->, then repeat step 6. To review the
next phrase in the file, press <+>, then repeat step 6. To select and review other
phrases in the same file, repeat steps 3 through 6.

To listen to the last 3 seconds of a phrase:

1. Open the phrase file in which you want to review phrases, if it is not already open.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to review, then press
<ENTER>. The selected phrase is graphically displayed.

5. To review the last 3 seconds of the phrase, press <ALT+P> or the <PAGEDOWN>
key. The last 3 seconds of the phrase voice.

6. To review the last 3 seconds of the previous phrase in the file, press <->, then repeat
step 5. To review the last 3 seconds of the next phrase in the file, press <+>, then
repeat step 5. To select and review other phrases in the same file, repeat steps 3
through 5.

Rerecording a Phrase

To rerecord an existing phrase:

1. Open the phrase file that contains the phrase you want to rerecord, if it is not already
open.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed.

 
3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to rerecord, then
press <ENTER>. The selected phrase is graphically displayed.

5. Press <R>.

6. To begin recording, press <SPACEBAR> and begin speaking.

7. To end recording, press <SPACEBAR>.
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Editing a Phrase

V-Edit editing tools allow you to select a section of a phrase for playing, copying, or
trimming; insert segments from existing phrases to other phrases; copy segments of a
phrase into a file to be copied into another file; and delete a section of a phrase.

When you select the Edit menu, the default edit mode is Edit Ends. There are three edit
modes:  Edit Ends, Edit Middle, and Insert. When you select Edit Ends mode, the area
outside the selected area is voiced, copied, or trimmed. When you select Edit Middle
mode, the area inside the selected area is voiced, copied, or trimmed. When you select
Insert mode, you can insert a single-phrase file as a new phrase in the open phrase file.

From the Edit menu, you can press <U> to restore the current phrase to its original state.
Undo is available until you save the phrase or open a new phrase. Undo cannot be used
to restore a segment of a phrase that you have cut from the middle of a phrase.

Selecting a Segment of a Phrase

Use the following procedure to select a segment of a phrase. Depending on the editing
mode you choose, the area outside or inside of the selected phrase section is the area
affected by the Edit menu option you select.

To select a segment of a phrase in Edit Ends mode:

1. Open the phrase file that contains the phrase you want to select a section of.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed. The default edit mode is Edit Ends.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to view, then press
<ENTER>. The selected phrase is graphically displayed with the left cursor blinking.

5. If you want to move the left cursor, press the right arrow key until the left cursor is in
the right position. Holding down the <CTRL> key while you press the right arrow key
moves the cursor faster. To move the cursor back to the start of the phrase, press the
<HOME> key.

6. If you want to move the right cursor, press <END>, then press the left arrow button
until the end cursor is in the correct position. Holding down the <CTRL> key while you
press the left arrow moves the cursor faster. In this editing mode, the area outside the
cursors is the affected area of the phrase.

To select a segment of a phrase in Edit Middle mode:

1. Open the phrase file that contains the phrase you want to select a section of.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed. The default edit mode is Edit Ends.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to view, then press
<ENTER>. The selected phrase is graphically displayed with the left cursor blinking.

5. Press <M>. The Edit Mode menu displays.

6. To select Edit Middle mode, press <2>.



Understanding Phrase Files and Using V-Edit Using Dialogic V-Edit

Octel 50 Installation Guide 14-31

7. If you want to move the left cursor, press the right arrow key until the left cursor is in
the right position. Holding down the <CTRL> key while you press the right arrow key
moves the cursor faster. To move the cursor back to the start of the phrase, press the
<HOME> key.

8. If you want to move the right cursor, press <END>, then press the left arrow button
until the end cursor is in the correct position. Holding down the <CTRL> key while you
press the left arrow moves the cursor faster. In this editing mode, the area inside the
cursors is the affected area of the phrase.

Copying a Segment of a Phrase into a File

You can copy segments of a phrase into a file to be copied into another file.

To copy segments of a phrase into a file

1. Open the phrase file that contains the phrase from which you want to copy a
segment.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to view, then press
<ENTER>. The selected phrase is graphically displayed with the left cursor blinking.

5. Follow the procedure Selecting a Portion of a Phrase to select the phrase segment to
be copied.

6. Press <C>.

7. When prompted, specify the name of the file to which you want to copy the affected
phrase segment, then press <ENTER>. The default filename is INSERT.PHR.

8. If the filename you specified in step 7 is a new file, the segment is copied. If the
filename specified in step 7 already exists, you are prompted whether you want to
overwrite it. Press <Y> to overwrite the phrase or <N> to retain the existing phrase.

Inserting a Phrase into the Current File

You can insert a phrase that exists as single-phrase file into the current file.

To insert a phrase into the current file:

1. Open the phrase file into which you want to insert the phrase.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase into which you want to insert a
phrase, then press <ENTER>. If that phrase number is already recorded, it is
graphically displayed with the left cursor blinking.

5. Press <M>. The Edit Mode menu is displayed.

6. To select Insert mode, press <3>.
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7. If this is a new phrase, proceed to step 8. If you are inserting the phrase into an
existing phrase, press the right arrow button to select the position at which you want
to insert the phrase.

8. To specify the file you want to insert, press <F>.

9. When prompted, specify the name of the file from which you want to insert the
phrase, if it is different than the File Name entry displayed, then press <ENTER>.

10. To hear how the phrase will sound with the inserted phrase, press <P>.

11. To insert the specified phrase into the current phrase at the selected point, press <I>.

Trimming an Existing Phrase

You can use V-Edit to trim a segment from an existing phrase.

To trim a phrase:

1. Open the phrase file that contains the phrase you want to trim.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to trim, then press
<ENTER>. The selected phrase is graphically displayed with the left cursor blinking.

5. Follow the procedure Selecting a Portion of a Phrase to select the phrase segment to
be trimmed.

6. Press <T>. If the current editing mode is Edit Ends, the areas outside the selected
segment are deleted. If the current editing mode is Edit Middle, the area inside the
selected segment is deleted.

Deleting a Phrase

Use the following procedure to delete an existing phrase.

To delete an existing phrase:

1. Open the phrase file that contains the phrase you want to delete, if it is not already
open.

2. From the Main menu, press <E> to access the Edit menu. The first phrase in the file
is graphically displayed.

3. To select a phrase, press <N>.

4. At the phrase prompt, enter the number of the phrase you want to delete, then press
<ENTER>. The selected phrase is graphically displayed.

5. Press <D>. The current phrase is deleted.

Use caution when deleting phrases as the current phrase is immediately erased when you
select Delete.
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Writing a Phrase to a File

You can use V-Edit to write a single phrase from the current file to a file. When you write a
single phrase to a file, the specified phrase is copied instead of deleted from the current
file. When you use this procedure to write a phrase to a file, the phrase is not stored as an
indexed file, such as the Octel 50 phrase files, but is stored as a single-phrase file to
which no additional phrases can be added. To write a single phrase to an indexed phrase
file, see the procedure on writing a phrase to an indexed file.

To write a phrase to a single-phrase file:

1. Open the file that contains the phrase you want to write to a file, if it is not already
open.

2. Press <W>.

3. At the prompt to enter a phrase number to write, enter the number of phrase you want
to write then press <ENTER>.

4. At the prompt to enter a filename, enter the name of the file to which you want to write
the specified phrase.

5. If you specified a new filename, the file is created and the phrase is written to it. If you
specified the name of an existing file, you are prompted whether you want to
overwrite the existing file. If you select <Y>, all phrases in the file are overwritten by
the single phrase.

To write a single phrase or group of phrases to an indexed phrase file:

1. From the Main menu, press <M>.

2. At the prompt to enter the name of the source file, enter the name of the file from
which you want the phrases moved then press <ENTER>. Include the complete file
path, if the file is not located in the \VEDIT directory.

3. At the prompt to enter the starting phrase number, press <ENTER> to accept the
default (phrase 1) or enter the number of starting phrase you want to move then press
<ENTER>.

4. At the prompt to enter the ending phrase number, press <ENTER> to accept the
default (the last phrase in the file) or enter the number of ending phrase you want to
move then press <ENTER>.

5. At the prompt to enter a destination filename, enter the name of the file to which you
want to move the phrases, then press <ENTER>.

6. At the prompt to enter the starting phrase number, press <ENTER> to accept the
default (phrase 1) or enter the number of starting phrase you want to move then press
<ENTER>. The ending phrase is entered automatically based on the number of
phrases you are moving. If there are existing phrases in the range you specify, they
will be overwritten when the phrases are moved to the file.

7. If the filename you enter does not already exist, you are prompted whether you want
to create the file. Press <Y> to create the file or <N> to return to the Main menu.

8. When prompted whether you are sure you want to move phrases, press <Y>.
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Reading a Phrase into a File

You can use V-Edit to read a single phrase from a file that was created using the Write
function.

To read the phrase from a single-phrase file into a file:

1. Open the file to which you want to add the phrase.

2. Press <G>.

3. At the prompt to enter a phrase number to get, enter the number you want to assign
the phrase to be read then press <ENTER>.

4. If the phrase number you enter is already assigned to an existing phrase, you are
prompted whether you want to overwrite the existing phrase. Press <Y> to overwrite
the existing phrase or <N> to return to the Main menu.

5. When prompted to enter the Filename, enter the path and filename of the single-
phrase file you want to insert into the open phrase file, then press <ENTER>. The
phrase from the file is then written into the open file at the specified phrase number.

Adding Text Records to a Phrase File

You can add a text record for each phrase in a phrase file. The text record is displayed
when you select its associated phrase. The text records for a file can be printed or saved
to diskette.

Text records can be created and edited in V-Edit. V-Edit can also convert a standard
ASCII-based file to a V-Edit text record that you can view, edit, print, or save to a file.

Creating or Editing a Text Record

You use the same procedure to create a new text record or edit an existing text record.

To create or edit a text record:

1. Open the phrase file for which you want to create or edit text records, if it is not
already open.

2. From the Main menu, press <T> to access the Text menu.

3. To select the text record to create or edit, press <N>.

4. At the prompt to enter the phrase, enter the number of the phrase for which you want
to create or edit a text record, then press <ENTER>. If a current text record exists, it
displays in the text editing box. If no text record currently exists, the text editing box is
blank.

5. To edit the text record, press <E>. The cursor appears in the top-left corner of the text
editing box.

6. To create a new text record or replace the existing text record, begin typing. To
modify the existing text, use the right and left arrow keys to position the cursor where
you want to insert or overwrite text, then either begin typing to overwrite the text after
the cursor or press <INSERT> to change to Insert mode and begin typing to add text
to the current text record after the cursor.

7. To create a new text record or modify the existing text record for the next or previous
phrase in the open phrase file, press the <-> or <+> key, respectively, then repeat
steps 5 and 6.
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8. To save the text records and return to the Text menu, press <ESC>.

Converting an ASCII-Based Text Record for Use with V-Edit

You can create an ASCII-based text file in another application and then convert it in V-Edit
for use with a phrase file.

When you create an ASCII-based text record file, each record must start on a separate
line and must be numbered to correspond with a phrase in the phrase file. Each number
must be followed by either:  an end paren, such as 1); surrounded by parentheses, such
as (1); surrounded by straight brackets, such as [1]; or surrounded by rounded brackets,
such as {1}. The character used must then by followed by two spaces.

Use the following procedure to convert an ASCII-based text record for use with V-Edit.

To convert an ASCII-based text record for use in V-Edit:

1. Open the phrase file in which you want to insert the converted text record file.

2. From the Main menu, press <T> to access the Text menu.

3. Press <C>.

4. At the prompt to enter the ASCII file name to convert, enter the path and filename of
the ASCII-based text file that contains the text records, then press <ENTER>.

Deleting Text Records

You can delete an individual text record or delete all of the text records in a phrase file.

Deleting an Individual Text Record

Use the following procedure to delete an individual text record from a phrase file.

To delete an individual text record:

1. Open the phrase file for which you want to delete a text record, if it is not already
open.

2. From the Main menu, press <T> to access the Text menu.

3. To select the text record to create or edit, press <N>.

4. At the prompt to enter the phrase, enter the number of the phrase for which you want
to delete the text record, then press <ENTER>. The current text record is displayed in
the text editing box.

5. Press <D>.

6. When prompted whether you are sure you want to delete the text, press <Y> to
remove the current text record or <N> to return to the Text menu.
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Deleting All of the Text Records in a Phrase File

Use the following procedure to delete all of the text records from a phrase file.

To delete all text records from a phrase file:

1. Open the phrase file for which you want to delete a text record, if it is not already
open.

2. From the Main menu, press <T> to access the Text menu.

3. Press <S>.

4. At the prompt whether you are sure you want to strip the text from the phrase file,
press <Y> to strip the text records from the current phrase file or <N> to return to the
Text menu.

Printing Text Records

You can print the text records for a phrase file to be used as a recording script or for
future reference. Make sure a printer is connected to the Octel 50 PC and that the printer
is on and functioning properly.

To print the text records for a phrase file:

1. Open the phrase file for which you want to print the text records, if it is not already
open.

2. From the Main menu, press <T> to access the Text menu.

3. Press <P>.

4. When prompted whether you want to print to a printer or disk, press <P>.

Saving Text Records to a File

You can save text records to a file for future reference.

To save text records to a file:

1. Open the phrase file for which you want to print the text records, if it is not already
open.

2. From the Main menu, press <T> to access the Text menu.

3. Press <P>.

4. When prompted whether you want to print to a printer or disk, press <D>.

5. When prompted to enter a filename, enter the path and name of the file to which you
want to save the text records of the open file. If you are saving to diskette, make sure
you have already inserted a diskette in the diskette drive.

6. If the file already exists with the name you entered in step 5, you are prompted
whether you want to overwrite the existing file. Press <Y> to overwrite the existing file
or <N> to return to the Text menu without overwriting the file.
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Removing Unused Space from Phrases

You can use V-Edit to remove any unused space from within a phrase file.

To remove unused space from within a phrase file:

1. Open the phrase file from which you want to remove leading and trailing silence, if it is
not already open.

2. From the Main menu, press <C>.

3. When prompted to enter the maximum number of phrases, either press <ENTER> to
accept the default, which is the maximum amount of phrases currently set, or enter a
new maximum number of phrases, then press <ENTER> to begin compression.

If the maximum number of phrases you enter is less than the number of existing
phrases in the file, all phrases above the entered maximum are deleted.

Removing Silence from Phrases

You can use V-Edit to remove silence from the start and end of phrases in a file. When
you remove leading and trailing silence, a default of 100 milliseconds of silence is left at
the start and end of each phrase in the file. You can adjust the amount of silence to leave
as much or as little as you want.

To adjust the amount of silence to leave at the start and end of each phrase in the
open file:

1. Open the phrase file from which you want to remove leading and trailing silence, if it is
not already open.

2. From the Main menu, press <S>. The Setup menu displays.

3. To adjust the auto edit parameters, press <2>.

4. When prompted to enter the number of milliseconds to leave on the front of phrases,
either press <ENTER> to accept the default (100 milliseconds) or enter a new
number, then press <ENTER>.

5. When prompted to enter the number of milliseconds to leave on the end of phrases,
either press <ENTER> to accept the default (100 milliseconds) or enter a new
number, then press <ENTER>.

These new silence settings are only valid for the currently open phrase file in the current
session. Once you exit V-Edit or open a new phrase file, the settings revert to the original
defaults (100 milliseconds).

 To remove leading and trailing silence from a group of phrases:

1. Open the phrase file from which you want to remove leading and trailing silence, if it is
not already open.

2. From the Main menu, press <A> to start Auto Edit.

3. When prompted to enter the starting phrase number, either press <ENTER> to
accept the default (the first phrase in the file) or enter the number of the phrase at
which you want to begin removing silence, then press <ENTER>.
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4. When prompted to enter the ending phrase number, either press <ENTER> to accept
the default (the last phrase in the file) or enter the number of the phrase at which you
want to end removing silence, then press <ENTER>.

5. When prompted to confirm the range of phrases, press <Y> to automatically remove
the leading and trailing silence from the specified range of phrases.

Exiting V-Edit

Use the following procedure to exit V-Edit.

To exit V-Edit:

1. From the Main menu, press <X>.

2. When prompted to confirm that you want to exit V-Edit, press <Y>. The \VEDIT
prompt displays.

Using a Modified Phrase File with Octel 50

Once you edit an existing phrase file using V-Edit, complete the following steps to copy
the modified file back to the \CVR directory for use with Octel 50.

To use a modified phrase file with Octel 50:

1. Shut down the Octel 50 system if it is currently running:

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.

b.  Press <ALT+F> to view the File menu options.

c.  From the File menu, use the down arrow key to select Exit then press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown then press <ENTER>. The system shutdown completes and the
\CVR prompt displays.

2.  Copy the phrase file you modified from the \VEDIT directory to the \CVR directory. For
example, to copy the SO3-D2.VAP file, from the \CVR directory prompt, type COPY
\VEDIT\SO3-D2.VAP then press <ENTER>. The existing file SO3-D2.VAP file is
overwritten.

3.  Start the Octel 50 system.

4.  Dial into the system and verify that the phrases you modified are voicing correctly.

5.  If the phrases are voicing correctly,  you can delete the backup file that you created in
step 2 of the procedure Preparing Existing Phrase Files for Use with V-Edit. If the
phrases are not voicing correctly, complete the following steps to restore the phrase
file from the backup you created in step 2 of the procedure Preparing Existing Phrase
Files for Use with V-Edit:

a.  Follow the procedure in step 1 to shut down the Octel 50 system.

b.  From the \CVR prompt, rename the backup file to overwrite the modified phrase
file. For example, if you backed up the SO3-D2.VAP file to a file named
SO3-D2.BAK, type REN SO3-D2.BAK SO3-D2.VAP then press <ENTER>.
The existing SO3-D2.VAP file is overwritten.
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c.  Start the Octel 50 system.

Using Rhetorex V-Edit

V-Edit is an advanced phrase editing tool that allows you to combine and edit:

• Existing phrases previously recorded with V-Edit

• Phrases professionally recorded outside of Octel 50

Phrases you create or modify using V-Edit that you want to use with Octel 50 must be
stored by phrase number in the SO3-D1.VOX, SO3-D2.VOX, or SO3-ALL.VOX phrase
files.

If you want to modify an existing phrase, you must split and expand it before you start
V-Edit. See the topic, “Preparing an Existing Phrase File for Use with V-Edit,” later in this
chapter.

Installing Rhetorex V-Edit

Use the following procedure to install Rhetorex V-Edit.

Before attempting to install V-Edit, make sure that you have completed the steps to install
the Rhetorex voice boards and the Octel 50 software.

To install Rhetorex V-Edit:

1. Shut down the Octel 50 system if it is currently running:

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.

b.  Press <ALT+F> to view the File menu options.

c.  From the File menu, use the down arrow key to select Exit then press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown then press <ENTER>. The system shutdown completes and the
\CVR prompt displays.

2. Insert the V-Edit Installation diskette in the diskette drive.

3. From the \CVR directory prompt, type MD VEDIT then press <ENTER>.

4. From the \CVR directory prompt, type CD VEDIT then press <ENTER>.

5. From the \VEDIT directory prompt, type COPY A:*.* then press <ENTER>. The
files from the diskette are copied to the \VEDIT directory.
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Preparing an Existing Phrase File for Use with V-Edit

Use the following procedure to prepare an existing phrase file for use with V-Edit. If you
want to review or modify an existing phrase file, you must first prepare it for use with V-
Edit.

In the following procedure, you must specify the name of the phrase file you want to
prepare for use with V-Edit. In this procedure, the SO3-D2.VOX file is used as an
example. To use another file, enter the name of that file instead of SO3-D2.VOX
wherever it is specified. Remember that phrase files SO3-D1.VOX and SO3-ALL.VOX
contain the standard phrases used by Octel 50. Do not create a new file with one of these
names or modify an existing file without verifying the phrase numbers very carefully. Keep
a list of the phrases and their corresponding numbers as you will need to refer to this list
while using V-Edit.

To prepare an existing phrase file for use with Rhetorex:

1. Shut down the Octel 50 system if it is currently running:

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.

b.  Press <ALT+F> to view the File menu options.

c.  From the File menu, use the down arrow key to select Exit then press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown then press <ENTER>. The system shutdown completes and the
\CVR prompt displays.

2. Back up the existing language file you want to modify. For example, to back up the
SO3-D2.VOX file to another filename on the same hard drive, from the \CVR directory
prompt, type COPY SO3-D2.VOX SO3-D2.BAK then press <ENTER>.

3. Copy the phrase file to the \VEDIT directory. For example, to copy the backup created
in the example in step 2, from the \CVR directory prompt, type COPY SO3-D2.VOX
\VEDIT then press <ENTER>. The file is copied to the \VEDIT directory.

4. From the \VEDIT prompt, type VJOIN -U -S SO3-D2.VOX -D D2.VOX -B
then press <ENTER>. This command splits all of the indexed phrases in the specified
phrase file into individual phrases starting with the name D2001.VOX.

5. The proposed results display for confirmation. Verify that the input file is correct, that
the output file is d2_ _ _.vox, and the last file to be used is correct. If they are correct,
press <Y>. If they are not correct, press <N> and repeat step 3. After a few moments,
the output files are listed.

The D2 specified in the command defines the prefix for the split files. In this example,
D2 is used because the SO3-D2.VOX file is being modified. If you were modifying the
SO3-D1.VOX file, you could use a D1 prefix. When you enter this command, use a
prefix that helps you identify the file you are modifying.

6. From the \CVR prompt, type EXPAND D2001.VOX D2001.LIN then press
<ENTER>. This command expands phrase number 1 in the file into the linear format
required for use with V-Edit. In this command, D2 is the prefix you assigned in step
3, and 001 is the 3-digit phrase number, VOX is the extension you assigned in step
3, and LIN is the extension you are assigning to the linear file. You must expand
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each phrase in the file you want to review or modify. See the file’s phrase list to
determine the phrases you want to expand.

7. Repeat step 5 for each phrase you want to review or modify. For example, to expand
phrase 25 in the file you split, from the \CVR prompt, type EXPAND D2025.VOX
D2025.LIN then press <ENTER>.

Once you finish using V-Edit reviewing or modifying the phrase, you must follow the
procedure Compressing Phrases for Use with Octel 50. Otherwise, the phrases are
unusable.

Starting Rhetorex V-Edit

Use the following procedure to start Rhetorex V-Edit. To properly connect to V-Edit, you
must know the base memory of the voice board containing the channel through which you
want to connect. If you do not know the base memory of the board, use the Configure
utility to determine it. For information on running the Configure utility, the topic, “Defining
an Alternate Rhetorex Board Configuration,” in Chapter 4, “Installing the Software.”

To launch Rhetorex V-Edit:

1. Shut down the Octel 50 system if it is currently running.

a.  If the Mailbox Status screen is open and the Exit button is highlighted, press
<ENTER>. The Mailbox Status screen closes and the menu bar is activated with
the File menu highlighted.

b.  Press <ALT+F> to view the File menu options.

c.  From the File menu, use the down arrow key to select Exit then press <ENTER>.
The Shutdown System dialog box displays.

d.  Select Shutdown then press <ENTER>. The system shutdown completes and the
\CVR prompt displays.

2. From the \CVR directory prompt, type CD VEDIT then press <ENTER>. The
\VEDIT directory prompt displays.

3. From the \CVR directory prompt, type VEDIT /C then press <ENTER>. The Voice
Editor Configuration menu displays.

You only need to start V-Edit with the /C option the first time you run V-Edit or if you
want to change the specified configuration options. The options you specify from the
Voice Editor Configuration menu are saved.

4. To use the record and playback features of V-Edit, you must specify the channel to
which you want to connect.  The default audio channel is 0. If you want to use the
default channel, proceed to step 8. If you want to use a different channel, press <5>
from the Voice Editor Configuration menu.

5. When prompted to select the audio channel, enter the number of the channel into
which you want to dial, from 0 to 3, then press <ENTER>. The Voice Editor
Configuration menu displays.

6. You must specify the base memory of the board that contains the channel to which
you are connecting to V-Edit. The default is D000. If the board is set to the default,
proceed to step 8. If the board is set to a different base memory, press <3> from the
Voice Editor Configuration menu.
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7. When prompted, enter the base memory, including the segment, of the board, then
press <ENTER>. The Voice Editor Configuration menu displays.

8. V-Edit requires you to specify a drive on the system PC to use for temporary phrase
storage. The default drive is C:. If you want to use the default, proceed to step 10. If
you want to use a different drive, press <1> from the Configuration menu.

9. When prompted to enter the path of the drive, type the drive you want to use for
temporary storage. The Voice Editor Configuration menu displays.

10. If you want to manually name each phrase you create, proceed to step 12. If you want
phrases to be automatically named and sequentially numbered when you write them
to the file, press <6> from the Voice Editor Configuration menu. The Auto Save menu
displays.

It is recommended that you manually name each phrase you create to ensure that the
phrases are numbered correctly.

11. Complete the following steps to define how phrases are automatically named and
numbered and the location to which they are saved:

a. Press <1> and, when prompted, enter the name of the drive to which you want
the automatically named phrases saved, then press <ENTER>. For example, to
save the phrases to the D: drive, type D then press <ENTER>. The Auto File
menu displays.

b. If you want to save the phrases to the root directory of the specified drive,
proceed to step c. If you want to save the phrases to a subdirectory on the
specified drive, press <7>. When prompted, enter the path to which you want to
save the phrases, then press <ENTER>. If the directory to which you want to
save the phrases is not at the root of the specified drive, make sure you enter the
entire directory path. For example, if you want to save the phrases to a directory
named PHRASES in the \CVR directory, type CVR\PHRASES then press
<ENTER>. The Auto File menu displays.

c. To specify a prefix for the phrases filenames, press <3>. This prefix is only used
for V-Edit  When prompted, enter the name of the prefix, then press <ENTER>.
The prefix must be no more than five characters. The Auto File menu displays.

d. Press <4> and, when prompted, enter the 3-digit number at which you want the
file numbering to begin, then press <ENTER>. For example, if you want
numbering to begin at 1, type 001 then press <ENTER>. The Auto File menu
displays.

e. To specify the file extension, press <5>. When prompted, type LIN then press
<ENTER>. The Auto File menu displays. The name displayed at the top of the
Auto File menu reflects the location and filename to which the first file you create
will be saved. Phrases are numbered sequentially beginning with the number you
entered in step d.

12. If do not want to print from V-Edit, proceed to step 13. If you do want to print from V-
Edit, press <4> from the Voice Editor Configuration menu. Do not select this option
unless the Octel 50 PC is properly connected to a printer able to print graphics.

13. When prompted, enter the number of the port to which the printer is connected, then
press <ENTER>. The Voice Editor Configuration menu displays.

14. To continue, press <C>. The Voice Editor Main Menu displays.
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Dialing into V-Edit

Use the following procedure to dial into V-Edit. You must dial into V-Edit to be able to
listen to and record phrases.

To dial into V-Edit:

1. Complete the procedure Starting Rhetorex V-Edit.

2. Dial the extension connected to the audio channel you specified in step 5 or 6 under
the procedure Starting Rhetorex V-Edit. For example, if you selected audio channel 2,
dial the extension connected to channel 2 on the voice board. The extension you dial
should not be part of a hunt group since the channel you connect to must be the
channel you specified as the audio channel.

3. When you hear the ring signal, press <F4> to take the line off-hook.

Opening an Existing Phrase

Use the following procedure to open an existing phrase. V-Edit has two phrase display
windows, Main and Other, so you can display two phrases at a time.

To open an existing phrase in V-Edit:

1. Complete the procedures Preparing an Existing Phrase File for Use with V-Edit,
Starting V-Edit, and Dialing into V-Edit. The Voice Editor Main Menu displays the Main
phrase window, which is empty. If you want to open a phrase in the Main window,
proceed to step 3.

2. If you want to open a phrase in the Other window, press <O> to move the Other
phrase window to the foreground.

3. Press <G>.

4. When prompted, enter the complete name of the phrase you want to review then
press <ENTER>. For example, to review phrase D2001.LIN type D2001.LIN then
press <ENTER>. A graphical representation of the phrase is displayed in the
foreground window. You may now review or edit the phrase.

If you want to open a new phrase in the Main or Other window, bring the window in which
you want to open the phrase to the foreground, press <C> to clear the current phrase,
and when prompted to confirm, press <Y>. Otherwise, the phrase you open will be
appended to the current phrase.

Reviewing an Existing Phrase

Use the following procedure to review an open phrase in V-Edit.

To review an existing phrase in V-Edit:

1. Complete the procedures Preparing an Existing Phrase File for Use with V-Edit,
Starting V-Edit, Dialing into V-Edit, and Opening an Existing Phrase.

2. To review the phrase in the foreground, press <P>. If you only want to listen to a
portion of the phrase, see the topic, “Selecting a Segment of a Phrase,” later in this
chapter.

3. If you want to swap the foreground and background phrases, press <O>.
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Recording Phrases

Use the following procedure to record a new phrase in V-Edit. The new phrase can then
be written to a file or inserted as a segment into an existing phrase.

If you are recording a new phrase for an existing file, follow the procedure Preparing
Phrase Files for Use with V-Edit before you record. If you are creating a new phrase file,
you must save the phrases as .LIN files, then follow the procedure Preparing Files for Use
with Octel 50. To insert a new recording into an existing phrase, see the topic, Pasting
into Phrases, later in this chapter.

When you choose the record option, the current phrase in the foreground window (Main
or Other) is automatically cleared. Make sure you write any changes to the current phrase
to the file before you choose the record option.

To record a new phrase:

1. Follow the procedures to start V-Edit and dial into V-Edit.

2. From the Main menu, press <R>. If a phrase is already open in the window, it is
cleared.

3. Press any key and start speaking into the telephone handset.

4. To stop recording, press any key. The recording is displayed in the phrase window.

5. To review the phrase, press <P>.

6. If you are satisfied with the recording, proceed with step 8. If you want to rerecord,
press <C> to clear the recording, then repeat steps 2 through 5.

7. Repeat step 6 until you are satisfied with the recorded phrase.

8. Complete one of the following steps to save the phrase:

• If you want to save the phrase manually, press <W>. When prompted, enter the
name of the .LIN file to which you want to save the recording. If the file already
exists, you are prompted to overwrite it. Press <Y> to overwrite the file or <N> to
cancel. If you press <N>, you are prompted to enter another filename.

• If you want to write the phrase to the current auto-indexed file, press <A>. You
are prompted to confirm. Press <Y> to write the phrase or <N> to cancel. If you
press <Y>, the name of the file to which the phrase is written is displayed. Press
any key to continue.

Selecting a Segment of a Phrase

Use the following procedure to select a segment of the active phrase. You can then play,
delete, or copy the selected segment.

To select a segment of a phrase:

1. From the Main menu, press <S> to access the Cursor menu. The cursors are vertical
broken lines that, by default, are located at the start and end of the active phrase.
When you first access the Cursor menu, the left cursor is blinking to indicate that it is
the active cursor.

2. To activate the right cursor, press <F2>. To reactivate the left cursor, press <F1>.
You can also press <ENTER> from the cursor menu to swap the active cursor.
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3. To move the active cursor to the right :

• To move the active cursor to the right in small increments, press the right arrow
key.

• To move the cursor to the right in medium increments, press the > key.

• To move the cursor to the right in large increments, hold down <Ctrl> while
pressing the right arrow key.

• To move the active cursor to the right edge of the phrase window, press <End>.

You cannot invert the cursors’ positions, although you can place them on top of each
other. The cursors are automatically placed on top of each other when you delete a
segment of a phrase. If you attempt to move a cursor and it does not move, make
sure that the correct cursor is active. Remember that the blinking cursor is always the
active cursor.

4. To move the active cursor to the left :

• To move the active cursor to the left in small increments, press the left arrow key.

• To move the cursor to the left in medium increments, press the > key.

• To move the cursor to the left in large increments, hold down <Ctrl> while
pressing the left arrow key.

• To move the active cursor to the left edge of the phrase window, press <Home>.

5. Once the segment of the phrase you want to review or modify is between the cursors,
press <ESC> to return to the Main menu.

Modifying the Display Scale

The following display options are available in V-Edit for Rhetorex:

• To zoom in on the portion of the phrase between the cursors, press <Z>. The
selected portion of the phrase is expanded. To return to the phrase’s original
scale without moving the cursors, press <Alt-Z>.

• To display the full length of the phrase by moving the cursors to select the entire
phrase, press <Alt-S>.

To move the cursors, see the topic, “Selecting a Segment of a Phrase,” earlier in this
chapter.
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Saving and Assigning Display Settings

Use the following procedures to store the active phrase’s current range, scale, and cursor
settings as a tag and then assign it to phrases. Four different display settings can be
saved at one time.

The tags you set are only available while the current phrase is open. Once you clear the
phrase, the tags are cleared.

To save the active phrase’s display settings as a tag:

1. Set the range, scale, and cursors to the settings you want to save. See the topics,
“Selecting a Segment of a Phrase” and “Modifying the Display Scale,” earlier in this
chapter.

2. From the Main menu, press <T>.

3. When prompted, enter a tag for the display settings, from A-D. If the tag currently
exists, you are prompted to overwrite it. Press <Y> to overwrite the existing display
settings of that tag or <N> to cancel.

To assign a defined tag to the active phrase:

1. From the Main menu or the Cursor menu, press <J>.

2. When prompted, enter the tag for the group of display settings, from A-D, you want to
assign to the phrase in the foreground. The display of the active phrase changes to
reflect the selected tag.

Deleting Phrases or Segments of Phrases

Use the following procedures to delete entire phrases or segments of phrases. The
deleted phrase or segment is placed in the buffer, which provides temporary storage for
phrases or segments of phrases. The current contents of the buffer can be pasted into a
new or existing phrase. Each time you delete or copy a phrase or phrase segment to the
buffer, the current contents of the buffer is overwritten.

To delete an entire phrase:

1. Complete steps 1 and 2 of Reviewing an Existing Phrase. The selected phrase
displays in the foreground.

2. From the Main menu, press <D>. The entire phrase is deleted.

3. From the Main menu, press <W>.

4. Enter the name of the current phrase, then press <ENTER>.

5. When prompted to overwrite, press <Y>. The file is saved as an empty phrase.

To delete a segment of a phrase:

1. Complete the procedure, “Selecting a Segment of a Phrase,” earlier in this chapter to
select the segment you want to delete.

2. From the Main menu, press <D> to delete the segment of the phrase between the
cursors.

3. From the Main menu, press <W>.
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4. Enter the name of the current phrase, then press <ENTER>.

5. When prompted to overwrite, press <Y>. The file is saved with the modifications.

Copying Phrases or Segments of Phrases

Use the following procedures to copy entire phrases or segments of phrases to the buffer.
The buffer provides temporary storage for phrases or segments of phrases. The current
contents of the buffer can be pasted into a new or existing phrase. Each time you delete
or copy a phrase or phrase segment to the buffer, the current contents of the buffer is
overwritten.

To copy an entire phrase:

1. Complete steps 1 and 2 of Reviewing an Existing Phrase. The selected phrase
displays in the foreground. Make sure the entire phrase is between the cursors.

2. From the Main menu, press <B>. The phrase is copied to the buffer.

To copy a segment of the phrase in the foreground window:

1. Complete the procedure Selecting a Segment of a Phrase to select the segment you
want to copy.

2. From the Main menu, press <B>. The phrase segment is copied to the buffer.

Pasting into Phrases

Use the following procedures to paste the contents of the buffer into a new or existing
phrase. For more information on cutting and pasting to the buffer, see the topics,
“Deleting Phrases or Segments of Phrases” and “Copying Phrases or Segments of
Phrases,” earlier in this chapter.

To paste the buffer contents into a new phrase:

1. Complete the steps to copy or delete a phrase or phrase segment to the buffer.

2. To clear the current phrase, press <C>. When prompted to confirm, press <Y>. The
phrase is cleared.

3. From the Main menu, press <B>.

4. When prompted to enter a filename, press <ENTER>. The contents of the buffer is
written to the foreground phrase.

5. Complete one of the following steps to save the phrase:

• If you want to save the phrase manually, press <W>. When prompted, enter the
name of the .LIN file to which you want to save the recording. If the file already
exists, you are prompted to overwrite it. Press <Y> to overwrite the file or <N> to
cancel. If you press <N>, you are prompted to enter another filename.

• If you want to write the phrase to the current auto-indexed file, press <A>. You
are prompted to confirm. Press <Y> to write the phrase or <N> to cancel. If you
press <Y>, the name of the file to which the phrase is written is displayed. Press
any key to continue.
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To paste the buffer contents into an existing phrase:

1. Complete the steps to copy or delete a phrase or phrase segment to the buffer.

2. To clear the current phrase, press <C>. When prompted to confirm, press <Y>. The
phrase is cleared.

3. Press <G>.

4. When prompted, enter the name of the .LIN filename of the phrase in which you want
to paste the buffer contents, then press <ENTER>. For example, to open phrase
D2001.LIN type D2001.LIN then press <ENTER>. A graphical representation of
the phrase is displayed in the Main window.

5. To activate the cursor menu, press <S>. Position the cursors on top of each other at
the location you want to paste the buffer contents. For more information on
positioning the cursors, see the topic, “Selecting a Segment of a Phrase,” earlier in
this chapter.

6. Once the cursors are positioned correctly, press <ESC> to return to the Main menu.

7. From the Main menu, press <B>.

8. When prompted to enter a filename, press <ENTER>. The contents of the buffer is
written to the foreground phrase.

9. To review the phrase, press <P>. If you are satisfied with the phrase, press <W>.

10. When prompted, enter the name of the file you entered in step 4, then press
<ENTER>.

11. When prompted to overwrite, press <Y>. The file is saved with the modifications.

Exiting V-Edit

Use the following procedure to exit the V-Edit.

To exit V-Edit:

1. From the Main menu or the Cursor menu, press <F10>.

2. When prompted to confirm that you want to exit V-Edit, press <Y>. The \VEDIT
prompt displays.
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Preparing the Phrases for Use with Octel 50

Once you complete creating or editing phrases, use the following procedures to compress
and join the files for use with Octel 50.

In the following procedure, you must specify the name of the phrase file you want to
prepare for use with V-Edit. In this procedure, the SO3-D2.VOX file is used as an
example. To use another file, enter the name of that file instead of SO3-D2.VOX
wherever it is specified. Remember that phrase files SO3-D1.VOX and SO3-ALL.VOX
contain the standard phrases used by Octel 50. Do not create a new file with one of these
names or modify an existing file without verifying the phrase numbers very carefully.

To prepare the phrases for use with Octel 50:

1. Complete the procedure to exit V-Edit.

2. From the \VEDIT directory prompt, type COMPRESS D2001.LIN D2001.VOX
then press <ENTER>. The file are compressed into .VOX files and the \VEDIT
prompt displays.

3. From the \VEDIT directory prompt type VJOIN -C 999 -S D2.VOX -D
SO3-D2.VOX -R PHRASE.MAP then press <ENTER>. Verify that the join file is
d2_ _ _.vox, the output file is so3-d2.vox, the last file to be used is d2999, and that the
report will be written to the file phrase.map. If they are correct, press <Y>. If they are
not correct, press <N> and repeat steps 4 through 6. After a few moments, the .VOX
files are joined to make the phrase SO3-D2.VOX and a phrase file listing is written to
the file PHRASE.MAP.

4. From the \VEDIT prompt, type COPY SO3-D2.VOX C:\CVR then press
<ENTER>. This replaces the existing SO3-D2.VOX file in the \CVR directory with the
file you modified using the V-Edit.

5. Launch the Octel 50 system and test the new or modified phrases. For information on
launching the Octel 50 system, see the topic, “Starting and Shutting Down Octel 50,”
in Chapter 12, “Maintaining the System.”

6. If you are satisfied with the new or modified phrases, shut down the Octel 50 system.
For information on shutting down the Octel 50 system, see the topic, “Starting and
Shutting Down Octel 50,” in Chapter 12, “Maintaining the System.” The \CVR prompt
displays.

7. From the \CVR prompt, type CD VEDIT then press <ENTER>. The \VEDIT prompt
displays.

8. From the \VEDIT prompt, type DELETE D2*.VOX, where D2 specifies the prefix
you used with V-Edit, then press <ENTER>. If you used a different prefix, substitute it
for D2 in the command. The .VOX files with the specified prefix are deleted.

9. Restart the Octel 50 system. For information on launching the Octel 50 system, see
the topic, “Starting and Shutting Down Octel 50,” in Chapter 12,”Maintaining the
System.”
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If you followed step 2 in the procedure Preparing an Existing Phrase for Use with V-Edit,
you have a backup of the original phrase file. If you are satisfied with the phrase
modifications and no longer need the backup file, you can delete it. For example, if you
followed the example in step 2 of the procedure Preparing an Existing Phrase for Use with
V-Edit to create a backup in the \CVR directory named SO3-D2.BAK, from the \CVR
prompt, type DEL SO3-D2.BAK then press <ENTER>. If you need to restore the
original phrase file, copy or rename the backup file as necessary to overwrite the current
phrase file. For example, if you followed the example in step 2 of the procedure Preparing
an Existing Phrase for Use with V-Edit to create a backup in the \CVR directory named
SO3-D2.BAK, from the \CVR prompt, type REN SO3-D2.BAK SO3-D2.VOX then
press <ENTER>.
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retrieval), 11-2
changing fax retrieval document number, 11-3
configuring, 3-7
connecting fax boards to the phone system, 3-10
fax board
fax board, installing, 3-9
Fax Retrieval utility, 11-1
fax retrieval, definition of, 11-2
Fax Setup parameters, 8-35
Non-Transfer method, 3-11
setting header or footer for fax retrieval, 11-4
Transfer method, 3-11

FD.CFG, 4-11

FD.EXE, 4-11

FDEXIT.EXE, 4-11

Footer for fax retrieval, setting up, 11-4
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G

General Setup parameters, 8-3

General Transfer Setup parameters, 8-12

H

Hangup Detection Setup parameters, 8-88

Hardware
installing, 3-1
requirements, 2-3
sentinel installation, 3-13

Header for fax retrieval, setting up, 11-4

I

Inband Signaling Setup parameters, 8-68

Installing
connecting telephone and fax lines to the phone

system, 3-10
determining system needs, 2-1
fax board, 3-9
hardware, 3-1
hardware requirements, 2-3
installation overview, 1-1
materials checklist, 3-2
Octel 50 software, 4-3
sentinel, 3-13
SMDI, 5-2
software, 4-1
system considerations, 2-2
verifying the PC is ready for installation, 4-2
verifying the phone system, 3-3
voice boards, 3-9

INTEGRAT.EXE, 4-11

Integrating, system switch, 7-2

Intercom Paging Setup parameters, 8-45

K

Keypad format, defining an alternate, 4-9

L

Log File utility, 12-13

Low-level Voice Board Setup parameters, 8-100

M

Mailboxes
rebuilding all mailboxes, 12-10
running a partial mailbox update, 12-5
running an update on all system mailboxes, 12-7

Maintaining the system, 12-1

MESSAGE.DAT, 4-11

Message
Message Delivery Setup parameters, 8-62

Message Timing parameters, 8-15
Message Waiting Light Setup parameters, 8-64

MSGCONF.DAT, 4-11

Multilingual capabilities, 14-23

N

Non-Transfer method (fax), 3-11

O

Octel 50
configuring the system, 10-1
determining system needs, 2-1
documentation, 1-2
hardware requirements, 2-3
installing the hardware, 3-1
maintaining the system, 12-1
materials checklist, 3-2
running Quick Assist as routine maintenance, 12-12
shutting down, 12-2
starting, 12-2
system considerations, 2-2
system overview, 1-2
verifying the phone system, 3-3

verifying the PC is ready for installation, 4-2

OPERATOR.CKP, 4-11

OPERATOR.LOG, 4-11

OPERATOR.P, 4-11

OPERATOR.SYS, 4-11, 4-12

P

PC Configuration Setup parameters, 8-97

Phrase files, multilingual capabilities, 14-23

PORTS.DAT, 4-12

Professionally recorded phrases, 14-23

Q

QASSIST.EXE, 4-12

Quick Assist utility, 12-3
rebuilding all mailboxes, 12-10
running a partial mailbox update, 12-5
running an update on all system mailboxes, 12-7
running as routine maintenance, 12-12
verifying Octel 50 system file integrity, 12-4

R

Receptionist Setup parameters, 8-7

Recording voice phrases, 14-23

Requirements, Call Analysis utility, 9-2

Rhetorex Board
AccuCall Call Analysis, 9-6
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adding additional boards to the system, 12-2
CCA Call Analysis, 9-3
configuring, 3-6
connecting to the phone system, 3-10
defining an alternate board configuration, 4-9
Visual Voice Editor, 14-39

Running
AccuCall, 9-6
CCA, 9-3
CPC, 9-14
Integrator, 7-2
Log File, 12-13
Quick Assist, 12-3
SMDI, 5-3
System Setup, 8-2

RUNSMO3.BAT, 4-12

S

Sample files, 4-7

Sentinel, installing, 3-13

SET_UP.CFG, 4-12

Setting up multilingual system, 14-24

Shutting down Octel 50, 12-2

SMDI utility
installing, 5-2
running SMDI, 5-3
SMDI Setup parameters, 8-99

SMOOTHX.EXE, 4-12

SO3-ALL.VAP, 4-12

SO3-D1.VAP, 4-12

SO3-D2.VAP, 4-12

Software
backing up the software, 4-2
installing, 4-1

Starting Octel 50, 12-2

SUBSCRIB.DAT, 4-12

Subscriber Setup parameters, 8-18

SWDATA.TXT, 4-12

Switch Integrator utility, 7-2

System Setup utility, 8-2
AMIS parameters, 8-23
Call Queuing parameters, 8-41
Call Screening parameters, 8-55
Call Transfer parameters, 8-48
Call Waiting parameters, 8-58
Caller parameters, 8-22
Channel Specific parameters, 8-91
Dialing parameters, 8-59
Fax Extensions tab, 8-40
Fax parameters, 8-35
General parameters, 8-3
General Transfer parameters, 8-12
Hangup Detection parameters, 8-88
Inband Signaling parameters, 8-68
Intercom Paging parameters, 8-45

Low-level Voice Board parameters, 8-100
Message Delivery parameters, 8-62
Message Timing parameters, 8-15
Message Waiting Light parameters, 8-64
PC Configuration parameters, 8-97
Receptionist parameters, 8-7
SMDI parameters, 8-99
Subscriber parameters, 8-18
Time/Date parameters, 8-13
Uninterruptable Power Supply parameters, 8-68

T

Time/Date parameters, 8-13

Transfer method (fax), 3-11

Troubleshooting AccuCall, 9-13

U

Understanding
DialPlan, 6-4
Transfer method vs. Non-Transfer method, 3-11

Uninterruptable Power Supply Setup parameters, 8-68

UPS Integrator utility
low battery, 10-2
normal operation, 10-2
power out, 10-2

UPS, installing, 3-13

Using
AccuCall, 9-6
CCA, 9-3
CPC, 9-14
Integrator, 7-2
SMDI, 5-3
System Setup, 8-2
V-Edit, 14-24
Visual Voice Editor, 14-39

Utilities
AccuCall utility, 9-6
Automatic Data Recovery, 12-13
CCA utility, 9-3
CPC utility, 9-14
Fax Retrieval utility, 11-1
Log File, 12-13
Quick Assist, 12-3
SMDI utility, 5-2
Switch Integrator utility, 7-2
System Setup utility, 8-2

V

VBOX.DAT, 4-12

V-Edit (Dialogic), 14-23

V-Edit, using, 14-24

Verifying Octel 50 system file integrity, 12-4

VFTREE.DAT, 4-12

Visual Voice Editor (Rhetorex), 14-23
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Visual Voice Editor, using, 14-39

Voice Board parameters, 8-100

Voice boards
adding additional boards to the system, 12-2
configuring, 3-3
connecting to the phone system, 3-10
installing, 3-9


